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Preface

This guide is the primary source of introduction and usage information for Oracle 
Application Server Integration B2B.

This Preface contains these topics:

■ Intended Audience

■ Documentation Accessibility

■ Structure

■ Related Documents

■ Conventions
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Intended Audience
Oracle Application Server Integration B2B User’s Guide is intended for customers who 
want to perform the following tasks for integrations between enterprises.

■ Design

■ Deploy

■ Monitor

■ Manage

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Standards will continue to evolve over 
time, and Oracle is actively engaged with other market-leading technology vendors to 
address technical obstacles so that our documentation can be accessible to all of our 
customers. For additional information, visit the Oracle Accessibility Program Web site 
at 

http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation JAWS, a Windows screen reader, 
may not always correctly read the code examples in this document. The conventions 
for writing code require that closing braces should appear on an otherwise empty line; 
however, JAWS may not always read a line of text that consists solely of a bracket or 
brace.

Accessibility of Links to External Web Sites in Documentation This documentation 
may contain links to Web sites of other companies or organizations that Oracle does 
not own or control. Oracle neither evaluates nor makes any representations regarding 
the accessibility of these Web sites.

Structure
This document contains:

Part I, "Introduction and Concepts"
This part provides OracleAS Integration B2B introduction and conceptual details.

Chapter 1, "Introduction to Oracle Application Server Integration B2B"
This chapter provides a conceptual overview of OracleAS Integration B2B. 

Chapter 2, "Supported Protocols"
This chapter provides an overview of supported protocols. 

Chapter 3, "Communicating with Host Trading Partner Applications"
This chapter describes how OracleAS Integration B2B communicates with the host 
application of the host trading partner.
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Part II, "Introduction to the User Interface Tool"
This part introduces and provides a tutorial on how to use the OracleAS Integration 
B2B user interface tool.

Chapter 4, "Getting Started with the User Interface Tool"
This chapter describes how to get started with the OracleAS Integration B2B user 
interface tool. This chapter briefly describes the tasks to perform and the features 
available from each user interface tool tab.

Chapter 5, "OracleAS Integration B2B Tutorials"
This chapter provides a simple tutorial on how to use the OracleAS Integration B2B 
user interface tool to design and deploy an integration within an enterprise.

Part III, "Design-Time and Deployment Tasks"
This part describes how to design and deploy a configuration consisting of a trading 
partner agreement between trading partners with the OracleAS Integration B2B user 
interface tool.

Chapter 6, "Managing Business Protocols"
This chapter describes the tasks required to manage business protocols that you assign 
to remote trading partners. The host trading partner is automatically assigned all 
business protocols in OracleAS Integration B2B.

Chapter 7, "Creating Trading Partners"
This chapter describes how to use the Create Trading Partner wizard to create a remote 
trading partner, assign it a business protocol with operational and communication 
capabilities, and assign communication capabilities to the business protocol of the host 
trading partner. The host trading partner is automatically assigned all business 
protocols and operational capabilities.

Chapter 8, "Managing Trading Partners"
This chapter describes the tasks required to manage trading partners created with the 
Create Trading Partner wizard and their business protocol operational and 
communication capabilities.

Chapter 9, "Managing Callouts"
This chapter describes how to use callouts to transform documents from one form to 
another.

Chapter 10, "Creating and Managing Trading Partner Agreements"
This chapter describes the tasks required to create and manage a trading partner 
agreement between a host and remote trading partner. Both trading partners include a 
business protocol with operational and communication capabilities.

Chapter 11, "Creating and Deploying a Configuration"
This chapter describes how to create and deploy a configuration consisting of a trading 
partner agreement between two trading partners. 

Part IV, "Administration, Monitoring, and Security Tasks"
This part describes how to administer OracleAS Integration B2B design-time and 
runtime data and create reports that monitor the status of a deployed configuration.
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Chapter 12, "Administering Oracle Application Server Integration B2B"
This chapter describes how to administer OracleAS Integration B2B design-time and 
runtime data with the OracleAS Integration B2B user interface tool.

Chapter 13, "System Management with Oracle Enterprise Manager 10g"
This chapter provides an overview of Oracle Application Server Integration B2B 
monitoring and administration tasks that you can perform from Oracle Enterprise 
Manager 10g.

Chapter 14, "Creating Reports"
This chapter describes how to create OracleAS Integration B2B reports that monitor 
the status of a deployed configuration.

Chapter 15, "Oracle Application Server Integration B2B Security"
This chapter describes the architecture and configuration of security for Oracle 
Application Server Integration B2B.

Appendix A, "Troubleshooting and Workarounds"
This appendix describes Oracle Application Server Integration B2B troubleshooting 
methods.

Glossary
This glossary provides definitions of terms

Related Documents
For more information, see these Oracle resources:

■ Oracle Application Server 10g Documentation Library

■ Oracle Application Server Integration B2B Installation Guide

Printed documentation is available for sale in the Oracle Store at

http://oraclestore.oracle.com/

To download free release notes, installation documentation, white papers, or other 
collateral, please visit the Oracle Technology Network (OTN). You must register online 
before using OTN; registration is free and can be done at

http://www.oracle.com/technology/membership/

If you already have a username and password for OTN, then you can go directly to the 
documentation section of the OTN Web site at

http://www.oracle.com/technology/documentation/

For additional information, see:

■ http://www.w3.org

■ http://www.rosettanet.org
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Conventions
This section describes the conventions used in the text and code examples of this 
documentation set. It describes:

■ Conventions in Text

■ Conventions in Code Examples

■ Conventions for Windows Operating Systems

Conventions in Text
We use various conventions in text to help you more quickly identify special terms. 
The following table describes those conventions and provides examples of their use.

Conventions in Code Examples
Code examples illustrate SQL, PL/SQL, SQL*Plus, or other command-line statements. 
They are displayed in a monospace (fixed-width) font and separated from normal text 
as shown in this example:

SELECT username FROM dba_users WHERE username = ’MIGRATE’;

Convention Meaning Example

Bold Bold typeface indicates terms that are 
defined in the text or terms that appear in a 
glossary, or both.

When you specify this clause, you create an 
index-organized table. 

Italics Italic typeface indicates book titles or 
emphasis.

Oracle Database Concepts

Ensure that the recovery catalog and target 
database do not reside on the same disk.

UPPERCASE 
monospace 
(fixed-width) 
font

Uppercase monospace typeface indicates 
elements supplied by the system. Such 
elements include parameters, privileges, 
datatypes, RMAN keywords, SQL 
keywords, SQL*Plus or utility commands, 
packages and methods, as well as 
system-supplied column names, database 
objects and structures, usernames, and 
roles.

You can specify this clause only for a NUMBER 
column.

You can back up the database by using the 
BACKUP command.

Query the TABLE_NAME column in the USER_
TABLES data dictionary view.

Use the DBMS_STATS.GENERATE_STATS 
procedure.

lowercase 
monospace 
(fixed-width) 
font

Lowercase monospace typeface indicates 
executables, filenames, directory names, 
and sample user-supplied elements. Such 
elements include computer and database 
names, net service names, and connect 
identifiers, as well as user-supplied 
database objects and structures, column 
names, packages and classes, usernames 
and roles, program units, and parameter 
values.

Note: Some programmatic elements use a 
mixture of UPPERCASE and lowercase. 
Enter these elements as shown.

Enter sqlplus to start SQL*Plus.

The password is specified in the orapwd file.

Back up the datafiles and control files in the 
/disk1/oracle/dbs directory.

The department_id, department_name, and 
location_id columns are in the 
hr.departments table.

Set the QUERY_REWRITE_ENABLED initialization 
parameter to true.

Connect as oe user.

The JRepUtil class implements these methods.

lowercase 
italic 
monospace 
(fixed-width) 
font

Lowercase italic monospace font represents 
placeholders or variables.

You can specify the parallel_clause.

Run old_release.SQL where old_release 
refers to the release you installed before 
upgrading.
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The following table describes typographic conventions used in code examples and 
provides examples of their use.

Conventions for Windows Operating Systems 
The following table describes conventions for Windows operating systems and 
provides examples of their use.

Convention Meaning Example

[ ] Brackets enclose one or more optional 
items. Do not enter the brackets.

DECIMAL (digits [ , precision ])

{ } Braces enclose two or more items, one of 
which is required. Do not enter the braces.

{ENABLE | DISABLE}

| A vertical bar represents a choice of two or 
more options within brackets or braces. 
Enter one of the options. Do not enter the 
vertical bar.

{ENABLE | DISABLE}
[COMPRESS | NOCOMPRESS]

... Horizontal ellipsis points indicate either:

■ That we have omitted parts of the 
code that are not directly related to the 
example

■ That you can repeat a portion of the 
code

CREATE TABLE ... AS subquery;

SELECT col1, col2, ... , coln FROM 
employees;

 .
 .
 .

Vertical ellipsis points indicate that we 
have omitted several lines of code not 
directly related to the example.

SQL> SELECT NAME FROM V$DATAFILE;
NAME
------------------------------------
/fsl/dbs/tbs_01.dbf
/fs1/dbs/tbs_02.dbf
.
.
.
/fsl/dbs/tbs_09.dbf
9 rows selected.

Other notation You must enter symbols other than 
brackets, braces, vertical bars, and ellipsis 
points as shown.

acctbal NUMBER(11,2);
acct    CONSTANT NUMBER(4) := 3;

Italics Italicized text indicates placeholders or 
variables for which you must supply 
particular values.

CONNECT SYSTEM/system_password
DB_NAME = database_name

UPPERCASE Uppercase typeface indicates elements 
supplied by the system. We show these 
terms in uppercase in order to distinguish 
them from terms you define. Unless terms 
appear in brackets, enter them in the order 
and with the spelling shown. However, 
because these terms are not case sensitive, 
you can enter them in lowercase.

SELECT last_name, employee_id FROM 
employees;
SELECT * FROM USER_TABLES;
DROP TABLE hr.employees;

lowercase Lowercase typeface indicates 
programmatic elements that you supply. 
For example, lowercase indicates names of 
tables, columns, or files.

Note: Some programmatic elements use a 
mixture of UPPERCASE and lowercase. 
Enter these elements as shown.

SELECT last_name, employee_id FROM 
employees;
sqlplus hr/hr
CREATE USER mjones IDENTIFIED BY ty3MU9;
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Convention Meaning Example

Choose Start > How to start a program. To start the Database Configuration Assistant, 
choose Start > Programs > Oracle - HOME_
NAME > Configuration and Migration Tools > 
Database Configuration Assistant.

File and directory 
names

File and directory names are not case 
sensitive. The following special characters 
are not allowed: left angle bracket (<), right 
angle bracket (>), colon (:), double 
quotation marks ("), slash (/), pipe (|), and 
dash (-). The special character backslash (\) 
is treated as an element separator, even 
when it appears in quotes. If the file name 
begins with \\, then Windows assumes it 
uses the Universal Naming Convention.

c:\winnt"\"system32 is the same as 
C:\WINNT\SYSTEM32

C:\> Represents the Windows command 
prompt of the current hard disk drive. The 
escape character in a command prompt is 
the caret (^). Your prompt reflects the 
subdirectory in which you are working. 
Referred to as the command prompt in this 
manual.

C:\oracle\oradata>

Special characters The backslash (\) special character is 
sometimes required as an escape character 
for the double quotation mark (") special 
character at the Windows command 
prompt. Parentheses and the single 
quotation mark (’) do not require an escape 
character. Refer to your Windows 
operating system documentation for more 
information on escape and special 
characters.

C:\>exp scott/tiger TABLES=emp 
QUERY=\"WHERE job=’SALESMAN’ and 
sal<1600\"
C:\>imp SYSTEM/password FROMUSER=scott 
TABLES=(emp, dept)

HOME_NAME Represents the Oracle home name. The 
home name can be up to 16 alphanumeric 
characters. The only special character 
allowed in the home name is the 
underscore. 

C:\> net start OracleHOME_NAMETNSListener
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ORACLE_HOME 
and ORACLE_
BASE

In releases before Oracle8i release 8.1.3, 
when you installed Oracle components, all 
subdirectories were located under a top 
level ORACLE_HOME directory.

This release complies with Optimal 
Flexible Architecture (OFA) guidelines. All 
subdirectories are not under a top level 
ORACLE_HOME directory. There is a top 
level directory called ORACLE_BASE that 
by default is C:\oracle. If you install the 
latest Oracle release on a computer with no 
other Oracle software installed, then the 
default setting for the first Oracle home 
directory is C:\oracle\orann, where nn 
is the latest release number. The Oracle 
home directory is located directly under 
ORACLE_BASE.

All directory path examples in this guide 
follow OFA conventions.

Refer to Oracle Database Platform Guide for 
Windows for additional information about 
OFA compliances and for information 
about installing Oracle products in 
non-OFA compliant directories.

Go to the ORACLE_BASE\ORACLE_
HOME\rdbms\admin directory.

Convention Meaning Example



Part I
Introduction and Concepts

This part provides Oracle Application Server Integration B2B introduction and 
conceptual details.

This part contains the following chapters: 

■ Chapter 1, "Introduction to Oracle Application Server Integration B2B"

■ Chapter 2, "Supported Protocols"

■ Chapter 3, "Communicating with Host Trading Partner Applications"
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1
Introduction to Oracle Application Server

Integration B2B

Oracle Application Server Integration B2B (OracleAS Integration B2B) is an e-business 
integration product for the business-to-business (B2B) exchange of services, 
information, and products. If you know who you want to trade with (for example, a 
specific supplier), what you want to do (for example, send a purchase order), and how 
you want to do it (for example, send the purchase order over the Internet), then you 
have defined a basic B2B transaction.

This chapter contains these topics:

■ What Does OracleAS Integration B2B Provide?

■ Supported Protocols

■ Design-Time Workflow

■ OracleAS Integration B2B Administration, Monitoring, and Security

■ Chapter Summary
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What Does OracleAS Integration B2B Provide?
OracleAS Integration B2B provides the features you need to design, deploy, monitor, 
and manage a B2B integration. Table 1–1 lists the features and benefits of OracleAS 
Integration B2B.

Figure 1–1 shows another view of OracleAS Integration B2B features. Who you want to 
trade with is defined in the trading partner management component. What you do is 
defined in the business protocol (shown within the dotted lines). How you do the B2B 
transaction is defined in the transport and packaging components. OracleAS 

Table 1–1 Features and Benefits of OracleAS Integration B2B

Feature Benefit See...

Standard B2B protocols 
and custom protocols

You can work with trading partners who use a variety 
of protocols; choose from RosettaNet, EDI EDIFACT, 
EDI X12, Applicability Statement 2 (AS2), UCCnet, 
or create a custom protocol.

Chapter 2, "Supported 
Protocols"

Integration with OracleAS 
Integration products and 
custom applications

■ Oracle E-Business 
Suite

■ Oracle Application 
Server Integration 
InterConnect 
(OracleAS Integration 
InterConnect)

■ Trading partner 
applications

Using the secure B2B connectivity of OracleAS 
Integration B2B, you can send a purchase order (or 
other business document) from your Oracle 
E-Business Suite iProcurement application, for 
example, to a trading partner. 

If your trading partner requires a business document 
format that differs from your format, use the 
transformation capabilities of OracleAS Integration 
InterConnect.

Using internal delivery channels, you can 
communicate with the back-end applications of the 
host trading partner 

Chapter 3, "Communicating 
with Host Trading Partner 
Applications"

Chapter 8, "Managing 
Trading Partners"

Integrated user experience The user interface tool and wizards guide all aspects 
of designing your B2B transaction, no matter which 
protocols you choose.

Chapter 4, "Getting Started 
with the User Interface Tool"

Comprehensive trading 
partner management

In OracleAS Integration B2B, you can associate 
standard or custom protocols and communication 
details with trading partners. You can easily manage 
multiple protocols and multiple versions for each of 
the trading partners.

To simplify your user experience, the host trading 
partner is automatically assigned support for a 
business protocol and operational capabilities that are 
compatible with the remote trading partner. When 
you create a trading partner agreement, the host 
trading partner is also automatically assigned support 
for a collaboration or business action that is 
compatible with the one assigned to the remote 
trading partner.

Chapter 6, "Managing 
Business Protocols"

Chapter 7, "Creating Trading 
Partners"

Chapter 8, "Managing 
Trading Partners"

Reports With the integrated reports feature, you can create 
business message, wire message, collaboration, and 
error status reports. You can also save a report 
definition for reuse or to view in Microsoft Excel. 

Chapter 14, "Creating 
Reports"

Security The security features of OracleAS Integration B2B 
include, for example, the ability to configure digital 
envelopes, remote trading partner certificates, digital 
signatures, secure socket layer (SSL), and host trading 
partner wallet passwords. OracleAS Integration B2B 
also leverages Oracle Application Server security 
features.

Chapter 15, "Oracle 
Application Server 
Integration B2B Security"
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Integration B2B interfaces with Oracle Application Server Integration InterConnect 
(OracleAS Integration InterConnect) using the IP queue, with Oracle E-Business Suite 
using the XML Gateway, and with trading partner applications using queues. The 
figure also shows that the B2B server supports a number of standard protocols, which 
are listed in Table 1–2.

Figure 1–1 OracleAS Integration B2B Architecture

Supported Protocols
Table 1–2 describes the protocols—the agreed-upon formats for transmitting data— 
and the protocol revisions that OracleAS Integration B2B supports, categorized by 
protocol type. As shown in the table, OracleAS Integration B2B implements the 
nonproprietary, XML-based RosettaNet standards to exchange documents over the 
Internet. OracleAS Integration B2B also implements electronic data interchange (EDI), 
a standard format for exchanging business data over the Internet (using AS2) or over 
value-added networks (VANs), by supporting EDI X12 and EDI EDIFACT. For 
proprietary transaction mechanisms, OracleAS Integration B2B provides the Custom 
Document protocol to create document definitions for XML and non-XML messages. 
The table also lists the exchange, transport, and packaging protocols that OracleAS 
Integration B2B supports.

IP queue

Oracle Application Server Integration B2B

Document Protocols
· RosettaNet
· EDI x12
· EDI EDIFACT
· Custom

Business Protocol

Process Protocol
· B2B

Exchange Protocols
· RosettaNet 

Implementation
 Framework
· AS2
· Generic

Transport Protocols
· HTTP
· HTTPS
· Email
· File / FTP

Packaging Protocols
· MIME
· S / MIME 
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Design-Time Workflow
The design-time workflow of OracleAS Integration B2B follows naturally from how 
businesses exchange services, information, and products:

1. Identify the business protocol.

Identifying the business protocol—a combination of a document protocol, 
exchange protocol, and process protocol (see Table 1–2)—consists of selecting a 
predefined business protocol or tuning it so that it is configured to your needs.

2. Manage trading partners—trading partner profiles and trading partner 
agreements. 

As part of trading partner management, you create the remote trading partner 
and associate it with the business protocol. Then you create a trading partner 
agreement and associate it with the remote trading partner and business protocol.

3.  Configure and deploy.

A configuration is the collection of trading partner data that you have created. 
Creating a configuration enforces the validation rules so that only valid, complete, 
and consistent data is available in the runtime repository. Then deployment 
activates a configuration from the design-time repository to the runtime 
repository.

Table 1–2 B2B Protocols Supported in OracleAS Integration B2B

Protocol Type Protocol and Revision

The document protocol defines the document type of 
the message payload, which is based on which standard 
(RosettaNet, EDI, and so on) you are using as part of the 
business logic.

■ RosettaNet (1.1 and 2.0)

■ EDI X12 (all revisions)

■ EDI EDIFACT (all revisions)

■ Custom Document—customer-defined protocols 

The exchange protocol defines the message exchange 
mechanism—how to exchange the documents defined 
by the document protocol. It defines the headers, 
acknowledgments, and packaging that puts the headers 
and payload together. It also defines the transport 
protocol and packaging protocol for the exchange.

■ RosettaNet Implementation Framework (RNIF 
01.10, RNIF V02.00)

■ AS2

■ Generic (Generic 1.0)

■ transport protocol—defines the underlying 
transport and its properties

■ HTTP (HTTP 1.0, HTTP 1.1)

■ HTTPS (HTTPS 1.0, HTTPS 1.1)

■ Email (SMTP 1.0, IMAP 1.0)

■ FTP (FTP 1.0)

■ File (File 1.0)

■ packaging protocol—defines a packaging 
mechanism. Message security such as signing and 
encryption are often based on a specific packaging 
mechanism

■ MIME (MIME 1.0)

■ S/MIME (S/MIME 2.0, S/MIME 3.0)

The process protocol defines how you exchange 
messages, using the document protocol-based business 
document, and exchanging it based on the exchange 
protocol. It is the mechanism by which business actions 
and collaborations are associated with specific 
document types.

■ B2B

See Also: Chapter 2, "Supported Protocols"
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Figure 1–2 shows the design-time workflow. 

Figure 1–2 Design-Time Workflow

Business Protocols
OracleAS Integration B2B provides business protocols, which bundle common 
message exchange options. The business protocols capture combinations needed to 
integrate typical B2B scenarios. Figure 1–1 shows a dashed line around the process, 
document, and exchange protocols that make up the business protocol.

Trading Partner Management—Creating Trading Partner Profiles
A trading partner is an organization that engages in e-business transactions between 
enterprises with another organization (trading partner). In OracleAS Integration B2B, 
trading partner management starts with creating a trading partner profile, which 
defines the following.

■ Who are the trading partners?

■ How are they uniquely identified?

■ What standards do they support?

■ How do they send documents?

■ How do they exchange document?

■ How do they communicate?

 A trading partner may have host (back-end) applications, databases, or customers to 
involve in the transaction. Using the OracleAS Integration B2B user interface tool 
defines you as the host trading partner. 

See Also: Chapter 4, "Getting Started with the User Interface Tool" 
to see how the design-time workflow is reflected in the OracleAS 
Integration B2B wizards and user interface tool.

See Also:

■ "Business Protocols" on page 2-11 for a list of the business 
protocols defined in OracleAS Integration B2B

■ Chapter 6, "Managing Business Protocols"

Trading Partner
Profile

Manage Trading Partners

2

Configure

3

Deploy

Capabilities

· Process Protocol
· Document Protocol
· Exchange Protocol

Identify the
Business Protocol

1

Trading
Partner
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The workflow for creating a trading partner is shown in Figure 1–3. The steps in the 
figure correspond to a page in the Create Trading Partner wizard. (See Table 7–1, 
" Create Trading Partner Wizard Pages" on page 7-4 for more information.)

Figure 1–3 Trading Partner Management Workflow

On the General page, you name the trading partners. On the Identification page, you 
provide standard identifiers (such as a DUNS number). For the remote trading partner, 
you set up the first three steps only. To simplify your user experience, the host trading 
partner is automatically assigned support for a business protocol and operational 
capabilities that are compatible with those of the remote trading partner.

In the operational capabilities step, you define the collaborations (for RosettaNet) or 
business actions (for EDI X12, EDIFACT, or Custom Document) for a trading partner’s 
business protocol. For example, if you select the RosettaNet over RNIF business 
protocol, the wizard prompts you to select a collaboration (such as PIP 3A4) and its 
associated role (buyer or seller), to indicate a time in which to process the 
collaboration, and to select whether OracleAS Integration B2B handles the 
acknowledgments. If you select an EDI or Custom Document business protocol, the 
wizard prompts you to select the business action (such as 850 or ORDERS), to indicate 
the initiator, and to select whether OracleAS Integration B2B handles the 
acknowledgment.

The delivery channel, document exchange, and transport steps shown in Figure 1–3 
comprise the communication capabilities of the trading partner’s business protocol. 
The delivery channel defines the secure exchange of messages between trading 
partners. Selections you make when specifying the delivery channel determine the 
document exchange and transport options. Delivery channel details that you provide 
include:

■ Delivery channel name

■ Acknowledgment mode

■ Global usage code

■ If nonrepudiation of receipt and nonrepudiation of origin are required

■ If encryption, transport security, and compression (for AS2 exchange protocol) are 
enabled

■ Time to acknowledgment value

■ Retry count value

The document exchange defines the characteristics for exchanging messages between 
trading partners. Document exchange details that you provide include:

■ Document exchange name

■ Exchange protocol revision and any override parameter values

■ Digital signature and signing credential

■ Digital envelope and encryption credential

The document exchange layer receives a business document, encrypts it (if specified), 
adds a digital signature for nonrepudiation (if specified), and sends it to the transport 
for transmission to the other trading partner. The document exchange elements 

General Identification Operational
Capability

Delivery
Channel

Document
Exchange

Transport Review
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essentially describe a trading partner’s message-receiving characteristics. The 
document protocols supported in OracleAS Integration B2B are listed in Table 1–2.

The transport defines characteristics for message delivery. The transport details that 
you provide include:

■ Transport name and protocol

■ Transport server name, hostname, address, and login credentials

■ Endpoint URI of the trading partner

For outgoing messages sent to a trading partner, OracleAS Integration B2B calls the 
transport with the message to send and provides the necessary transport 
protocol-specific bindings. For incoming messages received from a trading partner, the 
transport receives the messages and calls OracleAS Integration B2B with the received 
message and transport binding data for processing. The transport binding data 
specifies the protocol-specific status data and a list of protocol headers with their 
values. The transport protocols supported in OracleAS Integration B2B are listed in 
Table 1–2.

OracleAS Integration B2B is designed so that you can do all the trading partner 
management tasks in an efficient and comprehensive series of steps within the user 
interface. The Partners tab gives you access to all these tasks.

Trading Partner Management—Creating Trading Partner Agreements
Trading partner agreements define the terms and agreements that enable business 
documents to be exchanged between trading partners. Based on each trading partner 
profile, the trading partner agreement defines the following:

■ Who are the participants?

■ What is each participant’s unique identification?

■ What business protocol should be used?

■ How does each participant send documents?

■ How does each participant exchange documents?

■ How does each participant communicate?

■ What are the agreement terms?

Figure 1–4 shows an example of the information that is defined during trading partner 
management and that becomes part of a trading partner agreement. The figure shows 
that the host trading partner is the seller, the remote trading partner is the buyer, and 
the collaboration, PIP 3A4, is a transaction in which the remote trading partner (buyer) 
sends a purchase order request to the host trading partner (seller), who responds with 
a purchase order acceptance. 

See Also:

■ Chapter 4, "Getting Started with the User Interface Tool"

■ Chapter 7, "Creating Trading Partners"

■ Chapter 8, "Managing Trading Partners"
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Figure 1–4 Information Defined for the PIP 3A4 Collaboration

Trading partner agreements do not expose the internal processes of one trading 
partner to another.

Configuration and Deployment
In the configuration and deployment stage, you create a configuration—essentially a 
container for everything you have previously specified about trading partners and 
trading partner agreements. Then you deploy the configuration to the runtime 
environment. In the runtime environment, OracleAS Integration B2B sends messages 
to and receives messages from remote trading partners.

See Also:

■ Chapter 10, "Creating and Managing Trading Partner 
Agreements"

See Also: Chapter 11, "Creating and Deploying a Configuration"

Remote Trading Partner

Acme

RosettaNet over RNIF

Buyer-3A4-V02.00

123456789

Acme_DC

Host Trading Partner

GlobalChips **

RosettaNet over RNIF**

Seller-3A4-V02.00**

372463489

GlobalChips_DC

Participant

Business Protocol

Collaboration* (Operational Capabilities)

Trading Partner Identification

Delivery Channel (Communication Capabilities)

Trading Partner Agreement: Acme_3A4

* If the RosettaNet over RNIF business protocol is used, collaborations are part of the trading partner agreement. 
If any EDI or Custom Document business protocol is used, Business Actions are part of the trading partner agreement.

** Automatically included in the trading partner agreement.
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OracleAS Integration B2B Administration, Monitoring, and Security
Table 1–3 shows the features that are available to administer, monitor, and provide 
security in OracleAS Integration B2B.

Chapter Summary
This chapter describes the features, benefits, supported protocols, and design-time 
workflow of OracleAS Integration B2B. 

Table 1–3 OracleAS Integration B2B Features for Administration, Monitoring, and Security

To Do... Use... See...

Administer design-time and runtime 
data

OracleAS Integration B2B user 
interface tool

OracleAS Integration B2B 
Administration tab

Chapter 12, "Administering Oracle 
Application Server Integration B2B"

Manage an OracleAS Integration B2B 
middle tier, start and stop OracleAS 
Integration B2B components, or 
change server property values

Oracle Enterprise Manager 10g Chapter 13, "System Management 
with Oracle Enterprise Manager 10g"

Create reports that describe the 
runtime behavior status of a 
deployed configuration

OracleAS Integration B2B Reports 
tab

Chapter 14, "Creating Reports"

Control user access to content and 
protect your site against break-ins

OracleAS Integration B2B security 
features

Chapter 15, "Oracle Application 
Server Integration B2B Security"
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2
Supported Protocols

OracleAS Integration B2B supports standard B2B protocols, such as RosettaNet, EDI 
X12, EDI EDIFACT, Applicability Statement 2 (AS2), and UCCnet.

This chapter contains these topics:

■ Overview of Supported Protocols

■ Document Protocols

■ Exchange Protocols

■ Process Protocols

■ Business Protocols

■ Chapter Summary
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Overview of Supported Protocols
Table 2–1 lists the protocols—the agreed-upon formats for transmitting data— and the 
protocol revisions that OracleAS Integration B2B supports, categorized by protocol 
type. The protocols are described in more detail in subsequent sections.

Document Protocols
The document protocol defines the document type of the message payload. Business 
protocols can have multiple document protocols. Document protocols follow the 
hierarchy shown in Figure 2–1. A document protocol can consist of multiple document 
protocol revisions. A document protocol revision can consist of multiple document 
types. A document type can consist of multiple document definitions, because you can 
start with one document definition and customize it for different trading partners. For 
document definition files, you can use the template library of the Windows-based 
OracleAS Integration B2B - Document Editor to create EDI X12 and EDI 
EDIFACT.ecs files and RosettaNet.xsd and .dtd files that you then import into the 
OracleAS Integration B2B user interface tool. You cannot use OracleAS Integration B2B 
- Document Editor to define custom documents.

Table 2–1 B2B Protocols Supported in OracleAS Integration B2B

Protocol Type Protocol and Revision

The document protocol defines the document type of 
the message payload, which is based on which standard 
(RosettaNet, EDI, and so on) you are using as part of the 
business logic.

■ RosettaNet (1.1 and 2.0)

■ EDI X12 (all revisions)

■ EDI EDIFACT (all revisions)

■ Custom Document—customer-defined protocols 

The exchange protocol defines the message exchange 
mechanism—how to exchange the documents defined 
by the document protocol. It defines the headers, 
acknowledgments, and packaging that puts the headers 
and payload together. It also defines the transport 
protocol and packaging protocol for the exchange.

■ RosettaNet Implementation Framework (RNIF 
01.10, RNIF V02.00)

■ AS2

■ Generic (Generic 1.0)

■ transport protocol—defines the underlying 
transport and its properties

■ HTTP (HTTP 1.0, HTTP 1.1)

■ HTTPS (HTTPS 1.0, HTTPS 1.1)

■ Email (SMTP 1.0, IMAP 1.0)

■ FTP (FTP 1.0)

■ File (File 1.0)

■ packaging protocol—defines a packaging 
mechanism. Message security such as signing and 
encryption are often based on a specific packaging 
mechanism

■ MIME (MIME 1.0)

■ S/MIME (S/MIME 2.0, S/MIME 3.0)

The process protocol defines how you exchange 
messages, using the document protocol-based business 
document, and exchanging it based on the exchange 
protocol. It is the mechanism by which business actions 
and collaborations are associated with specific 
document types.

■ B2B
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Figure 2–1 Document Protocol Hierarchy

OracleAS Integration B2B supports the following document protocols. The document 
protocols are discussed in more detail in subsequent sections.

■ RosettaNet 

■ EDI X12

■ EDI EDIFACT

■ Custom Documents (includes support for UCCnet)

Using Document Protocols in OracleAS Integration B2B
To use the standard document protocols for RosettaNet, EDI X12, EDI EDIFACT, and 
UCCnet message exchanges, you must import them into OracleAS Integration B2B. 
See "Importing Support for Collaborations, Transaction Sets, and UCCnet Standards" 
on page 12-9 for details.

See Also:  

■ "OracleAS Integration B2B - Document Editor Overview" on 
page 6-4

■ "Managing Document Protocols" on page 6-5

■ "Page 2: Document Protocol Revision" on page 6-19 and "Page 3: 
Document Type" on page 6-20 for instructions on using OracleAS 
Integration B2B - Document Editor to import files when creating a 
business action

■ "Page 3: Requesting Business Action" on page 6-28 for instructions 
on using OracleAS Integration B2B - Document Editor to import 
files when creating a collaboration

■ The online Help included with OracleAS Integration B2B - 
Document Editor for instructions on using the library templates to 
create .ecs, .dtd, and .xsd files

■ Figure 6–4, Figure 6–5, and Figure 6–6  on page 6-7 for examples 
of document protocols defined for the EDI X12 over Generic 
Exchange business protocol

■ Figure 6–8 on page 6-16 for an example of process protocol 
management tasks for the RosettaNet over RNIF business protocol

Document Type
(850)

Document Protocol Revision
(EDI X12 4010)

Document Protocol
(EDI X12)

Document Definition
(.xsd file and associated information)
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RosettaNet
OracleAS Integration B2B implements the nonproprietary, XML-based RosettaNet 
standards to exchange documents over the Internet. RosettaNet standards prescribe 
when information should be exchanged, acknowledged, or confirmed, and how 
messages in an exchange should be packaged and physically exchanged between 
trading partners. RosettaNet standards are specified through the use of the RosettaNet 
Partner Interface Process (PIP), RosettaNet Dictionaries, and RNIF, which are 
described in subsequent sections.

OracleAS Integration B2B supports message exchanges using the RosettaNet PIPs 
shown in Table 2–3 when you create a collaboration. See "Process Protocols" on 
page 2-9 for more information about PIPs.

You can see how a collaboration is created using PIP 3A4 in "Acme Server, Task 1: 
Creating the Collaboration" on page 5-7 of tutorial 1.

Table 2–2 RosettaNet PIPs Supported in OracleAS Integration B2B

PIP Description Version

0A1 Notification of Failure V02.00.00

2A1 Distribute New Product Information V02.00.00

2A9 Query Technical Product Information V01.01.01

2A10 Distribute Design Engineering Information V02.00.00

2A12 Distribute Product Master V01.03.00

3A1 Request Quote V02.01.00

3A4 Request Purchase Order V02.03.00

3A6 Distribute Order Status V02.02.00

3A7 Notify of Purchase Order Update V02.03.00

3A8 Request Purchase Order Change V01.03.00

3A9 Request Purchase Order Cancellation V01.01.00

3B2 Notify of Advanced Shipment V01.01.00

3B3 Distribute Shipment Status R01.00.00

3B12 Request Shipping Order V01.01.00

3B13 Notify of Shipping Order Confirmation V01.01.00

3C1 Return Product V01.00.00

3C3 Notify of Invoice V01.01.00

3C4 Notify of Invoice Reject V01.00.00

4A1 Notify of Strategic Forecast V02.00.00

4A3 Notify of Threshold Release Forecast V02.01.00

4A4 Notify of Planning Release Forecast V03.00.00

4A5 Notify of Forecast Reply V02.00.00

4B2 Notify of Shipment Receipt V01.00.00

4C1 Distribute Inventory Report V02.03.00

7B1 Distribute Work in Process V01.00.00
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RosettaNet Dictionaries
The RosettaNet Business Dictionary provides a common vocabulary and a common 
set of properties to use in XML documents. For example, trading partners using the 
RosettaNet Business Dictionary might agree to use the term DRAM for memory chip. 
The RosettaNet Technical Dictionary is not supported in OracleAS Integration B2B.

RosettaNet Validation
RosettaNet validation compares the elements in RosettaNet XML-format business 
documents to the requirements specified in the RosettaNet Message Guideline 
specification to determine their validity. This specification defines requirements for 
details such as element datatypes, element lengths, element value lists, and element 
cardinality. PIPs that require RosettaNet dictionary validation are also validated when 
a dictionary is present.

The minimum validation-level requirements on the sections of a RosettaNet 
XML-format business document are as follows. These requirements cover the 
preamble, delivery header, service header, and service content sections of a document. 
Documents not following one or more of these requirements are identified as invalid.

1. The XML-format business document requires compliance with its DTD.

2. Elements with datatypes, lengths, or both that are specified in the RosettaNet 
Message Guideline specification require validation against this specification.

3. An element’s list of values specified in the entity instance list in the corresponding 
RosettaNet Message Guideline specification requires validation against this 
specification.

4. If the Message Guideline specification defines the cardinality specification of an 
element differently from the corresponding DTD specification, the Message 
Guideline specification takes precedence.

5. If a PIP requires dictionary validation, and a dictionary is included, the service 
content requires validation against the dictionary as a part of action performance.

6. Cross-tag validation is based on message guidelines.

EDI X12 
OracleAS Integration B2B supports message exchanges using American National 
Standards Institute (ANSI) X12. These standards prescribe the formats, character sets, 
and data elements used in the exchange of documents such as purchase orders and 
invoices.You can use the X12 transaction sets shown in Table 2–3 when you create a 
business action.

See Also: http://www.rosettanet.org for information about 
the RosettaNet consortium and its history, and for details about 
RosettaNet standards

Table 2–3 EDI X12 Transaction Sets Supported in OracleAS Integration B2B

Set Description Version

850 Purchase Order 4010

855 Purchase Order Acknowledgment 4010

997 Functional Acknowledgment 4010
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You can see how a business action is created using the 850, 855, and 997 transactions in 
"Acme Server, Task 1: Creating the Business Actions" on page 5-41 of tutorial 3.

EDI EDIFACT
OracleAS Integration B2B supports message exchanges using UN/EDIFACT, the 
United Nations Electronic Data Interchange for Administration, Commerce and 
Transport. These standards prescribe the formats, character sets, and data elements 
used in the exchange of documents such as purchase orders and invoices.You can use 
the EDI EDIFACT transaction sets shown in Table 2–4 when you create a business 
action.

You can see how a business action is created using the ORDERS, ORDRSP, and 
CONTRL transactions in "Acme Server, Task 1: Creating the Business Actions" on 
page 5-21 of tutorial 2.

Custom Documents
You can use the Custom Document protocol to create documents needed for 
proprietary transaction mechanisms. With the Custom Document option, you can 
create document definitions for XML and non-XML messages. With XML messages, 
you have the advantage of schema enforcement (.xsd). With non-XML messages, you 
can create trading partner agreements for specific message types.

OracleAS Integration B2B provides support for UCCnet under the Custom Document 
option. UCCnet is a service that enables trading partners to exchange 
standards-compliant data in the retail and consumer goods industries. When you use 
Custom Document, the message contents are not translated or validated. You can use 
the UCCnet standards shown in Table 2–5 when you create a Custom Document 
protocol.

As with the other protocols, Custom Document has the following features available: 
authentication, authorization, nonrepudiation of origin and content, nonrepudiation of 
receipt, time to perform, time to acknowledge, and retry counts. 

See Also: http://www.ansi.org for information about the 
organization that created and maintains the ANSI X12 standards

Table 2–4 EDI EDIFACT Transaction Sets Supported in OracleAS Integration B2B

Set Description Version

ORDERS Purchase Order Message D98A

ORDRSP Purchase Order Response Message D98A

CONTRL Syntax and Service Report Message D3

See Also: http://www.unece.org for information about the 
organization that created and maintains the UN/EDIFACT standards

Table 2–5 UCCnet Standards Supported in OracleAS Integration B2B

Standard Version

registerCommand 2.3.1

confirmCommand 2.3.1

linkCommand 2.3.1

checkComplianceCommand 2.3.1
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Exchange Protocols
The exchange protocol defines the headers, acknowledgments, and packaging that 
puts the headers and payload together (the message exchange mechanism). The 
exchange protocol also defines exchange-level security—signing and encryption—and 
transport protocols for the exchange. 

OracleAS Integration B2B supports the following exchange protocols:

■ RNIF

■ AS2

■ Generic

Exchange protocol guidelines are described in Table 2–6. 

documentCommand 2.3.1

documentIdentificationCommand 2.3.1

notificationStateCommand 2.3.1

queryCommand 2.3.1

registerLinkCommand 2.3.1

publicationCommand 2.3.1

publishCommand 2.3.1

catalogueItemMaintenanceCommand 2.3.1

priceCommand 2.3.1

validateCommand 2.3.1

registerOwnershipCommand 2.3.1

subscriptionCommand 2.3.1

notifyCommand‘ 2.3.1

response‘ 2.3.1

See Also: http://www.uccnet.org for further descriptions of 
UCCnet standards

Table 2–6 Exchange Protocol Guidelines

Guideline Description

Transport Supports multiple transport protocols (such as secure HTTP and 
SMTP) for delivering business messages between trading 
partners

Packaging Supports the multipurpose internet mail extensions (MIME) 
format

Authorization Ensures that a message sender is authorized to send the subject 
message to the receiving partner

Authentication Requires a message sender to digitally sign a message

Table 2–5 (Cont.) UCCnet Standards Supported in OracleAS Integration B2B

Standard Version
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The transport protocol and packaging protocol are components of the exchange 
protocol. The following transport and packaging protocols are supported in OracleAS 
Integration B2B:

■ Transport protocols

■ HTTP

■ HTTPS

■ Email

■ FTP

■ File

■ Packaging protocols

■ MIME

■ S/MIME

RNIF
RNIF defines implementation guidelines for creating software applications that 
provide for the reliable transport of PIPs in XML-format business documents between 
trading partners. Guidelines are provided for transport, routing, packaging, security, 
signals, and trading partner agreements.

RNIF specifies the envelope or container format that remains constant when 
exchanging business documents (the payloads), whereas the document exchange 
choreography and the XML schemas vary based on which PIP and document type are 

Encryption Ensures that messages transmitted can be seen only by the 
expected recipient, who is able to decrypt and extract the 
business data

Nonrepudiation Provides absolute evidence that a specific action occurred. This 
ensures that an originating trading partner cannot deny having 
sent a message and a receiving partner cannot deny having 
received a message. The following nonrepudiation types are 
available:

■ Nonrepudiation of origin requires a message sender to 
digitally sign a message. This protects against attempts by a 
sender to deny sending a message. The message recipient 
must store the message for an agreed-on period of time 
(typically three to seven years).

■ Nonrepudiation of receipt requires a message recipient to 
send back a digitally-signed acknowledgment. The message 
recipient must store both the receipt and the original 
message for an agreed-on period of time (typically three to 
seven years). This protects against any attempt by a 
message recipient to deny receiving a message.

See Also:

■ Figure 1–1 on page 1-3 for how the protocols fit into the OracleAS 
Integration B2B architecture

■ "Viewing Exchange Protocols" on page 6-14 for details about 
exchange protocols 

Table 2–6 (Cont.) Exchange Protocol Guidelines

Guideline Description
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used. The RNIF envelope format is also independent of the specific transfer protocol 
you use. 

OracleAS Integration B2B supports RNIF revisions 1.1 and 2.0. RNIF 2.0 does not 
include the proprietary aspects of RNIF 1.1, and adds support for multiple transfer 
protocols, hub-based routing, attachments, payload encryption, and more. 

AS2
AS2 is a specification for using EDI over the Internet. AS2 provides S/MIME 
encryption and security over HTTP or HTTPS. AS2 works with non-EDI document 
types such as .xml, .txt, .doc, and .xls. AS2 is also called EDI over the Internet, or 
EDIINT AS2.

You can see how an EDI over the Internet (AS2) transaction is created in "Tutorial 3: 
Setting Up an EDI X12 over Internet (AS2) Transaction" on page 5-40.

Generic
Using the Generic option, you can send messages with or without security, using any 
of the transport protocols listed in Table 2–1 on page 2-2. The Generic exchange 
protocol supports MIME and S/MIME, including S/MIME 3.0-based signing and 
encryption. There is no receipt acknowledgment support with the Generic exchange 
protocol (acknowledgment mode must be set to None on the Delivery Channel page of 
the Create Trading Partner wizard). 

Process Protocols
The process protocol defines how documents are exchanged. OracleAS Integration B2B 
supports complex processes such the RosettaNet PIP or simple processes, such as 
exchanging a single EDI business action. OracleAS Integration B2B provides the B2B 
process protocol, which is included with all business protocols supported in OracleAS 
Integration B2B. The B2B process protocol defines the business actions (for EDI or 
Custom Document business protocols) and the collaborations (for the RosettaNet over 
RNIF business protocol) that are associated with specific document types.

PIPs
A PIP is an XML-based dialog that defines the business processes between trading 
partners. It defines the structure, sequence of steps, roles (buyer and seller) activities, 

See Also: http://www.rosettanet.org for the white paper (in 
PDF) "RosettaNet Implementation Framework (RNIF) 2.0: Benefits of 
RNIF 2.0 and Comparison to RNIF 1.1" for a thorough discussion of 
the two versions

See Also: Chapter 7, "Creating Trading Partners" for information 
about digital signatures, encryption, and signing credentials

See Also:

■ Figure 6–7, "Process Protocol Management Tasks for any EDI or 
Custom Document Business Protocol" on page 6-16 for an 
example of business actions defined for the B2B process protocol

■ Figure 6–8, "Process Protocol Management Tasks for RosettaNet 
over RNIF Business Protocol" on page 6-16 for an example of 
collaborations defined for the B2B process protocol



2-10 Oracle Application Server Integration B2B User’s Guide

data elements, values, and value types for each business document message 
exchanged between trading partners. 

PIPs bundle the steps of the business process together. You can see this in "Tutorial 1: 
Setting Up a RosettaNet over the Internet Transaction" on page 5-7, in which only a 
few steps are needed to associate the buyer and seller (trading partners) with the 3A4 
collaboration. 

Using PIP 3A4 as an example, you can see how a PIP defines a dialog between trading 
partners, as shown in Figure 2–2. The figure shows how the PIP 3A4 messages are 
exchanged between buyer and seller.

Figure 2–2 PIP 3A4 Message Exchange

A PIP sequence combines a cluster, segment, and type. The PIP sequence 3A4, for 
example, encodes the information shown in Table 2–7.

Table 2–7 PIP 3A4 Breakdown

Element Description

3 Order manage cluster, which lets trading partners:

■ Order catalog products

■ Create custom orders

■ Manage product distribution and delivery

■ Support product returns and financial transactions

3A Quote and order entry segment

3A4 Specific PIP type, which supports:

■ Submittal of a purchase order by a buyer

■ Submittal of an acceptance purchase order by a seller

■ Ability of a buyer to cancel or change a purchase order based on the 
acknowledgment response

See Also:

■ Table 2–2 on page 2-4 for a list of PIPs supported in OracleAS 
Integration B2B

■ http://www.rosettanet.org for a complete list of PIP 
clusters and segments

Purchase Order 
Request

Receipt 
Acknowledgment

Purchase Order 
Confirmation

Receipt 
Acknowledgment

Buyer Seller
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Business Protocols
OracleAS Integration B2B provides business protocols, which bundle common 
message exchange options. The business protocols capture combinations needed to 
integrate typical B2B scenarios. Each business protocol combines a document 
protocol, an exchange protocol, and the B2B process protocol. OracleAS Integration 
B2B provides the following business protocols:

■ Custom Document over Generic Exchange

■ Custom Document over Internet

■ EDI EDIFACT over Generic Exchange

■ EDI EDIFACT over Internet

■ EDI X12 over Generic Exchange

■ EDI X12 over Internet

■ RosettaNet over RNIF

You can see this list by clicking Partners > Protocols.

The business protocols are flexible. After you select a business protocol, you have 
choices as you define the operational capabilities and communication capabilities of 
the business protocol of the remote trading partner and the communication 
capabilities of the host trading partner.

Mix and Match Protocols
OracleAS Integration B2B is flexible in how you mix and match protocols (described in 
Table 2–1 on page 2-2) and in allowing you to create your own custom documents. For 
example, you can create the following:

■ A custom XML document sent over HTTP or SMTP, with encryption and 
compression options

■ An EDI transaction set sent using FTP, with encryption

■ An EDI X12 transaction set sent over AS2, with signing, compression, and 
encryption options

■ A RosettaNet document sent over RNIF 1.1 or RNIF 2.0, with signing

■ A UCCnet document sent over AS2

Chapter Summary
This chapter describes the support OracleAS Integration B2B offers for standard B2B 
protocols such as RosettaNet, EDI X12, EDI EDIFACT, AS2, and UCCnet. The 
document, exchange, and process protocols are described, as well as the business 
protocol, which is a combination of the protocols. It also describes options for using 
Custom Documents to mix and match protocols.

See Also: "Business Protocol Management Overview" on page 6-2

See Also: Chapter 6, "Managing Business Protocols" for the options 
available as you create business actions and collaborations for a 
business protocol
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3
Communicating with Host Trading Partner

Applications

OracleAS Integration B2B communicates with the back-end applications of the host 
trading partner—host applications—by using internal delivery channels. This chapter 
provides an overview of the predefined internal delivery channels available with 
OracleAS Integration B2B.

This chapter contains these topics:

■ Internal Delivery Channels in OracleAS Integration B2B

■ Integrations with OracleAS Integration InterConnect

■ Integrations with Oracle E-Business Suite

■ Integrations with Host Applications

■ Chapter Summary

See Also: "Managing Internal Delivery Channels" on page 8-30 for 
details on creating an internal delivery channel
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Internal Delivery Channels in OracleAS Integration B2B
OracleAS Integration B2B provides the following predefined internal delivery 
channels to communicate with a host application. 

■ B2B Outbound and B2B Inbound—internal delivery channels for OracleAS 
Integration InterConnect

■ XML Gateway Outbound and XML Gateway Inbound—internal delivery 
channels for Oracle E-Business Suite

You use these predefined internal delivery channels in integration configurations in 
which OracleAS Integration InterConnect or Oracle E-Business Suite is used. 
Figure 3–1 and Figure 3–2 show these integration configurations.

Figure 3–1 Communication Between OracleAS Integration B2B and OracleAS Integration 
InterConnect Uses Predefined Internal Delivery Channels

Figure 3–2 Communication Between OracleAS Integration B2B and Oracle E-Business 
Suite Uses Predefined Internal Delivery Channels

OracleAS Integration B2B provides a user-defined internal delivery channel feature for 
communicating with other host applications. The user-defined internal delivery 
channels use AQ or JMS queues. Figure 3–3 shows this integration configuration.

Predefined Internal
Delivery Channels

B2B Outbound

B2B Inbound

Host
Application

Oracle
Application Server

Integration B2B

Host

Oracle
Application Server

Integration
InterConnect

Predefined Internal
Delivery Channels

XML Gateway Outbound

XML Gateway
Inbound

Oracle
Application Server

Integration B2B

Host

Oracle E-Business
Suite
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Figure 3–3 Communication Between OracleAS Integration B2B and Host Applications 
Uses User-Defined Internal Delivery Channels

As the preceding figures show, OracleAS Integration B2B can support multiple 
methods for communicating with host applications; however, all methods use internal 
delivery channels, either predefined or user-defined. You select the internal delivery 
channel to use with your host application when you create a trading partner 
agreement.

Integrations with OracleAS Integration InterConnect
OracleAS Integration B2B provides the following internal delivery channels to 
communicate with OracleAS Integration InterConnect:

■ B2B Inbound—this channel enables communication between the host application 
and OracleAS Integration B2B upon receipt of inbound messages from the remote 
trading partner.

■ B2B Outbound—this channel enables communication between the host application 
and OracleAS Integration B2B to send outbound messages to the remote trading 
partner.

OracleAS Integration InterConnect transforms message formats when the host and 
remote trading partner applications use different business document formats. The 
Advanced Queuing (AQ) adapter of OracleAS Integration InterConnect uses IP queues 
to send messages to and receive messages from OracleAS Integration B2B. You should 
set up the OracleAS Integration InterConnect AQ adapter to listen on the IP_IN_
QUEUE, with the consumer name of the AQ adapter set to b2buser, as in aq_
bridge_consumer_name=b2buser. When AQ is listening for a message sent by 
OracleAS Integration B2B, AQ must be set to publish. This publishes the message to 
the hub queue of OracleAS Integration InterConnect. 

OracleAS Integration B2B processes all exchange protocol specific headers and 
enqueues the payload, along with a few attributes, to the IP queue. OracleAS 
Integration InterConnect picks up the message from the queue and transforms it, first 
to the common view, and then to the final format, and sends it to the host application.

By default, the B2B Inbound internal delivery channel connects to the IP_IN_QUEUE 
queue and the B2B Outbound internal delivery channel connects to the IP_OUT_
QUEUE queue. These queues are defined as follows:

See Also: "Creating a Trading Partner Agreement" on page 10-6 for 
information on selecting an internal delivery channel

User-Defined Internal
Delivery Channels
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Inbound

Oracle
Application Server

Integration B2B

Host

Custom
Applications



3-4 Oracle Application Server Integration B2B User’s Guide

■ IP_IN_QUEUE—queue on which OracleAS Integration B2B (target) receives 
messages and publishes to OracleAS Integration InterConnect.

■ IP_OUT_QUEUE—queue on which OracleAS Integration B2B (source) publishes 
messages that are received from OracleAS Integration InterConnect. 

For OracleAS Integration InterConnect to recognize an incoming AQ message from 
OracleAS Integration B2B, the incoming AQ message structure must mirror the IP_
IN_QUEUE structure. For OracleAS Integration B2B to recognize an outgoing AQ 
message from OracleAS Integration InterConnect, the outgoing AQ message structure 
must mirror the IP_OUT_QUEUE structure. In the case of IP_OUT_QUEUE, the message 
is coming from OracleAS Integration InterConnect to OracleAS Integration B2B, but it 
is an outbound message—going out from the application to the trading partner. 

These two queues, IP_IN_QUEUE and IP_OUT_QUEUE, contain the IP_MESSAGE_
TYPE object, which is described in Table 3–1 and provided as reference information.

Integrations with Oracle E-Business Suite
OracleAS Integration B2B provides the following internal delivery channels to 
communicate with Oracle E-Business Suite:

■ XML Gateway Inbound—this channel enables communication between the host 
application and OracleAS Integration B2B upon receipt of inbound messages from 
the remote trading partner.

Table 3–1 IP_MESSAGE_TYPE Parameters

Name Description Type

MSG_ID The message ID VARCHAR2(128)

INREPLYTO_MSG_ID The ID of the message that this message is in reply to (optional) VARCHAR2(128)

FROM_PARTY The party that the message is coming from VARCHAR2(512)

TO_PARTY The party that the message is going to VARCHAR2(512)

ACTION_NAME The name of the business action (optional) VARCHAR2(512)

DOCTYPE_NAME The name of the document type VARCHAR2(512)

DOCTYPE_REVISION The revision number of the document type VARCHAR2(512)

MSGTYPE The type of message, for example, a response or a request message. 
Required. Supported values are:

0  INVALID

1  REQUEST

2  RESPONSE

3  ACKNOWLEDGMENT 

4  IN_BAND_EXCEPTION

5  OUT_OF_BAND_EXCEPTION

6  STATUS_REQUEST

7  STATUS_RESPONSE

8  PULL

9  FUNCTIONAL_ACK

99 OTHER

NUMBER(38)

PAYLOAD Message payload CLOB

ATTACHMENT Attachment (optional) BLOB
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■ XML Gateway Outbound—this channel enables communication between the host 
application and OracleAS Integration B2B to send outbound messages to the 
remote trading partner.

For example, the host trading partner running the Oracle E-Business Suite 
iProcurement application can send its purchase order request to a remote trading 
partner using the secure and reliable B2B connectivity of OracleAS Integration B2B. 
Figure 3–4 shows how OracleAS Integration B2B, using one of the exchange protocols, 
conducts B2B transactions between a trading partner and Oracle E-Business Suite. 

Figure 3–4 Using OracleAS Integration B2B with Oracle E-Business Suite

By default, the XML Gateway Inbound internal delivery channel connects to the ECX_
INQUEUE queue and the XML Gateway Outbound internal delivery channel connects 
to the ECX_OUTQUEUE queue. These two queues, ECX_INQUEUE and ECX_OUTQUEUE, 
contain the SYSTEM.ECXMSG message type, which is described in Table 3–2 and 
provided as reference information.

Table 3–2 SYSTEM.ECXMSG Parameters

Name Type

MESSAGE_TYPE VARCHAR2(2000)

MESSAGE_STANDARD VARCHAR2(2000)

TRANSACTION_TYPE VARCHAR2(2000)

Supply Chain
Trading

Connector

Oracle E-Business Suite

. . .Internet
Procurement

Order
Management

Internet

Trading Partners

XML
Gateway

OracleAS Integration B2B

· RosettaNet
· AS2
· Generic

(HTTP, SMTP/IMAP, FTP/File)

RN or
UCCnet

RN or
UCCnet
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Integrations with Host Applications
You can define Java message service (JMS) or advanced queuing (AQ) messages to 
communicate with host trading partner applications by defining your own internal 
delivery channels. You use user-defined internal delivery channels in integration 
configurations in which OracleAS Integration InterConnect or another transformation 
tool is not used. You also create a callout and callout usages. 

Overview of Callouts
Consider the example of a remote trading partner who sends a RosettaNet 
XML-formatted purchase order request to the host trading partner. The host trading 
partner application is an Oracle E-Business Suite application that does not understand 
RosettaNet XML-formatted messages. To enable communication between these two 
different formats, you create a callout that consists of callout usages. In this example, 
one callout usage transforms the RosettaNet XML-formatted purchase order request 
into an Oracle E-Business Suite XML format understood by the Oracle E-Business 
Suite application. Oracle E-Business Suite application, in turn, responds to the request 
message with a purchase order acceptance message in Oracle E-Business Suite XML 
format. This message is transformed by another callout usage back into a RosettaNet 
XML-formatted message for the remote trading partner.

TRANSACTION_SUBTYPE VARCHAR2(2000)

DOCUMENT_NUMBER VARCHAR2(2000)

PARTYID VARCHAR2(2000)

PARTY_SITE_ID VARCHAR2(2000)

PARTY_TYPE VARCHAR2(2000)

PROTOCOL_TYPE VARCHAR2(2000)

PROTOCOL_ADDRESS VARCHAR2(2000)

USERNAME VARCHAR2(2000)

PASSWORD VARCHAR2(2000)

PAYLOAD CLOB

ATTRIBUTE1 VARCHAR2(2000)

ATTRIBUTE2 VARCHAR2(2000)

ATTRIBUTE3 VARCHAR2(2000)

ATTRIBUTE4 VARCHAR2(2000)

ATTRIBUTE5 VARCHAR2(2000)

See Also: Oracle Applications Concepts, available at 
http://download-west.oracle.com/docs/cd/B12190_
11/current/html/docset.html, for information about the 
E-Business Suite Home page, new in Release 11i

See Also: "Creating an Internal Delivery Channel" on page 8-33 and 
"Example: Creating an Internal Delivery Channel Using the JMS 
Transport Protocol" on page 8-37 for details

Table 3–2 (Cont.) SYSTEM.ECXMSG Parameters

Name Type
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You create two separate internal delivery channels for these messages: 

■ One for the initiating purchase order request

■ One for the responding purchase order acceptance

When you create a trading partner agreement between the host and remote trading 
partners, you associate the initiating internal delivery channel with the initiating 
callout usage that transforms the purchase order request from RosettaNet XML to 
Oracle E-Business Suite XML. You also associate the responding internal delivery 
channel with the responding callout usage that transforms the purchase order 
acceptance from Oracle E-Business Suite XML to RosettaNet XML.

By default, the initiating internal delivery channel and callout usage are available for 
selection when you create a trading partner agreement. If you also want a responding 
internal delivery channel and responding callout usage to be available for selection, 
you must select Yes from the Is acknowledgment handled By Integration B2B? list on 
the Create Trading Partner - Operational Capability page or Create Supported 
Collaboration Role page when you create a trading partner.

Chapter Summary
This chapter describes how OracleAS Integration B2B communicates with host 
applications through the following internal delivery channels: B2B Inbound, B2B 
Outbound, XML Gateway Inbound, and XML Gateway Outbound.

See Also: Chapter 9, "Managing Callouts"
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Part II
Introduction to the User Interface Tool

This part introduces and provides a tutorial on how to use the Oracle Application 
Server Integration B2B user interface tool.

This part contains the following chapters:

■ Chapter 4, "Getting Started with the User Interface Tool"

■ Chapter 5, "OracleAS Integration B2B Tutorials"
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4
Getting Started with the User Interface Tool

This chapter describes how to get started with the Oracle Application Server 
Integration B2B user interface tool. This chapter briefly describes the tasks to perform 
and the features available from each user interface tool tab.

This chapter contains these topics:

■ Accessing the User Interface Tool

■ User Interface Tool Page Layouts

■ Partners Tab Overview

■ Deployment Tab Overview

■ Reports Tab Overview

■ Administration Tab Overview

■ Chapter Summary

See Also:

The following chapters for specific details about using the user 
interface tool:

■ Chapter 5, "OracleAS Integration B2B Tutorials" 

■ Chapter 6, "Managing Business Protocols"

■  Chapter 7, "Creating Trading Partners"

■ Chapter 8, "Managing Trading Partners"

■ Chapter 9, "Managing Callouts"

■ Chapter 10, "Creating and Managing Trading Partner 
Agreements" 

■ Chapter 11, "Creating and Deploying a Configuration" 

■ Chapter 12, "Administering Oracle Application Server 
Integration B2B"

■ Chapter 14, "Creating Reports"
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Accessing the User Interface Tool
Follow these instructions to access the OracleAS Integration B2B user interface tool. 

1. Open a Web browser. The Oracle Application Server Integration B2B Installation Guide 
lists the supported browsers.

2. Go to the following URL:

http://hostname:port/b2b

where:

■ hostname is the name of the host on which OracleAS Integration B2B is 
installed

■ port is the port number that OracleAS Integration B2B uses. The following 
sources identify the port number used.

– The ipsetupinfo.txt file in the install subdirectory of your Oracle 
home directory

– The End of Installation page that displayed at the end of OracleAS 
Integration B2B installation

A page for logging in to the OracleAS Integration B2B user interface tool appears.

3. Enter the following information:

The admin username enables you to create, update, and delete partner data with 
the OracleAS Integration B2B user interface tool.

4. Click Login.

The OracleAS Integration B2B home page appears with the four main tabs: 
Partners, Deployment, Reports, and Administration.

For This Field... Enter This...

Username admin

where admin is the default OracleAS Integration B2B user interface tool 
username. You can create additional users. These users can also use all 
features of the user interface tool if you assign them the Administrator 
role.

See Also: "Creating a Trading Partner Person" on page 8-22 for instructions 
on creating a user and assigning a password and "Assigning a User Role to 
a Host Trading Partner Person" on page 8-24 for instructions on assigning 
the Administrator user role

Password ias_admin_password

where ias_admin_password is the Oracle Application Server 
administrator password you entered during J2EE and Web Cache 
installation. You also entered this password when prompted during 
OracleAS Integration B2B installation.

See Also: "Viewing a Trading Partner Person and Updating the Person 
Password" on page 8-22 for instructions on changing the password
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These four tabs enable you to perform the following tasks:

This Tab... Enables You To...

Partners Perform the following partner data tasks:

■ Create or import RosettaNet collaborations, EDI X12 or EDI 
EDIFACT transaction sets, and UCCnet standards. A transaction 
set maps to a document type of a business action in the OracleAS 
Integration B2B user interface tool. Collaborations, business 
actions, and standards describe business documents and their 
movement between trading partners.

■ Create a remote trading partner

■ Assign support for a business protocol to a remote trading partner

■ Create operational capabilities (created or imported support for 
collaborations for the RosettaNet over RNIF business protocol or 
business actions or standards for any EDI or Custom Document 
business protocol) and communication capabilities (delivery 
channel, document exchange, transport, transport server, and 
endpoint details) for the business protocol of the remote trading 
partner

■ Create communication capabilities (delivery channel, document 
exchange, transport, transport server, and endpoint details) for the 
business protocol of the host trading partner

Note: To simplify the user experience, the host trading partner 
automatically includes support for all business protocols and 
operational capabilities. Only the remote trading partner requires 
support for a business protocol to be assigned and operational 
capabilities to be created.

■ Create a trading partner agreement between host and remote 
trading partners

Deployment Create, validate, and deploy a configuration that consists of a complete 
and consistent set of partner data created under the Partners tab. 
Creating a configuration means you intend to deploy the trading 
partner agreement that has been created. Deployment of a 
configuration results in OracleAS Integration B2B being ready to 
perform actual business as designed.

Note: Do not leave a configuration in a validated state. Either deploy or 
discard the configuration immediately.

Reports Monitor the status of the deployed configuration by creating and 
viewing reports
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5. See "User Interface Tool Page Layouts" on page 4-4 for a description of the general 
layout of OracleAS Integration B2B user interface tool pages.

User Interface Tool Page Layouts
Before describing the four main tabs, it is important to understand the layout of the 
pages of the OracleAS Integration B2B user interface tool.

The OracleAS Integration B2B user interface tool presents partner data tasks in a series 
of HTML pages. These pages follow a standard layout. This section describes the 
general layout of pages in the OracleAS Integration B2B user interface tool. This 
section contains these topics:

■ Main List Pages

■ Details Pages

■ Creating Incomplete Partner Data

■ Creating, Adding, Deleting, and Removing Data

■ Naming Conventions

■ Using the Browser Back and Forward Buttons

■ Using the Return to List Link

■ Searching for Data on the Main List Page

■ Exporting Partner Data to an XML File

■ Viewing the State of Partner Data on the Details Pages

Main List Pages
When you click a subtab of a main tab (for example, the subtab Trading Partners of 
main tab Partners), a main list page displays information you created such as that 
shown in Figure 4–1. Main list pages have general names such as Trading Partners or 
Trading Partner Agreements, and are not named after specific partner data that you 
create. These main list pages enable you to perform a series of tasks.

Administration Administer various portions of the configuration, including exporting, 
importing, and purging data. A link is provided to Oracle Enterprise 
Manager 10g for performing system management tasks.

See Also:

■ "Partners Tab Overview" on page 4-14

■ "Deployment Tab Overview" on page 4-19

■ "Reports Tab Overview" on page 4-19

■ "Administration Tab Overview" on page 4-20

This Tab... Enables You To...
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Figure 4–1 Main List Page Layout

Table 4–1 describes the contents of the page shown in Figure 4–1, including the tasks 
you can perform:

Table 4–1 Main List Page Contents

Page Element
Location in 
Page Description

Search list top left of 
Figure 4–1

Enables you to search for a specific element, such as a trading partner name, by 
selecting a criteria from the Search list. This list only displays if the quantity for 
this element exceeds ten (for example, more than ten trading partners).

See Also: "Searching for Data on the Main List Page" on page 4-9 for details 
about using the search feature

Subtab (Trading 
Partners)

top left of 
Figure 4–1

Identifies the subtab of the main tab in which you are located (in this example, 
the Trading Partners subtab of the Partners main tab). The subtabs that appear 
are based on the main tab you selected. Some subtabs have additional sections 
(for example, the Trading Partner Details page under the Trading Partners 
subtab includes General, Organization, Users, and Capabilities sections).

Main tab 
(Partners)

top right of 
Figure 4–1

Identifies the main tab in which you are located (in this example, the Partners 
tab). There are four main tabs (Partners, Deployment, Reports, and 
Administration).

Home link top right of 
Figure 4–1

Returns you to the OracleAS Integration B2B user interface tool home page. 
(See Step 4 on page 4-2.)

Help link top right of 
Figure 4–1

Enables you to access online help for the page.

Logout link top right of 
Figure 4–1

Logs you out of the OracleAS Integration B2B user interface tool and returns 
you to the login page. (See Step 3 on page 4-2.)

Logged in as 
message

top right of 
Figure 4–1

Displays the user currently logged into the OracleAS Integration B2B user 
interface tool, along with the host trading partner name (in this example, 
mark@Acme).
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Details Pages
Partner data that you create has its own details page typically accessed through the 
Name column shown in Figure 4–1 on page 4-5. Details pages are named after specific 
elements that you create. For example, Figure 4–2 shows the details page for a trading 
partner named RN-TradingPartner1. You access this page by clicking 
RN-TradingPartner1 in the Name column in Figure 4–1.

Shortcut section top right of 
Figure 4–1

Provides shortcuts for performing related tasks specific to this partner data (in 
this example, a shortcut for creating a trading partner agreement is provided, 
since a trading partner must be assigned to a trading partner agreement to be 
part of a deployed configuration). 

Create button middle of 
Figure 4–1

Enables you to create partner data (for this example, a trading partner).

Name column middle of 
Figure 4–1

Enables you to access specific details about the selected partner data (known as 
the details page). For example, if you select a trading partner (such as Acme), 
you can see the trading partner agreements with which it is associated.

Update column middle of 
Figure 4–1

Enables you to update the selected partner data (for this example, a trading 
partner).

Delete column middle of 
Figure 4–1

Enables you to delete the selected partner data (for this example, a trading 
partner).

Previous and 
Next lists

middle and 
bottom right of 
Figure 4–1

Enables you to access additional main list pages of partner data. This list 
displays only if the quantity for this element exceeds ten (for example, more 
than ten trading partners).

Links at bottom 
of page

bottom of 
Figure 4–1

Enable you to:

■ Access the four main tabs (Partners, Deployment, Reports, and 
Administration)

■ Return to the OracleAS Integration B2B user interface tool home page 
(Home)

■ Access online help for the page (Help)

■ Log out of the OracleAS Integration B2B user interface tool (Logout)

Table 4–1 (Cont.) Main List Page Contents

Page Element
Location in 
Page Description
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Figure 4–2 Details Page

Table 4–2 describes the contents of Figure 4–2 and the tasks you can perform.

Table 4–2 Details Page Contents

Page Elements
Location in 
Page Description

Details section top left of 
Figure 4–2

Enables you to view specific details, including a description and the current 
state of this partner data (in this example, Draft).

See Also: "Viewing the State of Partner Data on the Details Pages" on 
page 4-12 for details about states such as Draft

Section (General) top left of 
Figure 4–2

Identifies the section of the subtab in which you are located (in this example, 
the General section of the Trading Partners subtab of the Partners main tab). 
The sections that appear are based on the subtab you selected. 

Subtab (Trading 
Partners)

top left of 
Figure 4–2

Identifies the subtab of the main tab in which you are located (in this 
example, the Trading Partners subtab of the Partners main tab). The subtabs 
that appear are based on the main tab you selected. 

Main tab 
(Partners)

top right of 
Figure 4–2

Identifies the main tab in which you are located (in this example, the Partners 
tab). There are four main tabs (Partners, Deployment, Reports, and 
Administration).

Home link top right of 
Figure 4–2

Returns you to the OracleAS Integration B2B user interface tool home page. 
(See Step 4 on page 4-2.)

Help link top right of 
Figure 4–2

Enables you to access online help for the page.

Logout link top right of 
Figure 4–2

Logs you out of the OracleAS Integration B2B user interface tool and returns 
you to the login page. (See Step 3 on page 4-2.)
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Creating Incomplete Partner Data
The OracleAS Integration B2B user interface tool provides a flexibility that does not 
require you to complete all partner data tasks at the same time or in a completely 
sequential order.

For example, you can complete all partner tasks and store the partner details for later 
use. Or, you can complete a portion of your partner tasks and complete the remaining 
tasks later (for example, you can follow this approach with the Create Trading Partner 
wizard).

When you initially create a specific element, only fields clearly marked with an 
asterisk must be completed. You can ignore other fields that are not mandatory. You 
can modify these details at a later time when the correct details are known.

The approach to follow depends on what is best for your integration environment.

Logged in as 
message

top right of 
Figure 4–2

Displays the user currently logged into the OracleAS Integration B2B user 
interface tool, along with the host trading partner name (in this example, 
mark@Acme).

Validate button top right of 
Figure 4–2

Enables you to validate this partner data to ensure its correctness and 
completeness.

See Also: "Viewing the State of Partner Data on the Details Pages" on 
page 4-12 for details about the Validate button

Export button top right of 
Figure 4–2

Enables you to export the contents of this partner data to an XML file to send 
to other persons or organizations (trading partners) for review.

See Also: "Exporting Partner Data to an XML File" on page 4-10 for details 
about exporting partner data to persons or organizations (trading partners) 
for review

Delete button top right of 
Figure 4–2

Enables you to delete the selected partner data (for this example, the 
RN-TradingPartner1 trading partner).

Update button top right of 
Figure 4–2

Enables you to update the selected partner data (for this example, the 
RN-TradingPartner1 trading partner).

Create buttons, 
Delete columns, 
Update columns, 
Details column

middle of 
Figure 4–2

Enable you to manage (create, delete, update, and view) elements associated 
with the main partner data (for this example, you can manage trading partner 
identifications, associated trading partner agreements, and remote trading 
partner certificates from this Trading Partner Details page).

Links at bottom 
of page

bottom of 
Figure 4–2

Enable you to:

■ Access the four main tabs (Partners, Deployments, Reports, and 
Administration)

■ Return to the OracleAS Integration B2B user interface tool home page 
(Home)

■ Access online help for the page (Help)

■ Log out of the OracleAS Integration B2B user interface tool (Logout)

Return To List 
link

bottom left of 
Figure 4–2

Enables you to move one level up to the main list page. For example, clicking 
Return To List on this page takes you one level up to the Trading Partners 
page shown in Figure 4–1 on page 4-5.

Table 4–2 (Cont.) Details Page Contents

Page Elements
Location in 
Page Description
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Creating, Adding, Deleting, and Removing Data
The OracleAS Integration B2B user interface tool pages provide Create, Add, Delete, 
and Remove buttons. The Add and Remove buttons enable you to add or remove an 
association between elements. For example, when you remove a delivery channel from 
an agreement, it is still available in OracleAS Integration B2B for reuse at a later time. 

The Create and Delete buttons enable you to create and delete partner data. For 
example, if you delete a trading partner agreement, it is deleted from OracleAS 
Integration B2B and must be re-created if you want to use it again.

Naming Conventions
You are frequently prompted to provide names when creating data. Oracle 
recommends that you adhere to the following naming conventions:

■ Provide data with unique and meaningful names to make it easy to identify its 
content. 

For example, if you are creating a trading partner agreement using RosettaNet 
Partner Interface Process (PIP) 3A4 with a remote trading partner named Acme, 
use that name in the agreement (for example, Acme_PIP3A4_Agreement).

■ Do not include beginning or trailing blank spaces in the names of data you create

Using the Browser Back and Forward Buttons
Do not use the Back or Forward buttons of your Web browser when creating partner 
data. For example, if you are creating partner data with the Create Trading Partner 
wizard, use the Back and Next buttons specifically provided by the OracleAS 
Integration B2B user interface tool.

Using the Return to List Link
Details pages include a Return to List link at the bottom left that enables you to move 
up one level. For example, clicking Return to List on a specific Trading Partner Details 
page takes you up to the main Trading Partners list page. Use the Return to List link 
instead of the Back or Forward buttons of your Web browser to move up levels in the 
OracleAS Integration B2B user interface tool.

Searching for Data on the Main List Page
The OracleAS Integration B2B user interface tool includes a search feature available 
from list pages. Figure 4–3 provides an example of the search feature that appears on 
the Trading Partners page that you access by clicking Partners > Trading Partners.
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Figure 4–3 Search Feature

The search feature is available only if the number of elements on a page exceeds ten. 
For example, the number of trading partners available in Figure 4–3 is 11. Instead of 
browsing from page to page, select a specific search criteria in the Search list to find 
the appropriate trading partner.

The Search list contains attributes of the element. For example, if a text attribute is 
selected (such as name) on the Trading Partners main list page, a text field appears 
and enables you to enter a specific name for which to search. You can use the % sign as 
a wildcard instead of specifying the entire name.

Exporting Partner Data to an XML File
Some high-level partner data elements include an Export button on their details pages. 
This button enables you to export your partner data to an XML file. You can then 
submit this file for review and approval to applicable persons to ensure that it is 
correct. Figure 4–4 shows the location of the Export button in the upper-right part of a 
details page for a remote trading partner named RN-TradingPartner1.
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Figure 4–4 Partner Data Export Button

Only the details pages of certain partner data elements include the export feature. 
High-level partner data elements include lower-level partner data elements on their 
details pages that can also be defined. 

For example, the Trading Partner Details page in Figure 4–4 enables you to manage 
such lower-level partner data elements as trading partner identifications, associated 
trading partner agreements, and remote trading partner certificates. When you click 
Export on the Trading Partner Details page, the partner data that you defined for the 
trading partner is all included in the XML file (including data for trading partner 
identifications, associated trading partner agreements, and certificates).

Table 4–3 identifies the high-level partner data elements that have an Export button, 
and the partner data that is included in the XML file when you click Export. 
References are provided for more specific details about managing this data.



User Interface Tool Page Layouts

4-12 Oracle Application Server Integration B2B User’s Guide

Viewing the State of Partner Data on the Details Pages
Partner data created under the Partners tab goes through several lifecycle states from 
the time of creation through its role in a validated and deployed configuration. The 
current state of trading partners and trading partner agreements displays in the 
Details sections on their details pages. For example, see Figure 4–4 on page 4-11, 
where the State is Draft for RN-TradingPartner1. Table 4–4 shows the states available 
for trading partners and trading partner agreements.

Table 4–3 Partner Data Export

Details Pages with an 
Export Button Partner Data Exported to an XML File See Also...

■ Trading Partner 
Details page

The details of the trading partner, including 
this lower-level partner data:

■ Trading partner identifications, 
associated trading partner agreements, 
remote trading partner certificates, and 
host trading partner wallet manager 
passwords (under the General section)

■ Organization contact information (for 
contacting an organization) (under the 
Organization section)

■ Users and contact information (for 
creating a user and contacting a person) 
(under the Users section)

■ Business protocols and their associated 
operational capabilities (support for 
collaborations for the RosettaNet over 
RNIF business protocol or support for 
business actions for any EDI or Custom 
Document business protocols) and 
communication capabilities (delivery 
channels, document exchanges, 
transports, transport servers, and 
endpoints) (under the Capabilities 
section)

■ Chapter 7, 
"Creating Trading 
Partners"

■ Chapter 8, 
"Managing 
Trading Partners"

■ Chapter 9, 
"Managing 
Callouts"

Agreement Details page The details of the trading partner agreement, 
including host and remote trading partner 
participants

Chapter 10, "Creating 
and Managing Trading 
Partner Agreements"

Note: Do not manually edit exported files. If you do so, OracleAS 
Integration B2B cannot guarantee their integrity.

See Also: "Partners Tab Overview" on page 4-14 for additional 
details about the partner data described in this section

Table 4–4 Partner Data Element States

Lifecycle State Description

Draft The state when partner data is created, but not yet validated

Approved The state in which the partner data has been approved and validated for 
individual correctness

Deployed The state when the partner data is deployed in a validated configuration
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The following sections describe the support for these lifecycle states provided by the 
OracleAS Integration B2B user interface tool:

■ Draft State for Partner Data

■ Approved State for Partner Data

■ Deployed State for Partner Data

Draft State for Partner Data
When you create partner data, its initial state is Draft, which is displayed in the 
Details section of the details page. Figure 4–5 shows the Draft state (in this example, 
for a trading partner). During this state, you can optionally export your partner data to 
XML files to submit to specific persons for their review. The procedure to submit an 
XML file to a reviewer is completely optional. If any reviewers agree to and sign off on 
the partner data (for example, through notification by an e-mail), you (as the host 
trading partner) can update the status of the trading partner with the OracleAS 
Integration B2B user interface tool.

Figure 4–5 Draft State

Approved State for Partner Data
You can validate your partner data for individual correctness after creation by clicking 
the Validate button. This individual validation is separate from the complete, 
end-to-end validation that is performed on all partner data when you create a 
configuration. If no validation errors occur, the details page refreshes and the state 
changes from Draft to Approved, as shown in Figure 4–6. The Validate button is gone.

Figure 4–6 Approved State

If validation errors occur, they appear on the page. You must correct the errors and 
click Validate again.

See Also: "Exporting Partner Data to an XML File" on page 4-10 



Partners Tab Overview

4-14 Oracle Application Server Integration B2B User’s Guide

Deployed State for Partner Data
After you create, validate, and deploy a configuration, the State field changes to 
Deployed on the details pages of all trading partners and trading partner agreements 
included in the configuration.

Partners Tab Overview
When you select the Partners tab to manage partner data, the page shown in 
Figure 4–7 appears:

Figure 4–7 Partners Tab

This page enables you to perform the following tasks:

■ View definitions of key partner concepts

■ Access list pages for the following Partners subtabs to perform management tasks:

– Trading Partners List Page

– Trading Partner Agreements List Page

– Protocols List Page

– Callouts List Page

■ Access shortcuts in the Shortcuts section for creating a trading partner with the 
Create Trading Partner wizard and creating a trading partner agreement

Trading Partners List Page
When you select the Trading Partners tab, the list page shown in Figure 4–8 appears:

See Also: "Creating a Configuration" on page 11-4 for instructions 
on creating, validating, and deploying a configuration
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Figure 4–8 Trading Partners Tab

The Trading Partners page displays the host trading partner (in this example, named 
Acme and automatically identified by the word Host in parentheses) and all remote 
trading partners you created. The host trading partner name is automatically named 
MyCompany after installation. You can update it after installation to a name that 
uniquely reflects your organization (for example, Acme).

The host trading partner is the organization in which OracleAS Integration B2B is 
installed. There can be only one host trading partner. It cannot be deleted. The remote 
trading partners are the organizations outside your enterprise with whom to conduct 
business, as defined in a trading partner agreement. There can be multiple remote 
trading partners.

The host trading partner uses the OracleAS Integration B2B user interface tool to 
define the capabilities for all trading partners (both host and remote). The host trading 
partner consults with the remote trading partner to obtain the necessary details.

The Trading Partners page enables you to perform the following tasks to manage host 
and remote trading partners participating in an integration:

■ Access a shortcut in the Shortcuts section to create a trading partner agreement

■ Manage the host trading partner (update and view) and remote trading partners 
(create, delete, update, and view)

■ Click a specific trading partner in the Name column to access the page shown in 
Figure 4–9 with links for managing (create, view, update, add, and delete) the 
following:

■ Trading partner identification types, associated agreements, remote trading 
partner certificates, and the host trading partner wallet password (under the 
General section at the top left of the page)

■ Trading partner organizations and persons and their contact details (under the 
Organization and Users sections at the top left of the page)
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■ Business protocols (under the Capabilities section at the top left of the page). 
Once you add support for a business protocol to a remote trading partner (for 
example, RosettaNet over RNIF for RosettaNet or EDI EDIFACT over 
Generic Exchange for EDI EDIFACT), you can perform the following 
management tasks by clicking on the business protocol in the Name column of 
the Capabilities page shown in Figure 4–10:

* Operational capabilities tasks for the business protocol of the remote 
trading partner, such as adding or removing support for a collaboration (if 
using the RosettaNet over RNIF business protocol) or a business action (if 
using any EDI or Custom Document business protocol). See Figure 8–3 on 
page 8-4 for an example.

* Communication capabilities tasks for the business protocol of the host and 
remote trading partner, such as managing delivery channels, document 
exchanges, transports, transport servers, and endpoints. See Figure 8–3 on 
page 8-4 for an example.

To simplify the user experience, the host trading partner automatically 
includes support for all business protocols and operational capabilities. Only 
the remote trading partner requires support for a business protocol to be 
assigned and operational capabilities to be created.

Figure 4–9 Trading Partner Details Page

Figure 4–10 Business Protocol Details Page
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Trading Partner Agreements List Page
When you select the Agreements tab, the Trading Partner Agreements list page shown 
in Figure 4–11 appears:

Figure 4–11 Trading Partner Agreements Tab

This page enables you to perform the following tasks to manage agreements between 
trading partners:

■ Manage (create, update, delete, and view) trading partner agreements between 
trading partners

■ Click a specific trading partner agreement in the Name section to access a page to 
update details about the trading partners participating in the trading partner 
agreement (both remote and host trading partners)

■ Access shortcuts listed in the Shortcut section for performing agreement-related 
tasks (for example, creating a remote trading partner)

Protocols List Page
When you select the Protocols tab, the Business Protocols list page shown in 
Figure 4–12 appears:

Figure 4–12 Protocols Tab

This page enables you to perform the following tasks to manage business protocols of 
trading partners:

■ View all business protocols available with OracleAS Integration B2B

See Also:

■ Chapter 7, "Creating Trading Partners"

■ Chapter 8, "Managing Trading Partners"

See Also: Chapter 10, "Creating and Managing Trading Partner 
Agreements"
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■ Click a specific business protocol in the Name section to access a page to manage 
(create, delete, update, and view) the process protocol, document protocol, and 
exchange protocol of a business protocol. From this page, you can access the 
Process Protocol Revision Details page to manage (create, delete, update, and 
view) support for collaborations (for RosettaNet over RNIF) and business actions 
(for EDI or Custom Document, such as UCCnet standards) of business protocols. 
Collaborations, business actions, and standards describe business documents and 
their movement between trading partners.

Callouts List Page
When you select the Callouts tab, the list page shown in Figure 4–13 appears:

Figure 4–13 Callouts Tab

This page enables you to perform the following tasks to manage callouts:

■ Manage (create, delete, update, and view) callouts used to transform documents 
from one form to another (for example, Oracle E-Business Suite XML to and from 
RosettaNet XML).

■ Click a callout in the Name section to access a page to view callout details (such as 
classification, language type, implementation name, and library name), and 
manage (create, delete, update, and view) callout properties and usages.

See Also: Chapter 6, "Managing Business Protocols"

See Also: Chapter 9, "Managing Callouts"
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Deployment Tab Overview
When you select the Deployment tab with no deployed configurations, the list page 
shown in Figure 4–14 appears:

Figure 4–14 Deployment Tab

This page enables you to perform the following tasks to deploy configurations. 

■ Create a configuration that consists of the following:

■ Partner data consisting of host and remote trading partners, their business 
protocols and operational and communication capabilities, and trading 
partner agreements between these trading partners created under the Partners 
tab

■ Deploy, discard, quiesce, or export the configuration

Reports Tab Overview
When you select the Reports tab, the Reports list page shown in Figure 4–15 appears:

Figure 4–15 Reports Tab

Note: Do not leave a configuration in a validated state. Either deploy 
or discard the configuration.

See Also: Chapter 11, "Creating and Deploying a Configuration"    
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This page enables you to perform the following tasks:

■ Access the following Reports sections to create and view reports about deployed 
configurations:

■ Business message status reports

Provide details about the status of business messages sent between trading 
partners, including the business action, business message ID and status, and 
document and exchange protocols. Support for querying both XML or EDI 
payload content is provided. 

■ Wire message status reports

Provide details about trading partner wire message instances, including 
transport protocol type and wire message payload contents. These reports 
enable you to go from a business message to its corresponding wire message 
and from a wire message to its corresponding business messages. 

■ Collaboration status reports

Provide details about the collaboration name, protocol message identification, 
and exchange protocol (RosettaNet) 

■ Error status reports

Provide details about message processing errors

■ Save generated reports in comma-separated value (CSV) format for viewing in 
Microsoft Excel format

■ Import a previously saved report

■ Save report definitions to a file

Administration Tab Overview
When you select the Administration tab, the list page shown in Figure 4–16 appears:

Figure 4–16 Administration Tab

This page enables you to perform the following administration tasks:

■ View definitions of administration features that you access from this page

■ Access the Oracle Enterprise Manager 10g Application Server Control Console to 
start and stop OracleAS Integration B2B; view runtime performance; configure 
server properties for logging levels, B2B settings, and security levels; and view log 
files. 

■ Access the list pages for the following Administration subtabs for performing 
management tasks:

See Also: Chapter 14, "Creating Reports"
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■ Design List Page

■ Management List Page

Design List Page
When you select the Design tab, the list page shown in Figure 4–17 appears:

Figure 4–17 Design Tab

This page enables you to perform the following tasks:

■ View the methods available for contacting organizations and persons (contact 
types).

■ Manage trading partner identification types. If you create a trading partner 
identification type on this page, it displays when you create a trading partner 
identification by clicking Partners > Trading Partners > trading_partner_name_in_
Name_column > Trading Partner Identifications > Create.

See Also:

■ Chapter 12, "Administering Oracle Application Server Integration 
B2B"

■ Chapter 13, "System Management with Oracle Enterprise 
Manager 10g"

See Also:

■ "Managing Contact Types" on page 12-3

■ "Managing Trading Partner Identification Types" on page 12-4
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Management List Page
When you select the Management tab, the list page shown in Figure 4–18 appears:

Figure 4–18 Management Tab

This page enables you to perform the following tasks:

■ Import the OracleAS Integration B2B design-time repository and instance data of 
the runtime repository that was previously archived through the Oracle 
Application Server archiving tool

■ Import RosettaNet collaborations (partner interface processes (PIPs)), EDI X12 and 
EDIFACT transaction sets, and UCCnet standards into the OracleAS Integration 
B2B design-time repository to assign to trading partners

■ Export and import the entire contents of the OracleAS Integration B2B 
design-time repository to and from an XML file. This enables you to export the 
contents from one repository and import it into another repository.

■ Export and import a configuration created under the Deployment tab to and from 
an XML file

■ Purge the OracleAS Integration B2B design-time repository and instance data in 
the OracleAS Integration B2B runtime repository

Chapter Summary
This chapter shows the higher-level pages of the OracleAS Integration B2B user 
interface tool that you use, starting with the OracleAS Integration B2B home page. 
References are provided to chapters that describe these pages in more specific detail. 
This chapter describes in detail the layout, links, and tabs on main list pages and 
details pages. The main tabs (Partners, Deployment, Reports, and Administration) 
are described so that you understand the tasks you can perform on each page. Subtab 

See Also:

■ "Exporting and Importing the Design-Time Repository" on 
page 12-5

■ "Purging the Design-Time Repository and Runtime Repository" 
on page 12-10
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pages are also described (for example, Trading Partners and Agreements of the 
Partners tab). 
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5
OracleAS Integration B2B Tutorials

The OracleAS Integration B2B tutorials guide you through the steps to design, deploy, 
and verify three B2B scenarios. After using these tutorials, you should be able to create 
and deploy your own RosettaNet, EDI EDIFACT, or EDI X12 transactions.

This chapter contains these topics:

■ About the OracleAS Integration B2B Tutorials

■ Before You Begin the Tutorials

■ Tutorial 1: Setting Up a RosettaNet over the Internet Transaction

■ Tutorial 2: Setting Up an EDI EDIFACT over Generic (VAN) Transaction

■ Tutorial 3: Setting Up an EDI X12 over Internet (AS2) Transaction

■ Doing More Than One Tutorial

■ Chapter Summary
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About the OracleAS Integration B2B Tutorials
The tutorials use one business scenario to demonstrate three different 
industry-standard protocols: 

■ Tutorial 1: RosettaNet over the Internet

■ Tutorial 2: EDI EDIFACT over Generic (VAN)

■ Tutorial 3: EDI X12 over Internet (Applicability Statement 2)

Business Scenario
The tutorials depict B2B transactions between two U.S.-based organizations, 
GlobalChips and Acme. GlobalChips supplies components to the buyer, Acme. In the 
past, GlobalChips and Acme used EDI X12 over a value-added network (VAN) for 
their electronic ordering process. However, under pressure from competition and 
strategic buyers like Acme, whose European and Asian distributors use RosettaNet 
and EDI EDIFACT, GlobalChips needs an enterprise B2B solution that supports an 
array of e-business standards.

GlobalChips selected OracleAS Integration B2B as its enterprise B2B solution based on 
the following criteria:

■ Quick installation and setup

■ Multiprotocol support—RosettaNet, EDI EDIFACT, and EDI X12

■ Multiplatform support—Windows, Solaris, Linux, and HP-UX

■ Multilanguage support

■ Comprehensive global trading partner management

■ Real-time trading partner exchange monitoring

■ Scalability and high availability to support 24x7 business operations

■ Ability to continue using EDI over VAN where needed

■ Secure implementation of a B2B gateway, with flexibility to comply with evolving 
corporate policies

GlobalChips is prepared for global business using OracleAS Integration B2B, as shown 
in Figure 5–1.
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Figure 5–1 GlobalChips Uses OracleAS Integration B2B

Business Scenario Workflow in the Tutorials
The tutorials assume the following purchase order workflow from the business 
scenario:

1. Acme sends a purchase order request to GlobalChips.

2. GlobalChips sends an acknowledgment of the purchase order to Acme.

3. GlobalChips sends a purchase order confirmation to Acme.

4. Acme sends an acknowledgment of the purchase order confirmation to 
GlobalChips.

Note: For this tutorial, you set up OracleAS Integration B2B on 
servers at both Acme and GlobalChips "sites;" that is, on: 

■ The Acme server, where Acme is the host trading partner and 
GlobalChips is the remote trading partner.

■ The GlobalChips server, where GlobalChips is the host trading 
partner and Acme is the remote trading partner.

With this setup, you can verify that the purchase orders, 
acknowledgments, and purchase order confirmations are actually sent 
and received. 

On both servers, Acme is the buyer and GlobalChips is the seller.

Oracle Application Server Integration B2B
at GlobalChips 

(Seller)
Acme - Asia 

(Buyer)
Acme - Europe 

(Buyer)

Acme - U.S.
(Buyer)

EDI X12 over
Internet (AS2)

X12 855 (POA)X12 850 (PO)

EDI EDIFACT over
Generic (VAN)

EDIFACT ORDERS (PO)

EDIFACT ORDRSP (POA)

RosettaNet
over RNIF

PIP 3A4 (PO)

PIP 3A4 (POA)
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Before You Begin the Tutorials
It is strongly recommended that you complete at least one tutorial. The tutorials are 
independent of each other, so you can do tutorial 3 without doing tutorial 1. If you 
work with a partner, one person can set up the seller side and the other the buyer side. 
With this setup, you can verify that the messages are actually sent and received. 

If you want to do more than one tutorial, see "Doing More Than One Tutorial" on 
page 5-60 for more information.

Before you begin a tutorial, complete the following sections:

■ "Setting Up the CLASSPATH Environment" on page 5-4

■ "Logging In to OracleAS Integration B2B" on page 5-4

■ "Changing the Host Trading Partner Name" on page 5-5

Also note the location of configuration and runtime files that are used in the tutorials, 
as described in: 

■ "Location of Runtime and Configuration Files Used in the Tutorials" on page 5-5

Setting Up the CLASSPATH Environment
You must set up the CLASSPATH environment before running these tutorials. Based on 
your operating system, complete the steps in the following table. On UNIX platforms, 
you must grant execute permission using chmod +x to run the scripts.

Logging In to OracleAS Integration B2B
Use Microsoft Internet Explorer 5.5 or higher. On Linux, use Mozilla 1.5.

1. Connect to OracleAS Integration B2B at http://hostname:port/b2b.

This connection information is also provided in ipsetupinfo.txt in your 
ORACLE_HOME/install directory.

2. For username, enter admin.

3. For password, enter the password that you used with the ias_admin username 
during J2EE and Web Cache and OracleAS Integration B2B installations.

4. Click Login.

If Using... Follow These Steps...

Solaris or Linux 1. Open a Bourne shell, Korn shell, or C shell. (If you use a different shell, 
first edit the script described in Step 2 to execute properly in your shell 
environment.)

2. Run one of the following scripts:

In a Bourne or Korn shell—ORACLE_HOME/ip/install/setenv.sh

In a C shell—ORACLE_HOME/ip/install/setenv.csh

3. Ensure that you remain in this shell. The setenv script sets up the 
required CLASSPATH environment for running enqueue and dequeue 
scripts later in these tutorials. Switching to a different shell causes 
these scripts to fail.

Windows 1. Run the following script:

ORACLE_HOME\ip\install\setenv.bat
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Changing the Host Trading Partner Name
Change the host trading partner name (created at installation) to the name used in the 
tutorials.

1. Click Partners > Trading Partners.

2. For MyCompany (Host), click Update.

3. If you are on the Acme server, enter Acme in place of MyCompany. If you are on 
the GlobalChips server, enter GlobalChips in place of MyCompany.

4. Click Apply.

Location of Runtime and Configuration Files Used in the Tutorials
Table 5–1 lists the files in ORACLE_HOME/ip/tutorial/protocolname. You use 
these files to verify the purchase order transaction in task 5 of each tutorial.

Note: The path name delimiter used in this documentation, /, is for 
UNIX. If you are using Windows, assume that the path name delimiter 
is \.
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Table 5–1 Runtime and Configuration Files Used in the Tutorials

Tutorial Runtime Files Configuration Files

1 RosettaNet over Internet 3a4_req.xml

3a4_rsp.xml

deq.sh

deq.csh

deq.bat

enq_3a4_req.sh

enq_3a4_req.csh

enq_3a4_req.bat

enq_3a4_req.properties

enq_3a4_rsp.sh

enq_3a4_rsp.csh

enq_3a4_rsp.bat

enq_3a4_rsp.properties

ipdequeue.properties

3A4_MS_V02_02_
PurchaseOrderRequest.dtd

3A4_MS_V02_02_
PurchaseOrderConfirmation.dtd

RN_buyer_export.xml 

RN_seller_export.xml

2 EDI EDIFACT over Generic 
(VAN)

Acme_orders.xml

GlobalChips_ordrsp.xml

deq.sh

deq.csh

deq.bat

enq_orders.sh

enq_orders.csh

enq_orders.bat

enq_orders.properties

enq_ordrsp.sh

enq_ordrsp.csh

enq_ordrsp.bat

enq_ordrsp.properties

ipdequeue.properties

contrl.ecs

contrl.xsd

orders.ecs

orders.xsd

ordrsp.ecs

ordrsp.xsd

EDIFACT_buyer_export.xml

EDIFACT_seller_export.xml 

3 EDI X12 over Internet (AS2) Acme_850.xml

GlobalChips_855.xml

deq.sh

deq.csh

deq.bat

enq_850.sh

enq_850.csh

enq_850.bat

enq_855.sh

enq_855.csh

enq_855.bat

ipdequeue.properties

850.ecs

850.xsd

855.ecs

855.xsd

997.ecs

997.xsd

X12_buyer_export.xml

X12_seller_export.xml
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Tutorial 1: Setting Up a RosettaNet over the Internet Transaction
In the following tasks, you set up the Acme server first and then the GlobalChips 
server. If you are working through this tutorial with a partner, one person can do the 
tasks on the Acme server while the other does the tasks on the GlobalChips server. 

One person does the following tasks:

■ Acme Server, Task 1: Creating the Collaboration

■ Acme Server, Task 2: Setting Up the Trading Partners

■ Acme Server, Task 3: Creating the Trading Partner Agreement

■ Acme Server, Task 4: Creating and Deploying the Configuration

In parallel, another person does the following tasks:

■ GlobalChips Server, Task 1: Creating the Collaboration

■ GlobalChips Server, Task 2: Setting Up the Trading Partners

■ GlobalChips Server, Task 3: Creating the Trading Partner Agreement

■ GlobalChips Server, Task 4: Creating and Deploying the Configuration

After each partner finishes tasks 1 through 4 on the respective server, work together to 
do task 5:

■ Both Servers, Task 5: Verifying the Purchase Order Transaction

The RosettaNet transaction between Acme and GlobalChips is depicted in Figure 5–2.

Figure 5–2 Tutorial 1 RosettaNet Transaction: Acme is the Buyer and GlobalChips is the 
Seller

Acme Server, Task 1: Creating the Collaboration
In the following set of tasks, Acme is the host trading partner. You create one 
collaboration, PIP 3A4, which has the following business actions:

■ The purchase order request—from Acme to GlobalChips

■ The purchase order confirmation—from GlobalChips to Acme

Because the acknowledgments are a part of PIP 3A4, you do not have to create them.

Note: Fields and checkboxes that you should accept default values 
for, or leave blank, are omitted in the following steps, although they 
appear on the screen. This is done to simplify the instructions and 
move you through the tutorial more quickly. 

See Also: "Creating a Collaboration" on page 6-23

Oracle Application Server
Integration B2B
at GlobalChips 

(Seller)

Oracle Application Server
Integration B2B
 at Acme - Asia 

(Buyer)

RosettaNet
over RNIF

PIP 3A4 (PO)

PIP 3A4 (POA)
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Creating the 3A4 Collaboration
1. Click Partners > Protocols.

2. Click RosettaNet over RNIF.

3. From Shortcut, click Create Collaboration.

The following workflow for creating a collaboration is shown at the top of the 
page:

4. On the Create Collaboration: General page, provide the following information 
and click Next.

5. On the Create Collaboration: Business Transaction page, provide the following 
information and click Next.

6. On the Create Collaboration: Requesting Business Action page, provide the 
following information and click Next.

Field Value

Name 3A4

Revision V02.00

Initiating Role Name Buyer

Accepting Role Name Seller

Field Value

Name Request Purchase Order

Revision V02.00

Field Value

Protocol Action Name Purchase Order Request Action

Response Mode Async

Requesting Business Action Field Value

Create Mode Create New

Name Purchase Order Request Action

Revision V02.00

Acknowledgment Mode Async

Document Type Field Value

Name RequestPurchaseOrder

General Business
Transaction

Requesting
Business

Action

Responding
Business

Action
(Optional)

Review
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7. On the Create Collaboration: Responding Business Action page, provide the 
following information and click Next.

8. Review the data and click Finish, or click Back.

You should see Collaboration 3A4: V02.00 successfully created at the top of the 
page.

Acme Server, Task 2: Setting Up the Trading Partners
On the Acme server, Acme is the host trading partner and GlobalChips is the remote 
trading partner. 

This section contains these topics:

■ Setting Up the Remote Trading Partner (GlobalChips)

■ Setting Up the Host Trading Partner (Acme)

Revision V02.00

Document Definition Field Value

Name Request Purchase Order Definition

Definition 3A4_MS_V02_02_PurchaseOrderRequest.dtd

Field Value

Protocol Action Name Purchase Order Confirmation Action

Responding Business Action Field Value

Create Mode Create New

Name Purchase Order Confirmation Action

Revision V02.00

Document Type Field Value

Name PurchaseOrderConfirmation

Revision V02.00

Document Definition Field Value

Name Purchase Order Confirmation Definition

Definition 3A4_MS_V02_02_
PurchaseOrderConfirmation.dtd

Document Type Field Value
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If you have not already done so, change the default host trading partner name from 
MyCompany to:

■ Acme, if you are working on the Acme server

■ GlobalChips, if you are working on the GlobalChips server

See "Changing the Host Trading Partner Name" on page 5-5 for instructions.

Setting Up the Remote Trading Partner (GlobalChips)
In the following steps, you set up the remote trading partner’s business protocol, 
operational capabilities, and communication capabilities.

1. Click Partners.

2. From Shortcuts, click Create Trading Partner.

The following workflow for creating a trading partner is shown at the top of the 
page.

3. On the Create Trading Partner: General page, enter the remote trading partner 
name, GlobalChips, and click Next.

4. On the Create Trading Partner: Identification page, enter 111111111 for the 
DUNS value and click Next.

5. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Next.

6. On the Create Trading Partner: Delivery Channel page, provide the following 
information and click Next.

See Also:

■ "Creating and Assigning All Capabilities During a Single Wizard 
Session" on page 7-9

■ "Creating Business Protocol Communication Capabilities for the 
Host and Remote Trading Partners" on page 7-26

General Field Value

Business Protocol RosettaNet over RNIF

Collaboration 3A4 - V02.00

Collaboration Role Seller

Is acknowledgment handled by Integration 
B2B?

Yes

Field Value

Name GlobalChips RN DC

Acknowledgment Mode Async

General Identification Operational
Capability

Delivery
Channel

Document
Exchange

Transport Review
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7. On the Create Trading Partner: Document Exchange page, provide the following 
information and click Next.

8. On the Create Trading Partner: Transport page, provide the following 
information.

a. Click Create New, provide the following information, and click Next.

9. Review the data and click Finish, or click Back.

You should see Trading Partner GlobalChips successfully created at the top of 
the page.

Setting Up the Host Trading Partner (Acme)
In the following steps, you set up the host trading partner’s DUNS number and 
communication capabilities. To simplify your user experience, the host is 
automatically assigned a business protocol and operational capabilities that are 
compatible with the remote trading partner.

1. Click Partners > Trading Partners.

2. Click Acme (Host).

3. Under Trading Partner Identifications, click Create.

4. For Trading Partner Identification Type, select DUNS.

5. For Value, enter 222222222.

Field Value

Name GlobalChips RN DocEx

Exchange Protocol Revision RosettaNet - V02.00

General Field Value

Name GlobalChips RN Transport

Transport Protocol Field Value

Transport Protocol HTTP - 1.1

Transport Server Field Value

Name GlobalChips Transport Server

Host Name GlobalChips_hostname

The transport server host exchanging 
messages at the GlobalChips site.

Port 80 in a Windows environment; 7779 in a 
Solaris environment

Endpoint Field Value

URI b2b/transportServlet
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6. Click Apply.

7. Click Capabilities.

8. Click RosettaNet over RNIF.

9. Click Create Communication Capability.

The following workflow for creating the communication capabilities is shown at 
the top of the page.

10. On the Create Trading Partner: Delivery Channel page, provide the following 
information and click Next.

11. On the Create Trading Partner: Document Exchange page, click Create New. 
Provide the following information and click Next. 

12. On the Create Trading Partner: Transport page, provide the following information 
and click Next.

a. Select Create New and provide the following information:

b. Select Create New and provide the following information:

Field Value

Name Acme RN DC

Acknowledgment Mode Async

Field Value

Name Acme RN DocEx

Exchange Protocol Revision RosettaNet-V02.00

General Field Value

Name Acme RN Transport

Transport Protocol Field Value

Transport Protocol HTTP - 1.1

Transport Server Field Value

Name Acme Transport Server

Host Name Acme_hostname

The transport server host exchanging 
messages at the Acme site.

Port 80 in a Windows environment; 7779 in a 
Solaris environment

Delivery
Channel

Document
Exchange

Transport Review
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c. Select Use Existing and provide the following information:

13. Review the data and click Finish, or click Back.

You should see Communication Capability created successfully at the top of the 
page.

Acme Server, Task 3: Creating the Trading Partner Agreement
As the host trading partner, Acme is automatically included in the trading partner 
agreement. So, in the following steps, select GlobalChips as the trading partner in the 
agreement. To simplify your user experience, Acme is also automatically assigned 
support for a collaboration that is compatible with the one assigned to GlobalChips. 
You cannot create a trading partner agreement between more than two trading 
partners.

1. Click Partners. 

2. From Shortcuts, click Create Trading Partner Agreement.

3. From Trading Partner, select GlobalChips.

4. From Supported Business Protocol, select RosettaNet over RNIF.

5. From Supported Collaboration, select Seller - 3A4 - V02.00.

6. For Trading Partner Identification, select DUNS - 111111111 for GlobalChips and 
DUNS - 222222222 for Acme.

7. For Trading Partner Delivery Channel, select GlobalChips RN DC and Acme RN 
DC.

8. For Internal Delivery Channel, select B2B Outbound.

9. For Responding Internal Delivery Channel, select B2B Inbound.

10. In the Name field, enter Tutorial 1 Agreement.

11. In the Agreement ID field, enter 1100.

12. Click Apply.

You should see Agreement Tutorial 1 Agreement successfully created at the top 
of the page.

Note that both participants are shown on the page.

13. Click Validate.

You should see Agreement Tutorial 1 Agreement is valid. The agreement is 
approved as part of the validation.

Acme Server, Task 4: Creating and Deploying the Configuration
After you have created the trading partner agreement, you are ready to create the 
configuration. A configuration consists of the data you defined in the previous tasks in 
this tutorial. A configuration enforces validation rules, ensuring that only valid, 

Endpoint Field Value

Endpoint b2b/transportServlet

See Also: "Creating a Trading Partner Agreement" on page 10-6
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complete, and consistent data is available for deployment in a production 
environment.

1. Click Deployment.

2. Click Create.

3. For Configuration Name, enter Tutorial 1 Configuration.

4. Select Tutorial 1 Agreement.

5. Click Apply.

You should see Creation and validation of configuration Tutorial 1 
Configuration successful.

6. For Tutorial 1 Configuration, click Deploy.

7. Review the list of configurations and click Deploy.

You should see Deployment finished successfully for configuration Tutorial 1 
Configuration.

Task 5: Verifying the Purchase Order Transaction
See "Both Servers, Task 5: Verifying the Purchase Order Transaction" on page 5-18 for 
more information.

GlobalChips Server, Task 1: Creating the Collaboration
Acme and GlobalChips use the same collaboration. So, on the GlobalChips server, 
create the same collaboration that was created on the Acme server. See "Acme Server, 
Task 1: Creating the Collaboration" on page 5-7 for instructions.

GlobalChips Server, Task 2: Setting Up the Trading Partners
On the GlobalChips server, GlobalChips is the host trading partner and Acme is the 
remote trading partner. 

This section contains these topics:

■ Setting Up the Remote Trading Partner (Acme)

■ Setting Up the Host Trading Partner (GlobalChips)

If you have not already done so, change the default host trading partner name from 
MyCompany to:

■ Acme, if you are working on the Acme server

■ GlobalChips, if you are working on the GlobalChips server

See "Changing the Host Trading Partner Name" on page 5-5 for instructions.

See Also: Chapter 11, "Creating and Deploying a Configuration"

See Also:

■ "Creating and Assigning All Capabilities During a Single Wizard 
Session" on page 7-9

■ "Creating Business Protocol Communication Capabilities for the 
Host and Remote Trading Partners" on page 7-26
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Setting Up the Remote Trading Partner (Acme)
In the following steps, you set up the remote trading partner’s business protocol, 
operational capabilities, and communication capabilities.

1. Click Partners.

2. From Shortcuts, click Create Trading Partner.

The following workflow for creating a trading partner is shown at the top of the 
page.

3. On the Create Trading Partner: General page, provide the remote trading partner 
name, Acme, and click Next.

4. On the Create Trading Partner: Identification page, enter 222222222 for the 
DUNS value and click Next.

5. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Next.

6. On the Create Trading Partner: Delivery Channel page, provide the following 
information and click Next.

7. On the Create Trading Partner: Document Exchange page, provide the following 
information and click Next.

8. On the Create Trading Partner: Transport page, provide the following 
information.

General Field Value

Business Protocol RosettaNet over RNIF

Collaboration 3A4 - V02.00

Collaboration Role Buyer

Is acknowledgment handled by Integration 
B2B?

Yes

Field Value

Name Acme RN DC

Acknowledgment Mode Async

Field Value

Name Acme RN DocEx

Exchange Protocol Revision RosettaNet - V02.00

General Field Value

Name Acme RN Transport

General Identification Operational
Capability

Delivery
Channel

Document
Exchange

Transport Review
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a. Click Create New, provide the following information, and click Next.

9. Review the data and click Finish, or click Back.

You should see Trading Partner Acme successfully created at the top of the page.

Setting Up the Host Trading Partner (GlobalChips)
In the following steps, you set up the host trading partner’s DUNS number and 
communication capabilities. To simplify your user experience, the host is 
automatically assigned a business protocol and operational capabilities that are 
compatible with the remote trading partner.

1. Click Partners > Trading Partners.

2. Click GlobalChips (Host).

3. Under Trading Partner Identifications, click Create.

4. For Trading Partner Identification Type, select DUNS.

5. For Value, enter 111111111.

6. Click Apply.

7. Click Capabilities.

8. Click RosettaNet over RNIF.

9. Click Create Communication Capability.

The following workflow for creating the communication capabilities is shown at 
the top of the page.

10. On the Create Trading Partner: Delivery Channel page, provide the following 
information and click Next.

Transport Protocol Field Value

Transport Protocol HTTP - 1.1

Transport Server Field Value

Name Acme Transport Server

Host Name Acme_hostname

The transport server host exchanging 
messages at the Acme site.

Port 80 in a Windows environment; 7779 in a 
Solaris environment

Endpoint Field Value

URI b2b/transportServlet

Delivery
Channel

Document
Exchange

Transport Review
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11. On the Create Trading Partner: Document Exchange page, click Create New. 
Provide the following information and click Next.

12. On the Create Trading Partner: Transport page, provide the following information 
and click Next.

a. Select Create New and provide the following information:

b. Select Create New and provide the following information:

c. Select Use Existing and provide the following information:

13. Review the data and click Finish, or click Back.

You should see Communication Capability created successfully at the top of the 
page.

GlobalChips Server, Task 3: Creating the Trading Partner Agreement
As the host trading partner, GlobalChips is automatically included in the trading 
partner agreement. So, in the following steps, select Acme as the trading partner in the 

Field Value

Name GlobalChips RN DC

Acknowledgment Mode Async

Field Value

Name GlobalChips RN DocEx

Exchange Protocol Revision RosettaNet-V02.00

General Field Value

Name GlobalChips RN Transport

Transport Protocol Field Value

Transport Protocol HTTP - 1.1

Transport Server Field Value

Name GlobalChips Transport Server

Host Name GlobalChips_hostname

The transport server host exchanging 
messages at the GlobalChips site.

Port 80 in a Windows environment; 7779 in a 
Solaris environment

Endpoint Field Value

Endpoint b2b/transportServlet
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agreement. To simplify your user experience, GlobalChips is also automatically 
assigned support for a collaboration that is compatible with the one assigned to Acme.

1. Click Partners. 

2. From Shortcuts, click Create Trading Partner Agreement.

3. From Trading Partner, select Acme.

4. From Supported Business Protocol, select RosettaNet over RNIF.

5. From Supported Collaboration, select Buyer - 3A4 - V02.00.

6. For Trading Partner Identification, select DUNS - 222222222 for Acme and DUNS 
- 111111111 for GlobalChips.

7. For Trading Partner Delivery Channel, select Acme RN DC and GlobalChips RN 
DC.

8. For Internal Delivery Channel, select B2B Inbound.

9. For Responding Internal Delivery Channel, select B2B Outbound.

10. In the Name field, enter Tutorial 1 Agreement.

11. In the Agreement ID field, enter 1100.

12. Click Apply.

You should see Agreement Tutorial 1 Agreement successfully created at the top 
of the page.

Note that both participants are shown on the page.

13. Click Validate.

You should see Agreement Tutorial 1 Agreement is valid. The agreement is 
approved as part of the validation.

GlobalChips Server, Task 4: Creating and Deploying the Configuration
This step is the same on both servers. See "Acme Server, Task 4: Creating and 
Deploying the Configuration" on page 5-13 for instructions.

Both Servers, Task 5: Verifying the Purchase Order Transaction
Use the runtime files in ORACLE_HOME/ip/tutorial/RosettaNet/runtime (see 
Table 5–1 on page 5-6) to verify the transmission and receipt of the purchase order and 
purchase order confirmation. On UNIX platforms, you must grant execute permission 
using chmod +x to run the scripts.

Note: You cannot create a trading partner agreement between more 
than two trading partners.

See Also: "Creating a Trading Partner Agreement" on page 10-6

Note: You must run the setenv script to set up the CLASSPATH 
environment before running the following enqueue and dequeue 
scripts. See "Setting Up the CLASSPATH Environment" on page 5-4 if 
you have not already done so.
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1. On both the Acme and GlobalChips servers, run one of the following files: 

■ In a Bourne or Korn shell—deq.sh

■ In a C shell—deq.csh

■ In Windows—deq.bat

This dequeues the purchase order on the GlobalChips server and the purchase 
order confirmation on the Acme server.

The dequeue script generates a trace file, t1.trc, which shows the message that 
the application receives from OracleAS Integration B2B.

2. On the Acme server, run one of the following files:

■ In a Bourne or Korn shell—enq_3a4_req.sh

■ In a C shell—enq_3a4_req.csh

■ In Windows—enq_3a4_req.bat

This enqueues the Acme purchase order and translates it to RosettaNet PIP 3A4 
data to send to GlobalChips. Wait a minute or two before proceeding to the next 
step.

On the GlobalChips server, the purchase order is dequeued, which you can see in 
the trace file, t1.trc.

3. Open t1.trc, and select and copy the value for MsgID.

4. Open enq_3a4_rsp.properties and paste the MsgID value into the value for 
replyToMsgID. 

5. Save enq_3a4_rsp.properties.

6. On the GlobalChips server, run one of the following files:

■ In a Bourne or Korn shell—enq_3a4_rsp.sh

■ In a C shell—enq_3a4_rsp.csh

■ In Windows—enq_3a4_rsp.bat

This enqueues the purchase order confirmation from GlobalChips to Acme. Wait a 
minute before proceeding to the next step.

7. On the Acme server, the purchase order confirmation is dequeued, which you can 
see in the trace file, t1.trc.

Tutorial 2: Setting Up an EDI EDIFACT over Generic (VAN) Transaction
In the following tasks, you set up the Acme server first and then the GlobalChips 
server. If you are working through this tutorial with a partner, one person can do the 
tasks on the Acme server while the other does the tasks on the GlobalChips server.
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One person does the following tasks:

■ Acme Server, Task 1: Creating the Business Actions

■ Acme Server, Task 2: Setting Up the Trading Partners

■ Acme Server, Task 3: Creating the Trading Partner Agreement

■ Acme Server, Task 4: Creating and Deploying the Configuration

In parallel, the other person does the following tasks:

■ GlobalChips Server, Task 1: Creating the Business Actions

■ GlobalChips Server, Task 2: Setting Up the Trading Partners

■ GlobalChips Server, Task 3: Creating the Trading Partner Agreement

■ GlobalChips Server, Task 4: Creating and Deploying the Configuration

After each partner finishes tasks 1 through 4 on the respective server, work together to 
do task 5:

■ Both Servers, Task 5: Verifying the Purchase Order Transaction

The EDI EDIFACT transaction between Acme and GlobalChips is depicted in 
Figure 5–3.

Figure 5–3 Tutorial 2 EDIFACT Transaction: Acme Is the Buyer and GlobalChips Is the 
Seller

Note: Because the two servers can be on different hosts, the Acme 
and GlobalChips folders must be shared; that is, the GlobalChips 
trading partner must be able to put messages in the Acme folder 
(which may be on a different host). Similarly, the Acme trading 
partner must be able to access the GlobalChips folder (which may be 
on a different host). 

If for some reason the folders are not shared, then FTP must be used 
instead of the File protocol. If you use FTP, then you must specify the 
username and password when you create the transport server.

Note: Fields and checkboxes that you should accept default values 
for, or leave blank, are omitted in the following steps, although they 
appear on the screen. This is done to simplify the instructions and 
move you through the tutorial more quickly. 

Oracle Application Server
Integration B2B
at GlobalChips 

(Seller)

Oracle Application Server
Integration B2B

 at Acme - Europe
(Buyer)

EDI EDIFACT over
Generic (VAN)

EDIFACT ORDERS (PO)

EDIFACT ORDRSP (POA)
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Acme Server, Task 1: Creating the Business Actions
In the following set of tasks, Acme is the host trading partner. You create the following 
business actions for this transaction.

■ Process_ORDERS—Acme uses the Process_ORDERS business action to send a 
purchase order to GlobalChips.

■ Process_CONTRL—GlobalChips and Acme use the Process_CONTRL business 
action to send functional acknowledgments. GlobalChips acknowledges that they 
have received Acme’s purchase order. Acme acknowledges that they have 
received GlobalChips’ purchase order confirmation.

■ Process_ORDRSP—GlobalChips uses the Process_ORDRSP business action to 
send a purchase order confirmation indicating that they can fulfill Acme’s 
purchase order request.

Creating the Process_ORDERS Business Action—Acme Sends a Purchase Order
1. Click Partners > Protocols.

2. Click EDI EDIFACT over Generic Exchange.

3. From Shortcut, click Create Business Action.

The following workflow for creating a business action is shown at the top of the 
page:

4. On the Create Business Action: General page, provide the following information 
and click Next.

5. On the Create Business Action: Document Protocol Revision page, provide the 
following information and click Next.

Note: You must use all uppercase for document protocol parameters, 
as shown in this tutorial. This is an EDIFACT standard. 

See Also: "Creating a Business Action" on page 6-17

Field Value

Name Process_ORDERS

Revision 1.0

Is Nonrepudiation of Receipt Required No

Is Nonrepudiation of Origin Required No

Acknowledgment Mode Async

Field Value

Create Mode Create New

Name EDIFACT_D98A

General Document
Protocol
Revision

Document
Type

Review
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6. On the Create Business Action: Document Type page, provide the following 
information and click Next.

7. Review the data and click Finish, or click Back.

You should see Business Action Process_ORDERS: 1.0 successfully created at the 
top of the page.

Creating the Process_CONTRL Business Action—Functional Acknowledgments
You create the Process_CONTRL business action for two purposes:

■ For the buyer, Acme, to send a functional acknowledgment to GlobalChips. Acme 
acknowledges that they received GlobalChips’ purchase order confirmation.

■ For the seller, GlobalChips, to send a functional acknowledgment to Acme. 
GlobalChips acknowledges that they received Acme’s purchase order request.

1. Click Partners > Protocols.

2. Click EDI EDIFACT over Generic Exchange.

3. From Shortcut, click Create Business Action.

The following workflow for creating a business action is shown at the top of the 
page:

Revision D98A

Document Protocol Parameters Field Override Value1

1 If you are working on the GlobalChips server, use GLOBALCHIPS instead of ACME for the override value.

Interchange Sender Identification ACME

Interchange Recipient Identification ACME

Application Sender’s Identification ACME

Application Recipient’s Identification ACME

General Field Value

Name ORDERS

Revision D98A

Document Definition Field Value

Name ORDERS Definition

Definition orders.xsd

Document Type Parameters Field Override Value

Functional Group Identification ORDERS

Transaction Set ecs File orders.ecs

Field Value
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4. On the Create Business Action: General page, provide the following information 
and click Next.

5. On the Create Business Action: Document Protocol Revision page, provide the 
following information and click Next.

6. On the Create Business Action: Document Type page, provide the following 
information and click Next.

Field Value

Name Process_CONTRL

Revision 1.0

Is Nonrepudiation of Receipt Required No

Is Nonrepudiation of Origin Required No

Acknowledgment Mode Async

Field Value

Create Mode Create New

Name EDIFACT_D3

Revision D3

Document Protocol Parameters Field Override Value1

1 If you are working on the GlobalChips server, use GLOBALCHIPS instead of ACME for the override value.

Interchange Sender Identification ACME

Interchange Recipient Identification ACME

Application Sender’s Identification ACME

Application Recipient’s Identification ACME

General Field Override Value

Name CONTRL

Revision D3

Document Definition Field Value

Name Acme_CONTRL

Definition contrl.xsd

Document Type Parameters Field Override Value

Functional Group Identifier Code CONTRL

General Document
Protocol
Revision

Document
Type

Review
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7. Review the data and click Finish, or click Back.

You should see Business Action Process_CONTRL: 1.0 successfully created at the 
top of the page.

Creating the Process_ORDRSP Business Action—GlobalChips Sends a Purchase 
Order Confirmation
1. Click Partners > Protocols.

2. Click EDI EDIFACT over Generic Exchange.

3. From Shortcut, click Create Business Action.

The following workflow for creating a business action is shown at the top of the 
page:

4. On the Create Business Action: General page, provide the following information 
and click Next.

5. On the Create Business Action: Document Protocol Revision page, provide the 
following information and click Next. 

6. On the Create Business Action: Document Type page, provide the following 
information and click Next.

Transaction Set ecs File contrl.ecs

Field Value 

Name Process_ORDRSP

Revision 1.0

Is Nonrepudiation of Receipt Required No

Is Nonrepudiation of Origin Required No

Acknowledgment Mode Async

Field Value

Create Mode Use Existing

Document Protocol Revision EDIFACT_D98A-D98A

General Field Value

Name ORDRSP

Revision D98A

Document Type Parameters Field Override Value

General Document
Protocol
Revision

Document
Type

Review
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7. Review the data and click Finish, or click Back.

You should see Business Action Process_ORDRSP: 1.0 successfully created at the 
top of the page.

Acme Server, Task 2: Setting Up the Trading Partners
On the Acme server, Acme is the host trading partner and GlobalChips is the remote 
trading partner. 

This section contains these topics:

■ Setting Up the Remote Trading Partner (GlobalChips)

■ Setting Up the Host Trading Partner (Acme)

If you have not already done so, change the default host trading partner name from 
MyCompany to:

■ Acme, if you are working on the Acme server

■ GlobalChips, if you are working on the GlobalChips server

See "Changing the Host Trading Partner Name" on page 5-5 for instructions.

Setting Up the Remote Trading Partner (GlobalChips)
As you set up GlobalChips, you associate it with the business actions as follows:

■ Process_ORDERS-Responder. GlobalChips responds to the Process_ORDERS 
business action (see Step 5 on page 5-26, Is Initiator = False), because it receives the 
purchase order.

■ Process_CONTRL-Initiator. GlobalChips initiates the Process_CONTRL business 
action (see Step 14 on page 5-27, Is Initiator=True) when it sends a functional 
acknowledgment to Acme.

■ Process_CONTRL-Responder. GlobalChips responds to the Process_CONTRL 
business action (see Step 16 on page 5-28, Is Initiator=False), because it receives a 
functional acknowledgment from Acme.

Document Definition Field Value

Name ORDRSP

Definition ordrsp.xsd

Document Type Parameters Field Override Value

Functional Group Identifier Code ORDRSP

Transaction Set ecs File ordrsp.ecs

See Also:

■ "Creating and Assigning All Capabilities During a Single Wizard 
Session" on page 7-9

■ "Creating Business Protocol Communication Capabilities for the 
Host and Remote Trading Partners" on page 7-26
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■ Process_ORDRSP-Initiator. GlobalChips initiates the Process_ORDRSP business 
action (see Step 18 on page 5-28, Is Initiator=True) when it sends the purchase 
order confirmation to Acme.

1. Click Partners.

2. From Shortcuts, click Create Trading Partner.

The following workflow for creating a trading partner is shown at the top of the 
page.

3. On the Create Trading Partner: General page, provide the remote trading partner 
name, GlobalChips, and click Next.

4. Skip the Create Trading Partner: Identification page and click Next. 

5. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Next.

6. Continuing on the Create Trading Partner: Operational Capability page, provide 
the following override values and click Next.

7. On the Create Trading Partner: Delivery Channel page, provide the following 
information and click Next.

General Field Value

Business Protocol EDI EDIFACT over Generic Exchange

Business Action Process_ORDERS

Is Initiator False

Functional acknowledgment required? Yes

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type ORDERS

Use Existing Document Protocol Parameter 
Values

Uncheck the box.

Use Default Document Definition Check the box.

Document Protocol Parameters Field Override Value

Interchange Sender Identification GLOBALCHIPS

Interchange Recipient Identification GLOBALCHIPS

Application Sender’s Identification GLOBALCHIPS

Application Recipient’s Identification GLOBALCHIPS

General Identification Operational
Capability

Delivery
Channel

Document
Exchange

Transport Review
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8. On the Create Trading Partner: Document Exchange page, provide the following 
information and click Next.

9. On the Create Trading Partner: Transport page, provide the following 
information.

a. Click Create New, provide the following information, and click Next.

10. Review the data and click Finish, or click Back.

You should see Trading Partner GlobalChips successfully created at the top of 
the page.

11. Click Capabilities.

12. Click EDI EDIFACT over Generic Exchange.

13. Click Create Operational Capability.

14. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Apply.

Field Value

Name GlobalChips DC

Acknowledgment Mode None

Field Value

Name GlobalChips DocEx

Exchange Protocol Revision Generic - 1.0

General Field Value

Name GlobalChips Transport

Transport Protocol Field Value

Transport Protocol File - 1.0

Transport Server Field Value

Name GlobalChips Transport Server

Host Name GlobalChips_hostname

The transport server host exchanging 
messages at the GlobalChips site.

Endpoint Field Value

URI GlobalChips_endpoint 

Outgoing file directory for the remote trading 
partner.
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You should see Supported business action created successfully at the top of the 
page, for Process_CONTRL-Initiator.

15. Repeat Steps 11 through 13.

16. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Apply.

You should see Supported business action created successfully at the top of the 
page, for Process_CONTRL-Responder.

17. Repeat Steps 11 through 13.

18. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Apply.

General Field Value

Business Action Process_CONTRL

Is Initiator True

Functional acknowledgment required? No

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type CONTRL

Document Protocol Parameter Field Override Value

Interchange Sender Identification GLOBALCHIPS

Interchange Recipient Identification GLOBALCHIPS

Application Sender’s Identification GLOBALCHIPS

Application Recipient’s Identification GLOBALCHIPS

General Field Value

Business Action Process_CONTRL

Is Initiator False

Functional acknowledgment required? No

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type CONTRL

General Field Value

Business Action Process_ORDRSP

Is Initiator True
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You should see Supported business action created successfully at the top of the 
page, for Process_ORDRSP-Initiator.

Setting Up the Host Trading Partner (Acme)
In the following steps, you set up the host trading partner’s communication 
capabilities. To simplify your user experience, the host is automatically assigned a 
business protocol and operational capabilities that are compatible with the remote 
trading partner.

1. Click Partners > Trading Partners.

2. Click Acme (Host).

3. Click Capabilities.

4. Click EDI EDIFACT over Generic Exchange.

5. Click Create Communication Capability.

The following workflow for creating the communication capabilities is shown at 
the top of the page.

6. On the Create Trading Partner: Delivery Channel page, provide the following 
information and click Next.

7. On the Create Trading Partner: Document Exchange page, click Create New. 
Provide the following information and click Next.

8. On the Create Trading Partner: Transport page, provide the following information 
and click Next.

a. Select Create New and provide the following information:

Functional acknowledgment required? Yes

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type ORDRSP

Field Value

Name Acme DC

Acknowledgment Mode None

Field Value

Name Acme DocEx

Exchange Protocol Revision Generic - 1.0

General Field Value

Delivery
Channel

Document
Exchange

Transport Review
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b. Select Create New and provide the following information:

c. Select Create New and provide the following information:

9. Review the data and click Finish, or click Back. 

You should see Communication Capability created successfully at the top of the 
page.

Acme Server, Task 3: Creating the Trading Partner Agreement
As the host trading partner, Acme is automatically included in the trading partner 
agreement. So, in the following steps, select GlobalChips as the remote trading partner 
in the agreement. To simplify your user experience, Acme is also automatically 
assigned support for a business action that is compatible with the one assigned to 
GlobalChips.

1. Click Partners. 

2. From Shortcuts, click Create Trading Partner Agreement.

3. From Trading Partner, select GlobalChips.

4. From Supported Business Protocol, select EDI EDIFACT over Generic Exchange.

5. From Supported Business Action, select Process_ORDERS-Responder.

6. For Trading Partner Identification, select Name - GlobalChips and Name - 
Acme.

7. For Trading Partner Delivery Channel, select GlobalChips DC and Acme DC.

General Field Value

Name Acme Transport

Transport Protocol Field Value

Transport Protocol File - 1.0

Transport Server Field Value

Name Acme Server

Host Name Acme_hostname

The transport server host exchanging 
messages at the Acme site.

Endpoint Field Value

URI Acme_endpoint 

Incoming file directory for the host trading 
partner.

Note: You cannot create a trading partner agreement between more 
than two trading partners.
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8. For Internal Delivery Channel, select B2B Outbound.

9. For Responding Internal Delivery Channel, select B2B Inbound.

10. In the Name field, enter Tutorial 2 Agreement.

11. In the Agreement ID field, enter 1200.

12. Click Apply.

You should see Agreement Tutorial 2 Agreement successfully created at the top 
of the page.

13. For Trading Partner Participants, click Add.

14. From Supported Business Protocol, select EDI EDIFACT over Generic Exchange.

15. From Supported Business Action, select Process_CONTRL-Initiator.

16. Repeat Steps 6 and 7.

17. For Internal Delivery Channel, select B2B Inbound.

18. For Responding Internal Delivery Channel, select B2B Outbound.

19. Click Apply.

You should see Trading partner participant successfully added.

20. For Trading Partner Participants, click Add.

21. From Supported Business Protocol, select EDI EDIFACT over Generic Exchange.

22. From Supported Business Action, select Process_CONTRL-Responder.

23. Repeat Steps 6 through 9.

24. Click Apply.

You should see Trading partner participant successfully added.

25. For Trading Partner Participants, click Add.

26. From Supported Business Protocol, select EDI EDIFACT over Generic Exchange.

27. From Supported Business Action, select Process_ORDRSP - Initiator.

28. Repeat Steps 6 and 7.

29. For Internal Delivery Channel, select B2B Inbound.

30. For Responding Internal Delivery Channel, select B2B Outbound.

31. Click Apply.

You should see Trading partner participant successfully added.

32. Click Validate.

You should see Agreement Tutorial 2 Agreement is valid. The agreement is 
approved as part of the validation.

Acme Server, Task 4: Creating and Deploying the Configuration
After you have created the trading partner agreement, you are ready to create the 
configuration. A configuration consists of the data you defined in the previous tasks in 
this tutorial. A configuration enforces validation rules, ensuring that only valid, 

See Also: "Creating a Trading Partner Agreement" on page 10-6
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complete, and consistent data is available for deployment in a production 
environment.

1. Click Deployment.

2. Click Create.

3. For Configuration Name, enter Tutorial 2 Configuration.

4. Select Tutorial 2 Agreement.

5. Click Apply.

You should see Creation and validation of configuration Tutorial 2 
Configuration successful.

6. For Tutorial 2 Configuration, click Deploy.

7. Review the list of configurations and click Deploy.

You should see Deployment finished successfully for configuration Tutorial 2 
Configuration.

Task 5: Verifying the Purchase Order Transaction
See "Both Servers, Task 5: Verifying the Purchase Order Transaction" on page 5-39 for 
more information.

GlobalChips Server, Task 1: Creating the Business Actions
Acme and GlobalChips use the same set of business actions. So, on the GlobalChips 
server, create the same business actions that were created on the Acme server. You can 
use the same instructions, "Acme Server, Task 1: Creating the Business Actions" on 
page 5-21 for:

■ Creating the Process_ORDERS Business Action—Acme Sends a Purchase Order

■ Creating the Process_CONTRL Business Action—Functional Acknowledgments

■ Creating the Process_ORDRSP Business Action—GlobalChips Sends a Purchase 
Order Confirmation

GlobalChips Server, Task 2: Setting Up the Trading Partners
On the GlobalChips server, GlobalChips is the host trading partner and Acme is the 
remote trading partner. 

This section contains these topics:

■ Changing the Host Trading Partner Name to GlobalChips

■ Setting Up the Remote Trading Partner (Acme)

■ Setting Up the Host Trading Partner (GlobalChips)

See Also: Chapter 11, "Creating and Deploying a Configuration"

See Also:

■ "Creating and Assigning All Capabilities During a Single Wizard 
Session" on page 7-9

■ "Creating Business Protocol Communication Capabilities for the 
Host and Remote Trading Partners" on page 7-26
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If you have not already done so, change the default host trading partner name from 
MyCompany to:

■ Acme, if you are working on the Acme server

■ GlobalChips, if you are working on the GlobalChips server

See "Changing the Host Trading Partner Name" on page 5-5 for instructions.

Changing the Host Trading Partner Name to GlobalChips
For this tutorial, change the host trading partner name (created at installation) to 
GlobalChips.

1. Click Partners > Trading Partners.

2. For MyCompany (Host), click Update.

3. Enter GlobalChips in place of MyCompany.

4. Click Apply.

Setting Up the Remote Trading Partner (Acme)
As you set up Acme, you associate it with the following business actions:

■ Process_ORDERS-Initiator. Acme is the initiator of the Process_ORDERS business 
action (see Step 5 on page 5-33, Is Initiator = True), when it sends the purchase 
order to GlobalChips.

■ Process_CONTRL-Initiator. Acme is the initiator of the Process_CONTRL business 
action (see Step 14 on page 5-35, Is Initiator=True) when it sends a functional 
acknowledgment to GlobalChips.

■ Process_CONTRL-Responder. Acme is not the initiator of the Process_CONTRL 
business action (see Step 16 on page 5-36, Is Initiator=False) when it receives a 
functional acknowledgment from GlobalChips.

■ Process_ORDRSP-Responder. Acme is not the initiator of the Process_ORDRSP 
business action (see Step 18 on page 5-36, Is Initiator=False) when it receives the 
purchase order confirmation from GlobalChips.

1. Click Partners.

2. From Shortcuts, click Create Trading Partner.

The following workflow for creating a trading partner is shown at the top of the 
page.

3. On the Create Trading Partner: General page, provide the remote trading partner 
name, Acme, and click Next.

4. Skip the Create Trading Partner: Identification page and click Next. 

5. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Next.

General Field Value

Business Protocol EDI EDIFACT over Generic Exchange

General Identification Operational
Capability

Delivery
Channel

Document
Exchange

Transport Review
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6. Continuing on the Create Trading Partner: Operational Capability page, provide 
the following override values and click Next.

7. On the Create Trading Partner: Delivery Channel page, provide the following 
information and click Next.

8. On the Create Trading Partner: Document Exchange page, provide the following 
information and click Next.

9. On the Create Trading Partner: Transport page, provide the following 
information.

Business Action Process_ORDERS

Is Initiator True

Functional acknowledgment required? Yes

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type ORDERS

Use Existing Document Protocol Parameter 
Values

Uncheck the box.

Use Default Document Definition Check the box.

Document Protocol Parameters Field Override Value

Interchange Sender Identification ACME

Interchange Recipient Identification ACME

Application Sender’s Identification ACME

Application Recipient’s Identification ACME

Field Value

Name Acme DC

Acknowledgment Mode None

Field Value

Name Acme DocEx

Exchange Protocol Revision Generic - 1.0

General Field Value

Name Acme Transport

General Field Value
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a. Click Create New, provide the following information, and click Next.

10. Review the data and click Finish, or click Back.

You should see Trading Partner Acme created successfully at the top of the page.

11. Click Capabilities.

12. Click EDI EDIFACT over Generic Exchange.

13. Click Create Operational Capability.

14. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Apply.

Transport Protocol Field Value

Transport Protocol File - 1.0

Transport Server Field Value

Name Acme Server

Host Name Acme_hostname

The transport server host exchanging 
messages at the Acme site.

Endpoint Field Value

URI Acme_endpoint

Outgoing file directory for the remote trading 
partner.

General Field Value

Business Action Process_CONTRL

Is Initiator True

Functional acknowledgment required? No

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type CONTRL

Document Protocol Parameter Field Override Value

Interchange Sender Identification ACME

Interchange Recipient Identification ACME

Application Sender’s Identification ACME

Application Recipient’s Identification ACME
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You should see Supported business action created successfully at the top of the 
page, for Process_CONTRL-Initiator.

15. Repeat Steps 11 through 13.

16. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Apply.

You should see Supported business action created successfully at the top of the 
page, for Process_CONTRL-Responder.

17. Repeat Steps 11 through 13.

18. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Apply.

You should see Supported business action created successfully at the top of the 
page, for Process_ORDRSP-Responder.

Setting Up the Host Trading Partner (GlobalChips)
In the following steps, you set up the host trading partner’s communication 
capabilities. To simplify your user experience, the host is automatically assigned a 
business protocol and operational capabilities that are compatible with the remote 
trading partner.

1. Click Partners > Trading Partners.

2. Click GlobalChips (Host).

3. Click Capabilities.

General Field Value

Business Action Process_CONTRL

Is Initiator False

Functional acknowledgment required? No

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type CONTRL

General Field Value

Business Action Process_ORDRSP

Is Initiator False

Functional acknowledgment required? Yes

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type ORDRSP
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4. Click EDI EDIFACT over Generic Exchange.

5. Click Create Communication Capability.

The following workflow for creating the communication capabilities is shown at 
the top of the page.

6. On the Create Trading Partner: Delivery Channel page, provide the following 
information and click Next.

7. On the Create Trading Partner: Document Exchange page, click Create New. 
Provide the following information and click Next.

8. On the Create Trading Partner: Transport page, provide the following information 
and click Next.

a. Select Create New and provide the following information:

b. Select Create New and provide the following information:

c. Select Create New and provide the following information:

Field Value

Name GlobalChips DC

Acknowledgment Mode None

Field Value

Name GlobalChips DocEx

Exchange Protocol Revision Generic - 1.0

General Field Value

Name GlobalChips Transport

Transport Protocol Field Value

Transport Protocol File - 1.0

Transport Server Field Value

Name GlobalChips Server

Host Name GlobalChips_hostname

The transport server host exchanging 
messages at the GlobalChips site.

Delivery
Channel

Document
Exchange

Transport Review
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9. Review the data and click Finish, or click Back. 

You should see Communication Capability created successfully at the top of the 
page.

GlobalChips Server, Task 3: Creating the Trading Partner Agreement
As the host trading partner, GlobalChips is automatically included in the trading 
partner agreement. So, in the following steps, select Acme as the remote trading 
partner in the agreement. To simplify your user experience, GlobalChips is also 
automatically assigned support for a business action that is compatible with the one 
assigned to Acme.

1. Click Partners. 

2. From Shortcuts, click Create Trading Partner Agreement.

3. From Trading Partner, select Acme.

4. From Supported Business Protocol, select EDI EDIFACT over Generic Exchange.

5. From Supported Business Action, select Process_ORDERS-Initiator.

6. For Trading Partner Identification, select Name - Acme and Name - 
GlobalChips.

7. For Trading Partner Delivery Channel, select Acme DC and GlobalChips DC.

8. For Internal Delivery Channel, select B2B Inbound.

9. For Responding Internal Delivery Channel, select B2B Outbound.

10. In the Name field, enter Tutorial 2 Agreement.

11. In the Agreement ID field, enter 1200.

12. Click Apply.

You should see Agreement Tutorial 2 Agreement successfully created at the top 
of the page.

13. For Trading Partner Participants, click Add.

14. From Supported Business Protocol, select EDI EDIFACT over Generic Exchange.

15. From Supported Business Action, select Process_CONTRL-Initiator.

16. Repeat Steps 6 through 9.

17. Click Apply.

You should see Trading partner participant successfully added.

18. For Trading Partner Participants, click Add.

Endpoint Field Value

URI GlobalChips_endpoint

Incoming file directory for the host trading 
partner.

Note: You cannot create a trading partner agreement between more 
than two trading partners.
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19. From Supported Business Protocol, select EDI EDIFACT over Generic Exchange.

20. From Supported Business Action, select Process_CONTRL-Responder.

21. Repeat Steps 6 and 7.

22. For Internal Delivery Channel, select B2B Outbound.

23. For Responding Internal Delivery Channel, select B2B Inbound.

24. Click Apply.

You should see Trading partner participant successfully added.

25. For Trading Partner Participants, click Add.

26. From Supported Business Protocol, select EDI EDIFACT over Generic Exchange.

27. From Supported Business Action, select Process_ORDRSP-Responder.

28. Repeat Steps 6 and 7.

29. For Internal Delivery Channel, select B2B Outbound.

30. For Responding Internal Delivery Channel, select B2B Inbound.

31. Click Apply.

You should see Trading partner participant successfully added.

32. Click Validate.

You should see Agreement Tutorial 2 Agreement is valid. The agreement is 
approved as part of the validation.

GlobalChips Server, Task 4: Creating and Deploying the Configuration
This step is the same on both servers. See "Acme Server, Task 4: Creating and 
Deploying the Configuration" on page 5-31 for instructions.

Both Servers, Task 5: Verifying the Purchase Order Transaction
Use the runtime files in ORACLE_HOME/ip/tutorial/Edifact/runtime (see 
Table 5–1 on page 5-6) to verify the transmission and receipt of the purchase order and 
purchase order confirmation. On UNIX platforms, you must grant execute permission 
using chmod +x to run the scripts.

1. On both the Acme and GlobalChips servers, run one of the following files: 

■ In a Bourne or Korn shell—deq.sh

■ In a C shell—deq.csh

■ In Windows—deq.bat

This dequeues the purchase order on the GlobalChips server and the purchase 
order confirmation on the Acme server.

See Also: "Creating a Trading Partner Agreement" on page 10-6

Note: You must run the setenv script to set up the CLASSPATH 
environment before running the following enqueue and dequeue 
scripts. See "Setting Up the CLASSPATH Environment" on page 5-4 if 
you have not already done so.
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The dequeue script generates a trace file, t1.trc, which shows the message that 
the application receives from OracleAS Integration B2B.

2. On the Acme server, run one of the following files:

■ In a Bourne or Korn shell—enq_orders.sh

■ In a C shell—enq_orders.csh

■ In Windows—enq_orders.bat

This enqueues the Acme purchase order and translates it to EDIFACT ORDER 
data to send to GlobalChips. Wait a minute or two before proceeding to the next 
step.

On the GlobalChips server, the purchase order is dequeued, which you can see in 
the trace file, t1.trc. The trace file name can be configured in enq_
orders.properties.

3. On the GlobalChips server, run one of the following files:

■ In a Bourne or Korn shell—enq_ordrsp.sh

■ In a C shell—enq_ordrsp.csh

■ In Windows—enq_ordrsp.bat

This enqueues the purchase order confirmation from GlobalChips to Acme. Wait a 
minute before proceeding to the next step.

4. On the Acme server, the purchase order confirmation is dequeued, which you can 
see in the trace file, t1.trc.

The trace file name can be configured in enq_ordrsp.properties.

Tutorial 3: Setting Up an EDI X12 over Internet (AS2) Transaction
In the following tasks, you set up the Acme server first and then the GlobalChips 
server. If you are working through this tutorial with a partner, one person can do the 
tasks on the Acme server while the other does the tasks on the GlobalChips server.

One person does the following tasks:

■ Acme Server, Task 1: Creating the Business Actions

■ Acme Server, Task 2: Setting Up the Trading Partners

■ Acme Server, Task 3: Creating the Trading Partner Agreement

■ Acme Server, Task 4: Creating and Deploying the Configuration

In parallel, another person does the following tasks:

■ GlobalChips Server, Task 1: Creating the Business Actions

■ GlobalChips Server, Task 2: Setting Up the Trading Partners

■ GlobalChips Server, Task 3: Creating the Trading Partner Agreement

■ GlobalChips Server, Task 4: Creating and Deploying the Configuration

After each partner finishes tasks 1 through 4 on the respective server, work together to 
do task 5:

■ Both Servers, Task 5: Verifying the Purchase Order Transaction
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The EDI X12 transaction between Acme and GlobalChips is depicted in Figure 5–4.

Figure 5–4 Tutorial 3 EDI X12 Transaction: Acme Is the Buyer and GlobalChips Is the 
Seller

Acme Server, Task 1: Creating the Business Actions
In the following set of tasks, Acme is the host trading partner. You create the following 
business actions for this transaction.

■ Process_850—Acme uses the Process_850 business action to send a purchase order 
to GlobalChips.

■ Process_997—GlobalChips and Acme use the Process_997 business action to send 
acknowledgments. GlobalChips acknowledges that they have received Acme’s 
purchase order. Acme acknowledges that they have received GlobalChips’ 
purchase order confirmation.

■ Process_855—GlobalChips uses the Process_855 business action to send a 
purchase order confirmation indicating that they can fulfill Acme’s purchase order 
request.

Creating the Process_850 Business Action—Acme Sends a Purchase Order
1. Click Partners > Protocols.

2. Click EDI X12 over Internet.

3. From Shortcut, click Create Business Action.

The following workflow for creating a business action is shown at the top of the 
page:

4. On the Create Business Action: General page, provide the following information 
and click Next.

Note: Fields and checkboxes that you should accept default values 
for, or leave blank, are omitted in the following steps, although they 
appear on the screen. This is done to simplify the instructions and 
move you through the tutorial more quickly. 

See Also: "Creating a Business Action" on page 6-17

Oracle Application Server
Integration B2B
at GlobalChips 

(Seller)

Oracle Application Server
Integration B2B
 at Acme - U.S.

(Buyer)

EDI X12 over
Internet (AS2)

X12 850 (PO)

X12 855 (POA)

General Document
Protocol
Revision

Document
Type

Review
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5. On the Create Business Action: Document Protocol Revision page, provide the 
following information and click Next. 

6. On the Create Business Action: Document Type page, provide the following 
information and click Next.

7. Review the data and click Finish, or click Back.

You should see Business Action Process_850: 1.0 successfully created at the top of 
the page.

Field Value

Name Process_850

Revision 1.0

Is Nonrepudiation of Receipt Required No

Is Nonrepudiation of Origin Required No

Acknowledgment Mode Async

Field Value

Create Mode Create New

Name X12_4010

Revision 4010

Document Protocol Parameters Field Override Value1

1 If you are working on the GlobalChips server, use GlobalChips instead of Acme for the override value.

Interchange Sender ID Acme

Interchange Receiver ID Acme

Interchange Control Version Number 00200

Application Sender’s Code Acme

Application Receiver’s Code Acme

General Field Value

Name 850

Revision 4010

Document Definition Field Value

Name 850 Definition

Definition 850.xsd

Document Type Parameters Field Override Value

Functional Group Identifier Code PO

Transaction Set ecs File 850.ecs
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Creating the Process_997 Business Action—Acknowledgments
You create the Process_997 business action for two purposes:

■ For the buyer, Acme, to send an acknowledgment to GlobalChips. Acme 
acknowledges that they received GlobalChips’ purchase order confirmation.

■ For the seller, GlobalChips, to send an acknowledgment to Acme. GlobalChips 
acknowledges that they received Acme’s purchase order request.

1. Click Partners > Protocols.

2. Click EDI X12 over Internet.

3. From Shortcut, click Create Business Action.

The following workflow for creating a business action is shown at the top of the 
page:

4. On the Create Business Action: General page, provide the following information 
and click Next.

5. On the Create Business Action: Document Protocol Revision page, provide the 
following information and click Next.

6. On the Create Business Action: Document Type page, provide the following 
information and click Next.

Field Value

Name Process_997

Revision 1.0

Is Nonrepudiation of Receipt Required No

Is Nonrepudiation of Origin Required No

Acknowledgment Mode Async

Field Value

Create Mode Use Existing

Document Protocol Revision X12_4010 - 4010

General Field Override Value

Name 997

Revision 4010

Document Definition Field Value

Name 997 Definition

Definition 997.xsd

General Document
Protocol
Revision

Document
Type

Review
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7. Review the data and click Finish, or click Back.

You should see Business Action Process_997: 1.0 successfully created at the top of 
the page.

Creating the Process_855 Business Action—GlobalChips Sends a Purchase Order 
Confirmation
1. Click Partners > Protocols.

2. Click EDI X12 over Internet.

3. From Shortcut, click Create Business Action.

The following workflow for creating a business action is shown at the top of the 
page:

4. On the Create Business Action: General page, provide the following information 
and click Next.

5. On the Create Business Action: Document Protocol Revision page, provide the 
following information and click Next. 

6. On the Create Business Action: Document Type page, provide the following 
information and click Next.

Document Type Parameters Field Override Value

Functional Group Identifier Code FA

Transaction Set ecs File 997.ecs

Field Value 

Name Process_855

Revision 1.0

Is Nonrepudiation of Receipt Required No

Is Nonrepudiation of Origin Required No

Acknowledgment Mode Async

Field Value

Create Mode Use Existing

Document Protocol Revision X12_4010 - 4010

General Field Value

Name 855

Revision 4010

General Document
Protocol
Revision

Document
Type

Review
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7. Review the data and click Finish, or click Back.

You should see Business Action Process_855: 1.0 successfully created at the top of 
the page.

Acme Server, Task 2: Setting Up the Trading Partners
On the Acme server, Acme is the host trading partner and GlobalChips is the remote 
trading partner. 

This section contains these topics:

■ Setting Up the Remote Trading Partner (GlobalChips)

■ Setting Up the Host Trading Partner (Acme)

If you have not already done so, change the default host trading partner name from 
MyCompany to:

■ Acme, if you are working on the Acme server

■ GlobalChips, if you are working on the GlobalChips server

See "Changing the Host Trading Partner Name" on page 5-5 for instructions.

Setting Up the Remote Trading Partner (GlobalChips)
As you set up GlobalChips, you associate it with the business actions as follows:

■ Process_850-Responder. GlobalChips responds to the Process_850 business action 
(see Step 5 on page 5-46, Is Initiator = False) when it receives the purchase order.

■ Process_997-Initiator. GlobalChips initiates the Process_997 business action (see 
Step 14 on page 5-47, Is Initiator=True) when it sends an acknowledgment to 
Acme.

■ Process_855-Initiator. GlobalChips initiates the Process_855 business action (see 
Step 16 on page 5-48, Is Initiator=True) when it sends the purchase order 
confirmation to Acme.

Document Definition Field Value

Name 855 Definition

Definition 855.xsd

Document Type Parameters Field Override Value

Functional Group Identifier Code PR

Transaction Set ecs File 855.ecs

See Also:

■ "Creating and Assigning All Capabilities During a Single Wizard 
Session" on page 7-9

■ "Creating Business Protocol Communication Capabilities for the 
Host and Remote Trading Partners" on page 7-26
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■ Process_997-Responder. GlobalChips responds to the Process_997 business action 
(see Step 18 on page 5-48, Is Initiator=False) when it receives an acknowledgment 
from Acme.

1. Click Partners.

2. From Shortcuts, click Create Trading Partner.

The following workflow for creating a trading partner is shown at the top of the 
page.

3. On the Create Trading Partner: General page, provide the remote trading partner 
name, GlobalChips, and click Next.

4. On the Create Trading Partner: Identification page, enter GlobalChips for the 
AS2 Identifier value and click Next. 

5. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Next.

6. Continuing on the Create Trading Partner: Operational Capability page, provide 
the following override values and click Next.

7. On the Create Trading Partner: Delivery Channel page, provide the following 
information and click Next.

General Field Value

Business Protocol EDI X12 over Internet

Business Action Process_850

Is Initiator False

Functional acknowledgment required? Yes

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type 850

Use Existing Document Protocol Parameter 
Values

Uncheck the box.

Use Default Document Definition Check the box.

Document Protocol Parameters Field Override Value

Interchange Sender ID GlobalChips

Interchange Receiver ID GlobalChips

Application Sender’s Code GlobalChips

Application Receiver’s Code GlobalChips

General Identification Operational
Capability

Delivery
Channel

Document
Exchange

Transport Review
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8. On the Create Trading Partner: Document Exchange page, provide the following 
information and click Next.

9. On the Create Trading Partner: Transport page, provide the following 
information.

a. Click Create New, provide the following information, and click Next.

10. Review the data and click Finish, or click Back.

You should see Trading Partner GlobalChips successfully created at the top of 
the page.

11. Click Capabilities.

12. Click EDI X12 over Internet.

13. Click Create Operational Capability.

14. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Apply.

Field Value

Name GlobalChips X12 DC

Acknowledgment Mode Async

Field Value

Name GlobalChips X12 DocEx

Exchange Protocol Revision AS2 - 1.1

General Field Value

Name GlobalChips X12 Transport

Transport Protocol Field Value

Transport Protocol HTTP - 1.0

Transport Server Field Value

Name GlobalChips Transport Server

Host Name GlobalChips_hostname

The transport server host exchanging 
messages at the GlobalChips site.

Port 80 in a Windows environment; 7779 in a 
Solaris environment

Endpoint Field Value

URI b2b/transportServlet
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You should see Supported business action created successfully at the top of the 
page, for Process_997-Initiator.

15. Repeat Steps 11 through 13.

16. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Apply.

You should see Supported business action created successfully at the top of the 
page, for Process_855-Initiator.

17. Repeat Steps 11 through 13.

18. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Apply. 

Field Value

Business Action Process_997

Is Initiator True

Functional acknowledgment required? No

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type 997

Field Value

Business Action Process_855

Is Initiator True

Functional acknowledgment required? Yes

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type 855

Field Value

Business Action Process_997

Is Initiator False

Functional acknowledgment required? No

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type 997
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You should see Supported business action created successfully at the top of the 
page, for Process_997-Responder.

Setting Up the Host Trading Partner (Acme)
In the following steps, you set up the host trading partner’s AS2 identifier and 
communication capabilities. To simplify your user experience, the host is 
automatically assigned a business protocol and operational capabilities that are 
compatible with the remote trading partner.

1. Click Partners > Trading Partners.

2. Click Acme (Host).

3. Click General.

4. Under Trading Partner Identifications, click Create.

5. For Trading Partner Identification Type, select AS2 Identifier.

6. For Value, enter Acme.

7. Click Apply.

8. Click Capabilities.

9. Click EDI X12 over Internet.

10. Click Create Communication Capability.

The following workflow for creating the communication capabilities is shown at 
the top of the page.

11. On the Create Trading Partner: Delivery Channel page, provide the following 
information and click Next.

12. On the Create Trading Partner: Document Exchange page, click Create New. 
Provide the following information and click Next.

13. On the Create Trading Partner: Transport page, provide the following information 
and click Next.

a. Select Create New and provide the following information:

Field Value

Name Acme X12 DC

Acknowledgment Mode Async

Field Value

Name Acme X12 DocEx

Exchange Protocol Revision AS2 - 1.1

General Field Value

Name Acme X12 Transport

Delivery
Channel

Document
Exchange

Transport Review
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b. Select Create New and provide the following information:

c. Select Use Existing and provide the following information:

14. Review the data and click Finish, or click Back. 

You should see Communication Capability created successfully at the top of the 
page.

Acme Server, Task 3: Creating the Trading Partner Agreement
As the host trading partner, Acme is automatically included in the trading partner 
agreement. So, in the following steps, select GlobalChips as the trading partner in the 
agreement. To simplify your user experience, Acme is also automatically assigned 
support for a business action that is compatible with the one assigned to GlobalChips.

1. Click Partners. 

2. From Shortcuts, click Create Trading Partner Agreement.

3. From Trading Partner, select GlobalChips.

4. From Supported Business Protocol, select EDI X12 over Internet.

5. From Supported Business Action, select Process_850-Responder.

6. For Trading Partner Identification, select AS2 Identifier - GlobalChips and AS2 
Identifier - Acme.

7. For Trading Partner Delivery Channel, select GlobalChips X12 DC and Acme 
X12 DC.

8. For Internal Delivery Channel, select B2B Outbound.

9. For Responding Internal Delivery Channel, select B2B Inbound.

10. In the Name field, enter Tutorial 3 Agreement.

Transport Protocol Field Value

Transport Protocol HTTP - 1.0

Transport Server Field Value

Name Acme Transport Server

Host Name Acme_hostname

The transport server host exchanging 
messages at the Acme site.

Port 80 in a Windows environment; 7779 in a 
Solaris environment

Endpoint Field Value

Endpoint b2b/transportServlet

Note: You cannot create a trading partner agreement between more 
than two trading partners.
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11. In the Agreement ID field, enter 1300.

12. Click Apply.

You should see Agreement Tutorial 3 Agreement successfully created at the top 
of the page.

13. For Trading Partner Participant, click Add.

14. From Supported Business Protocol, select EDI X12 over Internet.

15. From Supported Business Action, select Process_997-Initiator.

16. Repeat Steps 6 through 7.

17. For Internal Delivery Channel, select B2B Inbound.

18. For Responding Internal Delivery Channel, select B2B Outbound.

19. Click Apply.

You should see Trading partner participant successfully added at the top of the 
page.

20. For Trading Partner Participant, click Add.

21. From Supported Business Protocol, select EDI X12 over Internet.

22. From Supported Business Action, select Process_855-Initiator.

23. Repeat Steps 6 and 7.

24. For Internal Delivery Channel, select B2B Inbound.

25. For Responding Internal Delivery Channel, select B2B Outbound.

26. Click Apply.

You should see Trading partner participant successfully added at the top of the 
page.

27. For Trading Partner Participant, click Add.

28. From Supported Business Protocol, select EDI X12 over Internet.

29. From Supported Business Action, select Process_997-Responder.

30. Repeat Steps 6 through 9.

31. Click Apply.

You should see Trading partner participant successfully added at the top of the 
page.

32. Click Validate.

You should see Agreement Tutorial 3 Agreement is valid. The agreement is 
approved as part of the validation.

Acme Server, Task 4: Creating and Deploying the Configuration
After you have created the trading partner agreement, you are ready to create the 
configuration. A configuration consists of the data you defined in the previous tasks in 
this tutorial. A configuration enforces validation rules, ensuring that only valid, 
complete, and consistent data is available for deployment in a production 
environment.

See Also: "Creating a Trading Partner Agreement" on page 10-6
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1. Click Deployment.

2. Click Create.

3. For Configuration Name, enter Tutorial 3 Configuration.

4. Select Tutorial 3 Agreement.

5. Click Apply.

6. For Tutorial 3 Configuration, click Deploy.

7. Review the list of configurations and click Deploy.

You should see Deployment finished successfully for configuration Tutorial 3 
Configuration.

Task 5: Verifying the Purchase Order Transaction
See "Both Servers, Task 5: Verifying the Purchase Order Transaction" on page 5-59 for 
more information.

GlobalChips Server, Task 1: Creating the Business Actions 
Acme and GlobalChips use the same set of business actions. So, on the GlobalChips 
server, create the same business actions that were created on the Acme server. You can 
use the same instructions, "Acme Server, Task 1: Creating the Business Actions" on 
page 5-41 for:

■ Creating the Process_850 Business Action—Acme Sends a Purchase Order

■ Creating the Process_997 Business Action—Acknowledgments

■ Creating the Process_855 Business Action—GlobalChips Sends a Purchase Order 
Confirmation

GlobalChips Server, Task 2: Setting Up the Trading Partners
On the GlobalChips server, GlobalChips is the host trading partner and Acme is the 
remote trading partner. 

This section contains these topics:

■ Setting Up the Remote Trading Partner (Acme)

■ Setting Up the Host Trading Partner (GlobalChips)

If you have not already done so, change the default host trading partner name from 
MyCompany to:

■ Acme, if you are working on the Acme server

■ GlobalChips, if you are working on the GlobalChips server

See "Changing the Host Trading Partner Name" on page 5-5 for instructions.

See Also: Chapter 11, "Creating and Deploying a Configuration"

See Also:

■ "Creating and Assigning All Capabilities During a Single Wizard 
Session" on page 7-9

■ "Creating Business Protocol Communication Capabilities for the 
Host and Remote Trading Partners" on page 7-26
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Setting Up the Remote Trading Partner (Acme)
As you set up Acme, you associate it with the following business actions:

■ Process_850-Initiator. Acme initiates the Process_850 business action (see Step 5 on 
page 5-53, Is Initiator = True) when it sends the purchase order to GlobalChips.

■ Process_997-Responder. Acme responds to the Process_997 business action (see 
Step 14 on page 5-55, Is Initiator=False), when it receives a functional 
acknowledgment from GlobalChips.

■ Process_855-Responder. Acme responds to the Process_855 business action (see 
Step 16 on page 5-55, Is Initiator=False), when it receives the purchase order 
confirmation from GlobalChips.

■ Process_997-Initiator. Acme initiates the Process_997 business action (see Step 18 
on page 5-55, Is Initiator=True) when it sends an acknowledgment to GlobalChips.

1. Click Partners.

2. From Shortcuts, click Create Trading Partner.

The following workflow for creating a trading partner is shown at the top of the 
page.

3. On the Create Trading Partner: General page, provide the remote trading partner 
name, Acme, and click Next.

4. On the Create Trading Partner: Identification page, enter Acme for the AS2 
Identifier value and click Next. 

5. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Next.

6. Continuing on the Create Trading Partner: Operational Capability page, provide 
the following override values and click Next.

General Field Value

Business Protocol EDI X12 over Internet

Business Action Process_850

Is Initiator True

Functional acknowledgment required? Yes

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type 850

Use Existing Document Protocol Parameter 
Values

Uncheck the box.

Use Default Document Definition Check the box.

General Identification Operational
Capability

Delivery
Channel

Document
Exchange

Transport Review
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7. On the Create Trading Partner: Delivery Channel page, provide the following 
information and click Next.

8. On the Create Trading Partner: Document Exchange page, provide the following 
information and click Next.

9. On the Create Trading Partner: Transport page, provide the following 
information.

a. Click Create New, provide the following information, and click Next.

10. Review the data and click Finish, or click Back.

Document Protocol Parameters Field Override Value

Interchange Sender ID Acme

Interchange Receiver ID Acme

Application Sender’s Code Acme

Application Receiver’s Code Acme

Field Value

Name Acme X12 DC

Acknowledgment Mode Async

Field Value

Name Acme X12 DocEx

Exchange Protocol Revision AS2 - 1.1

General Field Value

Name Acme X12 Transport

Transport Protocol Field Value

Transport Protocol HTTP - 1.0

Transport Server Field Value

Name Acme Transport Server

Host Name Acme_hostname

The transport server host exchanging 
messages at the Acme site.

Port 80 in a Windows environment; 7779 in a 
Solaris environment

Endpoint Field Value

URI b2b/transportServlet
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You should see Trading Partner Acme successfully created at the top of the page, 
for Process_850-Initiator. 

11. Click Capabilities.

12. Click EDI EX12 over Internet.

13. Click Create Operational Capability.

14. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Apply.

You should see Supported business action successfully created at the top of the 
page, for Process_997-Responder.

15. Repeat Steps 11 through 13.

16. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Apply.

You should see Supported business action created successfully at the top of the 
page, for Process_855-Responder.

17. Repeat Steps 11 through 13.

18. On the Create Trading Partner: Operational Capability page, provide the 
following information and click Apply.

General Field Value

Business Action Process_997

Is Initiator False

Functional acknowledgment required? No

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type 997

General Field Value

Business Action Process_855

Is Initiator False

Functional acknowledgment required? Yes

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type 855

General Field Value

Business Action Process_997
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You should see Supported business action created successfully at the top of the 
page, for Process_997-Initiator.

Setting Up the Host Trading Partner (GlobalChips)
In the following steps, you set up the host trading partner’s AS2 identifier and 
communication capabilities. To simplify your user experience, the host is 
automatically assigned a business protocol and operational capabilities that are 
compatible with the remote trading partner.

1. Click Partners > Trading Partners.

2. Click GlobalChips (Host).

3. Click General.

4. Under Trading Partner Identifications, click Create.

5. For Trading Partner Identification Type, select AS2 Identifier.

6. For Value, enter GlobalChips.

7. Click Apply.

8. Click Capabilities.

9. Click EDI X12 over Internet.

10. Click Create Communication Capability.

The following workflow for creating the communication capabilities is shown at 
the top of the page.

11. On the Create Trading Partner: Delivery Channel page, provide the following 
information and click Next.

12. On the Create Trading Partner: Document Exchange page, click Create New. 
Provide the following information and click Next.

Is Initiator True

Functional acknowledgment required? No

Is acknowledgment handled by Integration 
B2B?

Yes

Document Information Field Value

Document Type 997

Field Value

Name GlobalChips X12 DC

Acknowledgment Mode Async

General Field Value

Delivery
Channel

Document
Exchange

Transport Review
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13. On the Create Trading Partner: Transport page, provide the following information 
and click Next.

a. Select Create New and provide the following information:

b. Select Create New and provide the following information:

c. Select Use Existing and provide the following information:

14. Review the data and click Finish, or click Back. 

You should see Communication Capability created successfully at the top of the 
page.

GlobalChips Server, Task 3: Creating the Trading Partner Agreement
As the host trading partner, GlobalChips is automatically included in the trading 
partner agreement. So, in the following steps, select Acme as the trading partner in the 
agreement. To simplify your user experience, GlobalChips is also automatically 
assigned support for a business action that is compatible with the one assigned to 
Acme.

1. Click Partners. 

Field Value

Name GlobalChips X12 DocEx

Exchange Protocol Revision AS2 - 1.1

General Field Value

Name GlobalChips X12 Transport

Transport Protocol Field Value

Transport Protocol HTTP - 1.0

Transport Server Field Value

Name GlobalChips Transport Server

Host Name GlobalChips_hostname

The transport server host exchanging 
messages at the GlobalChips site.

Port 80 in a Windows environment; 7779 in a 
Solaris environment

Endpoint Field Value

Endpoint b2b/transportServlet

Note: You cannot create a trading partner agreement between more 
than two trading partners.
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2. From Shortcuts, click Create Trading Partner Agreement.

3. From Trading Partner, select Acme.

4. From Supported Business Protocol, select EDI X12 over Internet.

5. From Supported Business Action, select Process_850-Initiator.

6. For Trading Partner Identification, select AS2 Identifier - Acme and AS2 
Identifier - GlobalChips.

7. For Trading Partner Delivery Channel, select Acme X12 DC and GlobalChips 
X12 DC.

8. For Internal Delivery Channel, select B2B Inbound.

9. For Responding Internal Delivery Channel, select B2B Outbound.

10. In the Name field, enter Tutorial 3 Agreement.

11. In the Agreement ID field, enter 1300.

12. Click Apply.

You should see Agreement Tutorial 3 Agreement successfully created at the top 
of the page.

13. For Trading Partner Participant, click Add.

14. From Supported Business Protocol, select EDI X12 over Internet.

15. From Supported Business Action, select Process_997-Responder.

16. Repeat Steps 6 and 7.

17. For Internal Delivery Channel, select B2B Outbound.

18. For Responding Internal Delivery Channel, select B2B Inbound.

19. Click Apply.

You should see Trading partner participant successfully added at the top of the 
page.

20. For Trading Partner Participant, click Add.

21. From Supported Business Protocol, select EDI X12 over Internet.

22. From Supported Business Action, select Process_855-Responder.

23. Repeat Steps 6 and 7.

24. For Internal Delivery Channel, select B2B Outbound.

25. For Responding Internal Delivery Channel, select B2B Inbound.

26. Click Apply.

You should see Trading partner participant successfully added at the top of the 
page.

27. For Trading Partner Participant, click Add.

28. From Supported Business Protocol, select EDI X12 over Internet.

29. From Supported Business Action, select Process_997-Initiator.

30. Repeat Steps 6 through 9.

31. Click Apply.
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You should see Trading partner participant successfully added at the top of the 
page.

32. Click Validate.

You should see Agreement Tutorial 3 Agreement is valid. The agreement is 
approved as part of the validation.

GlobalChips Server, Task 4: Creating and Deploying the Configuration
This task is the same on both servers. See "Acme Server, Task 4: Creating and 
Deploying the Configuration" on page 5-51 for instructions.

Both Servers, Task 5: Verifying the Purchase Order Transaction
Use the runtime files in ORACLE_HOME/ip/tutorial/X12/runtime (see Table 5–1 
on page 5-6) to verify the transmission and receipt of the purchase order and purchase 
order confirmation. On UNIX platforms, you must grant execute permission using 
chmod +x to run the scripts.

1. On both the Acme and GlobalChips servers, run one of the following files: 

■ In a Bourne or Korn shell—deq.sh

■ In a C shell—deq.csh

■ In Windows—deq.bat

This dequeues the purchase order on the GlobalChips server and the purchase 
order confirmation on the Acme server.

The dequeue script generates a trace file, t1.trc, which shows the message that 
the application receives from OracleAS Integration B2B.

2. On the Acme server, run one of the following files:

■ In a Bourne or Korn shell— enq_850.sh

■ In a C shell— enq_850.csh

■ In Windows— enq_850.bat

This enqueues the Acme purchase order and translates it to X12 850 data to send 
to GlobalChips. Wait a minute or two before proceeding to the next step.

On the GlobalChips server, the purchase order is dequeued, which you can see in 
the trace file, t1.trc. The trace file name can be configured in 
ipdequeue.properties.

3. On the GlobalChips server, run one of the following files: 

■ In a Bourne or Korn shell—enq_855.sh

■ In a C shell—enq_855.csh

■ In Windows—enq_855.bat

See Also: "Creating a Trading Partner Agreement" on page 10-6

Note: You must run the setenv script to set up the CLASSPATH 
environment before running the following enqueue and dequeue 
scripts. See "Setting Up the CLASSPATH Environment" on page 5-4 if 
you have not already done so.
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This enqueues the purchase order confirmation from GlobalChips to Acme. Wait a 
minute before proceeding to the next step.

4. On the Acme server, the purchase order confirmation is dequeued, which you can 
see in the trace file, t1.trc.

The trace file name can be configured in ipdequeue.properties.

Doing More Than One Tutorial
If you do more than one tutorial, note the following:

■ You should restart the B2B server so that OracleAS Integration B2B can check for 
new objects in the metadata repository. See "Starting and Stopping the B2B Server 
with OPMN" on page 5-60 for more information.

■ After completing a tutorial, you may want to see how another B2B scenario works 
without completing all the setup. You can skip some setup steps by importing 
XML files with configuration data. See "Importing Configuration Data" on 
page 5-60 for more information.

Starting and Stopping the B2B Server with OPMN
At the operating system command prompt, use Oracle Process Manager and 
Notification Server (OPMN) to restart the B2B server as follows. You must be in the 
ORACLE_HOME/opmn/bin directory to run the commands.

prompt> opmnctl stopproc process-type=B2BServer
prompt> opmnctl startproc process-type=B2BServer

Importing Configuration Data
If you have completed one or more of the tutorials and want to take a shortcut when 
doing another tutorial, you can import XML files with configuration data. You can 
skip most of the steps in tasks 1, 2, and 3; however, you must update the endpoint, 
host name, and port for whichever trading partner you are setting up, as described in 
the following steps. Assuming you are logged in to OracleAS Integration B2B, do the 
following: 

1. Purge the metadata repository if you have already completed a tutorial. See 
"Starting and Stopping the B2B Server with OPMN" on page 5-60 for instructions.

2. Decide which trading partner you are setting up—Acme or GlobalChips. You need 
this information for Step 4.

3. Click Administration > Management.

4. Click Browse and find one of the following export files in ORACLE_
HOME/ip/tutorial/protocolname/config/.

For tutorial 1:

■ RN_buyer_export.xml—if you are setting up the Acme server

■ RN_seller_export.xml—if you are setting up the GlobalChips server

For tutorial 2:

■ EDIFACT_buyer_export.xml—if you are setting up the Acme server

See Also: Oracle Process Manager and Notification Server 
Administrator’s Guide
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■ EDIFACT_seller_export.xml—if you are setting up the GlobalChips 
server

For tutorial 3:

■ X12_buyer_export.xml—if you are setting up the Acme server

■ X12_seller_export.xml—if you are setting up the GlobalChips server

5. Click Import.

6. Click Trading Partners.

7. Click the name of the trading partner you are setting up.

8. Click Capabilities.

9. Click the business protocol associated with the tutorial you are doing, as follows:

■ RosettaNet over Internet for tutorial 1

■ EDI EDIFECT over Generic Exchange for tutorial 2

■ EDI X12 over Internet for tutorial 3

10. For any of the updatable Endpoints, click Update.

11. For URI, enter one of the following and click Apply.

■ b2b/transportServlet for tutorials 1 and 3, when setting up either Acme 
or GlobalChips

■ Acme_endpoint for tutorial 2, when setting up Acme

■ GlobalChips_endpoint for tutorial 2, when setting up GlobalChips

12. Repeat Steps 8 and 9 on page 5-61.

13. For Transports, find the name you want to update and click Update.

14. For Endpoint, select the name you entered in Step 11 and click Update.

15. Repeat Steps 8 and 9 on page 5-61.

You should see the name you entered in Step 11 in the URI column for Transports.

16. For Transport Servers, find the name you want to update and click Update.

17. For Host Name, enter one of the following: 

■ Acme_hostname if you are setting up Acme

This is the name of the transport server host exchanging messages at the Acme 
site.

■ GlobalChips_hostname if you are setting up GlobalChips

This is the name of the transport server host exchanging messages at the 
GlobalChips site.

18. For Port, enter one of the following and click Update.

■ 80 for Windows

■ 7779 for Solaris

19. Repeat Steps 8 and 9 on page 5-61.

You should see the name you entered in Step 17 in the Host Name column for 
Transport Servers. Verify that the Transport Protocol, Transport Server, and 
Endpoint values are correct.



Chapter Summary

5-62 Oracle Application Server Integration B2B User’s Guide

20. Click Partners > Agreements.

21. Click one of the following, depending on which tutorial you are doing:

■ Tutorial 1 Agreement

■ Tutorial 2 Agreement

■ Tutorial 3 Agreement

22. Click Validate.

23. Start at task 4, "Creating and Deploying the Configuration," for whichever tutorial 
you imported an XML file for in steps 4 and 5:

■ For tutorial 1, see "Acme Server, Task 4: Creating and Deploying the 
Configuration" on page 5-13 for instructions for either server.

■ For tutorial 2, see "Acme Server, Task 4: Creating and Deploying the 
Configuration" on page 5-31 for instructions for either server.

■ For tutorial 3, see "Acme Server, Task 4: Creating and Deploying the 
Configuration" on page 5-51 for instructions for either server.

Chapter Summary
This chapter provides tutorials for creating RosettaNet, EDI EDIFACT, and EDI X12 
configurations. Each tutorial guides you through the steps to design, deploy, and 
verify a configuration.

See Also: For more information about steps 11 through 18 on 
page 5-61, see the following:

■ For tutorial 1, "Setting Up the Remote Trading Partner 
(GlobalChips)" on page 5-10 and "Setting Up the Host Trading 
Partner (Acme)" on page 5-11 if you are setting up Acme

■ For tutorial 1, "Setting Up the Remote Trading Partner (Acme)" on 
page 5-15 and "Setting Up the Host Trading Partner 
(GlobalChips)" on page 5-16 if you are setting up GlobalChips

■ For tutorial 2, "Setting Up the Remote Trading Partner 
(GlobalChips)" on page 5-25 and "Setting Up the Host Trading 
Partner (Acme)" on page 5-29 if you are setting up Acme

■ For tutorial 2, "Setting Up the Remote Trading Partner (Acme)" on 
page 5-33 and "Setting Up the Host Trading Partner 
(GlobalChips)" on page 5-36 if you are setting up GlobalChips

■ For tutorial 3, "Setting Up the Remote Trading Partner 
(GlobalChips)" on page 5-45 and "Setting Up the Host Trading 
Partner (Acme)" on page 5-49 if you are setting up Acme

■ For tutorial 3,"Setting Up the Remote Trading Partner (Acme)" on 
page 5-53 and "Setting Up the Host Trading Partner 
(GlobalChips)" on page 5-56 if you are setting up GlobalChips



Part III
Design-Time and Deployment Tasks

This part describes how to design and deploy a configuration consisting of a trading 
partner agreement between trading partners with the Oracle Application Server 
Integration B2B user interface tool.

This part contains the following chapters:

■ Chapter 6, "Managing Business Protocols"

■ Chapter 7, "Creating Trading Partners"

■ Chapter 8, "Managing Trading Partners"

■ Chapter 9, "Managing Callouts"

■ Chapter 10, "Creating and Managing Trading Partner Agreements"

■ Chapter 11, "Creating and Deploying a Configuration"
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6
Managing Business Protocols

This chapter describes the tasks required to manage business protocols. You assign 
support for business protocols to the remote trading partner. The host trading partner 
is automatically assigned support for all business protocols in Oracle Application 
Server Integration B2B.

■ Business Protocol Management Overview

■ Viewing Business Protocols

■ Managing Document Protocols

■ Viewing Exchange Protocols

■ Managing Process Protocols

■ Common User Errors

■ Chapter Summary
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Business Protocol Management Overview
Each trading partner must have support for a business protocol. The business 
protocol identifies the implementation guidelines to use for the reliable transport of 
messages between trading partners. You use the OracleAS Integration B2B user 
interface tool to create operational capabilities and communication capabilities for 
the selected business protocol of the trading partner. Trading partners define their 
operational capabilities by the support for a business action (for any EDI or Custom 
Document business protocol) or collaboration (for the RosettaNet over RNIF business 
protocol). 

The business protocol is comprised of three protocols: document, exchange, and 
process (of which business actions and collaborations are a part). Figure 6–1 shows the 
business protocol format. Figure 6–2 shows a specific example of the type of process, 
document, and exchange protocol details that can display for a business protocol (in 
this example, RosettaNet over RNIF). This format is reflected in the layout of the 
OracleAS Integration B2B user interface tool (and shown throughout this chapter). 

Figure 6–1 Business Protocol Format

Figure 6–2 Business Protocol Format: RosettaNet Example

Note: Figure 6–2 shows a .dtd file as the document definition file 
with RosettaNet over RNIF. You can also specify .xsd files as the 
document definition file. OracleAS Integration B2B enables you to 
either import standard .dtd files downloaded from the RosettaNet 
Web site or import .xsd or .dtd files created with the OracleAS 
Integration B2B - Document Editor. At runtime, the payload must 
conform to the document definition file type you use. 

Business Protocol

Process Protocol
Collaboration (for RosettaNet over RNIF)
Business Action (for EDI or Custom Document)

Document Protocol
Document Protocol Revision

Document Type
Document Definition

Exchange Protocol
Transport Protocol
Packaging Protocol

Business Protocol: RosettaNet over RNIF

Process Protocol: B2B
Collaboration: Buyer - 3A4 - V02.00

Document Protocol: RosettaNet
Document Protocol Revision: V02.00

Document Type: RequestPurchaseOrder
Document Definition: PurchaseOrder.dtd

Exchange Protocol: RNIF V02.00
Transport Protocol: HTTP
Packaging Protocol: MIME
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Collaborations and Business Actions Overview
Figure 6–1 and Figure 6–2 show that collaborations and business actions appear as 
part of the process protocol for a business protocol. Collaborations and business 
actions describe the business documents and their movement between trading 
partners. Trading partners define their operational capabilities by the collaborations 
and business actions they support. When you create a remote trading partner with the 
Create Trading Partner wizard, you assign it either support for a collaboration (for the 
RosettaNet over RNIF business protocol) or business action (for any EDI or Custom 
Document business protocol). To simplify your user experience, the host trading 
partner is automatically assigned support for a business action or collaboration that is 
compatible with the selection for the remote trading partner.

Collaborations and business actions can be bidirectional. When you create support for 
a collaboration or business action of a trading partner, you also specify whether the 
trading partner initiates or responds to the collaboration. 

The OracleAS Integration B2B user interface tool provides two methods for creating 
support for collaborations and business actions. Table 6–1 describes these methods:

See Also: "Supported Protocols" on page 1-3

Table 6–1 Methods for Creating Support for Collaborations and Business Actions

Method Description

Import through a file The following frequently used collaborations, transaction sets, and 
standards are automatically installed with OracleAS Integration B2B. 
You can import them into the design-time repository. This enables 
you to see and use them in the OracleAS Integration B2B user 
interface tool.

■ Approximately 25 RosettaNet collaborations

■ EDI X12, document protocol revision 4010 with transaction sets 
850 purchase order, 855 purchase order acknowledgment, and 
997 functional acknowledgment

■ EDI EDIFACT, document protocol revision D98A with 
transaction sets ORDERS purchase order message and ORDRSP 
purchase order response message, and document protocol 
revision D3 with transaction set CONTRL syntax and service 
report message

■ UCCnet, document protocol revision 2.3.1 (available under 
Custom Document support)

An EDI transaction set maps to a document type of a business action 
in the OracleAS Integration B2B user interface tool.

After importing these files by clicking Administration > 
Management > Import, the business actions and collaborations 
display in the Process Protocol Revision Details page. (See Figure 6–7 
on page 6-16 and Figure 6–8 on page 6-16, respectively.) You can then 
assign support for collaborations and business actions to a remote 
trading partner with the Create Trading Partner wizard.

Create through 
wizards

You can create your own support for collaborations and business 
actions with the Create Collaboration wizard and Create Business 
Action wizard, respectively. Use of both wizards is described in this 
chapter.

For example, if you want to use a RosettaNet collaboration that is not 
included in the import file described previously, you can use the 
Create Collaboration wizard. 

Once complete, you can assign support for collaborations and 
business actions to a remote trading partner.
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OracleAS Integration B2B - Document Editor Overview
When you use the Create Business Action and Create Collaboration wizards, you are 
prompted to import document definition files. You can use the OracleAS Integration 
B2B - Document Editor to create these files for EDI X12, EDI EDIFACT, and 
RosettaNet. The OracleAS Integration B2B - Document Editor is an integrated 
guideline creation and implementation application for creating business-to-business 
(B2B) electronic commerce.

You can use the OracleAS Integration B2B - Document Editor library of templates to 
create EDI X12 and EDI EDIFACT .ecs files and RosettaNet .xsd and .dtd files that 
you then import into the OracleAS Integration B2B user interface tool with the Create 
Business Action wizard and Create Collaboration wizard. This enables you to create 
configurations with OracleAS Integration B2B trading partners that use EDI X12, EDI 
EDIFACT, and RosettaNet.

The OracleAS Integration B2B - Document Editor is available for installation from the 
root of the OracleAS Integration B2B CD-ROM.

Viewing Business Protocols
The OracleAS Integration B2B user interface tool enables you to view the business 
protocols. The remote trading partner must add support for a business protocol before 
doing anything else.

1. Click Partners > Protocols. 

The Business Protocols page displays the business protocols available with 
OracleAS Integration B2B. The Description column describes the contents of the 
business protocol.

See Also:

■ Chapter 2, "Supported Protocols" for a list of supported 
RosettaNet collaborations (Table 2–2 on page 2-4), EDI X12 
transaction sets (Table 2–3 on page 2-5), EDI EDIFACT transaction 
sets (Table 2–4 on page 2-6), and UCCnet standards (Table 2–5 on 
page 2-6)

■ Chapter 7, "Creating Trading Partners" for instructions on 
assigning support for a business action or collaboration to a 
remote trading partner

■ "Importing Support for Collaborations, Transaction Sets, and 
UCCnet Standards" on page 12-9 for instructions on importing 
collaborations, transaction sets, and UCCnet standards

See Also:

■ Oracle Application Server Integration B2B Installation Guide for 
instructions on installing the OracleAS Integration B2B - 
Document Editor

■ The online Help included with the OracleAS Integration B2B - 
Document Editor for instructions on using the library templates to 
create .ecs, .xsd, and .dtd files
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2. Click a specific business protocol to access the Business Protocol Details page. This 
page shows details about the document, exchange, and process protocols of the 
business protocol. The management tasks you can perform are described in detail 
in the remaining sections of this chapter.

Managing Document Protocols
The OracleAS Integration B2B user interface tool enables you to perform the document 
protocol management tasks shown in Figure 6–4 through Figure 6–6. These tasks are 
described in detail in this section. The document protocol defines the document type 
of the message payload. 

Business protocols can have multiple document protocols. Document protocols follow 
the hierarchy shown in Figure 6–3. A document protocol can consist of multiple 
document protocol revisions. A document protocol revision can consist of multiple 
document types. A document type can consist of multiple document definitions, 
because you can start with one document definition and customize it for different 
trading partners. In this example, the document definition file is a .xsd file.

Figure 6–3 Document Protocol Hierarchy

See Also:

■ "Business Protocols" on page 2-11 for details about business 
protocols

■ Chapter 7, "Creating Trading Partners" for instructions on adding 
support for a business protocol to a remote trading partner

Document Type
(850)

Document Protocol Revision
(EDI X12 4010)

Document Protocol
(EDI X12)

Document Definition
(.xsd file and associated information)
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Figure 6–4 Document Protocol Management Tasks (Part 1 of 3)

Clicking Details in the Document Protocol Revisions section of Figure 6–4 causes the 
Document Protocol Revision Details page shown in Figure 6–5 to appear.

Figure 6–5 Document Protocol Management Tasks (Part 2 of 3)

Clicking a specific document type (850 for this example) in the Name column of the 
Document Types section of Figure 6–5 causes the Document Type Details page shown 
in Figure 6–6 to appear. A document type consists of multiple document definitions, 
because you can start with one document definition and customize it for different 
trading partners.
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Figure 6–6 Document Protocol Management Tasks (Part 3 of 3)

Table 6–2 identifies the document protocol management tasks shown in Figure 6–4 
through Figure 6–6 and provides references to procedures for performing these tasks.

Table 6–2 Document Protocol Management Tasks

Page Elements Management Task See Section...

Create button in Document 
Protocol Revisions section of 
Figure 6–4

Create a document protocol 
revision

"Creating a Document 
Protocol Revision" on 
page 6-8

Details column in Document 
Protocol Revisions section of 
Figure 6–4

View details about a 
document protocol revision

"Viewing a Document 
Protocol Revision" on 
page 6-8

Update column in Document 
Protocol Revisions section of 
Figure 6–4

Update a document protocol 
revision

"Updating a Document 
Protocol Revision" on 
page 6-9

Delete column in Document 
Protocol Revisions section of 
Figure 6–4

Delete a document protocol 
revision

"Deleting a Document 
Protocol Revision" on 
page 6-10

Create button in Document Types 
section of Figure 6–5

Create a document type "Creating a Document 
Type" on page 6-10

Name column in Document 
Types section of Figure 6–5

View details about a 
document type

"Viewing a Document 
Type" on page 6-11

Update column in Document 
Types section of Figure 6–5

Update a document type "Updating a Document 
Type" on page 6-12

Delete column in Document 
Types section of Figure 6–5

Delete a document type "Deleting a Document 
Type" on page 6-12

Name column in Document 
Definitions section of Figure 6–6

View details about a 
document definition

"Viewing a Document 
Definition of a Document 
Type" on page 6-13

Update column in Document 
Definitions section of Figure 6–6

Update a document 
definition

"Updating a Document 
Definition of a Document 
Type" on page 6-13

Note: RosettaNet document protocol support is provided for only 
version 2.0. Regardless of the collaboration (PIP) version you create or 
import, the supported document protocol revision version is 2.0. 

See Also: "Document Protocols" on page 2-2
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Creating a Document Protocol Revision
The Create Business Action and Create Collaboration wizards enable you to create a 
document protocol revision as part of a single wizard session. You can also 
individually create a document protocol revision without using the wizards. Follow 
these instructions to individually create a document protocol revision. Once created, 
you can use the wizards to select this document protocol revision to be part of support 
for a business action or collaboration.

1. Click Partners > Protocols. 

2. Select a specific business protocol in the Name column of the Business Protocols 
section.

The Business Protocol Details page appears.

3. Click Create in the Document Protocol Revisions section.

The Create Document Protocol Revision page appears.

4. Enter the following details. An asterisk (*) indicates a required field.

5. Click Apply.

The document protocol revision is created and the new Document Protocol 
Revision Details page appears.

Viewing a Document Protocol Revision
Follow these instructions to view details about a specific document protocol revision:

1. Click Partners > Protocols.

2. Select a specific business protocol in the Name column of the Business Protocols 
section.

The Business Protocol Details page appears.

3. Select a specific document protocol revision to view in the Details column of the 
Document Protocol Revisions section.

Field Value

Name * Enter a unique and recognizable name for the document protocol 
revision.

Description Enter a description of the document protocol revision.

Revision * Enter a revision number for the document protocol revision.

Translation Enabled Select No or Yes.

Validation Enabled Select No or Yes. 

If you enable validation outside of the OracleAS Integration B2B user 
interface tool (for example, in EDI X12 or EDI EDIFACT), 
performance is impacted. 

Document Protocol 
Parameters

Note: This field only 
displays for EDI or 
Custom Document 
business protocols.

Enter specific values in the Override Value fields. You can also 
import interchange or group .ecs files that can optionally be 
created with the OracleAS Integration B2B - Document Editor. 
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The Document Protocol Revision Details page for the selected document protocol 
revision appears.

4. View specific details about the document protocol revision:

■ The business protocol and document protocol for this document protocol 
revision

■ The document protocol revision description, revision number, and status of 
translation and validation (in the Details section)

■ The document types and revisions of this document protocol revision

■ The document protocol parameters and their default and override values for 
this document protocol revision

See Figure 6–5 on page 6-6 for an example of the Document Protocol Revision 
Details page.

This page, as with the Business Protocol Details page shown in Figure 6–4 on 
page 6-6, enables you to delete or update the document protocol revision (except 
for RosettaNet).

Updating a Document Protocol Revision
You can update all document protocol revisions with the exception of RosettaNet. 
Follow these instructions to update a document protocol revision:

1. Click Partners > Protocols. 

2. Select a specific business protocol in the Name column of the Business Protocols 
section.

The Business Protocol Details page appears.

3. Select a specific document protocol revision to update in the Update column of the 
Document Protocol Revisions section.

The Update Document Protocol Revision page appears.

4. Make appropriate updates. An asterisk (*) indicates a required field.

5. Click Apply.

The document protocol revision is updated and the Document Protocol Revision 
Details page appears.

Field Value

Name * Update with a unique and recognizable name for the document 
protocol revision.

Description Update the description of the document protocol revision.

Revision * Update the revision number for the document protocol revision.

Translation Enabled Select No or Yes.

Validation Enabled Select No or Yes. 

If you enable validation outside of the OracleAS Integration B2B user 
interface tool (for example, in EDI X12 or EDI EDIFACT), 
performance is impacted. 

Document Protocol 
Parameters

Make appropriate updates to specific values in the Override Value 
fields. You can import .ecs files.
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Deleting a Document Protocol Revision
You can delete all document protocol revisions with the exception of RosettaNet. 
Follow these instructions to delete a document protocol revision:

1. Click Partners > Protocols. 

2. Select a specific business protocol in the Name column of the Business Protocols 
section.

The Business Protocol Details page appears.

3. Select a specific document protocol revision to delete in the Delete column of the 
Document Protocol Revisions section.

4. Click Yes when prompted to delete a document protocol revision.

The document protocol revision is deleted and the Business Protocol Details page 
appears.

Creating a Document Type
The Create Business Action and Create Collaboration wizards enable you to create a 
document type as part of a single wizard session. You can also individually create a 
document type without using the wizards. Follow these instructions to individually 
create a document type. Once created, you can use the wizards to select the document 
type of a specific document protocol revision. This provides support for a business 
action or collaboration. 

1. Click Partners > Protocols. 

2. Select a specific business protocol in the Name column of the Business Protocols 
section.

The Business Protocol Details page appears.

3. Select a specific revision in the Details column of the Document Protocol 
Revisions section.

4. Click Create in the Document Types section.

The Create Document Type page appears.

5. Enter the following details. An asterisk (*) indicates a required field.

Field Value

Details

■ Name * Enter a unique and recognizable name for the document type.

■ Description Enter a description of the document type.

■ Revision * Enter a revision number for the document type.

Document Definition

■ Name * Enter a unique and recognizable name for the document 
definition.

■ Description Enter a description of the document definition.

■ Translation Enabled Select No or Yes.

■ Validation Enabled Select No or Yes.

Note: If you are using globalization support with OracleAS 
Integration B2B, do not select Yes. 
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6. Click Apply.

The document type is created and the new Document Type Details page appears.

You can now select this document type in the Create Business Action wizard. To 
do this, you must perform the following steps:

a. Select the specific document protocol revision of which this document type is 
a part on the Create Business Action : Document Protocol Revision page (page 
two of four).

b. Select Use Existing from the Create Mode list on the Create Business Action : 
Document Type page (page three of four). The page refreshes to display a 
Document Type list from which you can select this document type. While the 
document protocol revision can include multiple document types, only a 
single type can be selected. The EDI and Custom Document business protocols 
enable you to select only a single document type for a document protocol 
revision.

You can now include this document type in a collaboration in the Create 
Collaboration wizard. To do this, you must perform the following steps:

a. Select the specific document protocol revision of which this document type is 
a part on the Create Collaboration : General page (page one of five). This 
document protocol revision can include multiple document types. RosettaNet 
enables you to have multiple document types included with a single 
document protocol revision.

Viewing a Document Type
1. Click Partners > Protocols.

2. Select a specific business protocol in the Name column of the Business Protocols 
section.

The Business Protocol Details page appears.

3. Select a specific document protocol revision in the Details column of the 
Document Protocol Revisions section.

The Document Protocol Revision Details page for the selected document protocol 
revision appears.

4. Select a specific document type to view in the Name column of the Document 
Types section.

■ Definition Click Browse to select a document definition file.

■ Document Type 
Parameters

Note: This section only 
appears for an EDI or 
Custom Document 
business protocol.

Enter values in the Override Value fields or click Browse to select 
a .ecs transaction set file that can optionally be created with the 
OracleAS Integration B2B - Document Editor. 

See Also:

■ "Creating a Business Action" on page 6-17

■ "Creating a Collaboration" on page 6-23

Field Value
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The Document Type Details page for the selected document type appears.

5. View specific details about the document type:

■ The business protocol and its associated document protocol and document 
protocol revision for this document type

■ The document definitions and values of this document type. You can also 
manage the document definitions for this document type.

See Figure 6–6 on page 6-7 for an example of the Document Type Details page.

This page, as with the Document Protocol Revision Details page shown in 
Figure 6–5 on page 6-6, enables you to delete or update the document type.

Updating a Document Type
Follow these instructions to update a document type:

1. Click Partners > Protocols. 

2. Select a specific business protocol in the Name column of the Business Protocols 
section.

The Business Protocol Details page appears.

3. Select a specific document protocol revision in the Details column of the 
Document Protocol Revisions section.

The Document Protocol Revision Details page appears.

4. Select a specific document type to update in the Update column of the Document 
Types section.

The Update Document Type page appears.

5. Make appropriate updates. An asterisk (*) indicates a required field.

6. Click Apply.

The document type is updated and the Document Type Details page appears.

Deleting a Document Type
Follow these instructions to delete a document type:

1. Click Partners > Protocols. 

Field Value

Name * Update with a unique and recognizable name for the document type.

Description Update the description of the document type.

Revision * Update the revision number for the document type.

Note: If this document type is for the RosettaNet over RNIF business 
protocol, this number must match the document type revision 
number. If they do not match, you receive an error after deployment. 
If you imported the predefined RosettaNet collaborations, both 
revision numbers automatically match. 

See Also: "Updating a Collaboration" on page 6-32

Document Definition * Select a document definition from the list.
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2. Select a specific business protocol in the Name column of the Business Protocols 
section.

The Business Protocol Details page appears.

3. Select a specific document protocol revision in the Details column of the 
Document Protocol Revisions section.

The Document Protocol Revision Details page appears.

4. Select a specific document type to delete in the Delete column of the Document 
Types section.

5. Click Yes when prompted to delete a document type.

The document type is deleted and the Document Protocol Revision Details page 
appears.

Viewing a Document Definition of a Document Type
Follow these instructions to view details about a specific document definition:

1. Click Partners > Protocols.

2. Select a specific business protocol in the Name column of the Business Protocols 
section.

The Business Protocol Details page appears.

3. Select a specific document protocol revision in the Details column of the 
Document Protocol Revisions section.

The Document Protocol Revision Details page appears.

4. Select a specific document type in the Name column of the Document Types 
section.

The Document Type Details page appears.

5. Select a specific document definition to view in the Name column of the 
Document Definitions section.

The Document Definition Details page for the selected document definition 
appears.

6. View specific details about the document definition:

■ The business protocol and its document protocol and document protocol 
revision for the document definition

■ The document definition description and the statuses of document definition 
translation and validation (in the Details section)

■ The document parameters and values of this document definition

This page, as with the Document Type Details page shown in Figure 6–6 on 
page 6-7, enables you to update the document definition.

Updating a Document Definition of a Document Type
Follow these instructions to update a document definition:

1. Click Partners > Protocols. 

2. Select a specific business protocol in the Name column of the Business Protocols 
section.
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The Business Protocol Details page appears.

3. Select a specific revision in the Details column of the Document Protocol 
Revisions section.

The Document Protocol Revision Details page appears.

4. Select a specific document type in the Name column of the Document Types 
section.

The Document Type Details page appears.

5. Select a specific document definition to update in the Update column of the 
Document Definitions section.

The Update Document Definition page appears.

6. Make appropriate updates. An asterisk (*) indicates a required field.

7. Click Apply.

The document definition is updated and the Document Definition Details page 
appears.

Viewing Exchange Protocols
The OracleAS Integration B2B user interface tool enables you to view exchange 
protocol details. The exchange protocol defines the headers, acknowledgments, and 
packaging that puts the headers and payload together (the message exchange 
mechanism). The exchange protocol also defines exchange-level security—signing and 
encryption—and transport protocols for the exchange.

Follow these instructions to view exchange protocol revision details:

1. Click Partners > Protocols. 

2. Select a specific business protocol in the Name column of the Business Protocols 
section.

The Business Protocol Details page appears.

3. Select a specific exchange protocol revision to view in the Details column of the 
Exchange Protocol Revisions section. (See Figure 6–4 on page 6-6.)

Field Value

Name * Update with a unique and recognizable name for the document 
definition.

Description Update the description of the document definition.

Translation Enabled Select No or Yes.

Validation Enabled Select No or Yes. 

Note: If you are using globalization support with OracleAS 
Integration B2B, do not select Yes. 

Definition Click Browse to select a document definition file (typically a .xsd 
file).

Parameters Make appropriate updates to specific values in the Override Value 
fields. You can also import specific files for EDI or Custom 
Document business protocols as needed.
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The Exchange Protocol Revision Details page for the selected exchange protocol 
revision appears.

4. View specific details about the following:

■ The revision, description, status or nonrepudiation of origin and receipt, 
number of retries allowed, time to acknowledge, status of request retry 
messages, implementation class, packaging protocol, and packaging 
identification

■ The Business Signals section, which shows the exception messages and the 
acknowledgment signals to exchange to confirm receipt of messages

■ The Protocol Elements section, which shows message header details such as 
preamble header, delivery header, and service header, whether these details 
can be encrypted, and their datatypes.

■ The Supported Transport Protocols section, which shows the supported 
transports for this version

■  The Supported Security Specifications section, which shows the supported 
signing and encryption features

■ The Parameters section, which shows the supported parameters for this 
version

5. Click Return to List to return to the Business Protocol Details page.

Managing Process Protocols
The OracleAS Integration B2B user interface tool enables you to perform the process 
protocol management tasks shown in Figure 6–7 and Figure 6–8. These tasks are 
described in detail in this section. OracleAS Integration B2B provides a single process 
protocol named B2B Process. This process protocol is included with all business 
protocols supported by OracleAS Integration B2B. The process protocol defines the 
business actions (for any EDI or Custom Document (such as UCCnet) business 
protocols) and the collaborations (for the RosettaNet over RNIF business protocol) that 
are associated with specific document types. 

Note: The Exchange Protocol Revision Details page can also be 
accessed by clicking Partners > Trading Partners > trading_partner_
name_in_Name_column > Capabilities > business_protocol_name_
in_Name_column > exchange_protocol_revision_name_in_Exchange_
Protocol_Revision_column (in Document Exchanges section).

Note: Support is not provided for remote trading partner-to-remote 
trading partner message routing. Messages are always exchanged 
with the host trading partner. If you must route messages from one 
remote trading partner to another remote trading partner, you must 
do so outside of the OracleAS Integration B2B user interface tool. 

See Also: "Exchange Protocols" on page 2-7
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Figure 6–7 Process Protocol Management Tasks for any EDI or Custom Document Business Protocol

Figure 6–8 Process Protocol Management Tasks for RosettaNet over RNIF Business Protocol

Table 6–3 identifies the process protocol management tasks shown in Figure 6–7 and 
Figure 6–8 and provides references to procedures for performing these tasks.

Table 6–3 Process Protocol Management Tasks

Page Elements Management Task See Section...

Create button in Business Actions 
section of Figure 6–7

Create a business action "Creating a Business 
Action" on page 6-17

Details column in Business 
Actions section of Figure 6–7

View details about a 
business action

"Viewing a Business 
Action" on page 6-22

Update column in Business 
Actions section of Figure 6–7

Update a business action "Updating a Business 
Action" on page 6-22

Delete column in Business 
Actions section of Figure 6–7

Delete a business action "Deleting a Business 
Action" on page 6-23

Create button in Collaborations 
section of Figure 6–8

Create a collaboration "Creating a Collaboration" 
on page 6-23

Details column in Collaborations 
section of Figure 6–8

View details about a 
collaboration

"Viewing a Collaboration" 
on page 6-31

Update column in Collaborations 
section of Figure 6–8

Update a collaboration "Updating a Collaboration" 
on page 6-32

Delete column in Collaborations 
section of Figure 6–8

Delete a collaboration "Deleting a Collaboration" 
on page 6-33
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Creating a Business Action
You can import some of the most frequently used EDI EDIFACT and EDI X12 
transaction sets and UCCnet standards into the OracleAS Integration B2B user 
interface tool by clicking Administration > Management > Import.

For transaction sets not included in the import file, OracleAS Integration B2B provides 
a Create Business Action wizard that enables you to create additional business actions 
for any EDI or Custom Document business protocol. Use of this wizard is described in 
this section. You can use the OracleAS Integration B2B - Document Editor to create the 
.ecs files that you are prompted to import when creating a business action with this 
wizard.

Regardless of whether you use the import or create business action method, you can 
then assign support for a business action to a remote trading partner in either of two 
ways. Trading partners define their operational capabilities by the business actions 
they support.

■ With the Create Trading Partner Wizard (on the Create Trading Partner : 
Operational Capability page when you initially create the remote trading partner)

■ Through the Create Operational Capability button of the Business Protocol 
Details page for the business protocol assigned to the remote trading partner you 
previously created

The Create Business Action wizard provides a series of pages that guide you through 
business action creation. Table 6–4 provides an overview of the wizard pages that 
appear and the types of questions for which you are prompted to provide details. 
Before using this wizard, review the information shown in Table 6–4.

Note: The revision for each business action and collaboration 
displays in the Revision column of the Business Actions and 
Collaborations sections. (See Figure 6–7 and Figure 6–8.)

See Also: "Process Protocols" on page 2-9

Table 6–4 Create Business Action Wizard Pages

Page Description

Page 1: General Page Prompts you to define the following general business action details:

■ Business action name, description, and revision number

■ Retry count and time to acknowledge values

■ If nonrepudiation of receipt and nonrepudiation of origin are 
required

■ Acknowledgment mode

Page 2: Document 
Protocol Revision

Prompts you to define the following document protocol revision 
details:

■ Document protocol revision name, description, and revision 
number

■ If document protocol revision translation and validation are to 
be performed by OracleAS Integration B2B

■ Document protocol parameter values

You can also import interchange or group .ecs files created with 
the OracleAS Integration B2B - Document Editor.
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Follow these tasks to create a business action with the Create Business Action wizard: 

■ Page 1: General Page

■ Page 2: Document Protocol Revision

■ Page 3: Document Type

■ Page 4: Review

Page 1: General Page
Follow these instructions to create and define the details of a business action:

1. Click Partners > Protocols. 

2. Click a specific EDI or Custom Document business protocol in the Name column 
of the Business Protocols section.

The Business Protocol Details page for the selected business protocol appears.

3. Start the Create Business Action wizard in either of two ways: 

a. Click Create Business Action in the Shortcut section. 

or

a. Click Details in the Process Protocol Revisions section.

b. Click Create in the Business Actions section.

The Create Business Action : General page appears and displays the selected 
business protocol and its process protocol and process protocol revision in the top 
left part of the page. These details appear on each remaining page of the wizard.

4. Enter the following details. An asterisk (*) indicates a required field.

Page 3: Document Type Prompts you to define the following document type details:

■ Document type name, description, and revision number

■ Document definition name and description

■ If document type translation and validation are to be performed 
by OracleAS Integration B2B

■ Document definition file to import

■ Document protocol parameter values

You can also import the document definition file.

Page 4: Review Prompts you to review details about the following selections you 
made on the previous pages:

■ Business action name and revision

■ Document protocol revision name and revision

■ Document type and definition

See Also: Chapter 7, "Creating Trading Partners" for instructions on 
assigning support for a business action to a remote trading partner

Field Value

Name * Enter a unique and recognizable name for the business action.

Table 6–4 (Cont.) Create Business Action Wizard Pages

Page Description
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5. Click Next.

The Create Business Action : Document Protocol Revision page appears.

Page 2: Document Protocol Revision
Follow these instructions to create a document protocol revision. An example of a 
document protocol revision is revision 4010 if you are using an EDI X12 business 
protocol or revision D98A or D3 if you are using an EDI EDIFACT business protocol.

1. If this business protocol already includes a document protocol revision, the Create 
Mode list appears. Select Use Existing or Create New. Otherwise, go to Step 3.

2. Go to the following step based on your mode selection:

3. If you selected Create New or the Create Mode list did not appear, perform Steps 
3a through 3b.

a. Enter the following details. An asterisk (*) indicates a required field.

Description Enter a description of the business action.

Revision * Enter a revision number for the business action.

Retry Count Enter a value. This value specifies the amount of time to wait 
before retrying.

Time To Acknowledge Enter a value in minutes. This value specifies the time in which an 
acknowledgment message must be received. If an 
acknowledgment is not received, an error message is returned.

Is Non-Repudiation of 
Receipt Required

Select No or Yes.

You can override this selection when you create the delivery 
channel (the communication capabilities) for the trading partner.

Is Non-Repudiation of 
Origin Required

Select No or Yes.

You can override this selection when you create the delivery 
channel (the communication capabilities) for the trading partner.

Acknowledgment Mode Select Async, None, or Sync.

See Also: Chapter 7, "Creating Trading Partners" for instructions on 
creating a delivery channel (the communication capabilities)

If You Selected... Go To...

Create New Step 3

Use Existing Step 4

Field Value

Name * Enter a unique and recognizable name for the document protocol 
revision.

Description Enter a description of the document protocol revision.

Revision * Enter a revision number for the document protocol.

Translation Enabled Select No or Yes. This enables OracleAS Integration B2B to 
perform translation.

Field Value
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b. Go to Step 5.

4. If you selected Use Existing, perform Steps 4a through 4b.

a. Select a document protocol revision from the Document Protocol Revision 
list.

b. Go to Step 5.

5. Click Next.

The Create Business Action : Document Type page appears.

Page 3: Document Type
Follow these instructions to create a document type under a document protocol 
revision that defines the business document. A document type maps to a transaction 
set in an EDI EDIFACT or X12 transaction set (for example, document type 850 or 855 
for EDI X12 document protocol revision 4010). This page also enables you to import 
definition and .ecs files that define document type parameters.

1. If the document protocol revision you selected in "Page 2: Document Protocol 
Revision" on page 6-19 already includes a document type, the Create Mode list 
appears. Select Use Existing or Create New. Otherwise, go to Step 3.

2. Go to the following step based on your mode selection:

3. If you selected Create New or the Create Mode list did not appear, perform Steps 
3a through 3b.

a. Enter the following details. An asterisk (*) indicates a required field.

Validation Enabled Select No or Yes. 

This enables OracleAS Integration B2B to perform validation. If 
you enable validation outside of the OracleAS Integration B2B 
user interface tool (for example, in EDI X12 or EDI EDIFACT), 
performance is impacted. 

Note: If you are using globalization support with OracleAS 
Integration B2B, do not select Yes. 

See Also: Oracle Application Server Integration B2B Installation Guide 
for additional globalization issues

Document Protocol 
Parameters

Enter specific values for parameters in the Override Value fields or 
import appropriate interchange or group .ecs parameter files 
that can optionally be created with the OracleAS Integration B2B - 
Document Editor. 

Note: You can override the values you specify or the files you 
import when you create a trading partner in "Page 3: Operational 
Capability Page" on page 7-11.

If You Selected... Go To...

Create New Step 3

Use Existing Step 4

Field Value

General

Field Value
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b. Go to Step 5.

4. If you selected Use Existing, perform Steps 4a through 4b.

a. Select a document type from the Document Type list.

b. Go to Step 5.

5. Click Next.

The Create Business Action : Review page appears and displays your selections 
from the previous pages.

Page 4: Review
1. Review the business action details. 

■ To modify these details, click the Back button of the Create Business Action 
wizard to return to the previous pages. When you complete modifications, 
click Next until you access the review page; then click Finish. Do not use the 
Back and Forward buttons of your Web browser.

■ If you are satisfied with these details, click Finish. 

The business action is created and the new Business Action Details page appears. 

You can now assign support for this business action to a remote trading partner as 
follows:

■ On the Operational Capability page of the Create Trading Partner wizard 
(page three of seven)

■ Name * Enter a unique and recognizable name for the document type. This 
must be a correct document type name, such as 850 or 997 for EDI 
X12 or ORDERS or ORDRSP for EDI EDIFACT.

■ Description Enter a description of the document type.

■ Revision * Select a revision number for the document type.

Document Definition

■ Name * Enter a unique and recognizable name for the document 
definition.

■ Description Enter a description of the document definition.

■ Translation Enabled Select Yes or No.

■ Validation Enabled Select Yes or No.

Note: If you are using globalization support with OracleAS 
Integration B2B, do not select Yes. 

■ Definition Click Browse to select a document definition file created with the 
OracleAS Integration B2B - Document Editor. (typically a .xsd 
file).

Document Type 
Parameters

Make appropriate updates to specific values in the Override Value 
fields or import appropriate transaction set .ecs parameter files 
created with the OracleAS Integration B2B - Document Editor. If 
the parameter is a string, you can enter a value of up to 100 
characters.

Note: You can override the values you specify or the files you 
import when you create a trading partner in "Page 3: Operational 
Capability Page" on page 7-11.

Field Value
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■ On the Operational Capability page, which is accessible from the Create 
Operational Capability button of the Business Protocol Details page for any 
EDI or Custom Document business protocol assigned to the trading partner 
(click Partners > Trading Partners > trading_partner_name_in_Name_column 
> Capabilities > business_protocol_name_in_Name_column)

2. Click Return to List to return to the Process Protocol Revision Details page.

3. Click Return to List to return to the Business Protocol Details page.

Viewing a Business Action
Follow these instructions to view a business action:

1. Click Partners > Protocols. 

2. Click a specific EDI or Custom Document business protocol in the Name column 
of the Business Protocols section.

3. Click Details in the Process Protocol Revisions section.

The Process Protocol Revision Details page appears.

4. Select the specific business action to view in the Details column of the Business 
Actions section.

The Business Action Details page for the selected business action appears.

5. View specific details, including the following:

■ The business protocol and its process protocol and process protocol revision

■ The description, revision, retry count, time to acknowledge, nonrepudiation of 
origin and receipt statuses, and acknowledgment mode (in the Details section)

■ The document type, which you can manage (remove and view) from this page

This page, as with the Process Protocol Revision Details page shown in Figure 6–7 
on page 6-16, enables you to delete or update the business action.

6. Click Return to List to return to the Process Protocol Revision Details page.

Updating a Business Action
Follow these instructions to update a business action:

1. Click Partners > Protocols. 

2. Click a specific EDI or Custom Document business protocol in the Name column 
of the Business Protocols section.

3. Click Details in the Process Protocol Revisions section.

The Process Protocol Revision Details page appears.

4. Select a specific business action to update in the Update column of the Business 
Actions section.

The Update Business Action page appears.

See Also: Chapter 7, "Creating Trading Partners" for instructions on 
assigning support for a business action to a remote trading partner
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5. Make appropriate updates. An asterisk (*) indicates a required field.

6. Click Apply.

The business action is updated and the Business Action Details page appears.

Deleting a Business Action
Follow these instructions to delete a business action:

1. Click Partners > Protocols. 

2. Click a specific EDI or Custom Document business protocol in the Name column 
of the Business Protocols section.

3. Click Details in the Process Protocol Revisions section.

The Process Protocol Revision Details page appears.

4. Select a specific business action to delete in the Delete column of the Business 
Actions section.

5. Click Yes when prompted to delete a business action.

The business action is deleted and the Process Protocol Revision Details page 
appears.

Creating a Collaboration
You can import approximately 25 of the most frequently used RosettaNet 
collaborations (for example, RosettaNet Partner Interface Process (PIP) 3A4) into the 
OracleAS Integration B2B user interface tool by clicking Administration > 
Management > Import.

For collaborations not included in the import file, OracleAS Integration B2B provides a 
Create Collaboration wizard that enables you to create additional collaborations for 
the RosettaNet over RNIF business protocol. Use of this wizard is described in this 
section.

You must first perform the following tasks before you can use the Create Collaboration 
wizard. The tasks to perform are based on the method by which you are creating the 
RosettaNet collaboration:

■ Download from the RosettaNet Web site:

Field Value

Name * Update with a unique and recognizable name for the business action.

Description Update the description of the business action.

Revision * Update the revision number for the business action.

Retry Count Update the retry count value for the business action.

Time To Acknowledge Update the time limit for performing this business action.

Is Non-Repudiation of 
Receipt Required

Select No or Yes.

Is Non-Repudiation of 
Origin Required

Select No or Yes.

Acknowledgment Mode Select Async, None, or Sync.



6-24 Oracle Application Server Integration B2B User’s Guide

1. Go to www.rosettanet.org.

2. Download a zip file of the appropriate PIP. This zip file includes the document 
definition file (.dtd file) that you import when using the Create Collaboration 
wizard. This file also includes the specification that describes the details to 
enter into the Create Collaboration wizard fields (for example, the 
collaboration name, revision, code, initiating role name, accepting role name, 
and so on).

■ Use the OracleAS Integration B2B - Document Editor:

1. Install the OracleAS Integration B2B - Document Editor, as described in the 
Oracle Application Server Integration B2B Installation Guide

2. See the online Help included with the OracleAS Integration B2B - Document 
Editor for instructions on exporting RosettaNet guidelines to .xsd or .dtd 
files. 

Regardless of whether you use the import or create collaboration method, you can 
then assign support for a collaboration to a remote trading partner in either of two 
ways:

■ With the Create Trading Partner Wizard (on the Create Trading Partner : 
Operational Capability page when you initially create the remote trading partner)

■ Through the Create Operational Capability button of the Business Protocol 
Details page for the business protocol assigned to the remote trading partner you 
previously created

The Create Collaboration wizard provides a series of pages that guide you through 
collaboration creation. Table 6–5 provides an overview of the wizard pages that appear 
and the types of questions for which you are prompted to provide details. Before using 
this wizard, review the information shown in Table 6–5.

Table 6–5 Create Collaboration Wizard Pages

Page Description

Page 1: General Page Prompts you to define the following general collaboration details:

■ Collaboration name, description, and revision number

■ Collaboration code

■ The time in which to perform the collaboration

■ Initiating role name and description

■ Accepting role name and description

Page 2: Business 
Transaction Page

Prompts you to define the following business transaction details:

■ Business transaction name, description, and revision number

■ The time in which to perform the transaction
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Follow these tasks to create a collaboration with the Create Collaboration wizard: 

■ Page 1: General Page

■ Page 2: Business Transaction Page

■ Page 3: Requesting Business Action

■ Page 4: Responding Business Action (Optional)

■ Page 5: Review

Page 3: Requesting 
Business Action

Prompts you to define the following requesting business action 
details:

■ Protocol action name

■ Response Mode (asynchronous or synchronous)

■ Requesting business action name, description, and revision 
number

■ Amount of time to wait before retrying

■ Time in which an acknowledgment message must be received

■ Acknowledgment mode

■ Document type name, description, and revision number

■ Document definition name and description

■ If RosettaNet Business Dictionary validation is enabled

■ The document definition file to import

Page 4: Responding 
Business Action 
(Optional)

Note: This page appears 
if you selected Sync or 
Async from the 
Response Mode list in 
Page 3: Requesting 
Business Action.

Prompts you to define the following responding business action 
details:

■ Protocol action name

■ Responding business action name, description, and revision 
number

■ Document protocol revision name and revision

■ Document type and definition

■ Amount of time to wait before retrying

■ Time in which an acknowledgment message must be received

■ Document type name, description, and revision number

■ Document definition name and description

■ If RosettaNet Business Dictionary validation is enabled

■ The document definition file to import

Page 5: Review Prompts you to review details about the following selections you 
made on the previous pages:

■ Collaboration name, revision, and initiating and accepting role 
names

■ Business transaction name

■ Requesting business action details (protocol action name, 
response mode, business action, revision, acknowledge mode, 
document type, and document definition)

■ Responding business action details (protocol action name, 
business action, revision, document type, and document 
definition)

Table 6–5 (Cont.) Create Collaboration Wizard Pages

Page Description
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Page 1: General Page
Follow these instructions to create the collaboration (for this example, PIP 7B1) and its 
initiating and accepting roles (for example, buyer and seller) for the RosettaNet over 
RNIF business protocol:

1. Click Partners > Protocols. 

2. Click the RosettaNet over RNIF business protocol in the Name column of the 
Business Protocols section.

The Business Protocol Details page for the RosettaNet over RNIF business 
protocol appears.

3. Start the Create Collaboration wizard in either of two ways: 

a. Click Create Collaboration in the Shortcut section. 

or

a. Click Details in the Process Protocol Revisions section.

b. Click Create in the Collaborations section.

The Create Collaboration : General page appears and displays the selected 
business protocol and its process protocol and process protocol revision in the top 
left part of the page. These details appear on each remaining page of the wizard.

4. Enter the following details. An asterisk (*) indicates a required field. An example 
of the details to enter for PIP 7B1 is provided for the first three pages of this 
wizard.

Note: Ensure that you carefully enter collaboration details into the 
Create Collaboration wizard. The naming and case conventions 
described in the downloaded RosettaNet PIP specification must be 
explicitly followed.

See Also: Chapter 7, "Creating Trading Partners" for instructions on 
assigning support for a collaboration to a remote trading partner

Field Value Example

General

■ Document 
Protocol 
Revision

Select the document protocol 
revision to use. This list only 
displays if more than one 
document protocol revision exists. 

Not applicable for this example

■ Name * Enter a unique and recognizable 
name for the collaboration (the 
RosettaNet PIP).

7B1

■ Description Enter a description of the 
collaboration.

Distributes status information about 
the manufacture or assembly of a 
product
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5. Click Next.

The Create Collaboration : Business Transaction page appears.

Page 2: Business Transaction Page
Follow these instructions to create the business transaction for the RosettaNet over 
RNIF business protocol. When complete, the business transaction includes the 
requesting and responding actions.

1. Enter the following details. An asterisk (*) indicates a required field.

■ Revision * Enter a revision number for the 
collaboration.

V01.00 (for RosettaNet 
Implementation Framework (RNIF) 
version 1.0)

Note: This number must match the 
document type revision number you 
enter on the Create Collaboration : 
Requesting Business Action and 
Responding Business Action pages.

■ Code Enter a code for the collaboration. Work in Process Notification

■ Time To 
Perform

Enter the time limit in minutes for 
performing this collaboration. You 
can override this value when you 
create your trading partner.

120

Initiating Role

■ Name * Enter a unique and recognizable 
name for the initiating role in this 
business transaction.

Solution Provider

■ Description Enter a description for the initiating 
role.

Party that architects, configures, 
engineers, sells, and determines the 
fulfillment of the configured 
solution to partners

Accepting Role

■ Name * Enter a unique and recognizable 
name for the accepting role in this 
business transaction.

Solution Requester

■ Description Enter a description for the 
accepting role.

Party that creates a demand for a 
product or service, or has contracted 
with a solution provider for the 
manufacture or fulfillment of a 
product

Field Value Example

Name * Enter a unique and recognizable 
name for the business transaction.

Work in Process Notification

Description Enter a description of the business 
transaction.

Work in Process Notification

Revision * Enter a revision number for the 
business transaction.

V01.00

Time To Perform Enter the time limit in minutes for 
performing this transaction.

120

Field Value Example
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2. Click Next.

The Create Collaboration : Requesting Business Action page appears.

Page 3: Requesting Business Action
Follow these instructions to create the requesting business action. The requesting 
business action is initiated by the initiating role you created in the Create 
Collaboration : General page (page 1) of this wizard.

1. Enter the unique and recognizable name in the Protocol Action Name field (for 
this example, Work in Process Notification Request Action). 

2. Select Async, None, or Sync from the Response Mode list (for this example, select 
None for PIP 7B1). Your selection determines the wizard page that appears after 
you complete the remaining details on this wizard page and click Next.

■ If you select Async or Sync, the Responding Business Action page ("Page 4: 
Responding Business Action (Optional)" on page 6-30) appears next.

■ If you select None, the Review page ("Page 5: Review" on page 6-31) appears 
next.

3. Select Use Existing or Create New from the Create Mode list (for this example, 
select Create New).

4. Go to the following step based on your mode selection in Step 3:

5. If you selected Create New, perform Steps 5a through 5b.

a. Enter the following details. An asterisk (*) indicates a required field.

Note: The name you specify must exactly match that shown in the 
Business Action in FSV column of the Business Action - Business 
Document Mapping table of the RosettaNet specification for the PIP 
you are using.

If You Selected... Go To...

Create New Step 5

Use Existing Step 6

Field Value Example

Name * Enter a unique and recognizable 
name for the requesting business 
action.

Work in Process Notification Action

Description Enter a description of the 
requesting business action.

Work in Process Notification Action

Revision * Enter a revision number for the 
requesting business action.

V01.00

Retry Count Enter a value. This value specifies 
the amount of time to wait before 
retrying.

3
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b. Go to Step 7.

6. If you selected Use Existing, perform Steps 6a through Step 6b.

a. Select an existing business action from the Business Action list.

b. Go to Step 7.

7. Click Next.

The Create Collaboration : Responding Business Action page appears.

Time To 
Acknowledge

Enter a value in minutes. This 
value specifies the time in which an 
acknowledgment message must be 
received. If an acknowledgment is 
not received, an error message is 
returned.

120

Acknowledge 
Mode

Select Async, None, or Sync

Document Type

■ Name * Enter a unique and recognizable 
name for the document type. A 
document type maps to a 
RosettaNet business document.

Work in Process Notification

■ Description Enter a description of the 
document type.

Work in Process Notification

■ Revision * Enter a revision number for the 
document type.

V01.00

Note: This number must match the 
collaboration revision number you 
enter on the Create Collaboration : 
General page.

Document 
Definition

■ Name * Enter a unique and recognizable 
name for the document definition. 

Work in Process Notification

■ Description Enter a description of the 
document definition.

Work in Process Notification

■ Validation 
Enabled

Select No or Yes. Selecting Yes 
enables RosettaNet Business 
Dictionary validation. If you enable 
validation outside of the OracleAS 
Integration B2B user interface tool, 
performance is impacted.

No

■ Definition * Click Browse to select a document 
definition file (typically a .dtd 
file).

Note: You can either import 
standard .dtd files downloaded 
from the RosettaNet Web site (as 
shown in this example) or import 
.xsd or .dtd files created with the 
OracleAS Integration B2B - 
Document Editor.

7B1_MS_V01_00_
WorkinProcessNotification.dtd

Field Value Example
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Page 4: Responding Business Action (Optional)
This wizard page appears if you selected Async or Sync from the Response Mode list 
in Step 2 of "Page 3: Requesting Business Action" on page 6-28. Follow these 
instructions to create the responding (accepting) business action. The responding 
business action is initiated by the accepting role you created in the Create 
Collaboration : General page (page 1) of this wizard.

1. Enter a name in the Protocol Action Name field. 

2. Select Create New or Use Existing from the Create Mode list.

3. Go to the following step based on your mode selection in Step 2:

4. If you selected Create New, perform Step 4a through Step 4b.

a. Enter the following details. An asterisk (*) indicates a required field.

Note: The name you specify must exactly match that shown in the 
Business Action in FSV column of the Business Action - Business 
Document Mapping table of the RosettaNet specification for the PIP 
you are using.

If You Selected... Go To...

Create New Step 4

Use Existing Step 5

Field Value

Name * Enter a unique and recognizable name for the responding business 
action.

Description Enter a description of the responding business action.

Revision * Enter a revision number for the responding business action.

Retry Count Enter a value. This value specifies the amount of time to wait 
before retrying.

Time To Acknowledge Enter a value in minutes. This value specifies the time in which an 
acknowledgment message must be received. If an 
acknowledgment is not received, an error message is returned.

Document Type

■ Name * Enter a unique and recognizable name for the document type.

■ Description Enter a description of the document type.

■ Revision * Enter a revision number for the document type.

Note: This number must match the collaboration revision number 
you enter on the Create Collaboration : General page.

Document Definition

■ Name * Enter a unique and recognizable name for the document 
definition.

■ Description Enter a description of the document definition.

■ Validation Enabled Select Yes or No.
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b. Go to Step 6.

5. If you selected Use Existing, perform Step 5a through Step 5b.

a. Select an existing business action from the Business Action list.

b. Go to Step 6.

6. Click Next.

The Create Collaboration : Review page appears and displays your selections from 
the previous pages.

Page 5: Review
1. Review the collaboration details. 

■ To modify these details, click the Back button of the Create Collaboration 
wizard to return to the previous pages. When you complete modifications, 
click Next until you access the review page; then click Finish. Do not use the 
Back and Forward buttons of your Web browser.

■ If you are satisfied with these details, click Finish. 

The collaboration is created and the new Collaboration Details page appears. 

You can now assign support for this collaboration to a remote trading partner as 
follows:

■ On the Operational Capability page of the Create Trading Partner wizard 
(page three of seven)

■ On the Create Supported Collaboration Role page, which is accessible from the 
Create Operational Capability button of the Business Protocol Details page 
for the RosettaNet over RNIF business protocol assigned to the trading partner 
(click Partners > Trading Partners > trading_partner_name_in_Name_column 
> Capabilities > RosettaNet over RNIF)

2. Click Return to List to return to the Process Protocol Revision Details page.

3. Click Return to List to return to the Business Protocol Details page.

Viewing a Collaboration
Follow these instructions to view a collaboration:

1. Click Partners > Protocols. 

2. Click the RosettaNet over RNIF business protocol in the Name column of the 
Business Protocols section.

3. Click Details in the Process Protocol Revisions section.

■ Definition * Click Browse to select a definition file (typically a .dtd file).

Note: You can either import standard .dtd files downloaded from 
the RosettaNet Web site (as shown in this example) or import 
.xsd or .dtd files created with the OracleAS Integration B2B - 
Document Editor.

See Also: Chapter 7, "Creating Trading Partners" for instructions on 
assigning support for a collaboration to a remote trading partner

Field Value
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The Process Protocol Revision Details page appears.

4. Select the specific collaboration to view in the Details column of the 
Collaborations section.

The Collaboration Details page for the selected collaboration appears.

5. View specific details, including the following:

■ The business protocol and its process protocol and process protocol revision

■ The description, revision, code, time to perform, initiating role, accepting role, 
and business transaction (in the Details section). Depending upon the 
collaboration selected, you can also access pages for updating the initiating 
role, accepting role, business transaction, requesting action, and responding 
action.

This page, as with the Process Protocol Revision Details page shown in Figure 6–8 
on page 6-16, enables you to delete or update the collaboration.

6. Click Return to List to return to the Process Protocol Revision Details page.

Updating a Collaboration
Follow these instructions to update a collaboration:

1. Click Partners > Protocols. 

2. Click the RosettaNet over RNIF business protocol in the Name column of the 
Business Protocols section.

3. Click Details in the Process Protocol Revisions section.

The Process Protocol Revision Details page appears.

4. Select a specific collaboration to update in the Update column of the 
Collaborations section.

The Update Collaboration page appears.

5. Make appropriate updates. An asterisk (*) indicates a required field.

6. Click Apply.

The collaboration is updated and the Collaboration Details page appears.

Field Value

Name * Update with a unique and recognizable name for the collaboration.

Description Update the description of the collaboration.

Revision * Update the revision number for the collaboration.

Note: This number must match the document type revision number. 
If they do not match, you receive an error after deployment. If you 
imported the predefined RosettaNet collaborations, both revision 
numbers automatically match. 

See Also: "Updating a Document Type" on page 6-12

Code Update the code for the collaboration.

Time To Perform Update the time limit in minutes for performing this collaboration.
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Deleting a Collaboration
Follow these instructions to delete a collaboration:

1. Click Partners > Protocols. 

2. Click the RosettaNet over RNIF business protocol in the Name column of the 
Business Protocols section.

3. Click Details in the Process Protocol Revisions section.

The Process Protocol Revision Details page appears.

4. Select a specific collaboration to delete in the Delete column of the Collaborations 
section.

5. Click Yes when prompted to delete a collaboration.

The collaboration is deleted and the Process Protocol Revision Details page 
appears.

Common User Errors
■ Do not include beginning or trailing blank spaces in the names of business 

protocol partner data that you create.

■ If you create a document type for the RosettaNet over RNIF business protocol, the 
collaboration revision number must match the document type revision number.

■ If you are using globalization support with OracleAS Integration B2B, do not 
enable validation in the OracleAS Integration B2B user interface tool.

■ If you create a collaboration with the Create Collaboration wizard, ensure that you 
carefully enter collaboration details into the Create Collaboration wizard. The 
naming and case conventions described in the downloaded RosettaNet PIP 
specification must be explicitly followed.

Chapter Summary
This chapter describes the tasks required to manage the three protocols that comprise 
the business protocol: document, exchange, and process. The process protocol consists 
of business actions and collaborations. This chapter also describes how to create a 
business action with the Create Business Action wizard and a collaboration with the 
Create Collaboration wizard. 
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7
Creating Trading Partners

This chapter describes how to use the Create Trading Partner wizard to create a 
remote trading partner, assign it support for a business protocol with operational and 
communication capabilities, and assign communication capabilities to the business 
protocol of the host trading partner. To simply your user experience, the host trading 
partner is automatically assigned all business protocols and operational capabilities.

This chapter contains these topics:

■ Trading Partner Creation Overview

■ Creating and Assigning All Capabilities During a Single Wizard Session

■ Creating and Defining All Capabilities During Separate Wizard Sessions

■ Common User Errors

■ Chapter Summary
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Trading Partner Creation Overview
The following sections provide an overview of the Create Trading Partner wizard:

■ What Is a Trading Partner?

■ How Do You Create a Trading Partner?

■ Create Trading Partner Wizard Overview

■ Create Trading Partner Wizard and Protocol Standards

■ Prerequisites to Using the Create Trading Partner Wizard

■ Accessing the Create Trading Partner Wizard

What Is a Trading Partner?
A trading partner is a party that engages in a business transaction with another 
trading partner. There are two types of trading partners in Oracle Application Server 
Integration B2B:

■ Host trading partner

The host trading partner is the organization in which OracleAS Integration B2B is 
installed. You do not need to create the host trading partner with the Create 
Trading Partner wizard; it is automatically included with OracleAS Integration 
B2B.

■ Remote trading partner

The remote trading partner is the organization outside your enterprise with whom 
the host trading partner conducts a business transaction. You must create the 
remote trading partner with the Create Trading Partner wizard.

How Do You Create a Trading Partner?
Figure 7–1 describes the main types of tasks to perform with the Create Trading 
Partner wizard.
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Figure 7–1 Create Trading Partner Wizard Tasks

You assign support for the business protocol to the remote trading partner. The 
business protocol identifies the implementation guidelines to use for the reliable 
transport of messages between trading partners. You then assign operational 
capabilities and communication capabilities to the business protocol of the remote 
trading partner. To simplify your user experience, the host trading partner is 
automatically assigned support for a business protocol and operational capabilities 
that are compatible with those of the remote trading partner. You assign only 
communication capabilities to the business protocol of the host trading partner. 

Operational capabilities describe the support for a business action (for any EDI or 
Custom Document business protocol) or collaboration (for the RosettaNet over RNIF 
business protocol) to use in a business transaction. 

Communication capabilities describe the following details:

■ Delivery channel details, such as use of nonrepudiation, encryption, and transport 
security

■ Document exchange details, such as use of a digital envelope, encryption 
credential, digital signature, and signing credential

■ Transport details, such as transport mode, protocol, server name, and endpoint 
address details

Business Protocol (EDI X12)

Communication Capabilities 
(delivery channel, 
document exchange, 
transport, transport server, 
and endpoint details)

Operational Capabilities 
(EDI Business Action)

Host Trading Partner (GlobalChips)

Business Protocol (EDI X12)

Communication Capabilities 
(delivery channel, 
document exchange, 
transport, transport server, 
and endpoint details)

Operational Capabilities 
(EDI Business Action)

Remote Trading Partner (Acme)

Business Protocol (EDI X12)

Host Trading Partner (GlobalChips) 

Business Protocol (EDI X12)

Remote Trading Partner (Acme)

Task 2: 
Define a Business Protocol for the Remote Trading Partner (Business Protocol 
for the Host Trading Partner is automatically defined)

Task 3: 
Define Operational and Communication Capabilities for the Business Protocol 
of the Remote Trading Partner

Task 1: 
Create a Remote Trading Partner (Host Trading Partner is automatically created)

Task 4: 
Define Communication Capabilities for the Business Protocol of the Host 
Trading Partner (Operational Capabilities are automatically defined)

Host Trading Partner (GlobalChips) Remote Trading Partner (Acme)
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The host trading partner consults with the remote trading partner to obtain the 
necessary business protocol, operational capability, and communication capability 
details and uses the OracleAS Integration B2B user interface tool to define this 
information for both trading partners. The remote trading partner has no access to the 
OracleAS Integration B2B user interface tool.

Create Trading Partner Wizard Overview
The Create Trading Partner wizard provides a series of pages that guide you through 
the remote trading partner creation tasks shown in Figure 7–1 on page 7-3. Table 7–1 
provides an overview of the wizard pages that appear and the types of questions for 
which you are prompted to provide details. Before using this wizard, review the 
information shown in Table 7–1.

Table 7–1 Create Trading Partner Wizard Pages

Page Description

Page 1: General Page Prompts you to enter a remote trading partner name and an 
optional description

Page 2: Identification 
Page

Prompts you to enter a value and description for a remote trading 
partner identification type. For example, a value for the following:

■ AS2 Identifier

■ DUNS number

■ EDI location code

■ Generic Identifier 

Note: Enter an Internet Protocol (IP) address to identify trading 
partners if you are using a generic exchange protocol with the 
HTTP or HTTPS transport protocol. Do not enter a hostname.

■ Any additional identification types you created by clicking 
Administration > Design > Trading Partner Identification 
Types > Create

Note: You can click Finish on this page to create the remote trading 
partner name. You can also click Next to continue assigning the 
remote trading partner support for a business protocol and creating 
its operational capabilities (support for collaborations or business 
actions) and communication capabilities (delivery channel, 
document exchange, transport, transport server, and endpoint) 
during this wizard session. If you click Finish, you can define these 
details at a later time.
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Page 3: Operational 
Capability Page

Prompts you to select a business protocol. Each business protocol 
has an associated document protocol, exchange protocol, and 
process protocol. 

Based on your business protocol selection, the page refreshes to 
prompt you for additional details to define for this remote trading 
partner. For example:

■ If you select the RosettaNet over RNIF business protocol, you 
are prompted to select support for a collaboration (for example, 
RosettaNet Partner Interface Process (PIP) 3A4) and its 
associated role (for example, buyer or seller), enter a time in 
which to process the collaboration, and select whether 
OracleAS Integration B2B handles acknowledgments.

■ If you select any EDI or Custom Document business protocol, 
you are prompted to select support for a business action, if the 
business action is the initiator, if a functional acknowledgment 
is required, whether OracleAS Integration B2B handles 
acknowledgments, and the document type. 

You also have the option to use or override default settings 
created with the Create Business Action wizard for document 
protocol parameter values and document definitions and to 
select different document definition files.

Page 4: Delivery 
Channel Page

Prompts you to define the following delivery channel details for the 
secure exchange of messages between trading partners:

■ Delivery channel name

■ Acknowledgment mode

■ Global usage code

■ If nonrepudiation of receipt and nonrepudiation of origin are 
required

■ If encryption, transport security, and compression are enabled

■ Time to acknowledgment value

■ Retry count value

Note: The selections you make on this page for nonrepudiation of 
receipt, nonrepudiation of origin, encryption, and transport security 
determine the fields that display and the transport protocols that are 
selectable on subsequent pages of this wizard.

Page 5: Document 
Exchange Page

Prompts you to define the following document exchange 
characteristics for exchanging messages between trading partners:

■ Document exchange name

■ Exchange protocol revision (for example, RosettaNet V02.00 or 
01.10) and parameter values that can be overridden, if 
necessary

■ Document exchange protocol parameters

■ Digital signature, signing credential, and certificate file if you 
selected Yes for nonrepudiation of receipt and nonrepudiation 
of origin on the Delivery Channel page

■ Digital envelope, encryption credential, and certificate file if 
you selected Yes to enable encryption on the Delivery Channel 
page

Table 7–1 (Cont.) Create Trading Partner Wizard Pages

Page Description
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Create Trading Partner Wizard and Protocol Standards
The Create Trading Partner wizard can prompt you for information that is not 
applicable to the business protocol you select. Nothing prevents you from providing 
responses to these prompts. However, you only receive the benefits provided by these 
features if your business protocol selection actually supports these capabilities. You 
must understand the capabilities of your business protocol before using the Create 
Trading Partner wizard. For example:

■ The Compression Enabled field on the Create Trading Partner : Delivery Channel 
page only applies to the business protocols using the AS2 exchange protocol: 
Custom Document over Internet, EDI X12 over Internet, and EDI EDIFACT over 
Internet. 

■ The Functional acknowledgment required? field on the Create Trading Partner: 
Operational Capability page that appears for all EDI and Custom Document 
business protocols only applies to business protocols that include the EDI X12 or 
EDI EDIFACT document protocol. It does not apply to business protocols using 
the Custom Document protocol. 

■ If you are using a business protocol with a generic exchange, you must select 
None from the Acknowledgment Mode list on the Create Trading Partner : 
Delivery Channel page. If you select Sync or Async, validation fails when creating 
a configuration.  

Page 6: Transport Page Prompts you to define the following transport characteristics for 
message delivery using a selected transport communication 
protocol:

■ Transport name and protocol. If you selected Yes to enable 
transport security on the Delivery Channel page, you are 
prompted to select a secure transport protocol.

■ Transport server name, hostname, address, and login 
credentials 

■ Transport parameters

■ Endpoint URI of the trading partner

Page 7: Review Page Prompts you to review details about the following selections you 
made on the previous wizard pages:

■ If using RosettaNet, the business protocol, support for a 
collaboration, collaboration role, and whether a default 
document definition is used (displayed under the Operational 
Capability header)

■ If using EDI or Custom Document, the business protocol, 
support for a business action, whether default document 
protocol parameters are used, and whether a default document 
definition is used (displayed under the Operational Capability 
header)

■ Delivery channel, document exchange, exchange protocol 
revision, transport, transport protocol, and transport server 
(displayed under the Communication Capability header)

Note: After the trading partner is created, the Trading Partner 
Details page includes General, Organization, Users, and Capabilities 
links at the top of the page. The Capabilities link points to the 
details described on the Review page.

Table 7–1 (Cont.) Create Trading Partner Wizard Pages

Page Description
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■ The Is Non-Repudiation of Origin Required, Is Non-Repudiation of Receipt 
Required, and Encryption Enabled fields on the Create Trading Partner : Delivery 
Channel page are not supported for business protocols using a generic exchange 
protocol with the File or FTP transport protocols. 

Prerequisites to Using the Create Trading Partner Wizard 
Ensure that you review and complete any necessary prerequisites described in 
Table 7–2 before using the Create Trading Partner wizard:

Accessing the Create Trading Partner Wizard
The Create Trading Partner wizard provides you with a flexible approach to 
performing the tasks in Figure 7–1. For example, you can:

■ Create a remote trading partner, assign support for the business protocol, and 
create the business protocol operational capabilities and communication 
capabilities during a single wizard session.

■ Create a remote trading partner now, assign support for the business protocol, and 
create the business protocol operational capabilities (support for a collaboration or 
business action) and communication capabilities (delivery channel, document 
exchange, transport, transport server, and endpoint) during separate wizard 
sessions.

■ Create the communication capabilities of the host trading partner during a 
separate wizard session. To simplify your user experience, the host trading partner 
is automatically assigned support for a business protocol and operational 
capabilities that are compatible with those of the remote trading partner. 

The method by which to access the different pages of the Create Trading Partner 
wizard is based upon the task you want to perform. Table 7–3 describes these tasks 
and their access methods.

Table 7–2 Prerequisites

Prerequisite See Section...

If you are using the generic exchange protocol parameter, 
ensure that you first review all product workarounds.

■ "Generic Exchange Protocol 
Workarounds" on page A-5

If you want to create a remote trading partner and assign it 
an EDI or Custom Document (such as a UCCnet standard) 
business protocol during a single wizard session, you must 
first create support for a business action or import a 
transaction set (maps to a document type of a business 
action in the OracleAS Integration B2B user interface tool) or 
standard. 

■ "Creating a Business 
Action" on page 6-17

■ "Importing Support for 
Collaborations, Transaction 
Sets, and UCCnet 
Standards" on page 12-9

If you want to create a remote trading partner and assign it 
the RosettaNet over RNIF business protocol during a single 
wizard session, you must first create or import support for a 
collaboration.

■ "Creating a Collaboration" 
on page 6-23

■ "Importing Support for 
Collaborations, Transaction 
Sets, and UCCnet 
Standards" on page 12-9
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Table 7–3 Create Trading Partner Wizard Tasks and Access Methods

Task Access Method See Section...

For Remote Trading Partners:

■ Create the trading partner, 
assign support for the 
business protocol, and create 
the business protocol 
operational and 
communication capabilities 
during a single wizard session

1. Click Partners > Trading Partners > Create or 
Partners > Create Trading Partner in the 
Shortcuts section.

2. Complete all Create Trading Partner wizard 
pages (seven pages in total).

"Creating and 
Assigning All 
Capabilities During a 
Single Wizard Session" 
on page 7-9

■ Create only the trading 
partner name during a single 
wizard session

1. Click Partners > Trading Partners > Create or 
Partners > Create Trading Partner in the 
Shortcuts section.

2. Complete only the first two pages of the Create 
Trading Partner wizard.

3. Click Finish.

"Creating a Remote 
Trading Partner" on 
page 7-24

■ Assign support for the 
business protocol during a 
separate session

Note: You can assign support for 
multiple business protocols to a 
remote trading partner. The host 
trading partner is automatically 
assigned all business protocols.

1. Click Partners > Trading Partners.

2. Select the previously created trading partner in 
the Name column.

3. Click Capabilities > Add in the Business 
Protocols section.

4. Select a business protocol from the Business 
Protocol list.

"Assigning the 
Business Protocol to 
the Remote Trading 
Partner" on page 7-24

■ Assign support for the 
business protocol and create 
its operational capabilities 
during a separate session

Note: The host trading partner is 
automatically assigned support for 
all operational capabilities.

1. Click Partners > Trading Partners.

2. Select the previously created trading partner in 
the Name column.

3. Click Capabilities.

4. Select the business protocol to which to add 
operational capabilities in the Name column of 
the Business Protocols section.

5. Click Create Operational Capability. This action 
starts the Operational Capability page of the 
wizard and enables you to create business action 
details (for any EDI or Custom Document 
business protocol) or collaboration details (for 
the RosettaNet over RNIF business protocol).

"Creating Business 
Protocol Operational 
Capabilities for the 
Remote Trading 
Partner" on page 7-25

For Both the Host and Remote 
Trading Partners:

■ Create the business protocol 
communication capabilities

Note: Use this method for the host 
trading partner and if you need to 
create the remote trading partner 
communication capabilities during 
a separate wizard session.

1. Click Partners > Trading Partners.

2. Select the previously created trading partner in 
the Name column.

3. Click Capabilities.

4. Select the business protocol to which to add 
communication capabilities in the Name column 
of the Business Protocols section.

5. Click Create Communication Capability. This 
action starts the Delivery Channel page of the 
wizard, and guides you through all remaining 
pages (Document Exchange, Transport, and 
Review) of the wizard.

"Creating Business 
Protocol 
Communication 
Capabilities for the 
Host and Remote 
Trading Partners" on 
page 7-26
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Creating and Assigning All Capabilities During a Single Wizard Session
You can create and assign all capabilities to a remote trading partner during a single 
wizard session. This method enables you to create a remote trading partner and assign 
and create the following capabilities:

■ Assign support for a business protocol such as RosettaNet, EDI EDIFACT, EDI 
X12, or Custom Document

■ Create the business protocol operational capabilities, such as support for a 
RosettaNet collaboration or an EDI or Custom Document business action

■ Create the business protocol communication capabilities (delivery channel, 
document exchange, transport, transport server, and endpoint details)

This method is useful for environments in which you know all required details at the 
same time.

Follow these tasks to create a remote trading partner, assign it support for a business 
protocol, and create business protocol operational and communication capabilities 
during a single wizard session.

■ Page 1: General Page

■ Page 2: Identification Page

■ Page 3: Operational Capability Page

■ Page 4: Delivery Channel Page

■ Page 5: Document Exchange Page

■ Page 6: Transport Page

■ Page 7: Review Page

Page 1: General Page
1. Click Partners > Trading Partners > Create or Partners > Create Trading Partner 

in the Shortcuts section.

The Create Trading Partner: General page appears.

2. Enter the following details. An asterisk (*) indicates a required field.

3. Click Next.

The Create Trading Partner: Identification page appears.

Note: You do not need to create a host trading partner; the host 
trading partner is automatically created during installation. There can 
be only one host trading partner. 

Field Value

Name * Enter a unique and recognizable name for the remote trading 
partner.

Description Enter an optional description for the remote trading partner.



Creating and Assigning All Capabilities During a Single Wizard Session

7-10 Oracle Application Server Integration B2B User’s Guide

Page 2: Identification Page
1. Enter a value for an identification type for the remote trading partner. The 

following types are automatically included with OracleAS Integration B2B. 
Additional identification types can display here if you created them by clicking 
Administration > Design > Trading Partner Identification Types > Create. 

2. Enter an optional description of the trading partner identification type.

3. Click one of the following based on what you want to do next.

4. Click Next.

The Create Trading Partner: Operational Capability page appears. 

Field Value

AS2 Identifier Enter the AS2 identifier. 

This type is an alias for the service address (specified by the AS2-from 
field) inside an AS2 transaction.

DUNS Enter a DUNS (data universal numbering system) value. 

This type, known formally as a D-U-N-S Number, is a unique, 
sequentially-generated, nine-digit number that you obtain from Dun 
and Bradstreet.

EDI Location Code Enter an EDI location code. 

This type provides a unique identification of all locations relevant to 
the EDI transaction.

Generic Identifier Enter the IP address to use for identifying trading partners if you are 
using the generic exchange protocol (EDI X12 over Generic Exchange, 
EDI EDIFACT over Generic Exchange, or Custom Document over 
Generic Exchange) with the HTTP or HTTPS transport protocol. Do 
not enter the hostname.

See Also: "Creating a Trading Partner Identification Type" on 
page 12-4 for instructions on creating additional identification types

Click... If You Want To...

Next Continue assigning the remote trading partner support for a business protocol 
and creating its operational capabilities (support for a collaboration or business 
action) and communication capabilities (delivery channel, document exchange, 
transport, transport server, and endpoint details) during this single wizard 
session. If you click Next, you can complete all remaining pages of this wizard. 
The remaining procedures in this section describe the pages that appear when 
you click Next.

Finish Exit the wizard and create the remaining details at a later time.
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Page 3: Operational Capability Page

1. Select a business protocol for a remote trading partner from the Business Protocol 
list. The business protocol identifies the implementation guidelines for the reliable 
transport of business document messages between trading partners. Each business 
protocol consists of the following three protocols:

■ Document protocol

Defines the document types of the message payload

■ Exchange protocol

Defines the message exchange mechanism—how to exchange the documents 
defined by the document protocol. It defines the headers, the 
acknowledgments, and the packaging that puts the headers and payload 
together. It also defines the transport protocol and packaging protocol for the 
exchange.

■ Process protocol

Defines how you exchange messages, using the document protocol-based 
business document, and exchanging it based on the exchange protocol.

The following business protocols (and their associated process, document, and 
exchange protocols) are available for selection:

The screen refreshes based on your selection in Step 1.

Notes:

■ In addition to accessing the Operational Capability page through 
the Create Trading Partner wizard, you can also access this page 
only by clicking Create Operational Capability on the Business 
Protocol Details page of a remote trading partner. Instructions for 
using that method are provided in "Creating Business Protocol 
Operational Capabilities for the Remote Trading Partner" on 
page 7-25.

■ To simplify your user experience, the host trading partner is 
automatically assigned all operational capabilities.

This Business Protocol...
Includes This 
Process Protocol

Includes This 
Document Protocol

Includes This 
Exchange Protocol

Custom Document over 
Generic Exchange

B2B Custom Generic

Custom Document over 
Internet

B2B Custom AS2

EDI EDIFACT over Generic 
Exchange

B2B EDI EDIFACT Generic

EDI EDIFACT over Internet B2B EDI EDIFACT AS

EDI X12 over Generic 
Exchange

B2B EDI X12 Generic

EDI X12 over Internet B2B EDI X12 AS2

RosettaNet over RNIF B2B RosettaNet RNIF
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2. Go to the following step based on your business protocol selection:

3. If you selected RosettaNet over RNIF, perform Steps 3a through 3f. The following 
partial list is an example of the PIPs that can appear if you performed the 
following tasks:

■  Imported RosettaNet support for collaborations by clicking Administration > 
Management > Import

■ Created the RosettaNet collaboration by clicking Partners > Protocols > 
RosettaNet over RNIF > Create Collaboration (in the Shortcut section)

a. Select a PIP value from the Collaboration list. A collaboration consists of a set 
of roles (for example, buyer and seller) that interact and exchange business 
document messages through a set of agreed-upon steps. This table provides an 
example of the collaborations that can appear if you imported the RosettaNet 
collaborations file. A brief description of the capabilities of each collaboration 
is also provided.

The page refreshes.

b. Select a value from the Collaboration Role list. This is the role performed by a 
trading partner in a collaboration. The role you select defines who the initiator 
or responder is in this collaboration between trading partners (for example, 

If You Selected... Go To...

RosettaNet over RNIF Step 3 on page 7-12

Any EDI or Custom Document business 
protocol

Step 4 on page 7-13

Collaboration Type This Collaboration Supports the...

0A1 Notification of failure Detection by either involved party of the failure of 
a business activity to complete successfully

3A4 Request purchase 
order 

Following sequence of events: 

■ Submittal of a purchase order request by a 
buyer 

■ Submittal of a receipt acknowledgment 
confirmation by a seller 

■ Submittal of a purchase order confirmation by 
a seller 

■ Submittal of receipt of a purchase order 
confirmation by a buyer 

3A6 Distribute order status Sellers to send the status of open orders to buyers

3A7 Notify of purchase 
order update

Process for requesting a work in process response 
containing information on the production status of 
the product being manufactured from trading 
partners

3A8 Request purchase 
order change

Buyer to change purchase order line items and 
obtain a quick response from the provider that 
acknowledges, at the line level, if the changes are 
accepted, rejected, or pending

3B2 Notify of advance 
shipment 

Shippers to send advance shipment and shipper’s 
manifest notifications 
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the buyer is the initiator for PIP 3A4). The available selections are based upon 
the support for a collaboration you selected from the list of example PIPs in 
Step 3a. This table provides an example of the roles that can appear if you 
imported the RosettaNet collaborations file.

c. Enter the time in minutes in which to process the support for a collaboration 
in the Time To Perform field. This value overrides the value defined by the 
collaboration. 

d. Select Yes or No from the Is acknowledgment handled by Integration B2B? 
list.

e. Click Next.

To simplify your user experience, the host trading partner is automatically 
assigned support for a collaboration that is compatible with your selection for 
the remote trading partner.

f. Go to "Page 4: Delivery Channel Page" on page 7-15.

4. If you selected any EDI or Custom Document business protocol, perform Steps 4a 
through 4f. Business actions appear for selection if you performed the following 
tasks:

■ Imported the EDI X12 and EDI EDIFACT transaction sets or UCCnet 
standards by clicking Administration > Management > Import

■ Created the EDI X12 and EDI EDIFACT business action by clicking Partners > 
Protocols > EDI_or_Custom_Document_business_protocol_name > Create 
Business Action (in the Shortcut section)

a. Enter the following details. An asterisk (*) indicates a required field.

If You Selected... The List Displays These Selections...

0A1 ■ PIP Failure Notifier

■ Failure Report Administrator

3A4 ■ Buyer

■ Seller

3A6 ■ Seller

■ Buyer

3A7 ■ Seller

■ Buyer

3A8 ■ Buyer

■ Seller

3B2 ■ Shipper

■ Receiver
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b. Select a document type from the Document Type list. A document type only 
displays for selection if you have already created or imported one.

c. If you want to change any document protocol parameter values, deselect the 
Use Existing Document Protocol Parameter Values check box.

d. If you want to change the document definition file and enable translation and 
validation, deselect the Use Default Document Definition check box.

e. Click Next. 

The steps to perform next are based on whether you deselected the check 
boxes:

f. Perform the following steps based on the check boxes you deselected. If you 
decide not to change anything, reselect either or both check boxes. This causes 
the page to refresh to hide the steps described in this table.

Field Value

Business Action * Select a business action.

The page refreshes to display the Document Type list and the 
following two check boxes:

■ Use Existing Document Protocol Parameter Values

■ Use Default Document Definition

Both check boxes are automatically selected. You specified values 
for both when you created the business action manually in 
"Creating a Business Action" on page 6-17 or imported it in 
"Importing Support for Collaborations, Transaction Sets, and 
UCCnet Standards" on page 12-9. 

If you deselect either or both check boxes, you have the 
opportunity to override the default settings after clicking Next. 

Is Initiator * Select False or True.

Functional 
acknowledgment 
required? *

Select No or Yes.

Is acknowledgment 
handled by Integration 
B2B? *

Select No or Yes. 

If You... The... Then Go to...

Did not deselect either check box The Delivery Channel page 
appears

"Page 4: Delivery Channel 
Page" on page 7-15.

Deselected either or both check 
boxes

The Operational 
Capabilities page refreshes.

Step 4f.
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Page 4: Delivery Channel Page

If You Deselected... Then...

Use Existing Document Protocol 
Parameter Values

1. Override appropriate document protocol parameter 
settings created or imported with the Create Business 
Action wizard by specifying an override value in the 
Override Value field.

2. Select the group or interchange .ecs files to import. 

3. Click Next when finished. 

4. Go to "Page 4: Delivery Channel Page" on page 7-15.

Use Default Document Definition 1. Enter a unique and recognizable name for the 
document definition.

2. Enter an optional description.

3. Specify whether to enable document definition 
translation and validation.

4. Specify a different document definition file that 
contains the parameter value contents.

5. If the document is a zip file, specify the root XSD file 
name.

6. Override appropriate document definition parameter 
settings by specifying an override value in the 
Override Value field. If the parameter is a string, you 
can enter a value of up to 100 characters.

7. Select .ecs files to import.

8. Click Next when finished. 

9. Go to "Page 4: Delivery Channel Page" on page 7-15.

See Also:

■ "Creating a Business Action" on page 6-17

■ "Creating a Collaboration" on page 6-23

■ "Importing Support for Collaborations, Transaction Sets, and 
UCCnet Standards" on page 12-9

Note: In addition to accessing the Delivery Channel page through 
the Create Trading Partner wizard, you can also access this and all 
remaining wizard pages by clicking Create Communication 
Capability on the Business Protocol Details pages of the remote and 
host trading partners. Instructions for using that method are provided 
in "Creating Business Protocol Communication Capabilities for the 
Host and Remote Trading Partners" on page 7-26.
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1. Enter the following delivery channel details to create the secure exchange of 
messages between trading partners. An asterisk (*) indicates a required field. The 
selections you make on this page from the Is Non-Repudiation of Receipt 
Required, Is Non-Repudiation of Origin Required, Encryption Enabled, and 
Transport Security Enabled lists determine the types of questions you are asked 
or selections you can make on later pages of this wizard.

Field Value

Name * Enter a unique and recognizable name for the delivery channel.

Acknowledgment Mode Select Async, None, or Sync for the mode in which the trading 
partner receives messages. 

If you are using a business protocol that includes a generic 
exchange, you must select None. If you do not select None, 
validation fails when creating a trading partner agreement.

Global Usage Code Select Production or Test. 

This specifies the usage of the delivery channel. If it is set to 
Test, then the delivery channel is used only for testing 
purposes. If it is set to Production, then it is used only for 
production purposes.

Is Non-Repudiation of 
Receipt Required1

Select No or Yes. 

If you select Yes, a digital signature and signing credential are 
necessary. You are prompted for these details later on the 
Document Exchange page of this wizard. The value you select 
must match with that selected for Is Non-Repudiation of 
Origin Required.

Is Non-Repudiation of Origin 
Required1

Select No or Yes. 

If you select Yes, a digital signature and signing credential are 
necessary. You are prompted for these details later on the 
Document Exchange page of this wizard. Do not select Yes if 
RosettaNet 01.10 is the exchange protocol to use. The value you 
select must match with that selected for Is Non-Repudiation of 
Receipt Required.

Encryption Enabled1 Select No or Yes. 

If you select Yes, a digital envelop and encryption credential 
are necessary. You are prompted for these details later on the 
Document Exchange page of this wizard. Do not select Yes if 
RosettaNet 01.10 is the exchange protocol to use.
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2. Click Next.

The Create Trading Partner: Document Exchange page appears. The document 
exchange describes the supported exchange revision protocol (such as RosettaNet 
01.10), digital signature and signing details, and digital envelope and encryption 
credential details. The document exchange uses these capabilities to exchange 
messages with a trading partner. 

Page 5: Document Exchange Page
1. Enter the following document exchange details. An asterisk (*) indicates a required 

field.

The page refreshes based on your selection in the Exchange Protocol Revision list 
and your previous selections from the Is Non-Repudiation of Receipt Required, 
Is Non-Repudiation of Origin Required, and Encryption Enabled lists on the 
Delivery Channel page of this wizard. 

Transport Security Enabled Select No or Yes. 

The selection you make determines the type of transport 
protocol (HTTP or HTTPS) you can select later on the Transport 
page of this wizard.

Compression Enabled Select No or Yes to compress the message. 

Compression is only supported for the Applicability 
Statement 2 (AS2) exchange protocol.

Time To Acknowledgment Enter a value in minutes. 

This value specifies the time in which an acknowledgment 
must be received. If an acknowledgment is not received, then 
retries occur.

Retry Count Enter a value. This defines the number of times to retry.
1 You must select either Yes or No if you want to include these delivery channel details in a trading partner 

agreement of a deployed configuration.

Field Value

Name * Enter a unique and recognizable name for the document 
exchange.

Exchange Protocol Revision * Select the exchange protocol revision to use. The revisions that 
appear are based on the exchange protocol you are using:

■ If using RNIF, select RosettaNet - 01.10 or RosettaNet - 
V02.00.

■ If using Generic Exchange, select Generic 1.0.

■ If using AS, select AS2 - 1.1

Field Value
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2. Accept or override (update) appropriate exchange protocol parameter default 
values in the Override Value field of the Exchange Protocol Parameters section. If 
you are using the AS2 exchange protocol, the parameter Signed and Compressed 
equals true means that OracleAS Integration B2B by default signs the message 
before compressing it.

3. If you selected Yes from the Encryption Enabled list on the Delivery Channel 
page, you are prompted to enter the following digital envelope and encryption 
credential details. An asterisk (*) indicates a required field.



Creating and Assigning All Capabilities During a Single Wizard Session

Creating Trading Partners 7-19

4. If you selected Yes from the Is Non-Repudiation of Receipt Required and Is 
Non-Repudiation of Origin Required lists on the Delivery Channel page, you are 
prompted to enter the following digital signature and signing credential details. 
An asterisk (*) indicates a required field.

Field Value

Digital Envelope * Select a digital envelope to use. The digital envelopes that appear 
are based on the exchange protocol revision you are using:

■ If using RosettaNet - V02.00, select one of the following digital 
envelopes:

SMIME 3.0 with DES

SMIME 3.0 with 3DES

SMIME 3.0 with RC2-40

SMIME 3.0 with RC2-64

SMIME 3.0 with RC2-128

SMIME 2.0 with DES

SMIME 2.0 with 3DES

SMIME 2.0 with RC2-40

SMIME 2.0 with RC2-64

SMIME 2.0 with RC2-128

■ If using AS2 - 1.1 or Generic 1.0, select one of the following 
digital envelopes:

SMIME 3.0 with DES

SMIME 3.0 with 3DES

SMIME 3.0 with RC2-40

SMIME 3.0 with RC2-64

SMIME 3.0 with RC2-128

Encryption Credential

■ Name * Select either of the following:

■ Create New and enter a new encryption credential name in 
the Name field.

■ Use Existing to access a list to select an existing encryption 
credential.

■ Certificate File * Click Browse to select a certificate file.
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5. Click Next.

The Create Trading Partner : Transport page appears and enables you to create 
transport details for message delivery. The transport protocols available for 
selection are based upon selecting Yes or No from the Transport Security Enabled 
list on the Delivery Channel page of this wizard.

Field Value

Digital Signature * Select a digital signature to use. The digital signatures that appear 
are based on the exchange protocol revision you are using:

■ If using RosettaNet - V02.00, select one of the following digital 
signatures:

SMIME 3.0 with SHA-RSA

SMIME 3.0 with MD5-RSA

SMIME 2.0 with SHA-RSA

SMIME 2.0 with MD5-RSA

■ If using AS2 - 1.1 or Generic 1.0, select one of the following 
digital signatures:

SMIME 3.0 with SHA-RSA

SMIME 3.0 with MD5-RSA

Note: Oracle recommends that you select a digital signature that 
uses SHA-RSA.

Signing Credential

■ Name * Select either of the following:

■ Create New and enter a new signing credential name in the 
Name field.

■ Use Existing to access a list to select an existing signing 
credential.

■ Certificate File Click Browse to select a certificate file.
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Page 6: Transport Page

1. Enter a unique and recognizable name for the transport.

2. Select the transport protocol from the Transport Protocol list. The transport 
protocol selections that display are based on whether you selected No or Yes for 
Transport Security Enabled on the Delivery Channel page.

3. If you are using the EDI X12 over Generic Exchange, EDI EDIFACT over Generic 
Exchange, or Custom Document over Generic Exchange business protocol, 
additional transport protocols can be selected:

■ Email - 1.0

■ FTP - 1.0

■ File - 1.0

The page refreshes based on your selection in Step 2 or 3. 

If You Selected... Then...

No Select HTTP - 1.0 or HTTP - 1.1 from the Transport Protocol list.

Yes Select HTTP - 1.0 (Secure) or HTTP - 1.1 (Secure) from the Transport 
Protocol list. Each selection uses secure socket layer (SSL) 3.0.

Note: If you select Email - 1.0, be aware of the following issues:

■ There can be problems if the document being exchanged has large 
records

■ Ensure that the incoming transport From and To headers use 
angle brackets (<,>) in the e-mail ID (for example, 
To=Joe<Joe@abc.com>)



Creating and Assigning All Capabilities During a Single Wizard Session

7-22 Oracle Application Server Integration B2B User’s Guide

4. Enter the following transport server details. An asterisk (*) indicates a required 
field.

5. Accept or override (update) appropriate transport parameter default values in the 
Override Value field of the Parameters section. For example, if you selected HTTP 
or secure HTTP, you can specify values for port and additional transport headers.

6. Enter the following endpoint details. An asterisk (*) indicates a required field.

7. Click Next.

The Create Trading Partner: Review page appears and displays details about the 
type of trading partner to create. 

Field Value

Transport Server

■ Name * Select either of the following:

■ Create New and enter a new transport server in the Name 
field.

■ Use Existing to access a list to select an existing transport 
server.

■ Description Enter a description for the transport server.

■ Host Name * Enter the hostname of the transport server.

Note: If using a generic exchange protocol (EDI X12 over 
Generic Exchange, EDI EDIFACT over Generic Exchange, or 
Custom Document over Generic Exchange) with the HTTP or 
HTTPS transport protocol, enter the IP address to use for 
identifying trading partners. Do not enter the hostname.

■ IP Address Enter the IP address of the transport server.

■ Username Enter the username for logging into the transport server.

■ Password Enter the password of the username.

Field Value

Endpoint

■ URI * Select either of the following:

■ Create New and enter a new endpoint in the URI field.

■ Use Existing to access the Endpoint list to select an 
existing URI. 

Note: Do not select any of the following predefined 
internal endpoints that display in the Endpoints list: 
apps.ECX_INBOUND, apps.ECX_OUTBOUND, b2b.IP_
IN_QUEUE, and b2b.IP_OUT_QUEUE. These endpoints 
are used only with internal delivery channels for 
communication between the host application and 
OracleAS Integration B2B, and cannot be updated or 
deleted. They cannot be used for communication between 
the host trading partner and the remote trading partner.

See Also: "Viewing a Business Protocol Endpoint" on page 8-61 for 
the internal endpoints that apply to each internal delivery channel
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Page 7: Review Page
1. Review the trading partner details. 

■ To modify these details, click the Back button of the Create Trading Partner 
wizard to return to the previous pages. When you complete modifications, 
click Next until you access the review page; then click Finish. Do not use the 
Back and Forward buttons of your Web browser.

■ If you are satisfied with these details, click Finish. 

The remote trading partner is created and the Trading Partner Details page for the 
new trading partner appears. Links to the General, Organization, Users, and 
Capabilities sections display at the top of the page. To simplify your user 
experience, the host trading partner is automatically assigned support for a 
business protocol and operational capabilities that are compatible with those of the 
remote trading partner. You see these details when you create a trading partner 
agreement between the two trading partners.

2. Click the Capabilities section at the top of the page to access the Capabilities page 
for the business protocol you selected in Step 1 on page 7-11. 

3. Click the business protocol in the Name column to access the Business Protocol 
Details page. This page includes details about the operational (support for a 
collaboration or business action) and communication capabilities (delivery 
channel, document exchange, transport, transport server, and endpoint) you 
created with the Create Trading Partner wizard.

Creating and Defining All Capabilities During Separate Wizard Sessions
This method enables you to create a remote trading partner, assign support for a 
business protocol to the remote trading partner, create business protocol operational 
capabilities for the remote trading partner, and create business protocol 
communication capabilities for the host and remote trading partner during separate 
sessions.

This method is useful for environments in which you do not currently know all 
required details or do not plan to use some communication capabilities. You can create 
the trading partner now, and complete remaining details as the information becomes 
known.

Follow these tasks to create the trading partner, assign support for the business 
protocol, and create the business protocol operational capabilities during separate 
wizard sessions. After completing these tasks, you can create the communication 
capabilities during an additional wizard session.

■ Creating a Remote Trading Partner

■ Assigning the Business Protocol to the Remote Trading Partner

■ Creating Business Protocol Operational Capabilities for the Remote Trading 
Partner

■ Creating Business Protocol Communication Capabilities for the Host and Remote 
Trading Partners
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Creating a Remote Trading Partner
1. Click Partners > Trading Partners > Create or Partners > Create Trading Partner 

in the Shortcuts section.

The Create Trading Partner: General page appears.

2. Enter the following details. An asterisk (*) indicates a required field.

3. Click Next.

The Create Trading Partner: Identification page appears.

4. Enter a value for an identification type for the remote trading partner. A 
identification type is required to create a trading partner agreement. The following 
types are automatically included with OracleAS Integration B2B. Additional 
identification types can display here if you created them by clicking 
Administration > Design > Trading Partner Identification Types > Create.

5. Enter an optional description for trading partner identification.

6. Click Finish. You can assign the remote trading partner support for a business 
protocol as needed at a later time.

Assigning the Business Protocol to the Remote Trading Partner
Follow these instructions to assign the business protocol to the remote trading partner.

1. Click Partners > Trading Partners.

2. Select the specific trading partner in the Name column.

Field Value

Name * Enter a unique and recognizable name for the remote trading 
partner.

Description Enter an optional description for the remote trading partner.

Field Value

AS2 Identifier Enter the AS2 identifier. This type is an alias for the service address 
(specified by the AS2-from field) inside an AS2 transaction.

DUNS Enter a DUNS (data universal numbering system) value. 

This type, known formally as a D-U-N-S Number, is a unique, 
sequentially-generated, nine-digit number that you obtain from Dun 
and Bradstreet.

EDI Location Code Enter an EDI location code. 

This type provides a unique identification of all locations relevant to 
the EDI transaction.

Generic Identifier Enter the IP address to use for identifying trading partners if you are 
using the generic exchange protocol (EDI X12 over Generic Exchange, 
EDI EDIFACT over Generic Exchange, or Custom Document over 
Generic Exchange) with the HTTP or HTTPS transport protocol. Do 
not enter the hostname.

See Also: "Creating a Trading Partner Identification Type" on 
page 12-4 for instructions on creating additional trading partner 
identification types
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3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Click Add in the Business Protocols section.

The Add Business Protocol page appears.

5. Select a business protocol to add from the Business Protocol list. See Step 1 of 
"Page 3: Operational Capability Page" on page 7-11 for a list of selections.

6. Click Apply.

The business protocol is assigned and the Capabilities page appears.   

7. Select the new business protocol in the Name column. 

The Business Protocol Details page for the selected business protocol appears.

8. View specific details. Note that the page is divided into two main sections 
(Operational Capabilities and Communication Capabilities) that each consist of 
additional subsections. You can create the operational and communication 
capabilities as needed at a later time.

Creating Business Protocol Operational Capabilities for the Remote Trading Partner
Follow these instructions to assign support for a collaboration or business action (the 
operational capabilities) to the business protocol added in "Assigning the Business 
Protocol to the Remote Trading Partner" on page 7-24. Collaborations and business 
actions describe the business documents and their movement between trading 
partners. Trading partners define their operational capabilities by the collaborations 
and business actions they support. This method uses the Operational Capability page 
of the Create Trading Partner wizard.

1. Click Partners > Trading Partners.

2. Select the specific remote trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select the business protocol to which to add operational capabilities in the Name 
column of the Business Protocols section.

5. Click Create Operational Capability in the Operational Capabilities section.

Section Subsections

Operational Capabilities ■ Supported Collaborations (appears if you 
selected the RosettaNet over RNIF business 
protocol)

■ Supported Business Actions (appears if you 
selected any EDI or Custom Document business 
protocol)

Communication Capabilities ■ Delivery Channels

■ Document Exchanges

■ Transports

■ Transport Servers

■ Endpoints



Creating and Defining All Capabilities During Separate Wizard Sessions

7-26 Oracle Application Server Integration B2B User’s Guide

The page that displays next is based upon the type of business protocol you 
selected in Step 4.

6. Perform the following steps based on the business protocol type you selected.

7. If you selected RosettaNet over RNIF as the business protocol, perform Steps 7a 
through 7d.

a. Make a selection from the Collaboration Role list. Each selection combines a 
role (for example, Buyer), a collaboration (for example, 3A4), and a version 
(for example, V02.00). The selections that appear are based on the types of 
support for collaborations you imported or created.

– Buyer - 3A4 - V02.00

– Buyer - 3A6 - V02.00

– Buyer - 3A7 - V02.00

– Buyer - 3A8 - V02.00

– Failure Report Administrator - 0A1 - V02.00

– PIP Report Administrator - 0A1 - V02.00

– Receiver - 3B2 - V01.00

– Seller - 3A4 - V02.00

– Seller - 3A6 - V02.00

– Seller - 3A7 - V02.00

– Seller - 3A8 - V02.00

– Shipper - 3B2 - V01.00

b. Select Yes or No from the Is acknowledgment handled by Integration B2B? 
list.

c. Enter the time in minutes in which to process the support for a collaboration 
in the Time To Perform field. This value overrides the value defined by the 
collaboration.

d. Click Apply.

Support for a collaboration is created. 

Creating Business Protocol Communication Capabilities for the Host and Remote 
Trading Partners

Follow these instructions to create communication capabilities (delivery channel, 
document exchange, transport, transport server, and endpoint details) for the host 
trading partner and the remote trading partner business protocol added in "Assigning 
the Business Protocol to the Remote Trading Partner" on page 7-24. This method uses 

If You Selected... Go to...

RosettaNet over RNIF Step 7

Any EDI or Custom Document business 
protocol

Steps 4a through 4f on page 7-13. After you 
complete those steps, the Supported Business 
Action Details page appears and displays your 
selections.
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the Delivery Channel, Document Exchange, and Transport pages of the Create Trading 
Partner wizard. A delivery channel is required to create a trading partner agreement.

1. Review the following sections before using the Create Trading Partner wizard.

■ "Create Trading Partner Wizard and Protocol Standards" on page 7-6 for 
details about how the communication capabilities available to you are based 
on the business protocol you select

■ "Prerequisites to Using the Create Trading Partner Wizard" on page 7-7 for 
communication capability prerequisites for using the Create Trading Partner 
wizard

2. Click Partners > Trading Partners.

3. Select the specific trading partner in the Name column.

4. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

5. Select the business protocol to which to add communication capabilities in the 
Name column of the Business Protocols section. See Step 1 on page 7-11 for a list 
of selections.

6. Click Create Communication Capability in the Communication Capabilities 
section.

The Delivery Channel page of the Create Trading Partner wizard appears. This 
wizard guides you through the remaining pages of the wizard (Delivery Channel, 
Document Exchange, Transport, and Review) to create the communication 
capabilities of the remote trading partner.

7. Go to "Page 4: Delivery Channel Page" on page 7-15 and follow the remaining 
pages of the Create Trading Partner wizard.

Common User Errors
■ Do not include beginning or trailing blank spaces in the names of trading partner 

data that you create.

■ The values you select for Is Non-Repudiation of Origin Required and Is 
Non-Repudiation of Receipt Required must match.

■ You must select Yes or No for Is Non-Repudiation of Origin Required, Is 
Non-Repudiation of Receipt Required, and Encryption Enabled if you want to 
include these delivery channel details in a trading partner agreement of a 
deployed configuration.

■ If you are using a business protocol with a generic exchange, you must select 
None from the Acknowledgment Mode list on the Create Trading Partner : 
Delivery Channel page. To avoid additional generic exchange errors, ensure that 
you review all details described in "Generic Exchange Protocol Workarounds" on 
page A-5.

Chapter Summary
This chapter describes how you use the Create Trading Partner wizard to perform the 
following tasks:

■ Create a remote trading partner

■ Assign support for a business protocol to a remote trading partner
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■ Create operational and communication capabilities for a remote trading partner

■ Create communication capabilities for the host trading partner

You can perform these tasks as part of single wizard session or separate wizard 
sessions.

To simplify your user experience, the host trading partner is automatically assigned 
support for a business protocol and operational capabilities that are compatible with 
those of the remote trading partner. You assign only communication capabilities to the 
business protocol of the host trading partner. 
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8
Managing Trading Partners

This chapter describes the tasks required to manage trading partners, support for their 
business protocols, and their business protocol operational and communication 
capabilities.

This chapter contains these topics:

■ Trading Partner Management Overview

■ Managing Trading Partners

■ Managing Trading Partner Identification

■ Managing Trading Partner Agreements of Trading Partners

■ Managing Remote Trading Partner Certificates

■ Managing the Host Trading Partner Wallet Password

■ Managing Trading Partner Contact Information for Persons and Organizations

■ Managing Trading Partner Persons

■ Managing Trading Partner Business Protocols

■ Managing Internal Delivery Channels

■ Managing Business Protocol Collaborations

■ Managing Business Protocol Business Actions

■ Managing Business Protocol Delivery Channels

■ Managing Business Protocol Document Exchanges

■ Managing Business Protocol Transports

■ Managing Business Protocol Transport Servers

■ Managing Business Protocol Endpoints

■ Common User Errors

■ Chapter Summary

See Also: Chapter 7, "Creating Trading Partners" for instructions on 
creating trading partners, assigning support for business protocols, 
and creating business protocol operational and communication 
capabilities
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Trading Partner Management Overview
In Chapter 7, "Creating Trading Partners" you created the remote trading partner, 
assigned support for the business protocol to the remote trading partner, created 
business protocol operational capabilities for the remote trading partner, and created 
business protocol communication capabilities for the host and remote trading partners. 
You can now perform additional trading partner management tasks (for example, 
viewing, updating, deleting, adding, and removing details). The following sections 
provide a brief overview of the pages from which you perform these tasks:

■ Trading Partner Details Page

■ Capabilities Page

■ Business Protocol Details Page

Trading Partner Details Page
Both trading partners have a Trading Partner Details page similar to that shown in 
Figure 8–1. A remote trading partner is shown for this example; the page for the host 
trading partner differs only in that you cannot manage a certificate; instead a method 
for managing a wallet password is provided.

You access the Trading Partner Details page by clicking Partners > Trading Partners > 
trading_partner_name_in_the_Name_column. Four sections display at the top of the 
Trading Partner Details page: General, Organization, Users, and Capabilities. 

Figure 8–1 Trading Partner Details Page

These four sections enable you to access pages from which to perform management 
tasks. Table 8–1 describes the tasks you can access from these sections and provides 
references for more details. 
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Capabilities Page
Clicking Capabilities on the Trading Partner Details page displays the Capabilities 
page shown in Figure 8–2. This page enables you to manage the business protocol 
associated with the trading partner and access a page for managing the operational 
and communication capabilities of the business protocol. The Capabilities page that 
displays in this example is for a remote trading partner; only business protocols that 
you have explicitly assigned to the remote trading partner appear. The Capabilities 
page for a host trading partner displays all business protocols available with OracleAS 
Integration B2B. This is because the host trading partner is automatically assigned 
support for all business protocols and operational capabilities. This simplifies the user 
experience. (See Figure 8–12 on page 8-27 for the Capabilities page of the host trading 
partner.)

Table 8–1 Trading Partner Details Page Management Tasks

Section Management Task Description See Section...

General This is the default page that displays when you first access the 
Trading Partner Details page shown in Figure 8–1. This page enables 
you to manage the following details:

■ Trading Partner Identifications

Enables you to manage the method for uniquely identifying a 
trading partner (for example, a Data Universal Numbering 
System (DUNS) number)

"Managing Trading Partner 
Identification" on page 8-7

■ Associated Agreements

Enables you to manage the trading partner agreement of which 
the trading partner is a part 

"Managing Trading Partner 
Agreements of Trading 
Partners" on page 8-10

■ Certificates (for remote trading partners only)

Enables you to securely bind an identity such as a remote 
trading partner to a public key

"Managing Remote Trading 
Partner Certificates" on 
page 8-11

■ Wallet passwords (for the host trading partner only)

Enables you to store and manage a wallet password

Note: Wallet password management tasks do not display in 
Figure 8–1, which is an example of a Trading Partner Details page for 
a remote trading partner. Instead, see Figure 8–8 on page 8-15.

"Managing the Host Trading 
Partner Wallet Password" on 
page 8-14

Organization Clicking this section displays a page for managing the contact 
information for persons (for example, an e-mail address). (See 
Figure 8–9 on page 8-17 for an example of this page.)

"Managing Trading Partner 
Contact Information for 
Persons and Organizations" 
on page 8-17

Users Clicking this section displays a page for managing OracleAS 
Integration B2B persons. Persons consist of Oracle Application 
Server Integration B2B user interface tool users and persons who can 
optionally review trading partner details (for example, the business 
protocol and operational and communication capabilities assigned to 
a trading partner). (See Figure 8–10 on page 8-20 for an example of 
this page.)

"Managing Trading Partner 
Persons" on page 8-20

Capabilities Clicking this section displays a page for managing the business 
protocol of a trading partner. You can also access a page to manage 
the operational and communication capabilities of the business 
protocol. (See Figure 8–2 on page 8-4.) For the host trading partner, 
internal delivery channels can also be managed from this page.

"Managing Trading Partner 
Business Protocols" on 
page 8-26
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Figure 8–2 Capabilities Page

Business Protocol Details Page
Clicking the business protocol name in the Name column in Figure 8–2 (for this 
example, RosettaNet over RNIF) enables the Business Protocol Details page shown in 
Figure 8–3 to appear.

Figure 8–3 Business Protocol Details Page

Management tasks on the Business Protocol Details page are divided into two sections: 
Operational Capabilities and Communication Capabilities. Table 8–2 describes the 
tasks you can access from these sections and provides references for more details. 

See Also: "Managing Trading Partner Business Protocols" on 
page 8-26 for additional details about the Capabilities pages for both 
host and remote trading partners
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The remaining sections of this chapter provide specific details on managing trading 
partners, support for their business protocols, and the operational and communication 
capabilities of the business protocols.

Managing Trading Partners
The OracleAS Integration B2B user interface tool enables you to perform the remote 
and host trading partner management tasks shown in Figure 8–4. These tasks are 
described in detail in this section. The remote trading partner is the party outside of 
the enterprise of the host trading partner (and its installation of OracleAS Integration 
B2B). The host trading partner is identified by the word (Host) that displays in the 
Trading Partners page shown in Figure 8–4.

Table 8–2 Business Protocol Details Page Management Tasks

Section Management Task Description See Section...

Operational 
Capabilities

This section enables you to manage the following operational 
capabilities:

■ Support for collaborations (these display if you are using the 
RosettaNet over RNIF business protocol)

Enables you to manage the collaborations used between 
trading partners

"Managing Business 
Protocol Collaborations" 
on page 8-40

■ Support for business actions (these display if you are using 
any EDI or Custom Document business protocol)

Enables you to manage the business actions used between 
trading partners

"Managing Business 
Protocol Business Actions" 
on page 8-44

Communication 
Capabilities

This section enables you to manage the following communication 
capabilities:

■ Delivery Channels

Enables you to manage security characteristics such as 
nonrepudiation of origin and receipt, acknowledgment 
mode, time to acknowledge, retry count, transport security, 
encryption, and file compression

"Managing Business 
Protocol Delivery 
Channels" on page 8-47

■ Document Exchanges

Enables you to manage the capabilities for exchanging 
messages with a trading partner

"Managing Business 
Protocol Document 
Exchanges" on page 8-50

■ Transports

Enables you to manage transport protocols, modes, servers, 
and endpoints

"Managing Business 
Protocol Transports" on 
page 8-53

■ Transport Servers

Enables you to manage the endpoint server of the trading 
partner

"Managing Business 
Protocol Transport 
Servers" on page 8-56

■ Endpoints

Enables you to manage the endpoint address (typically a URI) 
of a trading partner

"Managing Business 
Protocol Endpoints" on 
page 8-59
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Figure 8–4 Trading Partner Management Tasks

Table 8–3 identifies the trading partner management tasks shown in Figure 8–4 and 
provides references to procedures for performing these tasks.

Viewing a Host or Remote Trading Partner
Follow these instructions to view details about a host or remote trading partner:

1. Click Partners > Trading Partners.

2. Select a specific trading partner to view in the Name column. 

The Trading Partner Details page for the selected trading partner appears.

3. View specific details, including the following:

■ Trading partner identification type and value (for example, a DUNS number, 
EDI location code, or AS2 Identifier) of the trading partner

■ Trading partner agreements and their current state (for example, Draft) with 
which this trading partner is associated

■ Remote trading partner certificate name and location (The host trading partner 
uses a wallet password instead of a certificate.)

See Figure 8–5 on page 8-8 for an example of the Trading Partner Details page. The 
Trading Partner Details page, as with the Trading Partners page shown in 
Figure 8–4 on page 8-6, enables you to delete or update a remote trading partner 
and update the host trading partner.

Links to the General, Organization, Users, and Capabilities sections also display 
at the top of the page. 

Table 8–3 Trading Partner Management Tasks

Page Elements Management Task See Section...

Shortcut section in 
Trading Partners page 
of Figure 8–4

Take a shortcut to create a 
trading partner agreement

"Managing Trading Partner 
Agreements" on page 10-5

Create button of 
Trading Partners page 
of Figure 8–4

Create a remote trading partner 
(the host trading partner is 
automatically created)

"Trading Partner Creation Overview" 
on page 7-2

Name column of 
Trading Partners page 
of Figure 8–4

View details about a host or 
remote trading partner

"Viewing a Host or Remote Trading 
Partner" on page 8-6

Update column of 
Trading Partners page 
of Figure 8–4

Update a host or remote 
trading partner

"Updating a Host or Remote Trading 
Partner" on page 8-7

Delete column of 
Trading Partners page 
of Figure 8–4

Delete a remote trading partner 
(you cannot delete the host 
trading partner)

"Deleting a Remote Trading Partner" 
on page 8-7
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4. Click Return to List to return to the Trading Partners page.

Updating a Host or Remote Trading Partner
The remote trading partner name is the name you entered when creating a remote 
trading partner in Chapter 7, "Creating Trading Partners". The host trading partner is 
automatically named MyCompany after installation. You can change the host name to 
one that more accurately reflects your organization or company (for example, ipdev, 
which appears in Figure 8–4 on page 8-6). Follow these instructions to update the 
name (or description) of a host or remote trading partner. 

1. Click Partners > Trading Partners.

2. Select a specific trading partner name to update in the Update column. 

The Update Trading Partner page appears.

3. Make appropriate changes to the name (or description) of the trading partner.

4. Click Apply.

The trading partner is updated and the Trading Partners Details page appears.

Deleting a Remote Trading Partner
Follow these instructions to delete a remote trading partner:

1. Click Partners > Trading Partners.

2. Select a specific remote trading partner to delete in the Delete column.

3. Click Yes when prompted to delete a remote trading partner. 

The remote trading partner is deleted and the Trading Partners page appears.

Managing Trading Partner Identification
The OracleAS Integration B2B user interface tool enables you to perform the trading 
partner identification management tasks shown in Figure 8–5. These tasks are 
described in detail in this section. The trading partner identification value is separate 
from the trading partner name and provides an additional method to uniquely 
identify a trading partner. Trading partner identification consists of a type and a value 
and is required to create a trading partner agreement. A trading partner identification 
type called Name with a value of MyCompany is automatically created for the host 
trading partner. When you create a remote trading partner, a trading partner 
identification type called Name with a value of the remote trading partner’s name is 
also automatically created.

See Also:

■ "Exporting Partner Data to an XML File" on page 4-10 for 
details on the Export button that displays on Trading Partner 
Details pages 

■ "Viewing the State of Partner Data on the Details Pages" on 
page 4-12 for details on the Draft, Approved, and Deployed 
states that display on Trading Partner Details pages

Note: You cannot delete the host trading partner. Only remote 
trading partners can be deleted.
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Figure 8–5 Trading Partner Identification Management Tasks

Table 8–4 identifies the trading partner identification management tasks shown in 
Figure 8–5 and provides references to procedures for performing these tasks.

Creating Trading Partner Identification
Follow these instructions to create trading partner identification for the host or remote 
trading partner. The Create Trading Partner wizard also enables you to create an 
identification for the remote trading partner. Trading partner identification is required 
to create a trading partner agreement. A default trading partner identification type 
called Name is automatically provided for host and remote trading partners.

1. Click Partners > Trading Partners.

Table 8–4 Trading Partner Identification Management Tasks

Page Elements Management Task See Section...

Create button in Trading 
Partner Identifications section 
of Figure 8–5

Create trading partner 
identification

"Creating Trading Partner 
Identification" on page 8-8

Details column in Trading 
Partner Identifications section 
of Figure 8–5

View details about trading 
partner identification

"Viewing a Trading Partner 
Identification" on page 8-9

Update column in Trading 
Partner Identifications section 
of Figure 8–5

Update trading partner 
identification 

"Updating a Trading 
Partner Identification" on 
page 8-10

Delete column in Trading 
Partner Identifications section 
of Figure 8–5

Delete trading partner 
identification 

"Deleting a Trading Partner 
Identification" on page 8-10

Note: The trading partner identification type and value also display 
in the Trading Partner Identification Type and Value columns, 
respectively, of the Trading Partner Identifications section. (See 
Figure 8–5.)
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2. Select a specific trading partner in the Name column.

3. Click Create in the Trading Partner Identifications section.

The Create Trading Partner Identification page displays the fields for creating 
trading partner identification.

4. Enter the following details to create trading partner identification. An asterisk (*) 
indicates a required field. Additional identification types can display here if you 
created them by clicking Administration > Design > Trading Partner 
Identification Types > Create. 

5. Click Apply.

Trading partner identification is created and the new Trading Partner 
Identification Details page appears.

Viewing a Trading Partner Identification
Follow these instructions to view details about a specific trading partner identification:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Select a specific trading partner identification to view in the Details column of the 
Trading Partner Identifications section.

The Trading Partner Identification Details page for the selected trading partner 
identification appears.

Field Value

Trading Partner 
Identification 
Type* 

Select a type from the available values. 

■ DUNS

DUNS (data universal numbering system) known formally as a 
D-U-N-S Number, is a unique, sequentially-generated, nine-digit 
number that you obtain from Dun and Bradstreet.

■ EDI Location Code

Provides a unique identification of all locations relevant to the EDI 
transaction.

■ AS2 Identifier

An alias for the service address (specified by the AS2-from field) 
inside an AS2 transaction. 

■ Generic Identifier

The Internet Protocol (IP) address to use for identifying trading 
partners if you are using the generic exchange protocol (EDI X12 over 
Generic Exchange, EDI EDIFACT over Generic Exchange, or Custom 
Document over Generic Exchange) with the HTTP or HTTPS transport 
protocol. Do not enter the hostname. 

Value * Enter a value for the selected type. For example, if DUNS is your type, 
enter the DUNS number.

Description Provide an optional description.

See Also: "Page 2: Identification Page" on page 7-10 for an 
alternative method of creating trading partner identification for a 
remote trading partner with the Create Trading Partner wizard
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4. View specific details about the trading partner identification type and value (for 
example, a DUNS number, EDI location code, or AS2 identifier value).

This page, as with the Trading Partner Details page shown in Figure 8–5 on 
page 8-8, enables you to delete or update a trading partner identification that you 
created. You cannot delete the default type of Name.

Updating a Trading Partner Identification
Follow these instructions to update trading partner identification that you created. A 
trading partner identification type called Name that is automatically provided for the 
host and remote trading partners cannot be updated.

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Select a specific trading partner identification to update in the Update column of 
the Trading Partner Identifications section.

The Update Trading Partner Identification page appears.

4. Make appropriate changes. (See Step 4 on page 8-9 for a list of fields you can 
update.)

5. Click Apply.

The trading partner identification is updated and the Trading Partner 
Identification Details page appears.

Deleting a Trading Partner Identification
Follow these instructions to delete trading partner identification that you created. A 
trading partner identification called Name that is automatically provided for the host 
and remote trading partners cannot be deleted.

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Select a specific trading partner identification to delete in the Delete column of the 
Trading Partner Identifications section.

4. Click Yes when prompted to delete trading partner identification.

The trading partner identification is deleted and the Trading Partner Details page 
appears.

Managing Trading Partner Agreements of Trading Partners
The OracleAS Integration B2B user interface tool enables you to perform the trading 
partner associated agreement management tasks shown in Figure 8–6. The associated 
agreement is the trading partner agreement of which the trading partner is a part. This 
agreement defines the behavior that trading partners agree to follow when engaging in 
a business transaction.
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Figure 8–6 Trading Partner Associated Agreement Management Tasks

Table 8–5 identifies the trading partner associated agreement management tasks 
shown in Figure 8–6 and provides references to procedures for performing these tasks.

Managing Remote Trading Partner Certificates
The OracleAS Integration B2B user interface tool enables you to perform the remote 
trading partner certificate management tasks shown in Figure 8–7. These tasks are 
described in detail in this section. A certificate securely binds an identity such as a 
trading partner to a public key. A certificate is created when a trading partner’s public 
key is signed by a trusted identity known as a certificate authority (CA). This 
certificate ensures that the trading partner's partner data is correct and that the public 
key actually belongs to that trading partner during business transactions.

The host trading partner does not use a certificate. Instead, the host trading partner 
uses a wallet password for security.

Table 8–5 Trading Partner Associated Agreement Management Tasks

Page Elements Management Task See Section...

Name column in Associated 
Agreements section of 
Figure 8–6

View the trading partner 
agreement with which a 
trading partner is associated

"Viewing a Trading Partner 
Agreement" on page 10-8

Update column in Associated 
Agreements section of 
Figure 8–6

Update the trading partner 
agreement with which a 
trading partner is associated

"Updating a Trading 
Partner Agreement" on 
page 10-9

Delete column in Associated 
Agreements section of 
Figure 8–6

Delete the trading partner 
agreement with which a 
trading partner is associated

"Deleting a Trading Partner 
Agreement" on page 10-10

Note: The State column of the Associated Agreements section 
shown in Figure 8–6 displays the current state of the trading partner 
agreement.
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Figure 8–7 Remote Trading Partner Certificate Management Tasks

Table 8–6 identifies the remote trading partner certificate management tasks shown in 
Figure 8–7 and provides references to procedures for performing these tasks.

Note: The Create button in the Certificates section displays only 
for remote trading partners. Host trading partners create a wallet 
password and specify a directory location on the Trading Partner 
Details page of the host trading partner.

Table 8–6 Remote Trading Partner Certificate Management Tasks

Page Elements Management Task See Section...

Create button in Certificates 
section of Figure 8–7

Create a remote trading partner 
certificate

"Creating a Remote Trading 
Partner Certificate" on 
page 8-13

Name column in Certificates 
section of Figure 8–7

View details about a remote 
trading partner certificate

"Viewing a Remote Trading 
Partner Certificate" on 
page 8-13

Update column in Certificates 
section of Figure 8–7

Update a remote trading 
partner certificate

"Updating a Remote 
Trading Partner Certificate" 
on page 8-14

Delete column in Certificates 
section of Figure 8–7

Delete a remote trading partner 
certificate

"Deleting a Remote Trading 
Partner Certificate" on 
page 8-14

Note: The certificate file name displays in the Certificate Location 
column of the Certificates section. (See Figure 8–7.)

See Also: "Managing the Host Trading Partner Wallet Password" on 
page 8-14 for instructions on managing the wallet password for the 
host trading partner
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Creating a Remote Trading Partner Certificate
Follow these instructions to create a remote trading partner certificate. You can then 
assign nonrepudiation and enable encryption to this certificate by clicking Partners > 
Trading Partners > trading_partner_name_in_the_Name_column > Capabilities > 
business_protocol_name_in_Name_column > Create Communication Capabilities. 
On the Delivery Channel page that appears, enable nonrepudiation of origin, 
nonrepudiation of receipt, or encryption. On the Document Exchange page that 
follows, select Use Existing in the Signing Credential section. The remote trading 
partner certificate created in this section appears in the Certificate list.

The Create Trading Partner wizard also enables you to create and assign a certificate to 
a remote trading partner during a single wizard session. 

1. Click Partners > Trading Partners.

2. Select a specific remote trading partner in the Name column.

3. Click Create in the Certificates section.

The Create Certificate page appears.

4. Enter the following details to create a remote trading partner certificate. An 
asterisk (*) indicates a required field.

5. Click Apply.

The remote trading partner certificate is created and the new Certificate Details 
page appears. 

Viewing a Remote Trading Partner Certificate
Follow these instructions to view details about a specific remote trading partner 
certificate:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Select a specific certificate to view in the Name column of the Certificates section.

The Certificate Details page for the selected certificate appears.

4. View the certificate file name.

This page, as with the Trading Partner Details page shown in Figure 8–7 on 
page 8-12, enables you to delete or update the selected certificate.

5. Click Return to List to return to the Trading Partner Details page.

Field Value

Name * Enter a unique and recognizable name for the remote trading partner 
certificate.

Certificate File * Click Browse to select the remote trading partner certificate file. 

See Also: "Page 4: Delivery Channel Page" on page 7-15 and "Page 5: 
Document Exchange Page" on page 7-17 for an alternative method of 
creating a remote trading partner certificate with the Create Trading 
Partner wizard
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Updating a Remote Trading Partner Certificate
Follow these instructions to update a remote trading partner certificate:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Select a specific certificate to update in the Update column of the Certificates 
section.

The Update Certificate page appears.

4. Make appropriate changes. (See Step 4 on page 8-13 for a list of fields you can 
update.) Note that the Certificate File field is empty. You must upload the file 
again.

5. Click Apply.

The remote trading partner certificate is updated and the Certificate Details page 
appears.

Deleting a Remote Trading Partner Certificate
Follow these instructions to delete a remote trading partner certificate. You cannot 
delete a remote trading partner certificate that you created in "Creating a Remote 
Trading Partner Certificate" on page 8-13 and assigned to a remote trading partner 
under Create Communication Capability. You must first delete the delivery channel 
associated with that document exchange. Then you can delete it.

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Select a specific remote trading partner certificate to delete in the Delete column of 
the Certificates section.

4. Click Yes when prompted to delete a remote trading partner certificate.

The remote trading partner certificate is deleted and the Trading Partner Details 
page appears.

Managing the Host Trading Partner Wallet Password
The OracleAS Integration B2B user interface tool enables you to perform the host 
trading partner wallet password management tasks shown in Figure 8–8. These tasks 
are described in detail in this section. A wallet is a container in which certificates and 
trusted certificates are stored and managed. These data structures securely store a user 
private key, a user certificate, and a set of trusted certificates. A wallet password opens 
the user's wallet. 

When you create or update the wallet password on a previously validated Trading 
Partner Details page (that is, the State section displays as Approved), the state reverts 
to Draft and the Validate button reappears. You must revalidate the host trading 
partner by clicking Validate. 

A remote trading partner does not use a wallet password. Instead, the remote trading 
partner uses a remote certificate for security.
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Figure 8–8 Host Trading Partner Wallet Password Management Tasks

Table 8–7 identifies the host trading partner wallet password management tasks 
shown in Figure 8–8 and provides references to procedures for performing these tasks.

Creating a Host Trading Partner Wallet Password
An Oracle Wallet is automatically created during installation in ORACLE_
HOME/Apache/Apache/conf/ssl.wlt/default/ewallet.p12 on your Oracle 
Application Server middle tier. The initial password is welcome. Perform the 
following tasks in Oracle Wallet Manager:

■ Change the initial password 

■ Export the Oracle Wallet

■ Name the file ora_wallet.txt

After that, you can create a host trading partner wallet password on the Trading 
Partner Details page of the host trading partner. This password must match the Oracle 

Table 8–7 Host Trading Partner Wallet Password Management Tasks

Page Elements Management Task See Section...

Create button to the right of 
Wallet Password in the Details 
section of Figure 8–8

Create a wallet password "Creating a Host Trading 
Partner Wallet Password" 
on page 8-15

Update button of Figure 8–8

Note: This button displays to 
the right of Wallet Password in 
the Details section only after 
the wallet password has been 
created.

Update a wallet password "Updating a Host Trading 
Partner Wallet Password" 
on page 8-16

See Also: "Managing Remote Trading Partner Certificates" on 
page 8-11 for instructions on managing the certificate for the remote 
trading partner
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Wallet password. Follow these instructions to create a host trading partner wallet 
password:

1. Click Partners > Trading Partners.

2. Select the host trading partner in the Name column. The host trading partner is 
identified by the word (Host).

3. Click Create to the right of Wallet Password in the Details section.

The Create Host Wallet Password page appears.

4. Enter the following details to create a wallet password. An asterisk (*) indicates a 
required field.

5. Click Apply. The password is stored in encrypted format. 

The Create button to the right of Wallet Password in the Details section now 
always displays as the Update button.

6. Go to Oracle Enterprise Manager 10g Application Server Control Console and 
specify the directory for the wallet location with the OracleAS Integration B2B 
Wallet Location configuration parameter (for example, ORACLE_
HOME/Apache/Apache/conf/ssl.wlt/default/ora_wallet.txt).

Updating a Host Trading Partner Wallet Password
If you later update the wallet password in Oracle Wallet Manager, you must also 
update the password with the same value in the OracleAS Integration B2B user 
interface tool. Follow these instructions to update a host trading partner wallet 
password:

1. Click Partners > Trading Partners.

2. Select the host trading partner in the Name column.

3. Click Update to the right of Wallet Password in the Details section.

The Update Host Wallet Password page appears.

Field Value

New Wallet Password Enter the same wallet password that you created in Oracle 
Wallet Manager.

Confirm New Password Enter the same wallet password a second time.

See Also:

■ "OracleAS Integration B2B Middle-Tier Instance Server Properties" 
on page 13-8 for instructions on changing configuration 
parameters such as Wallet Location

■ Oracle Application Server Security Guide for instructions on using 
Oracle Wallet Manager

Note: You cannot update the wallet password in the OracleAS 
Integration B2B user interface tool without first updating it in 
Oracle Wallet Manager. 
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4. Make appropriate changes. (See Step 4 of "Creating a Host Trading Partner Wallet 
Password" on page 8-16 for a list of fields that you can update.) Ensure that the 
password matches the one you first specified in Oracle Wallet Manager.

5. Click Apply.

The host trading partner wallet password is updated and the Trading Partner 
Details page appears.

Managing Trading Partner Contact Information for Persons and 
Organizations

The OracleAS Integration B2B user interface tool enables you to perform the person 
and organization contact information management tasks shown in Figure 8–9. These 
tasks are described in detail in this section. Contact information is the method by 
which to contact a user or organization (such as an e-mail address or phone number).

Figure 8–9 Person and Organization Contact Information Management Tasks

Table 8–8 identifies the person and organization contact information management 
tasks shown in Figure 8–9 and provides references to procedures for performing these 
tasks.

Table 8–8 Person and Organization Contact Information Management Tasks

Page Elements Management Task See Section...

Create button of Contact 
Information section of 
Figure 8–9 

Create contact information for 
a person or organization

"Creating Contact 
Information for a Trading 
Partner Person or 
Organization" on page 8-18

Contact Type column of 
Contact Information section of 
Figure 8–9

View details about contact 
information for a person or 
organization

"Viewing Contact 
Information for a Trading 
Partner Person or 
Organization" on page 8-18

Contact Type column of 
Contact Information section of 
Figure 8–9 (to access the page to 
update contact information for 
a person or organization)

Update contact information for 
a person or organization

"Updating Contact 
Information for a Trading 
Partner Person or 
Organization" on page 8-19

Contact Type column of 
Contact Information section of 
Figure 8–9 (to access the page to 
delete contact information for a 
person or organization)

Delete contact information for 
a person or organization

"Deleting Contact 
Information for a Trading 
Partner Person or 
Organization" on page 8-20

Note: The contact information value (for example, an e-mail address) 
displays in the Value column of the Contact Information section. (See 
Figure 8–9.)
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Creating Contact Information for a Trading Partner Person or Organization
Follow these instructions to create contact information for a specific trading partner 
person or organization:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Perform the following steps based on the type of contact information to create:

The Create Contact Information page appears.

4. Enter the following details to create person or organization contact details. An 
asterisk (*) indicates a required field.

5. Click Apply.

The Contact Information Details page appears.

Viewing Contact Information for a Trading Partner Person or Organization
Follow these instructions to view details about contact information for a specific 
trading partner person or organization:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Perform the following steps based on the type of contact information to view:

To Create Contact Information For... Perform These Steps...

A person 1. Click Users at the top of the Trading Partner 
Details page.

2. Select a specific person in the Name column of 
the People section.

3. Click Create in the Contact Information section.

An organization 1. Click Organization at the top of the Trading 
Partner Details page.

2. Click Create in the Contact Information section.

Field Value

Contact Type * Select one of the automatically available contact types (Contact Name, Email, 
Fax, or Phone)

Value Enter a value for the selected contact type. For example, if you select Phone as 
the contact type, enter a phone number in this field.

Note: Contact type creation does not cause a person to be 
automatically contacted when a specific condition occurs, such as 
the need to review a trading partner agreement. You must 
manually contact a person through the selected contact type 
method.
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The Contact Information Details page appears.

4. View specific details about the contact type and method for contacting the person.

5. Click Return to List.

Updating Contact Information for a Trading Partner Person or Organization
Follow these instructions to update contact information for a specific trading partner 
person or organization:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Perform the following steps based on the type of contact information to update:

The Update Contact Information page appears.

4. Make appropriate changes to the contact type (for example, Contact Name, 
E-mail, Fax, or Phone) or value. 

5. Click Apply.

To View Contact Information For... Perform These Steps...

A person 1. Click Users at the top of the Trading Partner 
Details page.

2. Select a specific person for which to view 
contact information in the Name column of the 
People section.

3. Click a specific contact type in the Contact Type 
column of the Contact Information section.

An organization 1. Click Organization at the top of the Trading 
Partner Details page.

2. Click a specific contact type in the Contact Type 
column of the Contact Information section.

To Update Contact Information For... Perform These Steps...

A person 1. Click Users at the top of the Trading Partner 
Details page.

2. Select a specific person for which to update 
contact information in the Name column of the 
People section.

3. Select the contact information to update in the 
Contact Type column of the Contact 
Information section.

4. Click Update on the Contact Information 
Details page.

An organization 1. Click Organization at the top of the Trading 
Partner Details page.

2. Select the contact information to update in the 
Contact Type column of the Contact 
Information section.

3. Click Update on the Contact Information 
Details page.
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The contact information is updated and the Contact Information Details page 
appears.

Deleting Contact Information for a Trading Partner Person or Organization
Follow these instructions to delete contact information for a specific trading partner 
person or organization:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Perform the following steps based on the type of contact information to update:

4. Click Yes when prompted to delete the contact information.

5. Click Apply.

The contact information is deleted.

Managing Trading Partner Persons
The OracleAS Integration B2B user interface tool enables you to perform the person 
management tasks shown in Figure 8–10. These tasks are described in detail in this 
section. A person can be an OracleAS Integration B2B user interface tool user or a 
reviewer of trading partner and trading partner agreement details.

Figure 8–10 Person Management Tasks

To Delete Contact Information For... Perform These Steps...

A person 1. Click Users at the top of the Trading Partner 
Details page.

2. Select a specific person for which to delete 
contact information in the Name column of the 
People section.

3. Select the contact information to delete in the 
Contact Type column of the Contact 
Information section.

4. Click Delete on the Contact Information Details 
page.

An organization 1. Click Organization at the top of the Trading 
Partner Details page.

2. Select the contact information to delete in the 
Contact Type column of the Contact 
Information section.

3. Click Delete on the Contact Information Details 
page.
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You can create two person types in the People section: 

■ Host trading partner person (if you select the host trading partner)

■ Remote trading partner person (if you select a remote trading partner)

These two person types have different capabilities, as shown in Table 8–9.

Table 8–10 identifies the person management tasks shown in Figure 8–10 and provides 
references to procedures for performing these tasks.

Table 8–9 Person Capabilities

Capability
Host Trading 
Partner Person

Remote Trading 
Partner Person

Use the OracleAS Integration B2B user interface tool to:

■ Manage (create, view, update, and delete) partner 
data

■ Deploy and administer a configuration

■ Create reports

Note: The Administrator role must be assigned to a host 
trading partner person before they can use the OracleAS 
Integration B2B user interface tool. This role provides the 
user with access to the functionality of the entire user 
interface tool. The Reports role can be assigned to users 
who require access to only the functionality of the Reports 
tab of the user interface tool.

A person created for a remote trading partner cannot use 
the OracleAS Integration B2B user interface tool.

Yes No

Can add user roles and use cases (privileges) to the person 
type

Yes No

Table 8–10 Person Management Tasks

Page Elements Management Task See Section...

Create button in People section 
of Figure 8–10

Create a person for a trading 
partner

"Creating a Trading Partner 
Person" on page 8-22

Name column in People section 
of Figure 8–10 

View details about a person of 
a trading partner and update 
the person password

"Viewing a Trading Partner 
Person and Updating the 
Person Password" on 
page 8-22

Update column in People 
section of Figure 8–10

Update a person of a trading 
partner

"Updating a Trading 
Partner Person" on 
page 8-23

Delete column in People 
section of Figure 8–10

Delete a person of a trading 
partner

"Deleting a Trading Partner 
Person" on page 8-23

Name column in People section 
of Figure 8–10 (to access the 
page to assign a user role)

Assign a user role to a host 
trading partner person

"Assigning a User Role to a 
Host Trading Partner 
Person" on page 8-24

Name column in People section 
of Figure 8–10 (to access the 
page to remove a user role)

Remove a user role from a host 
trading partner person

"Removing a User Role 
from a Host Trading 
Partner Person" on 
page 8-24
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Creating a Trading Partner Person
Follow these instructions to create a trading partner person. This person can be a 
reviewer of trading partner agreement details. If this person is created for the host 
trading partner, they can also use the OracleAS Integration B2B user interface tool.

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Users at the top of the Trading Partner Details page.

The Users page for the selected trading partner appears.

4. Click Create in the People section. 

5. Enter the following details to create a trading partner person. An asterisk (*) 
indicates a required field.

6. Click Apply.

The trading partner person is created and the Person Details page appears. At this 
point, this person cannot use the OracleAS Integration B2B user interface tool. 
They must now be assigned a user role.

7. Click Return to List to return to the Users page.

Viewing a Trading Partner Person and Updating the Person Password
Follow these instructions to view details about a specific trading partner person and 
update the person password of a host trading partner:

1. Click Partners > Trading Partners.

Name column in People section 
of Figure 8–10 (to access the 
page to view user roles and use 
case groups)

View user roles and use case 
groups

"Viewing User Roles and 
Use Case Group Details" on 
page 8-25

Field Value

Name * Enter a unique and recognizable person name.

Password * Enter a password.

Note: If you are creating a remote trading partner person, then you can ignore 
this field. If you are creating a host trading partner person, enter a password if 
you want to later add the following user roles: 

■ The Administrator role for persons requiring access to the functionality of 
the entire OracleAS Integration B2B user interface tool

■ The Reports role for persons (such as business analysts) requiring access to 
the functionality of only the Reports tab of the user interface tool

Description Provide an optional description.

See Also:

■ Table 8–9 on page 8-21 for the capabilities of this person

■ "Assigning a User Role to a Host Trading Partner Person" on 
page 8-24

Table 8–10 (Cont.) Person Management Tasks

Page Elements Management Task See Section...
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2. Select a specific trading partner in the Name column. 

3. Click Users at the top of the Trading Partner Details page.

The Users page for the selected trading partner appears.

4. Select a specific trading partner person to view in the Name column of the People 
section.

The Person Details page for the selected trading partner person appears.

5. View specific details, including the method for contacting the person (for example, 
an e-mail address).

6. If you want to update the trading partner person password, click Update in the 
Details section.

The Update Person Password page appears.

7. Enter the following details to update a person password.

8. Click Apply. 

The Person Details page appears.

9. Click Return to List to return to the Users page.

Updating a Trading Partner Person
Follow these instructions to update a trading partner person:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Users at the top of the Trading Partner Details page.

The Users page for the selected trading partner appears.

4. Select a specific trading partner person to update in the Update column of the 
People section.

The Update Person page appears.

5. Make appropriate changes to the name or description. 

6. Click Apply.

The trading partner person is updated and the Person Details page appears.

Deleting a Trading Partner Person
Follow these instructions to delete a trading partner person:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Users at the top of the Trading Partner Details page.

The Users page for the selected trading partner appears.

Field Value

New Password Enter a new password.

Confirm New Password Enter the new password a second time.
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4. Select a specific trading partner person to delete in the Delete column of the 
People section.

5. Click Yes when prompted to delete a trading partner person.

The trading partner person is deleted and the Trading Partner Details page 
appears.

Assigning a User Role to a Host Trading Partner Person
You can add a user role to a host trading partner person, but not to a remote trading 
partner person. A user role is the group of related use cases (privileges) that permit a 
person to connect to and perform tasks with the OracleAS Integration B2B user 
interface tool. Follow these instructions to add a user role to a person:

1. Click Partners > Trading Partners.

2. Select the host trading partner in the Name column.

3. Click Users at the top of the Trading Partner Details page.

The Users page for the host trading partner appears.

4. Select a specific person in the Name column.

The Person Details page appears.

5. Click Add in the User Roles section to add a user role to the host trading partner 
person.

The Create User Role Enrollment page appears.

6. Select one of the following roles from the User Role list:

■ The Administrator role for persons requiring access to the functionality of the 
entire OracleAS Integration B2B user interface tool (that is, the Partners, 
Deployment, Reports, and Administration tabs)

■ The Reports role for persons (such as business analysts) requiring access to 
only the functionality of the Reports tab of the OracleAS Integration B2B user 
interface tool

7. Click Apply.

The user role is added and the Person Details page appears. If the person does not 
have a password, you receive an error and the user role is not added. 

8. Click Apply.

The Person Details page appears.

Removing a User Role from a Host Trading Partner Person
You can remove a user role from a host trading partner person that you created, but 
not from a remote trading partner person (they have none). You cannot remove the 
Administrator role from the default host trading partner user of admin. Follow these 
instructions to remove a user role from a person:

See Also: "Viewing a Trading Partner Person and Updating the 
Person Password" on page 8-22 if you need to add a password to 
the host trading partner person
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1. Click Partners > Trading Partners.

2. Select the host trading partner in the Name column.

3. Click Users at the top of the Trading Partner Details page.

The Users page for the host trading partner appears.

4. Select a specific person in the Name column.

The Person Details page appears.

5. Select a user role to remove in the Remove column of the User Roles section. 

6. Click Yes when prompted to remove the user role.

The user role is removed and the Person Details page appears.

Viewing User Roles and Use Case Group Details
User roles consist of use case groups that include the use cases (privileges) that permit 
a person to perform tasks with the OracleAS Integration B2B user interface tool. 

Follow these instructions to view the user role and its associated use case group 
details:

1. Click Partners > Trading Partners.

2. Select the host trading partner in the Name column.

3. Click Users at the top of the Trading Partner Details page.

The Users page for the host trading partner appears.

4. Select a specific person in the Name column.

The Person Details page appears.

5. Select the Administrator or Reports role in the Name column of the User Roles 
section.

The User Role Details page appears.

6. View specific details, including a description of the user role, the state of the role, 
and the use case group of the role.

7. Click the use case group in the Name column of the Use Case Groups section.

8. View the specific use cases assigned to the use case group of the role.

9. Click Return to List to return to the User Role Details page.

10. Click Return to List to return to the Person Details page.

Caution: If you remove a user role from a host trading partner 
person that you created, that person no longer has privileges to use 
the Oracle Application Server Integration B2B user interface tool.

Note: You cannot create, delete, or update user roles or use case 
groups.
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Managing Trading Partner Business Protocols
The OracleAS Integration B2B user interface tool enables you to perform the business 
protocol management tasks shown in Figure 8–11 and Figure 8–12. These tasks are 
described in detail in this section. The business protocol identifies the implementation 
guidelines for the reliable transport of business document messages between trading 
partners. Each trading partner must have support for a business protocol with 
operational and communication capabilities. A business protocol consists of the 
following three protocols:

■ Document protocol

Defines the document types of the message payload. Document protocols are 
defined as part of the operational capabilities of the business protocol in the 
OracleAS Integration B2B user interface tool

■ Exchange protocol 

Defines the message exchange mechanism—how to exchange the documents 
defined by the document protocol. It defines the headers, the acknowledgments, 
and the packaging that puts the headers and payload together.

■ Process protocol 

Defines how documents are exchanged. Process protocols are defined as part of 
the operational capabilities of the business protocol in the OracleAS Integration 
B2B user interface tool. OracleAS Integration B2B includes a single process 
protocol called the B2B process. The process protocol consists of support for 
collaborations (for the RosettaNet over RNIF business protocol) or business 
actions (for any EDI or Custom Document business protocol).

Figure 8–11 shows a business protocol for a remote trading partner (RosettaNet over 
RNIF in this example). You must use the OracleAS Integration B2B user interface tool 
to assign support for a business protocol to a remote trading partner. 

Figure 8–11 Business Protocol Management Tasks (Remote Trading Partner)

Figure 8–12 shows the business protocols for the host trading partner. Support for all 
business protocols in the OracleAS Integration B2B user interface tool is automatically 
assigned to the host trading partner. These business protocols cannot be removed.
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Figure 8–12 Business Protocol Management Tasks (Host Trading Partner)

Table 8–11 identifies the business protocol management tasks shown in Figure 8–11 
and Figure 8–12 and provides references to procedures for performing these tasks.

Assigning a Business Protocol
The procedural tasks to follow to assign a business protocol are different for a remote 
or host trading partner. The remote trading partner assigns support for a business 
protocol either during or separate from a session of the Create Trading Partner wizard. 
The host trading partner is automatically assigned support for all business protocols. 
Table 8–12 identifies each task and provides references to procedures for performing 
these tasks.

Table 8–11 Business Protocol Management Tasks

Page Elements Management Task See Section...

Add button in Figure 8–11 (for 
remote trading partners) 

Note: The host trading partner 
is automatically assigned 
support for all business 
protocols. (See Figure 8–12.)

Add a business protocol to a 
remote trading partner

"Assigning a Business 
Protocol" on page 8-27

Name column of Figure 8–11 or 
Figure 8–12

View details about a business 
protocol

"Viewing a Business 
Protocol" on page 8-28

Exchange Protocol column of 
Figure 8–11 or Figure 8–12

View details about the 
exchange protocol of a 
business protocol

"Viewing an Exchange 
Protocol" on page 8-29

Document Protocol column of 
Figure 8–11 or Figure 8–12

View details about the 
document protocol of a 
business protocol

"Viewing a Document 
Protocol" on page 8-29

Remove column of Figure 8–11

Note: The business protocol 
supported by the host trading 
partner cannot be removed. 
(See Figure 8–12.)

Remove support for a business 
protocol from a remote trading 
partner

"Removing a Business 
Protocol from a Remote 
Trading Partner" on 
page 8-30

Name column of Figure 8–11 or 
Figure 8–12 (for accessing a 
page to select the B2B process 
protocol)

View details about the process 
protocol of a business protocol

"Viewing a Process 
Protocol" on page 8-30
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Viewing a Business Protocol
Follow these instructions to view details about a specific business protocol:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol to view in the Name column.

The Business Protocol Details page for the selected business protocol appears.

5. View specific details, including the associated document, exchange, and process 
protocols listed in the Details section near the top. In addition, the following 
sections display on this page. (See Figure 8–15 on page 8-41 for an example.)

Table 8–12 Adding a Business Protocol to Remote and Host Trading Partners

Task See Section...

For Remote Trading Partners:

■ Create the trading partner and assign support for the business 
protocol and all its operational and communication capabilities 
during a single Create Trading Partner wizard session

"Creating and Assigning All Capabilities 
During a Single Wizard Session" on 
page 7-9

■ Add the business protocol during a separate Create Trading 
Partner wizard session

Note: You can assign multiple business protocols to a remote trading 
partner.

"Creating and Defining All Capabilities 
During Separate Wizard Sessions" on 
page 7-23

For the Host Trading Partner:

The host trading partner is automatically assigned support for all 
business protocols, as shown in Figure 8–12. 

Chapter 7, "Creating Trading Partners"

Section Subsection See Section...

Operational 
Capabilities

■ Supported Collaborations 
(for the RosettaNet over 
RNIF business protocol)

■ "Managing Business Protocol 
Collaborations" on page 8-40

■ Supported Business 
Actions (for any EDI or 
Custom Document business 
protocols)

■ "Managing Business Protocol 
Business Actions" on 
page 8-44

Communication 
Capabilities

■ Delivery Channels ■ "Managing Business Protocol 
Delivery Channels" on 
page 8-47

■ Document Exchanges ■ "Managing Business Protocol 
Document Exchanges" on 
page 8-50

■ Transports ■ "Managing Business Protocol 
Transports" on page 8-53

■ Transport Servers ■ "Managing Business Protocol 
Transport Servers" on 
page 8-56

■ Endpoints ■ "Managing Business Protocol 
Endpoints" on page 8-59
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6. Click Return to List to return to the Capabilities page.

Viewing an Exchange Protocol
Follow these instructions to view details about a specific exchange protocol of a 
business protocol:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific exchange protocol to view in the Exchange Protocol column.

The Exchange Protocol Details page for the selected exchange protocol appears.

5. View specific details about the following:

■ The Business Signals section shows the exception messages and the 
acknowledgment signals to exchange to confirm receipt of messages. 

■ The Supported Transport Protocols section shows the supported transports 
for this version.

■  The Supported Security Specifications section shows the supported signing 
and encryption features.

■ The Parameters section shows the supported parameters for this version.

6. Click Return to List to go to the Business Protocol Details page.

Viewing a Document Protocol
Follow these instructions to view details about a specific document protocol of a 
business protocol:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific document protocol to view in the Document Protocol column.

The Document Protocol Details page for the selected document protocol appears.

5. View specific details about a document protocol revision. You can manage (view, 
update, and delete) the revision from this page (unless it is RosettaNet, which can 
only be viewed).

6. Click Return to List to return to the Business Protocol Details page.

See Also: "Viewing Exchange Protocols" on page 6-14

See Also: "Viewing a Document Protocol Revision" on page 6-8
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Viewing a Process Protocol
OracleAS Integration B2B includes a single process protocol called the B2B process. 
Follow these instructions to view details about the B2B process:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Click B2B to the right of Process Protocol in the Details section.

The Process Protocol Details page for the selected process protocol appears.

6. View specific details about process protocol revisions and supported document 
protocols.

7. Click the process protocol revision in the Details column.

The Process Protocol Revision Details page appears.

8. View specific details about support for collaborations (if the RosettaNet over RNIF 
business protocol is selected) or business actions (if any EDI or Custom Document 
business protocol is selected) associated with this process protocol.

9. Click Return to List to return to the Business Protocol Details page.

Removing a Business Protocol from a Remote Trading Partner
Follow these instructions to remove a business protocol from a remote trading partner:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol to remove in the Remove column.

5. Click Yes when prompted to remove a business protocol.

The business protocol is removed and the Business Protocol Details page appears.

Managing Internal Delivery Channels
The host application of the trading partner is the ultimate source and destination for 
sending and receiving messages. The OracleAS Integration B2B user interface tool 
enables you to create an internal delivery channel for the host application of the host 
trading partner. This internal delivery channel provides the communication interface 
between the host application and OracleAS Integration B2B (See Figure 8–13). 

You select an internal delivery channel for the host trading partner when you create a 
trading partner agreement. The internal delivery channel operates only within the 
enterprise of the host trading partner, and differs from the "external" delivery channel 
that enables host and remote trading partners in different enterprises to communicate.

See Also: "Managing Process Protocols" on page 6-15
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The OracleAS Integration B2B user interface tool enables you to perform the internal 
delivery channel management tasks shown in Figure 8–14. These tasks are described in 
detail in this section. OracleAS Integration B2B provides four predefined internal 
delivery channels for use with Oracle Application Server Integration InterConnect 
and Oracle E-Business Suite:

■ B2B Inbound

For integrations with host applications using the IP_MESSAGE_TYPE message 
structure. This channel enables communication between the host application using 
this message structure and OracleAS Integration B2B upon receipt of inbound 
messages from a remote trading partner. This channel is automatically associated 
with the b2b.IP_IN_QUEUE internal endpoint.

■ B2B Outbound

For integrations with host applications using the IP_MESSAGE_TYPE message 
structure. This channel enables communication between the host application using 
this message structure and OracleAS Integration B2B to send outbound messages 
to a remote trading partner. This channel is automatically associated with the 
b2b.IP_OUT_QUEUE internal endpoint.

■ XML Gateway Inbound

For integrations with Oracle E-Business Suite applications. This channel enables 
communication between the host application and OracleAS Integration B2B upon 
receipt of inbound messages from a remote trading partner. This channel is 
automatically associated with the apps.ECX_INBOUND internal endpoint.

■ XML Gateway Outbound

For integrations with Oracle E-Business Suite applications. This channel enables 
communication between the host application and OracleAS Integration B2B to 
send outbound messages to a remote trading partner. This channel is 
automatically associated with the apps.ECX_OUTBOUND internal endpoint.

You can also create your own internal delivery channels to use with the host trading 
partner host application, including separate internal delivery channels for sending and 
responding (acknowledgment) messages. An example of this is an environment in 
which your business transaction with a remote trading partner requires an 
acknowledgment (for example, RosettaNet Partner Interface Process (PIP) 3A4), and 
you want to use two separate internal delivery channels for these messages (one for 
inbound and the other for outbound). When you create a trading partner, select Yes 
from the Is acknowledgment handled By Integration B2B? list on the Create Trading 
Partner - Operational Capability page or Create Supported Collaboration Role page. 
When you create a trading partner agreement for the business protocol of this trading 
partner, you can select both internal delivery channels.

Figure 8–13 provides an example of a host application that includes two internal 
delivery channels:

■ The outbound internal delivery channel sends a purchase order request to a 
remote trading partner

■ The inbound internal delivery channel receives a purchase order acknowledgment 
from a remote trading partner
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Figure 8–13 Internal Delivery Channel

Figure 8–14 Internal Delivery Channel Management Tasks

Table 8–13 identifies the internal delivery channel management tasks shown in 
Figure 8–14 and provides references to procedures for performing these tasks.

Note: Do not update any parameters available under the Transport 
Parameter column in Figure 8–14. If you must update the XML 
Gateway Inbound or Outbound internal delivery channel endpoint 
names, click Partners > Trading Partners > host_trading_partner_
name_in_the_Name_column > Capabilities > business_protocol_
name_in_Name_column. Then, click Update in the Endpoints section 
for the internal delivery channel endpoint to update.

Remote
Trading
Partner

Host
Trading
Partner

InternetHost
Application

Internal Delivery Channel
(purchase order request 
in outbound direction)

Responding Internal 
Delivery Channel
(purchase order 
acknowledgement 
in inbound direction)
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Creating an Internal Delivery Channel
Follow these instructions to create an internal delivery channel:

■ Page 1: General Page

■ Page 2: Transport Page

■ Page 3: Review Page

Table 8–13 Internal Delivery Channel Management Tasks

Page Elements Management Task See Section...

Create button in 
Internal Delivery 
Channels section of 
Figure 8–14

Create an internal delivery channel "Creating an Internal Delivery 
Channel" on page 8-33

"Example: Creating an Internal 
Delivery Channel Using the 
JMS Transport Protocol" on 
page 8-37

Transport Parameter 
column in Internal 
Delivery Channels 
section of Figure 8–14

View details about a transport used 
with an internal delivery channel. Do 
not update any transport parameters 
on this page or any pages available 
under it. These pages are for viewing 
only.

"Viewing a Business Protocol 
Transport" on page 8-55

Transport Server 
column in Internal 
Delivery Channels 
section of Figure 8–14

View details about a transport server 
used with an internal delivery 
channel.

"Viewing a Business Protocol 
Transport Server" on page 8-58

Delete column in 
Internal Delivery 
Channels section of 
Figure 8–14

Delete an internal delivery channel 
that you created.

"Deleting an Internal Delivery 
Channel" on page 8-40

Note: The Is Inbound column describes the direction in which the 
internal delivery channel communicates. The direction is always from 
the perspective of the host trading partner. If the host initiates a 
business transaction with a remote trading partner, the direction is 
outbound. If the host is the recipient of a business transaction initiated 
by a remote trading partner, the direction is inbound.

See Also:

■ Table 3–1, " IP_MESSAGE_TYPE Parameters" on page 3-4 for 
information about the IP_MESSAGE_TYPE message structure

■ Chapter 7, "Creating Trading Partners" for instructions on 
selecting Yes from the Is acknowledgment handled By 
Integration B2B? list on the Create Trading Partner - Operational 
Capability page or Create Supported Collaboration Role page

■ "Creating a Trading Partner Agreement" on page 10-6 for 
instructions on assigning an internal delivery channel to the host 
trading partner in a trading partner agreement

Note: You cannot update an internal delivery channel.
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Page 1: General Page
1. Click Partners > Trading Partners.

2. Select the host trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the host trading partner appears.

4. Click Create in the Internal Delivery Channels section.

The Create Internal Delivery Channel - General page appears.

5. Enter the following details. An asterisk (*) indicates a required field.

6. Click Next.

The Create Internal Delivery Channel - Transport page appears. 

Page 2: Transport Page
1. Select Create New or Use Existing.

2. Go to the following section based on your selection:

Creating a New Transport  Follow these instructions to create a new transport for the 
internal delivery channel.

1. Enter a unique and recognizable name for the transport in the Name field.

2. Select the transport protocol to use from the Transport Protocol list.

Field Value

Name * Enter a unique and recognizable name for the internal delivery 
channel.

Is Inbound * Select Yes if the internal delivery channel is used for receiving 
an inbound message sent to OracleAS Integration B2B from a 
remote trading partner. Otherwise, select No for outbound 
messages sent from OracleAS Integration B2B to a remote 
trading partner.

If You Selected... Go To...

Create New "Creating a New Transport" on page 8-34

Use Existing "Using an Existing Transport" on page 8-37

Selection Description

AQ Enables applications to communicate asynchronously with OracleAS Integration 
B2B over a reliable, scalable, and secure communication channel. Oracle advanced 
queuing (AQ) provides an extremely flexible mechanism for bidirectional, 
asynchronous communication. Application location is transparent, using any 
number of Oracle's connectivity options, including OCI, JDBC, or PL/SQL. Both 
XML and non-XML message payloads are supported. 

JMS Enables applications to send and receive messages to and from the queues and 
topics administered by any Java Message Service (JMS) provider; the Oracle JMS 
(OJMS) and MQSeries JMS (IBM) providers can be used with OracleAS Integration 
B2B. 

File Enables files to be copied between applications.
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The page refreshes based on your selection. 

3. Select Use Existing or Create New in the Transport Server section.

4. Go to the following step based on your selection:

5. If you selected Create New in Step 4, perform Steps 5a through 5c.

a. Enter the following transport server details for the internal delivery channel. 
An asterisk (*) indicates a required field.

b. Enter appropriate transport parameter values in the Current Value column of 
the Parameters section. If you select File or FTP, other parameters appear.

FTP Enables files to be passed with FTP between applications.

If You Selected... Go To...

Create New Step 5 on page 8-35

Use Existing Step 6 on page 8-36

Field Value

Name * Enter a unique and recognizable name for the transport server.

Description Enter a description for the transport server.

Host Name * Enter the hostname of the transport server.

Note: If using a generic exchange protocol (EDI X12 over Generic 
Exchange, EDI EDIFACT over Generic Exchange, or Custom 
Document over Generic Exchange) with the HTTP or HTTPS 
transport protocol, enter the IP address to use for identifying 
trading partners. Do not enter the hostname.

IP Address Enter the IP address of the transport server.

Username Enter the username for logging into the transport server.

Password Enter the password of the username.

Transport Protocol Field Value

AQ Hostname Enter the name of the host on which the application 
database is installed.

Port Enter the application database port number.

SID Enter the application database system identifier 
(SID).

Consumer Enter the consumer queue name. The name can be 
from 1 to 30 characters in length. The application 
that writes to the queue uses a consumer name to 
indicate that OracleAS Integration B2B must pick 
up a message.

Leave this field blank if the queues AQ connects to 
on the application database side are single 
consumer queues. If any of the queues are 
multiconsumer queues, specify a consumer name.

Selection Description



Managing Internal Delivery Channels

8-36 Oracle Application Server Integration B2B User’s Guide

c. Go to Step 7.

6. If you selected Use Existing in Step 4, perform Steps 6a through 6b.

a. Select a transport server from the Transport Server list. Note that all delivery 
channels appear in this list. Do not select any delivery channels used for 
communication between host and remote trading partners. Only delivery 
channels that enable communication between the host application and the 
host trading partner can be selected. Of the predefined internal delivery 
channels that appear, only XML Gateway Inbound and XML Gateway 
Outbound can be customized. B2B Inbound and B2B Outbound cannot be 
customized. 

b. Go to Step 7.

7. Enter the following endpoint details. An asterisk (*) indicates a required field.

8. Click Next.

Recipient Enter the recipient queue name. The name can be 
from 1 to 30 characters in length. The application 
that writes to the queue uses a recipient name to 
indicate that OracleAS Integration B2B sent a 
message.

Leave this field blank if the queues AQ connects to 
on the application database side are single recipient 
queues. If any of the queues are multirecipient 
queues, specify a recipient name.

Polling Interval Enter the time interval in milliseconds during 
which OracleAS Integration B2B polls the server for 
inbound messages. 

JMS Connection Factory 
Location

Enter the JNDI location or Java class name for the 
connection factory.

Factory Provider 
Properties

Enter the JMS vendor-specific properties to pass to 
the connection factory. 

Destination 
Provider Properties

Enter the JMS vendor-specific properties to pass to 
the destination. 

isTopic Enter False or True to indicate if JMS is 
communicating with a topic. The JMS can 
communicate with either a topic or a queue.

Subscriber ID Enter the subscriber ID. This is required if JMS is 
communicating with a topic.

Polling Interval Enter the time interval in milliseconds during 
which OracleAS Integration B2B polls the server for 
inbound messages.

Field Value

URI * (default name) Select either of the following:

■ Create New to enter a new endpoint in the URI field.

■ Use Existing to refresh the page and display the Endpoint 
list for selecting an existing URI.

Transport Protocol Field Value
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The Create Internal Delivery Channel: Review page appears and displays details 
about the type of internal delivery channel to create.

9. Go to "Page 3: Review Page" on page 8-37.

Using an Existing Transport  Follow these instructions to use an existing transport.

1. Make a selection from the Transport Parameter list. See "Managing Internal 
Delivery Channels" on page 8-30 for definitions of the predefined channels.

■ B2B Inbound

■ B2B Outbound

■ XML Gateway Inbound

■ XML Gateway Outbound

■ Internal delivery channels you previously created

2. Click Next.

The Create Internal Delivery Channel: Review page appears and displays details 
about the type of internal delivery channel to create.

3. Go to "Page 3: Review Page" on page 8-37.

Page 3: Review Page
1. Review the internal delivery channel details. 

■ To modify these details, click the Back button of the Create Internal Delivery 
Channel wizard to return to the previous pages. When you complete 
modifications, click Next until you access the review page; then click Finish. 
Do not use the Back and Forward buttons of your Web browser.

■ If you are satisfied with these details, click Finish.

The internal delivery channel is created and the Capabilities page of the host 
trading partner appears. The internal delivery channel can now be selected when 
you create a trading partner agreement.

Example: Creating an Internal Delivery Channel Using the JMS Transport Protocol
This section provides an example of creating an internal delivery channel using the 
transport protocol.

1. Open the ORACLE_HOME/home/config/application.xmlfile.

2. Define the resource provider by adding the following lines immediately before the 
</orion-application> tag. For example:

<resource-provider class="oracle.jms.OjmsContext" name="JMS_b2b"> 
     <description>OJMS Context using thin JDBC</description> 
     <property name="url" value="jdbc:oracle:thin:sunbox2005:1521:b2bdev" /> 
     <property name="username" value="b2b" /> 
     <property name="password" value="b2b" /> 
 </resource-provider> 

Note: Sample scripts to create JMS queues and send and receive 
sample JMS messages are located in ORACLE_
HOME/tip/adapter/b2b/transport/test/jms. 
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3. Enter values appropriate to your environment.

4. If Oracle Application Server Java Authentication and Authorization Service 
(JAAS) Provider (JAZN) security is activated in the application.xml file, 
disable the following line with comment markers:

<!-- jazn.provider="XML" location="./jazn-data.xml"/ --> 

5. Open the ORACLE_HOME/home/config/principals.xml file.

6. Activate the admin user by removing deactiviated="true" from the end of 
the following line.

<user username="admin" password="welcome">

7. Disable the following line with comment markers: 

<!-- server host="myhost" port="1089" username="admin" password="welcome" /--> 

8. Identify the remote method invocation (RMI) port value in the ORACLE_
HOME/home/config/rmi.xml file. This value is required for the 
java.naming.provider.url value in the Destination Provider Properties 
field of Step 10c.

9. Place the application-client.xml file in the classes/META-INF/ 
directory. The application-client.xml file must be empty between the start 
and end tags:

<application-client> 
</application-client> 

10. Create an internal delivery channel in the OracleAS Integration B2B user interface 
tool. 

a. Select JMS from the Transport Protocol list.

b. Enter the following endpoint details in the Transport Server section:

Where... Is...

Hostname sunbox2005

Note: This is the host on which the database with OJMS is installed.

Port 1521

SID b2bdev

Username b2b

Password b2b

Note: Specific examples are provided for some of the fields of the 
Create Internal Delivery Channel wizard. You must also provide 
appropriate values for other fields. 

Field Value Example

Username This value maps to the jms.sender.destination_username property b2b

Password This value maps to the jms.sender.destination_password property b2b
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c. Enter appropriate transport parameter values in the Current Value column of 
the Parameters section. 

In the case of the Factory Provider Properties field, specify the 
java.naming.provider.url value based on the OC4J status:

d. Enter the name of the destination location in the URI field of the Endpoints 
section. This maps to the jms.sender.jndi_destination_location 
property. For example: 

java:comp/resource/JMS_b2b/Queues/B2B_JMS_INQUEUE

where JMS_b2b is the resource provider defined in application.xml and 
B2B_JMS_INQUEUE is the name of the JMS queue. 

Troubleshooting the JMS Internal Delivery Channel
■ Ensure that ORACLE_HOME/dms/diagnostics/lib/ojdl.jar is in the 

CLASSPATH. 

■ Check if OC4J is a standalone or middle-tier installation. The JNDI naming URL 
value is different in both cases. 

■ Ensure that OC4J is running.

■ Ensure that the admin user is not deactivated. Check the principals.xml file. 

■ Ensure that the RMI port is correct. Check the rmi.xml file.

Field Value Example

Connection Factory 
Location

This value maps to 
jms.sender.jndi_connection_
factory_location 

java:comp/resource/JMS_
b2b/QueueConnectionFactories/qcf

Factory Provider 
Properties

This value maps to 
jms.sender.factory_provider_
properties

java.naming.factory.initial=com.evermin
d.server.rmi.RMIInitialContextFactory;ja
va.naming.security.credentials=welcom
e;java.naming.security.principal=admin;
java.naming.provider.url=opmn:ormi:/
/144.25.141.184:6004

Destination 
Provider Properties

This value maps to 
jms.sender.destination_
provider_properties

java.naming.factory.initial=com.evermin
d.server.rmi.RMIInitialContextFactory;ja
va.naming.security.credentials=welcom
e;java.naming.security.principal=admin;
java.naming.provider.url=opmn:ormi:/
/144.25.141.184:6004

If OC4J Is a... Then...

Standalone 
installation

The value takes the form:

ormi://myhost:1089, where 1089 is the RMI port in the rmi.xml file.

Middle-tier 
installation

The value takes the form:

opmn:ormi://myhost:6004, where 6004 is the request port defined in 
ORACLE_HOME/opmn/conf/opmn.xml.

Note: Do not prefix this value with jms://; this is automatically 
added.
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■ Ensure that the jazn-xml line is commented out in the application.xml file 
(or user admin is activated in the jazn-data.xml file).

■ Restart OC4J after making any changes to the application.xml and 
principals.xml files.

Deleting an Internal Delivery Channel
You can only delete internal delivery channels that you created. Follow these 
instructions to delete an internal delivery channel:

1. Click Partners > Trading Partners.

2. Select the host trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the host trading partner appears.

4. Select a specific internal delivery channel to delete in the Delete column of the 
Internal Delivery Channels section.

5. Click Yes when prompted to delete an internal delivery channel. 

The internal delivery channel is deleted and the Capabilities page for the host 
trading partner appears.

Managing Business Protocol Collaborations
The OracleAS Integration B2B user interface tool enables you to perform the 
collaboration management tasks for the RosettaNet over RNIF business protocol 
shown in Figure 8–15. These tasks are described in detail in this section. Collaborations 
consist of a set of partner interface processes (PIPs) that define the capabilities of a 
trading partner in a business transaction (such as buyer and seller). Collaborations 
apply only to the RosettaNet over RNIF business protocol, and not to any EDI or 
Custom Document business protocols. In the OracleAS Integration B2B user interface 
tool, trading partners define their operational capabilities by the collaborations they 
support.
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Figure 8–15 Business Protocol Collaboration Management Tasks

Table 8–14 identifies the business protocol collaboration management tasks shown in 
Figure 8–15 and provides references to procedures for performing these tasks.

Table 8–14 Business Protocol Collaboration Management Tasks

Page Elements Management Task See Section...

Create Operational Capability 
button of Figure 8–15 

Note: To simplify your user 
experience, the host trading 
partner is automatically 
assigned support for a 
collaboration that is compatible 
with the selection for the 
remote trading partner.

Select support for a 
collaboration (which includes a 
PIP) and a collaboration role 
(for example, buyer or seller) 
for the RosettaNet over RNIF 
business protocol (trading 
partners define their 
operational capabilities by the 
collaborations they support)

Chapter 7, "Creating 
Trading Partners"

Details column in Supported 
Collaborations section of 
Figure 8–15

View details about support for 
a collaboration

"Viewing a Business 
Protocol Collaboration" on 
page 8-42

Update column in Supported 
Collaborations section of 
Figure 8–15

Update support for a 
collaboration

"Updating a Business 
Protocol Collaboration" on 
page 8-42

Delete column in Supported 
Collaborations section of 
Figure 8–15

Delete support for a 
collaboration

"Deleting a Business 
Protocol Collaboration" on 
page 8-43



Managing Business Protocol Collaborations

8-42 Oracle Application Server Integration B2B User’s Guide

Viewing a Business Protocol Collaboration
Follow these instructions to view details about a specific collaboration for the 
RosettaNet over RNIF business protocol:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select the RosettaNet over RNIF business protocol in the Name column.

5. Select a specific collaboration to view in the Details column of the Supported 
Collaborations section.

The Supported Collaboration Role Details page for the selected collaboration 
appears.

6. View specific details, including the following:

■ Collaboration role (for example, buyer or seller)

■ Collaboration (for example, PIP 3A4)

■ Version (for example, V02.00)

■ If acknowledgment is handled by OracleAS Integration B2B

■ The time to perform the collaboration

■ If any validation rules are associated with the business protocol collaboration

This page, as with the Business Protocol Details page shown in Figure 8–15 on 
page 8-41, enables you to delete or update the selected collaboration.

7. Click Return to List to return to the Capabilities page.

Updating a Business Protocol Collaboration
Follow these instructions to update a collaboration for the RosettaNet over RNIF 
business protocol:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select the RosettaNet over RNIF business protocol in the Name column.

5. Select a specific collaboration to update in the Update column of the Supported 
Collaborations section.

The Update Supported Collaboration Role page appears.

6. Make appropriate updates:

Note: You must have already created or imported support for a 
collaboration for it to display in the Business Protocol Details page. 
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7. Click Apply.

The business protocol collaboration is updated and the Collaboration Role Details 
page appears.

Deleting a Business Protocol Collaboration
Follow these instructions to delete support for a collaboration for the RosettaNet over 
RNIF business protocol:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select the RosettaNet over RNIF business protocol in the Name column.

5. Select a specific collaboration to delete in the Delete column of the Supported 
Collaborations section.

6. Click Yes when prompted to delete a collaboration.

The collaboration is deleted and the Business Protocol Details page appears.

Field Value

Collaboration Role Select an appropriate update from the list. The following list is 
an example of what can appear. The collaboration roles that 
display are based upon those that you imported or created. 
Each selection combines a role (for example, Buyer), a 
collaboration (for example, PIP 3A4), and a version (for 
example, V02.00). 

■ Buyer - 3A4 - V02.00

■ Buyer - 3A6 - V02.00

■ Buyer - 3A7 - V02.00

■ Buyer - 3A8 - V02.00

■ Failure Report Administrator - 0A1 - V02.00

■ PIP Report Administrator - 0A1 - V02.00

■ Receiver - 3B2 - V01.00

■ Seller - 3A4 - V02.00

■ Seller - 3A6 - V02.00

■ Seller - 3A7 - V02.00

■ Seller - 3A8 - V02.00

■ Shipper - 3B2 - V01.00

Is acknowledgment handled 
by Integration B2B?

Select No or Yes. 

If Yes is selected, OracleAS Integration B2B handles 
acknowledgment. If No is selected, the application handles 
acknowledgment.

Time To Perform Update the time in minutes in which to process the support for 
a collaboration. This value overrides the value defined by the 
collaboration.
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Managing Business Protocol Business Actions
The OracleAS Integration B2B user interface tool enables you to perform the business 
action management tasks shown in Figure 8–16. These tasks are described in detail in 
this section. Business actions define the roles played in a configuration between 
trading partners in a business transaction (such as initiator and responder). Business 
actions apply to any EDI or Custom Document business protocols, and not to the 
RosettaNet over RNIF business protocol. In the OracleAS Integration B2B user 
interface tool, trading partners define their operational capabilities by the business 
actions they support.

Figure 8–16 Business Protocol Business Action Management Tasks

Table 8–15 identifies the business protocol business action management tasks shown in 
Figure 8–16 and provides references to procedures for performing these tasks.

Table 8–15 Business Protocol Business Action Management Tasks

Page Elements Management Task See Section...

Create Operational Capability 
button of Figure 8–16

Note: To simplify your user 
experience, the host trading 
partner is automatically 
assigned support for a business 
action that is compatible with 
the selection for the remote 
trading partner.

Select support for a business 
action for an EDI or Custom 
Document business protocol 
(trading partners define their 
operational capabilities by the 
business actions they support)

Chapter 7, "Creating 
Trading Partners"
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Viewing a Business Protocol Business Action
Follow these instructions to view details about a specific business action of an EDI or 
Custom Document business protocol:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific EDI or Custom Document business protocol in the Name column.

5. Select a specific business action to view in the Name column of the Supported 
Business Actions section.

The Supported Business Action Details page for the selected business action 
appears.

6. View specific details, including support for the business action, initiator status, 
functional acknowledgment, and if acknowledgment is handled by OracleAS 
Integration B2B. You can also view document information, such as the document 
protocol, document protocol revision, document type, document definition, and 
document protocol parameter settings.

This page, as with the Business Protocol Details page shown in Figure 8–16 on 
page 8-44, enables you to delete or update the selected business action.

7. Click Return to List to return to the Business Protocol Details page.

Updating a Business Protocol Business Action
Follow these instructions to update support for a business action of an EDI or Custom 
Document business protocol:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

Name column in Supported 
Business Actions section of 
Figure 8–16

View details about support for 
a business action

"Viewing a Business 
Protocol Business Action" 
on page 8-45

Update column in Supported 
Business Actions section of 
Figure 8–16

Update support for a business 
action

"Updating a Business 
Protocol Business Action" 
on page 8-45

Delete column in Supported 
Business Actions section of 
Figure 8–16

Delete support for a business 
action

"Deleting a Business 
Protocol Business Action" 
on page 8-46

Note: You must have already created or imported support for a 
business action for it to display in the Business Protocol Details page. 

Table 8–15 (Cont.) Business Protocol Business Action Management Tasks

Page Elements Management Task See Section...
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4. Select a specific EDI or Custom Document business protocol in the Name column.

5. Select a specific business action to update in the Update column of the Supported 
Business Actions section.

The Update Supported Business Action page appears.

6. Make appropriate updates. 

7. Click Apply.

The business action is updated and the Supported Business Action Details page 
appears.

Deleting a Business Protocol Business Action
Follow these instructions to delete support for a business action of an EDI or Custom 
Document business protocol:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific EDI or Custom Document business protocol in the Name column.

5. Select a specific business action to delete in the Delete column of the Supported 
Business Actions section.

6. Click Yes when prompted to delete a business action.

The business action is deleted and the Business Protocol Details page appears.

Field Value

Is Initiator * Select False or True.

Functional 
acknowledgment 
required? *

Select No or Yes.

Is acknowledgment 
handled by Integration 
B2B? *

Select No or Yes. 

If Yes is selected, OracleAS Integration B2B handles 
acknowledgment. If No is selected, the application handles 
acknowledgment.

Use Existing Document 
Definition

Deselect to change the default settings.

Use Default Document 
Definition

Select to change the default settings.

Document Protocol 
Parameters

Override values in the New Value column. You can also import 
interchange or group .ecs files. 

Note: .ecs files are only applicable to the EDI business protocol.
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Managing Business Protocol Delivery Channels
The OracleAS Integration B2B user interface tool enables you to perform the delivery 
channel management tasks shown in Figure 8–17. These tasks are described in detail in 
this section. The delivery channel describes whether security characteristics such as 
nonrepudiation of origin and receipt, acknowledgment mode, time to acknowledge, 
retry count, transport security, encryption, and file compression are required. The 
delivery channel also includes the following: 

■ Associated transport (with its transport protocol, mode, server, and endpoint 
address)

■ Associated document exchange (with its exchange protocol parameters, exchange 
protocol override elements, exchange protocol revision, and, if defined, its support 
for a digital envelope, encryption credential, digital signature, signing 
credential, and validation)

A business protocol can have multiple delivery channels. To create a trading partner 
agreement, you must create a delivery channel. When you create a trading partner 
agreement, you can assign only one delivery channel to the agreement.

In the OracleAS Integration B2B user interface tool, delivery channels are part of the 
communication capabilities of the supported business protocol.

Figure 8–17 Delivery Channel Management Tasks
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Table 8–16 identifies the delivery channel management tasks shown in Figure 8–17 and 
provides references to procedures for performing these tasks.

Viewing a Business Protocol Delivery Channel
Follow these instructions to view details about a specific delivery channel:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific delivery channel in the Name column of the Delivery Channels 
section.

The Delivery Channel Details page for the selected delivery channel appears.

6. View specific details, including the delivery channel name, document exchange 
(with a link to that details page), transport (with a link to that details page), 
acknowledgment mode, global usage code, nonrepudiation of receipt or origin 
support, encryption support, transport security support, time to acknowledgment 
value, and retry count value.

This page, as with the Business Protocol Details page shown in Figure 8–17 on 
page 8-47, enables you to delete or update the selected delivery channel.

7. Click Return to List to return to the Business Protocol Details page.

Table 8–16 Delivery Channel Management Tasks

Page Elements Management Task See Section...

Create Communication 
Capability button of 
Figure 8–17

Starts the Create Trading 
Partner wizard to guide you 
through creation of a delivery 
channel, document exchange, 
transport, transport server, and 
endpoint (pages 4 through 7 of 
the wizard)

"Creating Business Protocol 
Communication 
Capabilities for the Host 
and Remote Trading 
Partners" on page 7-26

Name column in Delivery 
Channels section of Figure 8–17

View details about a delivery 
channel (including the 
associated document exchange 
and transport)

"Viewing a Business 
Protocol Delivery Channel" 
on page 8-48

Update column in Delivery 
Channels section of Figure 8–17

Update a delivery channel "Updating a Business 
Protocol Delivery Channel" 
on page 8-49

Delete column in Delivery 
Channels section of Figure 8–17

Delete a delivery channel "Deleting a Business 
Protocol Delivery Channel" 
on page 8-50

Note: The transport and document exchange associated with the 
delivery channel display in the Document Exchange and Transport 
columns of the Delivery Channels section. (See Figure 8–17.) 
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Updating a Business Protocol Delivery Channel
Follow these instructions to update a delivery channel:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific delivery channel to update in the Update column of the Delivery 
Channels section.

The Update Delivery Channel page appears.

6. Make appropriate updates. An asterisk (*) indicates a required field.

7. Click Apply.

The delivery channel is updated and the Delivery Channel Details page appears.

Field Value

Name * Enter a unique and recognizable name for the delivery channel.

Document Exchange Select a document exchange to use with this delivery channel.

Transport Select a transport to use with this delivery channel.

Acknowledgment Mode Select Async, None, or Sync for the mode in which the trading 
partner receives messages.

Global Usage Code Select Production or Test. 

This specifies the usage of the delivery channel. If set to Test, 
the delivery channel is used only for testing purposes. If set to 
Production, it is used only for production purposes. This 
parameter is used mainly with RNIF.

Is Non-Repudiation of 
Receipt Required

Cannot be updated on this page. You must create a new 
delivery channel to update this value.

Is Non-Repudiation of Origin 
Required

Cannot be updated on this page. You must create a new 
delivery channel to update this value.

Encryption Enabled Cannot be updated on this page. You must create a new 
delivery channel to update this value.

Transport Security Enabled Select No or Yes. 

If you select Yes, a secure transport protocol, security 
specification, and remote trading partner certificate are 
necessary. You must update these details on the Update 
Transport page.

Compression Enabled Select No or Yes. 

This field applies only to the AS2 exchange protocol. By 
default, OracleAS Integration B2B signs the message before 
encrypting it.

Time To Acknowledgment Enter a value in minutes. This value specifies the time in which 
an acknowledgment message must be received. If an 
acknowledgment is not received, an error message is returned.

Retry Count Enter a value. This value specifies the number of times to retry.
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Deleting a Business Protocol Delivery Channel
Follow these instructions to delete a delivery channel:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific delivery channel to delete in the Delete column of the Delivery 
Channels section.

6. Click Yes when prompted to delete a delivery channel.

The delivery channel is deleted and the Business Protocol Details page appears.

Managing Business Protocol Document Exchanges
The OracleAS Integration B2B user interface tool enables you to perform the document 
exchange management tasks shown in Figure 8–18. These tasks are described in detail 
in this section. The document exchange describes the supported exchange protocol 
revision (such as RosettaNet 01.10) and, if being used, credential encryptions, signing 
credentials, digital envelopes, digital signatures, and validation support. The 
document exchange uses these capabilities to exchange messages with a trading 
partner.

In the OracleAS Integration B2B user interface tool, document exchanges are part of 
the communication capabilities of the business protocol. A document exchange is 
associated with a delivery channel that you assign to a trading partner agreement.
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Figure 8–18 Document Exchange Management Tasks

Table 8–17 identifies the document exchange management tasks shown in Figure 8–18 
and provides references to procedures for performing these tasks.

Table 8–17 Document Exchange Management Tasks

Page Elements Management Task See Section...

Create Communication 
Capability button of 
Figure 8–18

Starts the Create Trading 
Partner wizard to guide you 
through creation of a delivery 
channel, document exchange, 
transport, transport server, and 
endpoint (pages 4 through 7 of 
the wizard)

"Creating Business Protocol 
Communication 
Capabilities for the Host 
and Remote Trading 
Partners" on page 7-26

Name column in Document 
Exchanges section of 
Figure 8–18

View details about a document 
exchange

"Viewing a Business 
Protocol Document 
Exchange" on page 8-52

Exchange Protocol Revision 
column in Document 
Exchanges section of 
Figure 8–18

View details about an exchange 
protocol revision

"Viewing Exchange 
Protocols" on page 6-14

Update column in Document 
Exchanges section of 
Figure 8–18

Update a document exchange "Updating a Business 
Protocol Document 
Exchange" on page 8-52
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Viewing a Business Protocol Document Exchange
Follow these instructions to view details about a specific document exchange:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific document exchange to view in the Name column of the 
Document Exchanges section.

The Document Exchange Details page for the selected document exchange 
appears.

6. View specific details, including exchange protocol parameters, exchange protocols, 
digital envelopes, encryption credentials, digital signatures, signing credentials, 
and validation support in the Details section at the top of the page.

This page, as with the Business Protocol Details page shown in Figure 8–18 on 
page 8-51, enables you to update the selected document exchange. You can also 
delete the document exchange from this page.

7. Click Return to List to return to the Business Protocol Details page.

Updating a Business Protocol Document Exchange
Follow these instructions to update a document exchange:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific document exchange to update in the Update column of the 
Document Exchanges section.

The Update Document Exchange page appears.

6. Make appropriate updates. An asterisk (*) indicates a required field.

Name column in Document 
Exchanges section of 
Figure 8–18 (to access a page to 
delete a document exchange)

Delete a document exchange "Deleting a Business 
Protocol Document 
Exchange" on page 8-53

Note: The exchange protocol revision of this document exchange 
displays in the Exchange Protocol Revision column of the Document 
Exchanges section. (See Figure 8–18.)

Table 8–17 (Cont.) Document Exchange Management Tasks

Page Elements Management Task See Section...
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7. Click Apply.

The document exchange is updated and the Document Exchange Details page 
appears.

Deleting a Business Protocol Document Exchange
Follow these instructions to delete a document exchange:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific document exchange to delete in the Name column of the 
Document Exchanges section.

The Document Exchange Details page appears.

6. Click Delete to delete the document exchange. 

7. Click Yes when prompted to delete the document exchange.

The document exchange is deleted and the Business Protocol Details page appears.

Managing Business Protocol Transports
The OracleAS Integration B2B user interface tool enables you to perform the transport 
management tasks shown in Figure 8–19. These tasks are described in detail in this 
section. The transport defines the properties specific to a given usage of a protocol 
endpoint. The transport is responsible for message delivery using the selected 
transport protocol (such as HTTP 1.1), mode (synchronous or asynchronous), server, 
and protocol endpoint address (trading partner address, such as a URI). 

In the OracleAS Integration B2B user interface tool, transports are part of the 
communication capabilities of the business protocol. A transport is associated with a 
delivery channel that you assign to a trading partner agreement.

Field Value

Exchange Protocol 
Revision *

Select the exchange protocol revision to use. The revisions that appear 
are based on the exchange protocol you are using:

■ If using RNIF, select RosettaNet - 01.10 or RosettaNet - V02.00.

■ If using Generic Exchange, select Generic 1.0.

■ If using AS, select AS2 - 1.1

Exchange Protocol 
Parameters

Change appropriate exchange protocol parameters values.

If you are using the AS2 exchange protocol, the parameter Signed and 
Compressed equals true means that OracleAS Integration B2B by 
default signs the message before compressing it.
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Figure 8–19 Transport Management Tasks

Table 8–18 identifies the transport management tasks shown in Figure 8–19 and 
provides references to procedures for performing these tasks.

Table 8–18 Transport Management Tasks

Page Elements Management Task See Section...

Create Communication 
Capability button of 
Figure 8–19

Starts the Create Trading 
Partner wizard to guide you 
through creation of a delivery 
channel, document exchange, 
transport, transport server, and 
endpoint (pages 4 through 7 of 
the wizard)

"Creating Business Protocol 
Communication 
Capabilities for the Host 
and Remote Trading 
Partners" on page 7-26

Name column in Transports 
section of Figure 8–19

View details about a transport "Viewing a Business 
Protocol Transport" on 
page 8-55

Update column in Transports 
section of Figure 8–19

Update a transport "Updating a Business 
Protocol Transport" on 
page 8-55

Name column in Transports 
section of Figure 8–19 (to access 
a page to delete a transport)

Delete a transport "Deleting a Business 
Protocol Transport" on 
page 8-56



Managing Business Protocol Transports

Managing Trading Partners 8-55

Viewing a Business Protocol Transport
Follow these instructions to view details about a specific transport:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific transport to view in the Name column of the Transports section.

The Transport Details page for the selected transport appears.

6. View specific details about the transport protocol (for example, HTTP), transport 
server name, URI (trading partner endpoint address), and transport parameters 
(such as the port number and additional transport headers). 

If you selected a transport server for a predefined internal delivery channel, the 
URI is the specific internal endpoint to which it applies.

This page, as with the Business Protocol Details page shown in Figure 8–19 on 
page 8-54, enables you to update the selected transport. You can also delete the 
transport from this page.

7. Click Return to List to return to the Business Protocol Details page.

Updating a Business Protocol Transport
Follow these instructions to update a transport:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific transport to update in the Update column of the Transports 
section.

The Update Transport Parameter page appears.

6. Make appropriate updates. An asterisk (*) indicates a required field.

Note: The transport server and URI for this transport also display in 
the Transport Server and URI columns, respectively, of the Transports 
section. (See Figure 8–19.)

See Also: "Viewing a Business Protocol Endpoint" on page 8-61 for 
the internal endpoints that apply to each internal delivery channel

Field Value

Transport Protocol Select a transport protocol (for example, HTTP).

Transport Server Select a transport server.
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7. Click Apply.

The transport is updated and the Transport Details page appears.

Deleting a Business Protocol Transport
Follow these instructions to delete a transport:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific transport to delete in the Name column of the Transports section.

The Transport Details page appears.

6. Click Delete to delete the transport. 

7. Click Yes when prompted to delete the transport.

The transport is deleted and the Business Protocol Details page appears.

Managing Business Protocol Transport Servers
The OracleAS Integration B2B user interface tool enables you to perform the transport 
server management tasks shown in Figure 8–20. These tasks are described in detail in 
this section. The transport server is the endpoint server name for the trading partner.

In the OracleAS Integration B2B user interface tool, transport servers are part of the 
communication capabilities of the business protocol. A transport server is associated 
with a delivery channel that you assign to a trading partner agreement.

Endpoint Select an endpoint. All endpoints in the OracleAS Integration 
B2B user interface tool display for selection.

Field Value
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Figure 8–20 Transport Server Management Tasks

Table 8–19 identifies the transport server management tasks shown in Figure 8–20 and 
provides references to procedures for performing these tasks.

Table 8–19 Transport Server Management Tasks

Page Elements Management Task See Section...

Create Communication 
Capability button of 
Figure 8–20

Starts the Create Trading 
Partner wizard to guide you 
through creation of a delivery 
channel, document exchange, 
and transport (pages 4 through 
7 of the wizard)

"Creating Business Protocol 
Communication 
Capabilities for the Host 
and Remote Trading 
Partners" on page 7-26

Name column in Transport 
Servers section of Figure 8–20

View details about a transport 
server

"Viewing a Business 
Protocol Transport Server" 
on page 8-58

Update column in Transport 
Servers section of Figure 8–20

Update a transport server "Updating a Business 
Protocol Transport Server" 
on page 8-58

Name column in Transport 
Servers section of Figure 8–20 
(to access a page to delete a 
transport server)

Delete a transport server "Deleting a Business 
Protocol Transport Server" 
on page 8-59
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Viewing a Business Protocol Transport Server
Follow these instructions to view a transport server:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific transport server to view in the Name column of the Transport 
Servers section.

The Transport Server Details page for the selected transport server appears.

6. View specific details about the trading partner name, server name, server protocol 
used (for example, HTTP), IP address, server username, server password, and 
transport protocol parameter values (such as the port number of the server and 
additional transport headers).

This page, as with the Business Protocol Details page shown in Figure 8–20 on 
page 8-57, enables you to update the selected transport server. You can also delete 
the transport server from this page.

7. Click Return to List to return to the Business Protocol Details page.

Updating a Business Protocol Transport Server
Follow these instructions to update a transport server:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific transport server to update in the Update column of the Transport 
Servers section.

The Update Transport Server page appears.

6. Make appropriate updates. An asterisk (*) indicates a required field.

Note: The transport protocol and the server host name for this 
transport server also display in the Transport Protocol and Host 
Name columns, respectively, of the Transport Servers section. (See 
Figure 8–20.)

Note: Any updates that you make on this page must always include 
updating the password. If you update any other field, but do not 
update the password, you receive an error at runtime. The password 
you enter can be the same one you previously specified.
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7. Update appropriate parameter values in the Transport Parameter Values section.

8. Click Apply.

The transport is updated and the Transport Server Details page appears.

Deleting a Business Protocol Transport Server
Follow these instructions to delete a transport server:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific transport server to delete in the Name column of the Transport 
Server section.

The Transport Server Details page appears.

6. Click Delete to delete the transport server. 

7. Click Yes when prompted to delete the transport server.

The transport server is deleted and the Business Protocol Details page appears.

Managing Business Protocol Endpoints
The OracleAS Integration B2B user interface tool enables you to perform the endpoint 
management tasks shown in Figure 8–21. These tasks are described in detail in this 
section. Endpoints are trading partner addresses (typically a URI). An endpoint 
includes a protocol endpoint, which is a combination of a specific endpoint address 
(such as http://server.partner.com:5555/submit/rnmsg) and transport 
protocol (such as HTTP 1.1). Endpoints are global to all trading partners. 

Field Value

Description Update a description for the transport server.

Host Name * Update the hostname of the transport server.

IP Address Update the IP address of the transport server.

Username Update the username for logging into the transport server.

Password Update the password of the username.

Transport Parameter Values Update appropriate parameters. The parameters that appear 
are based on the transport protocol you are using: HTTP 1.0, 
HTTP 1.1, Email 1.0, FTP 1.0, or File 1.0. For example, if you are 
using HTTP 1.0 or 1.1, you can update the following 
parameters:

■ HTTP port number of the server

■ The additional transport headers, which store name and 
value pairs. A valid setting for this parameter takes the 
format name1=value1;name2=value2;...name_
n=value_n, where name1 through name_n equals the 
header name, and value1 through value_n equals the 
header value of the HTTP protocol.
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In the OracleAS Integration B2B user interface tool, endpoints are part of the 
communication capabilities of the business protocol. An endpoint is associated with a 
delivery channel that you assign to a trading partner agreement.

Figure 8–21 Endpoint Management Tasks

Table 8–20 identifies the endpoint management tasks shown in Figure 8–21 and 
provides references to procedures for performing these tasks.

Table 8–20 Endpoint Management Tasks

Page Elements Management Task See Section...

Create 
Communication 
Capability button of 
Figure 8–21

Starts the Create Trading Partner 
wizard to guide you through creation 
of a delivery channel, document 
exchange, transport, transport server, 
and endpoint (pages 4 through 7 of 
the wizard)

"Creating Business Protocol 
Communication Capabilities 
for the Host and Remote 
Trading Partners" on 
page 7-26

URI column in 
Endpoints section of 
Figure 8–21

View details about an endpoint "Viewing a Business Protocol 
Endpoint" on page 8-61

Update column in 
Endpoints section of 
Figure 8–21

Update an endpoint "Updating a Business 
Protocol Endpoint" on 
page 8-62

Delete column in 
Endpoints section of 
Figure 8–21

Delete an endpoint "Deleting a Business Protocol 
Endpoint" on page 8-62
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Viewing a Business Protocol Endpoint
Follow these instructions to view details about a specific endpoint:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific endpoint to view in the URI column of the Endpoints section. 
OracleAS Integration B2B includes four predefined, internal endpoints that cannot 
be deleted. Each endpoint is associated with a specific internal delivery channel to 
enable communication between the host application and the host trading partner’s 
installation of OracleAS Integration B2B.

■ apps.ECX_INBOUND

Associated with the XML Gateway Inbound internal delivery channel. You can 
update the URI of this internal delivery channel.

■ apps.ECX_OUTBOUND

Associated with the XML Gateway Outbound internal delivery channel. You 
can update the URI of this internal delivery channel.

■ b2b.IP_IN_QUEUE

Associated with the B2B Inbound internal delivery channel

■ b2b.IP_OUT_QUEUE

Associated with the B2B Outbound internal delivery channel

The Endpoint Details page for the selected endpoint appears.

6. View specific details about the URI endpoint address and the transport protocol 
used. You can also manage the protocol endpoint of the business protocol 
endpoint from this page.

This page, as with the Business Protocol Details page shown in Figure 8–21 on 
page 8-60, enables you to delete or update the selected endpoint.

URI column in 
Endpoints section of 
Figure 8–21

View details about a protocol 
endpoint of a business protocol 
endpoint

"Viewing a Protocol 
Endpoint of a Business 
Protocol Endpoint" on 
page 8-62

URI column in 
Endpoints section of 
Figure 8–21 (to access a 
page for updating a 
protocol endpoint)

Update a protocol endpoint of a 
business protocol endpoint

"Updating a Protocol 
Endpoint of a Business 
Protocol Endpoint" on 
page 8-63

URI column in 
Endpoints section of 
Figure 8–21 (to access a 
page for deleting a 
protocol endpoint)

Delete a protocol endpoint of a 
business protocol endpoint

"Deleting a Protocol 
Endpoint of a Business 
Protocol Endpoint" on 
page 8-64

Table 8–20 (Cont.) Endpoint Management Tasks

Page Elements Management Task See Section...
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7. Click Return to List to return to the Business Protocol Details page.

Updating a Business Protocol Endpoint
Follow these instructions to update an endpoint:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific endpoint to update in the Update column of the Endpoints 
section.

The Update Endpoints page appears.

6. Make appropriate changes to the URI (endpoint address) and description.

7. Click Apply.

The endpoint is updated and the Endpoint Details page appears.

Deleting a Business Protocol Endpoint
Follow these instructions to delete an endpoint:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific endpoint to delete in the Delete column of the Endpoints section.

6. Click Yes when prompted to delete an endpoint.

The endpoint is deleted and the Business Protocol Details page appears.

Viewing a Protocol Endpoint of a Business Protocol Endpoint
Follow these instructions to view details about a specific protocol endpoint of a 
business protocol endpoint:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

See Also: The following sections for instructions on managing 
protocol endpoints:

■ "Viewing a Protocol Endpoint of a Business Protocol Endpoint" on 
page 8-62

■ "Updating a Protocol Endpoint of a Business Protocol Endpoint" 
on page 8-63

■ "Deleting a Protocol Endpoint of a Business Protocol Endpoint" on 
page 8-64
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3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific endpoint to view in the URI column of the Endpoints section.

The Endpoint Details page for the selected endpoint appears.

6. Select a specific protocol endpoint to view in the Details column of the Protocol 
Endpoints section.

The Protocol Endpoint Details page for the selected endpoint appears.

7. View specific details about the endpoint and transport protocol that comprise this 
protocol endpoint.

This page, as with the Endpoint Details page, enables you to delete or update the 
selected protocol endpoint.

8. Click Return to List to return to the Endpoint Details page.

9. Click Return to List to return to the Business Protocol Details page.

Updating a Protocol Endpoint of a Business Protocol Endpoint
Follow these instructions to update a protocol endpoint of a business protocol 
endpoint:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific endpoint in the URI column of the Endpoints section.

The Endpoint Details page for the selected endpoint appears.

6. Select a specific protocol endpoint to update in the Update column of the Protocol 
Endpoints section.

The Update Protocol Endpoint page appears.

7. Make appropriate updates. An asterisk (*) indicates a required field.

8. Click Apply.

The protocol endpoint is updated and the Protocol Endpoint Details page appears.

Field Value

Endpoint * Update the endpoint used with this endpoint.

Transport Protocol Update the transport endpoint used with this endpoint.
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Deleting a Protocol Endpoint of a Business Protocol Endpoint
Follow these instructions to delete a protocol endpoint of a business protocol endpoint:

1. Click Partners > Trading Partners.

2. Select a specific trading partner in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

The Capabilities page for the selected trading partner appears.

4. Select a specific business protocol in the Name column.

5. Select a specific endpoint in the URI column of the Endpoints section.

The Endpoint Details page for the selected endpoint appears.

6. Select a specific protocol endpoint to delete in the Delete column of the Protocol 
Endpoints section.

7. Click Yes when prompted to delete a protocol endpoint.

The protocol endpoint is deleted and the Endpoint Details page appears.

Common User Errors
■ Ensure that the endpoint address you specify exists and is accessible.

■ Do not include beginning or trailing blank spaces in the names of trading partner 
data that you create.

■ Any updates that you make on the Update Transport Server page must always 
include updating the password. If you update any other field, but do not update 
the password, you receive an error at runtime. The password you enter can be the 
same one you previously specified.

Chapter Summary
This chapter first describes how to manage trading partners and their business 
protocol operational and communication capabilities that you previously created. This 
chapter begins with a brief overview of the main management pages in the OracleAS 
Integration B2B user interface tool (Trading Partner Details page, Capabilities page, 
and Business Protocol Details page). The remaining sections describe the specific tasks 
you can perform from these pages.
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9
Managing Callouts

This chapter describes how to manage callouts that enable you to transform the 
formats of messages exchanged between remote and host trading partners.

This chapter contains these topics:

■ Callouts Overview

■ Managing Callouts

■ Managing Callout Properties

■ Managing Callout Usages

■ Tutorial: Adding Callout Usages to the RosettaNet over the Internet Transaction

■ Common User Errors

■ Chapter Summary
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Callouts Overview
The host application of a trading partner is the ultimate source and destination for 
sending and receiving messages. You create or use predefined internal delivery 
channels in the OracleAS Integration B2B user interface tool that enable 
communication between the host application and the host trading partner.

You can have an environment in which the host application does not understand the 
format of a message sent from a remote trading partner. For example, a remote 
trading partner sends a RosettaNet XML-formatted purchase order request to a host 
trading partner. The host application of the host trading partner is an Oracle 
E-Business Suite application that does not understand RosettaNet XML-formatted 
messages. Figure 9–1 provides an example of this environment.

To enable communication between these two different formats, you create a callout 
that consists of callout usages. In this example, one callout usage transforms the 
RosettaNet XML-formatted purchase order request into an Oracle E-Business Suite 
XML format understood by the Oracle E-Business Suite application. The Oracle 
E-Business Suite application, in turn, responds to the request message with a purchase 
order acceptance message in Oracle E-Business Suite XML format. This message is 
transformed by another callout usage back into a RosettaNet XML-formatted message 
for the remote trading partner.

You create two separate internal delivery channels for these messages: 

■ One for the initiating purchase order request

■ One for the responding purchase order acceptance

When you create a trading partner agreement between the host and remote trading 
partners, you associate the initiating internal delivery channel with the initiating 
callout usage that transforms the purchase order request from RosettaNet XML to 
Oracle E-Business Suite XML. You also associate the responding internal delivery 
channel with the responding callout usage that transforms the purchase order 
acceptance from Oracle E-Business Suite XML to RosettaNet XML.
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Figure 9–1 Callouts

By default, the initiating internal delivery channel and callout usage are available for 
selection when you create a trading partner agreement. If you also want a responding 
internal delivery channel and responding callout usage to be available for selection, 
you must select Yes from the Is acknowledgment handled By Integration B2B? list on 
the Create Trading Partner - Operational Capability page or Create Supported 
Collaboration Role page when you create a trading partner.

When you then create the trading partner agreement, you can select both internal 
delivery channels and both callout usages. Figure 9–2 provides an example of the 
upper part of the Create Agreement page that enables you to make these selections. 

Remote
Trading
Partner

Host
Trading
Partner

Host
Application

Purchase Order Request
(Oracle E-Business Suite
XML format)

Purchase Order 
Acceptance
(Oracle E-Business Suite
XML format)

Responding Callout 
Usage
(Transforms Oracle 
E-Business Suite 
XML to RosettaNet 
XML)

Callout Usage
(Transforms 
RosettaNet
XML to Oracle 
E-Business
Suite XML)

(Oracle
E-Business
Suite XML)

(seller) (buyer)

(RosettaNet
XML)

A

B

A

B

Internal Delivery 
Channel

Responding Internal 
Delivery Channel

Purchase Order Request
(RosettaNet XML format)

Purchase Order Acceptance
(RosettaNet XML format)

Source Document Definition: PurchaseOrderRequest
Target Document Definition: PurchaseOrderAcceptance

Source Document Definition: PurchaseOrderAcceptance
Target Document Definition: PurchaseOrderRequest
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Figure 9–2 Selecting Callouts when Creating a Trading Partner Agreement

You perform the following tasks to use callouts with OracleAS Integration B2B: 

■ Create a callout .jar file library name outside of OracleAS Integration B2B that 
follows the standards described in the Oracle Application Server Integration B2B 
Callouts Java API Reference to transform messages from one format to another, and 
vice versa.

■ Create (register) a callout in the OracleAS Integration B2B user interface tool that 
includes the callout .jar file library name, the callout usages (that define the 
source and target document definitions such as a purchase order request and 
purchase order acceptance), and any input and output callout properties.

■ Associate the callout usages with internal delivery channels when creating a 
trading partner agreement. During deployment of the trading partner agreement 
as part of a configuration, the callout usages are invoked and the transformation 
is performed.

See Also:

■ "Page 3: Operational Capability Page" on page 7-11 for 
instructions on selecting Yes from the Is acknowledgment 
handled By Integration B2B? list on the Create Trading Partner - 
Operational Capability page

■ "Creating Business Protocol Operational Capabilities for the 
Remote Trading Partner" on page 7-25 for instructions on selecting 
Yes from the Is acknowledgment handled By Integration B2B? 
list on the Create Supported Collaboration Role page

■ "Managing Internal Delivery Channels" on page 8-30

■ "Managing Trading Partner Agreements" on page 10-5

■ Oracle Application Server Integration B2B Callouts Java API Reference 
in the Oracle Application Server Documentation Library for 
guidelines on creating a callout
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Managing Callouts
The OracleAS Integration B2B user interface tool enables you to perform the callout 
management tasks shown in Figure 9–3. Callouts enable you to transform the formats 
of messages exchanged between remote and host trading partners. These tasks are 
described in detail in this section. 

Figure 9–3 Callout Management Tasks

Table 9–1 identifies the callout management tasks shown in Figure 9–3 and provides 
references to procedures for performing these tasks.

Creating a Callout
A predefined callout named XSLTCallout is provided for XML-to-XML 
transformations. You cannot update or delete this callout or create callout properties or 
callout usages for it. You can also create your own Java callouts. A callout includes 
attributes, such as a name, description, implementation class name, and callout .jar 
file library name. These callout details load the callout class, map the input and output 
parameters, and invoke the class. You can create multiple callouts with the same name. 
However, you must assign them different implementation names. Follow these 
instructions to create a callout:

1. Click Partners > Callouts.

2. Click Create in the Callouts section.

The Create Callout page appears.

3. Enter the following details to create a callout. An asterisk (*) indicates a required 
field.

Table 9–1 Callout Management Tasks

Page Elements Management Task See Section...

Create button in Callouts 
section of Figure 9–3

Create a callout "Creating a Callout" on 
page 9-5

Name column in Callouts 
section of Figure 9–3

View details about a callout "Viewing a Callout" on 
page 9-6

Update column in Callouts 
section of Figure 9–3

Update a callout "Updating a Callout" on 
page 9-6

Delete column in Callouts 
section of Figure 9–3

Delete a callout "Deleting a Callout" on 
page 9-7

Field Value

Name * Enter a unique and recognizable name for the callout.

Description Enter a description.

Implementation 
Name *

Enter the class file name. 

Note: OracleAS Integration B2B includes a predefined class file named 
XSLTCalloutImpl that you can use for XML-to-XML transformations.
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4. Click Apply.

The callout is created and the new Callout Details page appears. 

Viewing a Callout
Follow these instructions to view details about a specific callout:

1. Click Partners > Callouts.

2. Select a specific callout to view in the Name column of the Callouts section.

The Callout Details page for the selected callout appears.

3. View specific details, including the following:

■ The callout name, description, implementation name (class name), library 
name, and timeout value (in seconds)

■ Any callout properties assigned to this callout

■ The callout usages assigned to this callout (the source and target document 
definitions for the callout, such as a purchase order request and purchase 
order acceptance). For a callout to be selectable when you create a trading 
partner agreement, a callout usage must exist.

This page, as with the Callouts page shown in Figure 9–3 on page 9-5, enables you 
to delete or update a callout that you created.

4. Click Return to List to return to the Callouts page.

Updating a Callout
Follow these instructions to update a callout that you created:

1. Click Partners > Callouts.

2. Select a specific callout to update in the Update column of the Callouts section.

The Update Callout page appears.

Library Name * Enter the callout .jar file library name that defines how to perform the 
transformation. The class file is included in the .jar file.

Note: If you specify your own callout .jar file, the directory location 
for this file must be specified with the Callout Directory parameter of 
the Server Properties page in Oracle Enterprise Manager 10g 
Application Server Control Console. Note that the directory location for 
the default b2b.jar file included with OracleAS Integration B2B does 
not need to be specified.

Timeout (seconds) Enter the time limit in which to process the callout. 

Note: Do not modify the b2b.jar file included with OracleAS 
Integration B2B. Modifying this file can cause corruption.

See Also: "OracleAS Integration B2B Middle-Tier Instance Server 
Properties" on page 13-8 for instructions on accessing the Callout 
Directory server property in Oracle Enterprise Manager 10g 
Application Server Control Console to set the callout .jar file 
location

Field Value
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3. Make appropriate changes. (See Step 3 on page 9-5 for a list of fields you can 
update.)

4. Click Apply.

The callout is updated and the Callout Details page appears.

Deleting a Callout
Follow these instructions to delete a callout that you created:

1. Click Partners > Trading Partners > Callouts.

2. Select a specific callout to delete in the Delete column of the Callouts section.

3. Click Yes when prompted to delete a callout.

The callout is deleted and the Callouts page appears.

Managing Callout Properties
The OracleAS Integration B2B user interface tool enables you to perform the callout 
property management tasks shown in Figure 9–4. These tasks are described in detail in 
this section. A predefined callout property named xsltFile is included with the 
XSLTCalloutImpl class file (the implementation name). You can also create your own 
callout properties.

Callout properties are similar in concept to global variables to which you can assign 
local values that are applicable only to a specific callout usage. Or, you can create a 
callout property and assign it a default value that is applicable to all callout usages.

For example, the xsltFile property specifies the location for a specific .xslt file. Within 
one callout usage, you can assign a value to the xsltFile property that is appropriate 
for one specific callout usage (for example, /private/RNtoEBStransform.xslt for 
transformations from RosettaNet XML to Oracle E-Business Suite XML). In another 
callout usage, you can assign a different value (for example, 
private/EBStoRNtransform.xslt for transformations from Oracle E-Business Suite 
XML to RosettaNet XML).

Note: Ensure that you do not delete a callout included in a trading 
partner agreement of a configuration.
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Figure 9–4 Callout Property Management Tasks

Table 9–2 identifies the callout property management tasks shown in Figure 9–4 and 
provides references to procedures for performing these tasks.

Creating Callout Properties
Follow these instructions to create a callout property:

1. Click Partners > Callouts.

2. Select a specific callout in the Name column.

The Callout Details page appears.

3. Click Create in the Callout Properties section.

The Create Callout Property page appears.

4. Enter the following details to create a callout property. An asterisk (*) indicates a 
required field.

Table 9–2 Callout Property Management Tasks

Page Elements Management Task See Section...

Create button in Callout 
Properties section of Figure 9–4

Create a callout property "Creating Callout 
Properties" on page 9-8

Name column in Callout 
Properties section of Figure 9–4

View details about a callout 
property

"Viewing Callout 
Properties" on page 9-9

Update column in Callout 
Properties section of Figure 9–4

Update a callout property "Updating Callout 
Properties" on page 9-9

Delete column in Callout 
Properties section of Figure 9–4

Delete a callout property "Deleting Callout 
Properties" on page 9-10

See Also: "Creating a Callout Metadata Parameter Value for a 
Callout Usage" on page 9-13 to assign local values to a callout 
property that are applicable only to a specific callout usage and to 
create your own callout properties for a specific callout usage
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5. Click Apply.

The callout property is created and the new Callout Property Details page appears. 
You can now assign local values to this callout property that are applicable only to 
a specific callout usage. Or, you can use this callout property in its current format 
to be applicable to all callout usages.

Viewing Callout Properties
Follow these instructions to view details about a specific callout property:

1. Click Partners > Callouts.

2. Select a specific callout in the Name column.

The Callout Details page appears.

3. Select a specific callout to view in the Name column of the Callout Properties 
section.

The Callout Properties Details page for the selected callout property appears.

4. View specific details, including the callout property name, description, type (for 
example, string), if the property is mandatory, if the property is overridable, the 
minimum and maximum lengths, if encryption is enabled, and the default value 
(which is visible if not encrypted).

This page, as with the Callout Details page shown in Figure 9–4 on page 9-8, 
enables you to delete or update the selected callout property.

5. Click Return to List to return to the Callout Details page.

Updating Callout Properties
Follow these instructions to update a callout property:

1. Click Partners > Callouts.

2. Select a specific callout in the Name column.

The Callout Details page appears.

3. Select a specific callout to update in the Update column of the Callout Properties 
section.

Field Value

Name * Enter a unique and recognizable name for the callout property.

Description Enter an optional description. 

Type * Select a type (Boolean, date, float, integer, or string).

Mandatory Select False or True.

Overridable Select False or True. 

If set to True, you can override the value at the callout usage level. If set 
to False, do not enter a value at the callout usage level.

Minimum Length Enter a minimum length for the callout property.

Maximum Length Enter a maximum length for the callout property.

Encrypt Value Select False or True.

Default Value Enter a value. If the Encrypt Value is set to True, this value is encrypted.
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The Update Callout Property page appears.

4. Make appropriate changes. (See Step 4 on page 9-8 for a list of fields you can 
update.)

5. Click Apply.

The callout property is updated and the Callout Property Details page appears.

Deleting Callout Properties
Follow these instructions to delete a callout property:

1. Click Partners > Callouts.

2. Select a specific callout in the Name column.

The Callout Details page appears.

3. Select a specific callout property to delete in the Delete column of the Callout 
Properties section.

4. Click Yes when prompted to delete a callout property.

The callout property is deleted and the Callout Details page appears.

Managing Callout Usages
The OracleAS Integration B2B user interface tool enables you to perform the callout 
usage management tasks shown in Figure 9–5 and Figure 9–6. These tasks are 
described in detail in this section. Callout usage enables you to map the source (input) 
document definition to a target (output) document definition for a transformation. 
You select the callout usage when you create a trading partner agreement. A callout 
can have multiple callout usages. You can also create callout metadata parameter 
values unique to a specific callout usage or you can assign local values that override 
callout properties set at the callout level. 

Figure 9–5 Callout Usage Management Tasks (Part 1 of 2)
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Clicking Details for a specific callout usage in the Callout Usage section causes the 
Callout Usage Details page to appear:

Figure 9–6 Callout Usage Management Tasks (Part 2 of 2)

Table 9–3 identifies the callout usage management tasks shown in Figure 9–5 and 
Figure 9–6 and provides references to procedures for performing these tasks.

Creating a Callout Usage
If you want to select a callout when you create a trading partner agreement, you must 
first create a callout usage. A callout usage consists of a source (input) and target 
(output) document definition for transformation. The document definitions that 
display for selection are the ones you created through either of two methods:

■ Created support for a business action or collaboration with the Create Business 
Action wizard or Create Collaboration wizard

Table 9–3 Callout Usage Management Tasks

Page Elements Management Task See Section...

Create button in Callout Usage 
section of Figure 9–5

Create a callout usage "Creating a Callout Usage" 
on page 9-11

Details column in Callout 
Usage section of Figure 9–5

View details about a callout 
usage

"Viewing a Callout Usage" 
on page 9-12

Update column in Callout 
Usage section of Figure 9–5

Update a callout usage "Updating a Callout Usage" 
on page 9-13

Delete column in Callout 
Usage section of Figure 9–5

Delete a callout usage "Deleting a Callout Usage" 
on page 9-13

Create button in Callout 
Metadata Parameter Values 
section of Figure 9–6

Create a callout metadata 
parameter value for a callout 
usage

"Creating a Callout 
Metadata Parameter Value 
for a Callout Usage" on 
page 9-13

Name column in Callout 
Metadata Parameter Values 
section of Figure 9–6

View details about a callout 
metadata parameter value for a 
callout usage

"Viewing a Callout 
Metadata Parameter Value 
for a Callout Usage" on 
page 9-15

Update column in Callout 
Metadata Parameter Values 
section of Figure 9–6

Update a callout metadata 
parameter value for a callout 
usage

"Updating a Callout 
Metadata Parameter Value 
for a Callout Usage" on 
page 9-15

Delete column in Callout 
Metadata Parameter Values 
section of Figure 9–6

Delete a callout metadata 
parameter value for a callout 
usage

"Deleting a Callout 
Metadata Parameter Value 
of a Callout Usage" on 
page 9-15
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■ Imported EDI X12 and EDI EDIFACT transaction sets, UCCnet standards, and 
RosettaNet collaborations into the design-time repository by clicking 
Administration > Management > Import

Follow these instructions to create a callout usage:

1. Click Partners > Callouts.

2. Select a specific callout in the Name column.

The Callout Details page appears.

3. Click Create in the Callout Usage section.

The Create Callout Usage page appears.

4. Enter the following details to create a callout usage. An asterisk (*) indicates a 
required field.

5. Click Apply.

The callout usage is created and the new Callout Usage Details page appears. The 
callout usage can now be selected when you create a trading partner agreement.

Viewing a Callout Usage
Follow these instructions to view details about a specific callout usage:

1. Click Partners > Callouts.

2. Select a specific callout in the Name column.

The Callout Details page appears.

3. Select a specific callout usage to view in the Details column of the Callout Usage 
section.

The Callout Usage Details page for the selected callout usage appears.

4. View specific details, including the following.

■ View the callout usage name

Field Value

Source Document Definition * Select a source document definition.

The selection you make here is the input to the callout (for 
example, a purchase order request initiated by a remote 
trading partner, as shown in Figure 9–1 on page 9-3).

Target Document Definition * Select a target document definition.

The selection you make here is the output to the callout (for 
example, a purchase order acceptance for a host application 
of a host trading partner, as shown in Figure 9–1 on 
page 9-3).

See Also:

■ "Creating a Business Action" on page 6-17

■ "Creating a Collaboration" on page 6-23

■ "Creating a Trading Partner Agreement" on page 10-6

■ "Importing Support for Collaborations, Transaction Sets, and 
UCCnet Standards" on page 12-9



Managing Callout Usages

Managing Callouts 9-13

■ Callout metadata parameter value. You can also manage (create, view, update, 
and delete) callout metadata parameter values for the callout usage from this 
page. This enables you to create parameters unique to a specific callout usage 
or assign local values that override callout properties set at the callout level.

This page, as with the Callout Details page shown in Figure 9–5 on page 9-10, 
enables you to delete or update the selected callout usage.

5. Click Return to List to return to the Callout Details page.

Updating a Callout Usage
Follow these instructions to update a callout usage:

1. Click Partners > Callouts.

2. Select a specific callout in the Name column.

The Callout Details page appears.

3. Select a specific callout usage to update in the Update column of the Callout 
Usage section.

The Update Callout Usage page appears.

4. Make appropriate changes. (See Step 4 on page 9-12 for a list of fields you can 
update.)

5. Click Apply.

The callout usage is updated and the Callout Usage Details page appears.

Deleting a Callout Usage
Follow these instructions to delete a callout usage:

1. Click Partners > Callouts.

2. Select a specific callout in the Name column.

The Callout Details page appears.

3. Select a specific callout usage to delete in the Delete column of the Callout Usage 
section.

4. Click Yes when prompted to delete a callout usage.

The callout usage is deleted and the Callout Details page appears.

Creating a Callout Metadata Parameter Value for a Callout Usage
You can create a callout metadata parameter value for a callout usage that enables you 
to override properties set at the callout level (for example, with the xsltFile property). 
Callout metadata parameter values are similar in concept to local variables in that they 
are only applicable to a specific callout usage.

For example, the xsltFile property specifies the location for a specific .xslt file. Within 
one callout usage, you can assign a value to the xsltFile property that is appropriate 
for that specific callout usage (for example, /private/RNtoEBStransform.xslt for 
transformations from RosettaNet XML to Oracle E-Business Suite XML). In another 
callout usage, you can assign a different value (for example, 
private/EBStoRNtransform.xslt for transformations from Oracle E-Business Suite 
XML to RosettaNet XML).
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You can also create callout metadata parameter values unique to a specific callout 
usage.

1. Click Partners > Callouts.

2. Select a specific callout in the Name column.

The Callout Details page appears.

3. Select a specific callout usage in the Details column of the Callout Usage section.

The Callout Usage Details page for the selected callout usage appears.

4. Click Create in the Callout Metadata Parameter Values section.

The Create Callout Metadata Parameter Value page appears.

5. Select whether to create or use an existing callout property value.

6. Go to the following steps based on your selection.

7. If you selected the Use Existing Callout Property check box, perform Steps 7a 
through 7b.

a. Enter the following details to create a callout metadata parameter value. An 
asterisk (*) indicates a required field.

b. Go to Step 9.

8. If you did not select the Use Existing Callout Property check box, perform Steps 
8a through 8b.

a. Enter the following details to create a callout metadata parameter value. An 
asterisk (*) indicates a required field.

Did You Select the Use Existing Callout Property Check Box? Go To...

Yes Step 7

No Step 8

Field Value

Callout Property Select a callout property created at the callout level.

Value * Enter a callout property value. This value overrides the value set at the 
callout level.

Field Value

Name * Enter a unique and recognizable name for the callout metadata 
parameter value.

Description Enter an optional description. 

Type * Select a type (Boolean, date, float, integer, or string). 

Note: Changing a type can invalidate the callout metadata parameter 
value default value.

Note: The date value does not currently function properly. To use the 
date value, create a callout property in which you select the date value 
from the Type list of the Create Callout Property page. 

Encrypt Value Select False or True. You cannot update this value at a later time.
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b. Go to Step 9.

9. Click Apply.

The callout metadata parameter value for this callout usage is created and the new 
Callout Usage Details page appears.

Viewing a Callout Metadata Parameter Value for a Callout Usage
Follow these instructions to view details about a specific callout metadata parameter 
value for a callout usage:

1. Click Partners > Callouts.

2. Select a specific callout in the Name column.

The Callout Details page appears.

3. Select a specific callout usage in the Details column of the Callout Usage section.

The Callout Usage Details page for the selected callout usage appears.

4. View specific details in the Callout Metadata Parameter Values section, including 
the callout metadata parameter value name, if the value is encrypted, type (for 
example, string), and value.

5. Click Return to List to return to the Callout Details page.

Updating a Callout Metadata Parameter Value for a Callout Usage
Follow these instructions to update a callout metadata parameter value of a callout 
usage:

1. Click Partners > Callouts.

2. Select a specific callout in the Name column.

The Callout Details page appears.

3. Select a specific callout usage in the Details column of the Callout Usage section.

4. Select a specific callout metadata parameter value to update in the Update column 
of the Callout Metadata Parameter Values section.

The Update Callout Metadata Parameter Value page appears.

5. Update the callout metadata parameter value.

6. Click Apply.

The callout metadata parameter value is updated and the Callout Usage Details 
page appears.

Deleting a Callout Metadata Parameter Value of a Callout Usage
Follow these instructions to delete a callout metadata parameter value of a callout 
usage:

1. Click Partners > Callouts.

Value * Select Create New to create a new value or Use Existing to select an 
existing value. If Encrypt Value is set to True, this value is encrypted.

Field Value
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2. Select a specific callout in the Name column.

The Callout Details page appears.

3. Select a specific callout usage in the Details column of the Callout Usage section.

4. Select a specific callout metadata parameter value to delete in the Delete column 
of the Callout Metadata Parameter Values section.

5. Click Yes when prompted to delete a callout metadata parameter value.

The callout metadata parameter value is deleted and the Callout Usage Details 
page appears.

Tutorial: Adding Callout Usages to the RosettaNet over the Internet 
Transaction

This section describes how to add callout usages to the RosettaNet over the Internet 
tutorial described in "Tutorial 1: Setting Up a RosettaNet over the Internet Transaction" 
on page 5-7. These callout usages use the predefined callout named XSLTCallout to 
perform the following tasks:

■ Transform an Oracle E-Business Suite Open Application Group (OAG) purchase 
order document to a RosettaNet PIP 3A4 purchase order request document on the 
Acme server (the buyer)

■ Transform a RosettaNet PIP 3A4 purchase order request document to an OAG 
purchase order document on the GlobalChips server (the seller)

This section describes these tasks:

■ Acme Server, Task 1: Performing the RosettaNet over RNIF Tutorial

■ Acme Server, Task 2: Setting Up Callout Usages

■ GlobalChips Server, Task 1: Performing the RosettaNet over RNIF Tutorial

■ GlobalChips Server, Task 2: Setting Up Callout Usages

Acme Server, Task 1: Performing the RosettaNet over RNIF Tutorial
This tutorial assumes you have completed the RosettaNet over the Internet tutorial 
described in "Tutorial 1: Setting Up a RosettaNet over the Internet Transaction" on 
page 5-7. As part of that tutorial, you set up the Acme server, where Acme was the 
host trading partner (buyer) and GlobalChips was the remote trading partner (seller). 

Acme Server, Task 2: Setting Up Callout Usages
Perform the following callout usage tasks on the Acme server:

■ Create an OAG Custom Document Type

■ Modify XML Gateway Settings

■ Modify the XSLTCallout Settings

■ Create a Trading Partner Agreement

■ Create and Deploy a Configuration

See Also: "Callouts Overview" on page 9-2
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Create an OAG Custom Document Type
You now create a document type. The document definition of this document type 
becomes part of the callout usage you create later in this tutorial.

1. Click Partners > Protocols > Custom Document over Internet.

2. Click Create in the Document Protocol Revisions section.

3. Enter the following details:

4. Click Apply.

The Document Protocol Revision Details page appears.

5. Click Create in the Document Types section.

6. Enter the following details:

There are several document type parameters to use for integrating the OAG 
purchase order document with the XML Gateways. The first two document type 
parameter values enable the correct document type to be identified in the 
outbound direction. (A document type that has the document type parameter 
values specified for these two parameters is selected.)

Field Value

Name OAG

Note: This maps to a value in an enqueue script that you must create.

Revision 7.0

Details Field Value

Name OAG PO

Revision 7.0

Document Definition Field Value

Name OAG_DocDef

Document Type Parameters Field Value Description

Outbound Process Type POPI TRANSACTION_TYPE value specified in the 
outbound SYSTEM.ECXMSG message 
structure

Outbound Process SubType POPI TRANSACTION_SUBTYPE value specified in 
the outbound SYSTEM.ECXMSG message 
structure

Inbound Process Type POPI For incoming messages, the value of this 
parameter is placed in the TRANSACTION_
TYPE field of the SYSTEM.ECXMSG message 
structure

Inbound Process SubType POPI For incoming messages, the value of this 
parameter is placed in the TRANSACTION_
SUBTYPE field of the SYSTEM.ECXMSG 
message structure
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Do not provide values for any of the following parameters: 

■ OutboundPartyCode

Not applicable for XML Gateway integration

■ IdentifyingXPath

For an incoming REQUEST message, the value of this parameter is the xpath 
used when the DOCUMENT_NUMBER field is populated from the payload of the 
SYSTEM.ECXMSG message.

■ CorrelatingXPath

For an incoming ACKNOWLEDGE message, the value of this parameter is the 
xpath used when the DOCUMENT_NUMBER field is populated from the payload 
of the SYSTEM.ECXMSG message.

7. Click Apply.

You now associate this document type with the RosettaNet over RNIF business 
protocol.

8. Click Partners > Protocols > RosettaNet over RNIF.

9. Click Details in the Process Protocol Revisions section.

10. Click Details for 3A4 in the Collaborations section.

11. Click Request Purchase Order in the Business Transaction section.

12. Click Purchase Order Request Action in the Requesting Action section.

13. Click Purchase Order Request Action in the Business Action section.

14. Click Add in the Document Types section.

15. Select OAG PO from the Document Type list.

16. Click Apply.

The purchase order request action now includes the OAG purchase order 
document type.

Modify XML Gateway Settings
Oracle E-Business Suite uses the XML Gateway Inbound and XML Gateway 
Outbound internal delivery channels. You now update these internal delivery 
channels with connection information appropriate to your environment.

1. Click Partners > Trading Partners.

2. Click Acme (Host) in the Name column.

3. Click Capabilities at the top of the Trading Partner Details page.

4. Click XML Gateway Inbound in the Transport Server column of the Internal 
Delivery Channels section.

Inbound Party Code 3101 For incoming messages, the value of this 
parameter is placed in the PARTY_TYPE field 
of the SYSTEM.ECXMSG message structure

See Also: "Integrations with Oracle E-Business Suite" on page 3-4 for 
details about the SYSTEM.ECXMGS message structure

Document Type Parameters Field Value Description
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5. Click Update on the Transport Server Details page.

6. Enter details in the following fields that are appropriate to your environment:

7. Click Update.

8. Click Return to List at the bottom of the page.

9. Click XML Gateway Outbound in the Transport Server column of the Internal 
Delivery Channels section.

10. Repeat Steps 5 through 7.

11. If you changed the Username parameter in Step 6, you must also update the 
endpoint URIs for both XML Gateway internal delivery channels:

a. Click Partners > Trading Partners > Acme (Host).

b. Click Capabilities at the top of the Trading Partner Details page.

c. Click the RosettaNet over RNIF business protocol.

d. Click Update for apps.ECX_OUTBOUND in the Endpoints section.

e. Update the name to b2b.ECX_OUTBOUND.

f. Click Update.

g. Repeat Step 11d through Step 11f for the apps.ECX_INBOUND endpoint URI.

Modify the XSLTCallout Settings
1. Click Partners > Callouts.

2. Select XSLTCallout in the Name column.

3. Click Create in the Callout Usage section.

4. Enter the following details to create a callout usage that takes the OAG purchase 
order document definition and maps it to the RosettaNet PIP 3A4 purchase order 
request document.

5. Click Apply.

General Field Value

Host Name your_host

IP Address your_IP_address

Username username

Password password

Transport Parameter Values Field Value

port port_number

sid database_sid

Field Value

Source Document Definition OAG_DocDef

Target Document Definition Pip3a4PurchaseOrderRequest
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6. Click Create in the Callout Metadata Parameter Values section.

The Create Callout Metadata Parameter Value page appears.

7. Click the Use Existing Callout Property check box.

8.  Enter the following details to create a callout metadata parameter value.

9. Click Apply.

Create a Trading Partner Agreement
1. Follow the instructions in "Acme Server, Task 3: Creating the Trading Partner 

Agreement" on page 5-13 to create a trading partner agreement. Make the 
following selections:

■ Select XML Gateway Outbound from the Internal Delivery Channel list.

■ Select the associated OAG_DocDef -> Pip3A4PurchaseOrderRequest callout 
usage from the Callout Usage list.

Create and Deploy a Configuration
1. Follow the instructions in "Acme Server, Task 4: Creating and Deploying the 

Configuration" on page 5-13 to create and deploy a configuration.

GlobalChips Server, Task 1: Performing the RosettaNet over RNIF Tutorial
This tutorial assumes you have completed the RosettaNet over the Internet tutorial 
described in "Tutorial 1: Setting Up a RosettaNet over the Internet Transaction" on 
page 5-7. As part of that tutorial, you set up the GlobalChips server (seller), where 
GlobalChips was the host trading partner and Acme was the remote trading partner 
(buyer). On both servers, Acme was the buyer and GlobalChips was the seller.

GlobalChips Server, Task 2: Setting Up Callout Usages
Perform the following callout usage tasks on the GlobalChips server:

■ Create an OAG Custom Document Type

■ Modify XML Gateway Settings

■ Modify the XSLTCallout Settings

■ Create a Trading Partner Agreement

■ Create and Deploy a Configuration

Create an OAG Custom Document Type
1. Follow the instructions in "Create an OAG Custom Document Type" on page 9-17 

to create an OAG PO document type on the GlobalChips server.

Field Value

Callout Property xsltFile

Value Provide the complete directory path to the XSLT file that you create to 
transform the OAG purchase order document to a RosettaNet PIP 3A4 
purchase order request (for example, named oag_po_to_3a4_req.xslt).
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Modify XML Gateway Settings
1. Follow the instructions in "Modify XML Gateway Settings" on page 9-18 to modify 

the XML Gateway settings on the GlobalChips server. This time, select 
GlobalChips (Host) on the Trading Partners page.

Modify the XSLTCallout Settings
1. Click Partners > Callouts.

2. Select XSLTCallout in the Name column.

3. Click Create in the Callout Usage section.

4. Enter the following details to create a callout usage that takes the RosettaNet PIP 
3A4 purchase order request document and maps it to the OAG purchase order 
document definition.

5. Click Apply.

6. Click Create in the Callout Metadata Parameter Values section.

The Create Callout Metadata Parameter Value page appears.

7. Click the Use Existing Callout Property check box.

8.  Enter the following details to create a callout metadata parameter value.

9. Click Apply.

Create a Trading Partner Agreement
1. Follow the instructions in "GlobalChips Server, Task 3: Creating the Trading 

Partner Agreement" on page 5-17 to create a trading partner agreement. Make the 
following selections:

■ Select XML Gateway Inbound from the Internal Delivery Channel list.

■ Select the associated Pip3A4PurchaseOrderRequest -> OAG_DocDef callout 
usage from the Callout Usage list.

Create and Deploy a Configuration
1. Follow the instructions in "GlobalChips Server, Task 4: Creating and Deploying the 

Configuration" on page 5-18 to create and deploy a configuration.

Field Value

Source Document Definition Pip3a4PurchaseOrderRequest

Target Document Definition OAG_DocDef

Field Value

Callout Property xsltFile

Value Provide the complete directory path to the XSLT file that you create to 
transform the RosettaNet PIP 3A4 purchase order request to an OAG 
purchase order document (for example, named 3a4_req_to_oag_
po.xslt).
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Common User Errors
■ Do not include beginning or trailing blank spaces in the names of callout partner 

data that you create.

■ Do not have two callouts with the same name and same implementation name.

Chapter Summary
This chapter describes how to use callouts to transform documents from one form to 
another. You can use callouts to invoke an XSLT style sheet and any Java program in 
general. For example, an incoming remote trading partner’s EDI document is sent to 
the host trading partner’s host Oracle E-Business Suite application, which uses XML. 
Callouts enable you to transform the EDI document into an XML format understood 
by the Oracle E-Business Suite application. The outgoing document can then be 
transformed back into its original format. Callouts are associated with internal 
delivery channels. This chapter also provides a tutorial that describes how to add 
callout usages to the RosettaNet over the Internet tutorial described in "Tutorial 1: 
Setting Up a RosettaNet over the Internet Transaction" on page 5-7.
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10
Creating and Managing Trading Partner

Agreements

This chapter describes the tasks required to create and manage a trading partner 
agreement between a host and remote trading partner. Both trading partners include 
support for a business protocol with operational and communication capabilities.

This chapter contains these topics:

■ Trading Partner Agreement Overview

■ Managing Trading Partner Agreements

■ Managing Trading Partner Agreement Participants

■ Managing Delivery Channels of Trading Partner Agreement Participants

■ Common User Errors

■ Chapter Summary

See Also:

■ Chapter 7, "Creating Trading Partners" for instructions on creating 
a remote trading partner, assigning it support for a business 
protocol, creating business protocol operational and 
communication capabilities for the remote trading partner, and 
creating communication capabilities for the business protocol of 
the host trading partner

■ Chapter 8, "Managing Trading Partners" for instructions on 
managing trading partners, their business protocols, and the 
business protocol operational and communication capabilities
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Trading Partner Agreement Overview
The following sections provide an overview on creating a trading partner agreement:

■ What is A Trading Partner Agreement?

■ How Do You Create a Trading Partner Agreement?

■ Prerequisites to Creating a Trading Partner Agreement

What is A Trading Partner Agreement?
A trading partner agreement defines the behavior that trading partners agree to follow 
when engaging in a business transaction. A trading partner agreement consists of two 
trading partners:

■ Host trading partner

■ Remote trading partner 

A remote trading partner in an agreement includes support for a specific business 
protocol and its associated: 

■ Support for a collaboration (the RosettaNet over RNIF business protocol) or 
business action (for any EDI or Custom Document business protocol). Trading 
partners define their operational capabilities by the collaborations or business 
actions they support. 

■ Delivery channel, which defines details such as nonrepudiation, encryption, and 
transport security capabilities, as well as the document exchange and transport 
used (known in the OracleAS Integration B2B user interface tool as the 
communication capabilities) 

■ Trading partner identification type and value, such as a DUNS number

The host trading partner also includes a delivery channel and trading partner 
identification type and value. However, the host trading partner does not include a 
specific business protocol and its associated support for a collaboration or business 
action. The host trading partner instead is automatically assigned support for all 
business protocols and associated collaborations and business actions included in 
OracleAS Integration B2B. You assign support for a business protocol and a 
collaboration or business action to a remote trading partner. The host trading partner 
is automatically assigned support for a business protocol and a collaboration or 
business action that are compatible with the selections for the remote trading partner. 
This action simplifies your user experience.

Figure 10–1 shows the contents of a trading partner agreement.
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Figure 10–1 Trading Partner Agreement

How Do You Create a Trading Partner Agreement?
The OracleAS Integration B2B user interface tool enables you to perform the following 
tasks to create a trading partner agreement:

■ Select the remote trading partner

■ Select the business protocol support for the remote trading partner

■ Select support for a collaboration (for the RosettaNet over RNIF business protocol) 
or business action (for any EDI or Custom Document business protocol) for the 
business protocol of the remote trading partner. Trading partners define their 
operational capabilities by the collaborations or business actions they support.

You do not need to select support for the business protocol and a collaboration or 
business action for the host trading partner. Based on your selections for the 
remote trading partner, the host trading partner is automatically assigned details 
that are compatible with those of the remote trading partner. For example, if you 
select support for the RosettaNet over RNIF business protocol and Buyer - 3A4 - 
V02.00 as the collaboration and role for the remote trading partner, the host 
trading partner is automatically assigned support for RosettaNet over RNIF as the 
business protocol and Seller - 3A4 - V02.00 as the collaboration and role. This 
simplifies your user experience.

■ Select the trading partner identification types and delivery channels 
(communication capabilities) for both the remote and host trading partners

■ Select the host trading partner internal delivery channel and (optionally) the 
callout usages

■ Assign a required trading partner agreement name and identifier

■ Assign optional details such as an agreement description, dates during which the 
agreement is active, invocation limit, and concurrent conversation limit

Figure 10–2 shows the page for creating a trading partner agreement.

Remote Trading Partner

Acme

RosettaNet over RNIF

Buyer-3A4-V02.00

123456789

Acme_DC

Host Trading Partner

GlobalChips **

RosettaNet over RNIF**

Seller-3A4-V02.00**

372463489

GlobalChips_DC

Participant

Business Protocol

Collaboration* (Operational Capabilities)

Trading Partner Identification

Delivery Channel (Communication Capabilities)

Trading Partner Agreement: Acme_3A4

* If the RosettaNet over RNIF business protocol is used, collaborations are part of the trading partner agreement. 
If any EDI or Custom Document business protocol is used, Business Actions are part of the trading partner agreement.

** Automatically included in the trading partner agreement.
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Figure 10–2 Create Trading Partner Agreement Page

Prerequisites to Creating a Trading Partner Agreement
Ensure that you review and complete the prerequisites described in Table 10–1 before 
creating a trading partner agreement.

Table 10–1 Prerequisites to Creating a Trading Partner Agreement

Prerequisite See Section...

Remote trading partner

■ Create a remote trading partner 

■ Assign support for a business protocol to the remote 
trading partner

■ Assign support for a collaboration or business action 
(operational capabilities) and delivery channel 
(communication capabilities) to the business protocol of 
the remote trading partner

Chapter 7, "Creating Trading 
Partners"

■ Define a trading partner identification type for the 
remote trading partner or use the automatically created 
type of Name

Chapter 7, "Creating Trading 
Partners" or "Creating Trading 
Partner Identification" on 
page 8-8

Host trading partner

■ Define delivery channel (communication capabilities) 
for the host trading partner

Chapter 7, "Creating Trading 
Partners"

■ Define a trading partner identification type for the host 
trading partner or use the automatically created type of 
Name

"Creating Trading Partner 
Identification" on page 8-8
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Managing Trading Partner Agreements
The Oracle Application Server Integration B2B user interface tool enables you to 
perform the trading partner agreement management tasks shown in Figure 10–3. The 
trading partner agreement defines the behavior that the host and remote trading 
partners agree to follow when engaging in a business transaction. These tasks are 
described in detail in this section.

Figure 10–3 Trading Partner Agreement Management Tasks

Table 10–2 identifies the trading partner agreement management tasks shown in 
Figure 10–3 and provides references to procedures for performing these tasks.

■ Create internal delivery channels or use the predefined 
selections

"Managing Internal Delivery 
Channels" on page 8-30

■ Create callout usages (optional) Chapter 9, "Managing Callouts"

Table 10–2 Trading Partner Agreement Management Tasks

Page Elements Management Task See Section...

Shortcut section of 
Figure 10–3

Take a shortcut to create a remote 
trading partner (the host trading 
partner is automatically created)

"Creating and Assigning All 
Capabilities During a Single 
Wizard Session" on page 7-9

Create button of 
Figure 10–3

Create a trading partner agreement "Creating a Trading Partner 
Agreement" on page 10-6

Name column of 
Figure 10–3

View details about a trading partner 
agreement

"Viewing a Trading Partner 
Agreement" on page 10-8

Update column of 
Figure 10–3

Update a trading partner agreement "Updating a Trading Partner 
Agreement" on page 10-9

Delete column of 
Figure 10–3

Delete a trading partner agreement "Deleting a Trading Partner 
Agreement" on page 10-10

Note: The state of the trading partner agreement displays in the 
State column of the Trading Partner Agreements page. (See 
Figure 10–3.)

See Also: "Viewing the State of Partner Data on the Details Pages" 
on page 4-12 for details about lifecycle states of trading partners and 
trading partner agreements

Table 10–1 (Cont.) Prerequisites to Creating a Trading Partner Agreement

Prerequisite See Section...
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Creating a Trading Partner Agreement
You create a trading partner agreement between the host trading partner and a remote 
trading partner. Follow these instructions to create a trading partner agreement:

1. Click Partners > Agreements > Create or Partners > Create Trading Partner 
Agreement in the Shortcuts section.

The Create Agreement screen appears.

2. Select a remote trading partner from the Trading Partner list. You must already 
have created a remote trading partner for one to display in this list. If you have not 
already done so, see "Creating and Assigning All Capabilities During a Single 
Wizard Session" on page 7-9 for instructions. 

The host trading partner is not available for selection; it is automatically included 
in the trading partner agreement and does not need to be selected.

The page refreshes to display the Supported Business Protocol list.

3. Select a business protocol. You must already have assigned support for a business 
protocol to this remote trading partner for one to display in this list. If you have 
not already done so, see "Creating and Assigning All Capabilities During a Single 
Wizard Session" on page 7-9 for instructions.

The page refreshes. The list that now displays immediately under the Supported 
Business Protocol list is based on the business protocol you selected.

4. Make a selection based on the business protocol type you selected.

Note: You cannot create a trading partner agreement between more 
than two trading partners.

If You Selected... Then...

RosettaNet over RNIF Select support for a collaboration from the Supported 
Collaboration list (for example, Buyer - 3A4 - V02.00). 

This is the collaboration you selected when you created this 
remote trading partner. To simplify your user experience, the host 
trading partner is automatically assigned support for a 
collaboration that is compatible with your remote trading partner 
selection (for example, Seller - 3A4 - V02.00).

Any EDI or Custom 
Document business 
protocol

Select support for a business action from the Supported Business 
Actions list. 

This is the business action you selected when you created this 
remote trading partner. To simplify your user experience, the host 
trading partner is automatically assigned support for a business 
action that is compatible with your remote trading partner 
selection.

Note: You can select support for only one collaboration or business 
action at a time. To add additional collaborations or business actions 
to the agreement, you must first create the agreement, then click Add 
in the Trading Partner Participants section of the Agreement Details 
page.
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5. Enter the following details to create a trading partner agreement. An asterisk (*) 
indicates a required field. 

Field Value

Host/Trading Partner Both the host and remote trading partner appear in this section.

■ Trading Partner 
Identification *

Select trading partner identification type values for both the host 
and remote trading partners. Both trading partners automatically 
include a default identification type called Name. You can also use 
one of the other predefined identification types (for example, a Data 
Universal Numbering System (DUNS)) or create your own 
identification type.

See Also: "Creating Trading Partner Identification" on page 8-8 for 
instructions on creating a trading partner identification type

■ Trading Partner 
Delivery Channel *

Select the delivery channels for both the host and remote trading 
partners. You must have already created delivery channels for both 
trading partners for selections to display in these lists. 

See Also: Chapter 7, "Creating Trading Partners" for instructions on 
creating a delivery channel

Host Delivery Channel 
and Callout Usage

■ Internal Delivery 
Channel *

Select the internal delivery channel to use for sending messages (for 
example, sending an outbound purchase order request from the host 
application of the host trading partner to the remote trading 
partner). This delivery channel communicates between the host 
trading partner’s host application and OracleAS Integration B2B. 
OracleAS Integration B2B includes four predefined internal delivery 
channels. You can also create your own.

Note: The default internal delivery channel selection is sufficient for 
most environments.

See Also: "Managing Internal Delivery Channels" on page 8-30 for 
additional details about internal delivery channels

■ Callout Usage If required, select a callout usage to use to transform the format of 
one message to another. This field is associated with the Internal 
Delivery Channel field. For example, if the internal delivery channel 
is used for sending an outbound purchase order request from the 
host application of the host trading partner to the remote trading 
partner, the callout usage translates the outbound purchase order 
request into a format understood by the remote trading partner.

See Also: "Managing Callouts" on page 9-5 for additional details 
about callouts and callout usages

■ Responding 
Internal Delivery 
Channel

If required, select the internal delivery channel to use for responding 
to (acknowledging) messages (for example, sending an inbound 
purchase order acceptance from the remote trading partner to the 
host application of the host trading partner).

Note: This field appears if you selected Yes from the Is 
Acknowledgment Handled By Integration B2B? list when creating a 
remote trading partner on the Operational Capabilities page.

Note: The default internal delivery channel selection is sufficient for 
most environments.

See Also: "Managing Internal Delivery Channels" on page 8-30 for 
additional details about responding internal delivery channels
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6. Click Apply.

The trading partner agreement is created and the Agreement Details page appears. 
To simplify your user experience, the host trading partner is automatically 
assigned support for a collaboration or business action that is compatible with that 
assigned to the remote trading partner. For example, if remote trading partner 
support is for collaboration Buyer - 3A4 - V02.00, the host trading partner is 
automatically assigned support for collaboration Seller - 3A4 - V02.00.

7. Click Validate. 

If successful, the message agreement_name Agreement is valid appears at the top.

Viewing a Trading Partner Agreement
Follow these instructions to view details about a specific trading partner agreement:

1. Click Partners > Agreements.

2. Select a specific trading partner agreement to view in the Name column.

■ Responding Callout 
Usage

If required, select a responding callout usage to use to transform the 
format of one message to another. This field is associated with the 
Responding Internal Delivery Channel field. For example, if the 
responding internal delivery channel is used for sending an inbound 
purchase order acceptance from the remote trading partner to the 
host application of the host trading partner, the callout usage 
translates the inbound purchase order acceptance into a format 
understood by the host application of the host trading partner.

See Also: "Managing Callouts" on page 9-5 for additional details 
about callouts and responding callout usages

Note: This field appears if you selected Yes from the Is 
Acknowledgment Handled By Integration B2B? list when creating a 
remote trading partner on the Operational Capabilities page.

General

■ Name * Enter a unique and recognizable name for the trading partner 
agreement.

■ Agreement Id * Enter a unique agreement identifier. 

■ Description Enter a description for the trading partner agreement.

■ Effective From Date Select the calendar icon to enter an agreement beginning date. If no 
date is specified, the agreement is always effective.

■ Effective To Date Select the calendar icon to enter an agreement ending date. If no date 
is specified, the agreement is always effective.

■ Invocation Limit Enter a value for the maximum number of times the collaboration or 
business action can be invoked. If you do not enter a value, there is 
no limit on the number of invocations.

■ Concurrent 
Conversations

Enter a value for the maximum number of concurrent business 
actions or collaborations that can be in progress.

See Also:

■ "Managing Internal Delivery Channels" on page 8-30

■ "Managing Callouts" on page 9-5

Field Value
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The Agreement Details page for the selected trading partner agreement appears.

3. View specific details, including the following:

■ The agreement ID, agreement description, dates during which the agreement 
is active, invocation limit, number of concurrent conversations, and 
agreement state (in the Details section)

■ The host and remote trading partners in this agreement (known as 
participants in the OracleAS Integration B2B user interface tool) and their 
associated support for a collaboration (for the RosettaNet over RNIF business 
protocol) or business action (for any EDI or Custom Document business 
protocols).

See Figure 10–4 on page 10-10 for an example of an Agreement Details page.

This page, as with the Trading Partner Agreements page shown in Figure 10–3 on 
page 10-5, enables you to delete or update a trading partner agreement.

Depending on the current state of an agreement (which displays in the State field 
of the Details section), different buttons and additional sections can also display. If 
the state is Approved or Deployed, no button displays.

The Export button also displays on the Agreement Details page. This button 
enables you to export your partner data to an XML file. You can then submit this 
file for review to applicable trading partners in a trading partner agreement to 
ensure that it is correct.

4. Click Return to List to return to the Trading Partner Agreements page.

Updating a Trading Partner Agreement
Follow these instructions to update a trading partner agreement:

1. Click Partners > Agreements. 

2. Select a specific trading partner agreement to update in the Update column.

The Update Agreement page appears.

3. Make appropriate updates. An asterisk (*) indicates a required field.

See Also: These sections for instructions on performing the 
following tasks:

■ "Viewing the State of Partner Data on the Details Pages" on 
page 4-12 for details about the states (such as Draft) that 
display on agreement details pages

■ "Exporting Partner Data to an XML File" on page 4-10 for 
details about the Export button

Field Value

Name * Update with a unique and recognizable name for the trading partner 
agreement.

Agreement Id * Update the agreement identifier.

Description Update the description for the trading partner agreement.

Effective From Date Select the calendar icon to update an agreement beginning date. If no 
date is specified, the agreement is always effective.
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4. Click Apply.

The agreement is updated and the Agreement Details page appears.

Deleting a Trading Partner Agreement
Follow these instructions to delete a trading partner agreement:

1. Click Partners > Agreements.

2. Select a specific trading partner agreement to delete in the Delete column.

3. Click Yes when prompted to delete a trading partner agreement.

The trading partner agreement is deleted and the Trading Partner Agreements 
page appears.

Managing Trading Partner Agreement Participants
The Oracle Application Server Integration B2B user interface tool enables you to 
perform the trading partner agreement participant management tasks shown in 
Figure 10–4. Participants are the host and remote trading partners that you assigned to 
the trading partner agreement in "Creating a Trading Partner Agreement" on 
page 10-6. These tasks are described in detail in this section.

Figure 10–4 Trading Partner Agreement Participant Management Tasks

Effective To Date Select the calendar icon to update an agreement ending date. If no date 
is specified, the agreement is always effective.

Invocation Limit Update the value for the maximum number of times the collaboration or 
business action can be invoked. If you do not enter a value, there is no 
limit on the number of invocations.

Concurrent 
Conversations

Update the value for the maximum number of concurrent business 
actions or collaborations that can be in progress.

Field Value
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Table 10–3 identifies the trading partner agreement participant management tasks 
shown in Figure 10–4 and provides references to procedures for performing these 
tasks.

Adding Additional Identifications and Operational and Communication Capabilities to 
Trading Partner Agreement Participants

You can add additional trading partner identifications, support for business protocols 
and a collaboration or business action (operational capabilities), and delivery channels 
(communication capabilities) to trading partners in this agreement. 

Follow these instructions to add additional identifications and operational and 
communication capabilities to trading partners in a trading partner agreement.

1. Click Partners > Agreements.

2. Select a specific trading partner agreement in the Name column.

The Agreement Details page for the selected trading partner agreement appears. 

3. Click Add in the Trading Partner Participants section.

The Add Trading Partner Participant page appears.

4. Select a business protocol from the Supported Business Protocol list.

The page refreshes to display additional fields. 

5. Make an appropriate selection from the Supported Collaboration list (if your 
business protocol selection is RosettaNet over RNIF) or the Supported Business 
Action list (if your business protocol selection is any EDI or Custom Document 
protocol).

Table 10–3 Trading Partner Agreement Participant Management Tasks

Page Elements Management Task See Section...

Add button in Trading 
Partner Participants 
section of Figure 10–4

Add additional identification and 
operational and communication 
capabilities to trading partner 
agreement participants

"Adding Additional 
Identifications and 
Operational and 
Communication Capabilities 
to Trading Partner 
Agreement Participants" on 
page 10-11

Name column in 
Trading Partner 
Participants section of 
Figure 10–4

View details about a trading partner 
agreement participant

"Viewing a Trading Partner 
Agreement Participant" on 
page 10-12

Update column in 
Trading Partner 
Participants section of 
Figure 10–4

Update a trading partner agreement 
participant

"Updating a Trading Partner 
Agreement Participant" on 
page 10-13

Remove column in 
Trading Partner 
Participants section of 
Figure 10–4

Remove a trading partner agreement 
participant

"Removing a Trading 
Partner Agreement 
Participant" on page 10-14
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6. Enter the following details:

7. Click Apply.

The trading partner agreement participant details are updated and the Trading 
Partner Participant Details page appears. 

Viewing a Trading Partner Agreement Participant
Follow these instructions to view details about a specific trading partner agreement 
participant:

1. Click Partners > Agreements.

2. Select a specific trading partner agreement in the Name column.

The Agreement Details page for the selected trading partner agreement appears. 

3. Select a specific trading partner participant to view in the Name column of the 
Trading Partner Participants section.

The Trading Partner Participant Details page for the selected trading partner 
agreement participant appears.

4. View specific details about the identification value and support for a collaboration 
(for the RosettaNet over RNIF business protocol) or business action (for any EDI 
or Custom Document business protocol). You can also view and manage (add, 
remove, and update) the delivery channel associated with this trading partner 
agreement participant.

See Figure 10–5 on page 10-14 for an example of the Trading Partner Participant 
Details page.

5. Click Return to List to return to the Agreement Details page for the selected 
trading partner agreement.

Field Value

Host/Trading Partner Both the host and remote trading partner appear in this section.

■ Trading Partner 
Identification

Select trading partner identification type values for both the host and 
remote trading partners. The host and remote trading partners 
automatically include a default identification type called Name. You 
can also create your own identification type.

See Also: "Creating a Trading Partner Identification Type" on 
page 12-4 for instructions on creating a trading partner identification 
type

■ Trading Partner 
Delivery Channel

Select the delivery channels for both the host and remote trading 
partners. You must have already created delivery channels for both 
trading partners for selections to display in these lists. 

See Also: Chapter 7, "Creating Trading Partners" for instructions on 
creating a delivery channel

Note: If you change the support for a collaboration or business 
action associated with a remote trading partner, the host trading 
partner automatically adjusts to support a collaboration or business 
action that is compatible with the remote trading partner. This 
simplifies your user experience.
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Updating a Trading Partner Agreement Participant
Follow these instructions to update the trading partner identification, delivery 
channel, internal delivery channel, and callout usage of a trading partner agreement 
participant.

1. Click Partners > Agreements.

2. Select a specific trading partner agreement in the Name column.

The Agreement Details page for the selected trading partner agreement appears. 

3. Select a specific trading partner participant to update in the Update column of the 
Trading Partner Participants section.

The Update Trading Partner Participant page appears.

4. Make appropriate updates.

5. Click Apply.

The trading partner agreement participant is updated and the Trading Partner 
Participant Details page appears.

Field Value

Host/Trading Partner Both the host and remote trading partner appear in this section.

■ Trading Partner 
Identification

Update the trading partner identification type values for both the host 
and remote trading partners. Both trading partners include a default 
identification type called Name that is automatically included with 
OracleAS Integration B2B. You can also create your own identification 
type.

See Also: "Creating a Trading Partner Identification Type" on 
page 12-4 for instructions on creating a trading partner identification 
type

■ Trading Partner 
Delivery Channel

Update the delivery channels for both the host and remote trading 
partners. You must have already created delivery channels for both 
trading partners for selections to display in these lists. 

See Also: Chapter 7, "Creating Trading Partners" for instructions on 
creating a delivery channel

Host Delivery Channel 
and Callout Usage

■ Internal Delivery 
Channel

Update the internal delivery channel of the host trading partner. 

See Also: Step 5 on page 10-7 for a description of internal delivery 
channels

■ Callout Usage Update the callout usage associated with the internal delivery channel 
of the host trading partner. 

See Also: Step 5 on page 10-7 for a description of callout usages

■ Responding 
Internal Delivery 
Channel

Update the responding internal delivery channel of the host trading 
partner. 

See Also: Step 5 on page 10-7 for a description of responding internal 
delivery channels

■ Responding 
Callout Usage

Update the responding callout usage associated with the responding 
internal delivery channel of the host trading partner. 

See Also: Step 5 on page 10-7 for a description of responding callout 
usages
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Removing a Trading Partner Agreement Participant
Follow these instructions to remove a remote trading partner agreement participant. 
You cannot remove the host trading partner participant.

1. Click Partners > Agreements.

2. Select a specific trading partner agreement in the Name column.

The Agreement Details page for the selected trading partner agreement appears. 

3. Select a specific trading partner participant to remove in the Remove column of 
the Trading Partner Participants section.

4. Click Yes when prompted to remove a trading partner agreement participant. 

The trading partner agreement participant is removed and the Agreement Details 
page appears. A trading partner agreement requires two trading partners (the host 
trading partner and a remote trading partner) as participants. If your agreement 
includes less than two participants, you must add the necessary number of trading 
partners.

Managing Delivery Channels of Trading Partner Agreement Participants
The Oracle Application Server Integration B2B user interface tool enables you to 
perform the delivery channel management tasks shown in Figure 10–5. These tasks are 
described in detail in this section. The delivery channel describes security 
characteristics such as nonrepudiation of origin and receipt, acknowledgment mode, 
time to acknowledge, retry count, transport security, encryption, and file compression. 
Document exchange and transport details are also assigned to a delivery channel.

Figure 10–5 Delivery Channel Management Tasks

Table 10–4 identifies the delivery channel management tasks shown in Figure 10–5 and 
provides references to procedures for performing these tasks.

Table 10–4 Delivery Channel Management Tasks

Page Elements Management Task See Section...

Add button in 
Delivery Channels 
Used section of 
Figure 10–5

Add a delivery channel to a trading 
partner agreement participant 

"Adding a Delivery Channel 
to a Trading Partner 
Agreement Participant" on 
page 10-15

Name column in 
Delivery Channels 
Used section of 
Figure 10–5

View details about a delivery channel of 
a trading partner agreement participant

"Viewing a Delivery Channel 
of a Trading Partner 
Agreement Participant" on 
page 10-15
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Adding a Delivery Channel to a Trading Partner Agreement Participant
If you previously removed a delivery channel from a trading partner participant in an 
agreement, you can add a new delivery channel. You can also use this page to change 
the delivery channel used by a trading partner participating in an agreement. Follow 
these instructions to perform either of these tasks.

1. Click Partners > Agreements.

2. Select a specific trading partner agreement in the Name column.

The Agreement Details page for the selected trading partner agreement appears. 

3. Select a specific trading partner participant in the Name column of the Trading 
Partner Participants section.

The Trading Partner Participant Details page for the selected trading partner 
agreement participant appears.

4. Click Add in the Delivery Channels Used section.

The Add Participant Delivery Channel page appears.

5. Select a delivery channel from the Delivery Channel list. 

6. Click Apply.

The delivery channel is added and the Participant Delivery Channel Details page 
appears.

Viewing a Delivery Channel of a Trading Partner Agreement Participant 
Follow these instructions to view details about a delivery channel of a trading partner 
agreement participant:

1. Click Partners > Agreements.

2. Select a specific trading partner agreement in the Name column.

The Agreement Details page for the selected trading partner agreement appears. 

3. Select a specific trading partner participant in the Name column of the Trading 
Partner Participants section.

The Trading Partner Participant Details page appears.

4. Select a specific delivery channel to view in the Name column of the Delivery 
Channels Used section.

Update column in 
Delivery Channels 
Used section of 
Figure 10–5

Update a delivery channel of a trading 
partner agreement participant

"Updating a Delivery 
Channel of a Trading Partner 
Agreement Participant" on 
page 10-16

Remove column in 
Delivery Channels 
Used section of 
Figure 10–5

Remove a delivery channel from a 
trading partner agreement participant

"Removing a Delivery 
Channel from a Trading 
Partner Agreement 
Participant" on page 10-16

See Also: Chapter 7, "Creating Trading Partners" for procedures on 
creating a delivery channel

Table 10–4 (Cont.) Delivery Channel Management Tasks

Page Elements Management Task See Section...
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The Participant Delivery Channel Details page for the selected delivery channel 
appears.

5. View specific details about the document exchange and transport associated with 
this delivery channel, and the status of acknowledgment mode, global usage code, 
nonrepudiation of receipt, nonrepudiation of origin, encryption, transport security, 
time to acknowledgment value, and retry count value. 

This page, as with the Trading Partner Participant Details page shown in 
Figure 10–5 on page 10-14, enables you to remove or update the delivery channel 
of the selected trading partner agreement participant.

6. Click Return to List to return to the Trading Partner Participant Details page.

7. Click Return to List to return to the Agreement Details page.

Updating a Delivery Channel of a Trading Partner Agreement Participant
Follow these instructions to update a delivery channel of a trading partner agreement 
participant:

1. Click Partners > Agreements.

2. Select a specific trading partner agreement in the Name column.

The Agreement Details page for the selected trading partner agreement appears. 

3. Select a specific trading partner participant in the Name column of the Trading 
Partner Participants section.

The Trading Partner Participant Details page for the selected trading partner 
agreement participant appears.

4. Select a specific delivery channel to update in the Update column of the Delivery 
Channels Used section.

The Update Participant Delivery Channel page appears.

5. Select a delivery channel from the Delivery Channel list.

6. Click Apply.

The trading partner agreement participant is updated and the Trading Partner 
Participant Details page appears.

7. Click Return to List to return to the Agreement Details page.

Removing a Delivery Channel from a Trading Partner Agreement Participant

Follow these instructions to remove a delivery channel from a trading partner 
agreement participant:

1. Click Partners > Agreements.

2. Select a specific trading partner agreement in the Name column.

Note: If you remove a delivery channel and add a new one to a 
trading partner participant, any internal delivery channel and 
responding internal delivery channel in the trading partner agreement 
are also removed. To re-add these channels, click Update in the 
Trading Partner Participants section of the Agreement Details page. 
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The Agreement Details page for the selected trading partner agreement appears. 

3. Select a specific trading partner participant in the Name column of the Trading 
Partner Participants section.

The Trading Partner Participant Details page for the selected trading partner 
agreement participant appears.

4. Select a specific delivery channel to remove in the Remove column of the Delivery 
Channels Used section.

5. Click Yes when prompted to remove a trading partner delivery channel.

The delivery channel is removed and you are returned to the Trading Partner 
Participant Details page. You can add this delivery channel again at a later time.

Common User Errors
1. You cannot create a trading partner agreement if you did not perform all of the 

following tasks:

■ Created a remote trading partner

■ Assigned support for a business protocol and a collaboration or business 
action (operational capabilities) to the remote trading partner

■ Created delivery channels for both the host and remote trading partners 
(communication capabilities)

2. You cannot delete a remote trading partner in a trading partner agreement that is 
in a draft, approved, or deployed state. You must first delete the trading partner 
agreement.

3. If you are using a business protocol with a generic exchange, you must select 
None from the Acknowledgment Mode list when creating the delivery channel 
for the trading partner. If you select Sync or Async, validation fails when creating 
a configuration. 

4. Do not include beginning or trailing blank spaces in the names of trading partner 
agreement partner data that you create.

Chapter Summary
This chapter describes how you create a trading partner agreement to which you 
assign the remote trading partner as a participant. The host trading partner is 
automatically assigned to the agreement. You also assign support for a business 
protocol and support for a collaboration (for the RosettaNet over RNIF business 
protocol) or business action (for any EDI or Custom Document business protocols) to 
the remote trading partner. To simplify your user experience, the host trading partner 
is automatically assigned support for a business protocol and a collaboration or 
business action that are compatible with the remote trading partner. For example, if 
the remote trading partner is using the RosettaNet over RNIF business protocol with 
collaboration and role Buyer - 3A4 - V02.00, the host trading partner is automatically 
assigned support for the RosettaNet over RNIF business protocol with collaboration 
and role Seller - 3A4 - V02.00. 

You also assign a trading partner identification type and a delivery channel to both 
trading partners. Internal delivery channels and callout usages can also be assigned.
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11
Creating and Deploying a Configuration

This chapter describes how to create and deploy a configuration consisting of at least 
one trading partner agreement between two trading partners.

This chapter contains these topics: 

■ When Must I Read This Chapter?

■ Configuration Overview

■ Creating a Configuration

■ Deploying a Configuration

■ Viewing a Configuration

■ Quiescing a Configuration

■ Discarding a Configuration

■ Exporting a Configuration

■ Common User Errors

■ Chapter Summary
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When Must I Read This Chapter?
You must first complete the following tasks described in previous chapters before 
performing the procedures described in this chapter:

■ Create or import support for RosettaNet collaborations, EDI X12 or EDI 
EDIFACT transaction sets (business actions), or UCCnet standards

■ Create a remote trading partner

■ Assign support for a business protocol to the remote trading partner

■ Create operational and communication capabilities for the business protocol of 
the remote trading partner

■ Create communication capabilities for the business protocol of the host trading 
partner

■ Create and validate a trading partner agreement between the host and remote 
trading partners

Configuration Overview
This section contains these topics:

■ What is a Configuration?

■ Configuration Creation Overview

What is a Configuration?
A configuration consists of a complete, validated, and consistent set of one or more 
validated trading partner agreements in OracleAS Integration B2B. A configuration 
enables trading partner agreements to pass from the design phase to the deployment 
phase. 

Creating a configuration means you intend to deploy the trading partner agreements 
that have been created. Deployment of a configuration results in OracleAS Integration 
B2B being ready to honor and enforce actual business as designed in the trading 
partner agreement.

Configuration Creation Overview
You must use the OracleAS Integration B2B user interface tool to perform the 
following configuration tasks:

1. Create and validate a configuration of partner data consisting of at least one 
validated trading partner agreement between trading partners. Each trading 
partner agreement consists of the host and remote trading partners, which consist 
of the collaborations or business actions being exchanged. Delivery channels are 
used to send the collaborations or business actions between the trading partners.

When you create a configuration, the integrity of the trading partner agreement 
and the trading partner data is validated to ensure that it is consistent and 
complete. If validation is successful, the configuration is created.

See Also: Chapter 6, "Managing Business Protocols" through 
Chapter 10, "Creating and Managing Trading Partner Agreements" for 
instructions on performing these tasks



Configuration Overview

Creating and Deploying a Configuration 11-3

You must deploy or discard the configuration immediately, and not leave it in a 
validated state. Until you deploy the configuration, you cannot update or create 
any additional operational capabilities for the trading partner in the agreement.

An option is also available for exporting the partner data of the configuration to an 
XML file.

2. Deploy the configuration consisting of at least one trading partner agreement from 
the design-time repository to the runtime repository. You cannot deploy the same 
trading partner agreement in multiple configurations. Multiple, active 
configurations can run simultaneously if each has a different trading partner 
agreement. 

Any currently running configuration with the same trading partner agreement is 
automatically quiesced (gracefully shut down). You can also manually quiesce a 
deployed configuration or export the partner data of the deployed configuration 
to an XML file. 

Figure 11–1 shows the life of a configuration.

Figure 11–1 Life of a Configuration

See Also: "Common User Errors" for a review of common user 
errors to avoid before creating and deploying a configuration

Validated Agreement

Create Configuration

Validated Configuration

Deploy

Active Configuration

Quiesce

Redeploy

Quiesced Configuration

Retire

Retired Configuration

Purge
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Creating a Configuration
Follow these instructions to create a configuration:

1. Click Deployment.

The Configuration page appears. The Current Configurations section displays all 
current configurations and their state. The Retired and Discarded Configurations 
section (which must be expanded) displays all retired or discarded configurations 
and their associated trading partner agreements.

2. Expand the Retired and Discarded Configurations navigation tree.

Any configurations that you previously discarded or retired appear.

The Last Update column in both sections displays the time at which a specific action 
was performed with this configuration (for example, the time at which it was 
deployed or validated).

The Action column in both sections provides a shortcut for performing the next most 
likely action with this configuration. For example, if the state is Active, your next most 
likely action is Quiesce. If the state is Validated, your next most likely action is 
Deploy.

The current state of a configuration displays in the State column of the Current 
Configurations section:

Note: Only approved trading partner agreements can be included 
in the deployment unit and, therefore, in the configuration. 

State Description

Validated The partner data has been successfully validated to ensure that it is 
correct and complete and a configuration has been created. The 
configuration is ready for deployment. Only valid configurations can 
exist; invalid configurations cannot be created.

Active The trading partner agreement included in the configuration is available 
for execution of business in the OracleAS Integration B2B runtime 
repository. Messages are accepted based on your design in the trading 
partner agreement and processed accordingly.
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The state of retired and discarded configurations displays in the State column of the 
Retired and Discarded Configurations section:

3. Click Create.

The Create Configuration page appears.

4. Enter a unique and recognizable name for the configuration in the Configuration 
Name field. A configuration name can be no more than 30 characters in length. If 
you enter a previously used name for a configuration that is currently deployed or 
has been discarded, you receive an error and are prompted to enter a different 
name.

5. Select at least one trading partner agreement to include in this configuration from 
the Agreement list. If there is no approved trading partner agreement, the Apply 
button is disabled.

6. Click Apply. 

A page displays a message indicating that a configuration is being created, built, 
and validated to ensure correctness and completeness of the partner data. 
Configuration creation can take some time based on the complexity of your 
partner data. 

A second user accessing the same OracleAS Integration B2B user interface tool on 
another host can also view configuration creation progress. The second user sees a 
message stating that configuration creation is in progress. A View Status link 
appears that takes the second user to a configuration creation progress page. 

7. See the following section based on whether or not configuration creation is 
successful:

Quiesced The configuration is in the process of being quiesced (gracefully shut 
down). Once quiesced, the configuration can be redeployed or retired.

State Description

Discarded A configuration has been discarded and cannot be deployed. These 
types of configurations were validated, but never deployed. The trading 
partner agreement is also listed.

Retired A deployed configuration has been retired and cannot be redeployed.

If Configuration Creation Is... See Section...

Successful "Successful Configuration Creation and Validation" on 
page 11-6

Unsuccessful "Unsuccessful Configuration Creation and Validation" on 
page 11-6

Note: Do not leave a configuration in a validated state. Either deploy 
or discard the configuration.

State Description
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Successful Configuration Creation and Validation
If configuration creation and validation are successful, the following message displays 
at the top of the page:

Creation and validation of configuration name successful

where name is the configuration name you entered in Step 4 of "Creating a 
Configuration" on page 11-5.

The Deployment page displays Validated in the State column for the configuration. 
You must deploy or discard the configuration immediately, and not leave it in a 
validated state. 

At this point, you cannot update or delete the following partner data in a successfully 
created and validated configuration:

■ Trading partner agreements 

■ Trading partners

You receive an error if you attempt to make changes. If you must make changes, first 
deploy or discard the configuration.

Unsuccessful Configuration Creation and Validation
If configuration creation and validation are unsuccessful, the Validation Results page 
displays an error. Perform the following steps:

1. See the user interface tool ui.log file in the ORACLE_HOME/ip/log/ui/ 
directory for specific details about the onscreen error.

2. If you want to create a record of the onscreen errors, use the Save As option of 
your Web browser or click the Deployment tab. Clicking the Deployment tab 
creates a View Errors link to these configuration errors from the main 
Deployment tab page.

3. If you do not want to create a record of the onscreen errors, click Discard Errors. 
You cannot return to this page.

Deploying a Configuration
This section contains these topics:

■ Configuration Deployment Overview

■ Deploying a Validated Configuration

Configuration Deployment Overview
Configuration deployment consists of deploying the designed and validated trading 
partner agreement and the corresponding set of trading partner data to the runtime 
repository.

Only one active configuration with the same trading partner agreement is permitted 
at any given time. Deployment of a new configuration with the same trading partner 
agreement results in the quiescing of the old, currently running configuration. 
Multiple, active configurations can run simultaneously if each has a different trading 
partner agreement. A configuration accepts only noninitiating messages during 
quiescing. This lets the ongoing business complete processing in accordance with the 
old configuration. After all messages in a quiescing configuration are processed, the 
configuration is shut down. 
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After the old configuration is shut down, the new configuration becomes active. You 
can redeploy or retire the old configuration.

Deploying a Validated Configuration
Only configurations that were successfully validated and created can be deployed. 

Follow these instructions to deploy a configuration:

1. Click Deployment. 

2. Deploy the configuration in either of two ways. Only configurations whose 
current status displays as Validated in the State column of the Current 
Configurations section can be deployed.

a. Click Deploy in the Action column for the configuration you want to deploy. 

or

a. Select a specific configuration to deploy in the Name column.

The Configuration Details page for the selected configuration appears.

b. Click Deploy.

The Deployment page appears.

3. Click Apply.

The Deploying Configuration page appears and displays deployment progress.

4. Click Deploy to continue with deployment. You can also click Cancel to cancel 
deployment.

A second user accessing the same OracleAS Integration B2B user interface tool on 
another host can also view deployment progress. The second user sees a message 
stating that deployment is in progress. A View Status link appears that takes the 
second user to a deployment progress page. 

Only one configuration with the same trading partner agreement can be active at a 
time. Therefore, any currently running configuration is automatically quiesced and 
shut down.

If deployment is successful, the Deployment page displays the Last Update field 
with the date at which the configuration was deployed. The State column status 
for the newly deployed configuration changes to Active and the Action column 
status changes to Quiesce.

Note: If the partner data of a trading partner in a currently deployed 
configuration changes (for example, the host trading partner now uses 
a wallet password) and that trading partner is also part of a second 
configuration being deployed, the initial configuration is quiesced and 
automatically restarted to include the change.
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Deployment can be unsuccessful. For example, system errors or out-of-memory errors 
can cause deployment to fail.

You can now manage and create reports about your deployed configuration.

Viewing a Configuration
You can view details about the status of a specific configuration.

Follow these instructions to view details about a configuration:

1. Click Deployment. 

2. Select a specific configuration to view in the Name column of the Current 
Configurations section or the Retired and Discarded Configurations section.

The Configuration Details page for the selected configuration appears. 

3. View specific details, including the following:

■ The configuration name, description, date of last update, state, and whether it 
can be redeployed

■ The trading partner agreement name and state included in this configuration. 
The following types of states can appear in the State column:

Depending upon the current state of the configuration, different buttons can 
appear. For example, if the configuration is deployed, Quiesce and Export buttons 
appear. If the configuration is validated, Deploy, Discard, and Export buttons can 
appear. 

4. Click Return To List to return to the Deployment page.

See Also: Chapter 14, "Creating Reports"

State Description

Validated The trading partner agreement is part of a configuration that has been 
successfully validated to ensure that it is correct and complete and a 
configuration has been created. The configuration is now ready for 
deployment.

Deployed The trading partner agreement is part of a configuration that has been 
successfully deployed to the runtime repository.

Draft The trading partner agreement has been modified after it was part of a 
discarded or deployed configuration.
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Quiescing a Configuration
You can manually quiesce (gracefully shut down) a deployed configuration. Once 
quiesced, the configuration can be redeployed or retired. In addition, a currently 
deployed configuration is automatically quiesced when you attempt to deploy a 
second configuration with the same trading partner agreement.

Follow these instructions to quiesce a configuration.

1. Click Deployment. 

2. Quiesce the configuration in either of two ways. Only configurations whose 
current status displays as Active in the State column of the Current 
Configurations section can be quiesced.

a. Click Quiesce in the Action column for the configuration you want to quiesce. 

or

a. Select a specific configuration to quiesce in the Name column of the Current 
Configurations section.

The Configuration Details page for the selected configuration appears.

b. Click Quiesce.

The configuration is quiesced and now displays in the Retired and Discarded 
Configurations section of the Deployment page. The status of the 
configuration displays as Discarded in the State column. A quiesced 
configuration can be redeployed or retired. 

Discarding a Configuration
Discarded configurations are validated configurations that were never deployed. You 
can discard a configuration that is no longer needed or because you want to change 
the partner data included in the configuration.

Follow these instructions to discard a configuration:

1. Click Deployment. 

2. Select a specific configuration to discard in the Name column of the Current 
Configurations section. Only configurations whose current status displays as 
Validated in the Status column of the Current Configurations section can be 
discarded. 

The Configuration Details page for the selected configuration appears.

3. Click Discard. 

The configuration is discarded and is no longer available for deployment. The 
configuration now displays in the Retired and Discarded Configurations section 
of the Deployment page. The status of the configuration displays as Discarded in 
the State column.
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Exporting a Configuration

You can export the partner data that comprises a configuration to an XML file. To 
access the page for exporting a configuration, a successfully validated configuration 
must exist. 

Follow these instructions to export a configuration to an XML file:

1. Click Deployment. 

2. Select a specific configuration to export in the Name column of the Current 
Configurations or the Retired and Discarded Configurations section. 

The Configuration Details page for the selected configuration appears.

3. Click Export.

4. Specify a directory in which to save this configuration (automatically named 
export.xml) when prompted. 

Export can take some time based on the size of the configuration.

You can later reimport the partner data that comprises a configuration as follows: 

a. Click Administration > Management.

b. Click Browse to access the file to import.

c. Select the file.

d. Click Import.

The partner data that comprises the configuration is reimported, but the 
configuration is not re-created. You must first validate the trading partner 
agreement of the configuration, and then re-create the configuration.

Common User Errors
The following are common deployment user errors.

■ Ensure that any trading partner agreement that you create is part of a completely 
created, end-to-end integration of partner data. This is because when you create a 
configuration, the trading partner agreement and its deployable units are included 
in the configuration.

■ Do not deploy two trading partner agreements in which the same two trading 
partners perform the same collaborations or business actions. For example, the 

Caution: Do not manually edit exported files. If you do so, OracleAS 
Integration B2B cannot guarantee their integrity.

Note: Do not export a configuration using Microsoft Internet 
Explorer with an HTTPS URL. You receive an error if you attempt to 
perform this action. See issue 812935 at support.microsoft.com 
for additional details. Use Mozilla or Netscape to export a 
configuration with an HTTPS URL.

See Also: "Exporting and Importing the Design-Time Repository" 
on page 12-5 for details about importing a configuration
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following trading partner details are defined in two separate agreements. This 
action in two separate agreements causes runtime errors to occur.

– Host trading partner Acme uses the collaboration role Buyer - 3A4 - V02.00

– Remote trading partner GlobalChips uses the collaboration role Seller - 3A4 - 
V02.00

 Do not do this even if the agreements have different names, different agreement 
IDs, and are included in different configurations.

■ Ensure that all endpoints exist and are accessible before creating a configuration.

■ Ensure that as you move to and from the development, test, and production 
phases, all endpoints are properly updated.

■ A configuration name can be no more than 30 characters in length. If you enter a 
previously used name for a configuration that is currently deployed or has been 
discarded, you receive an error and are prompted to enter a different

■ Do not manually edit exported files. If you do so, OracleAS Integration B2B cannot 
guarantee their integrity.

■ Do not include beginning or trailing blank spaces in the names of configuration 
partner data that you create.

■ Ensure that you deploy or discard the configuration immediately, and do not leave 
it in a validated state. 

■ You cannot update or delete the following partner data in a successfully created 
and validated configuration:

■ Trading partner agreements 

■ Trading partners

Chapter Summary
This chapter describes how to create and deploy a configuration (the complete, 
validated, and consistent set of partner data). It also describes how to quiesce 
configurations, discard configurations, and export configurations to an XML file.
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Part IV
Administration, Monitoring, and Security

Tasks

This part describes how to administer Oracle Application Server Integration B2B 
design-time and runtime data, create reports that monitor the status of a deployed 
configuration, ensure that your Oracle Application Server Integration B2B instance is 
secure, and troubleshoot configuration issues.

This part contains the following chapters:

■ Chapter 12, "Administering Oracle Application Server Integration B2B"

■ Chapter 13, "System Management with Oracle Enterprise Manager 10g"

■ Chapter 14, "Creating Reports"

■ Chapter 15, "Oracle Application Server Integration B2B Security"

■ Appendix A, "Troubleshooting and Workarounds"





Administering Oracle Application Server Integration B2B 12-1

12
Administering Oracle Application Server

Integration B2B

This chapter describes how to administer Oracle Application Server Integration B2B 
partner and instance data with the OracleAS Integration B2B user interface tool.

This chapter contains these topics:

■ Administering OracleAS Integration B2B with the User Interface Tools

■ Managing Contact Types

■ Managing Trading Partner Identification Types

■ Exporting and Importing the Design-Time Repository

■ Purging the Design-Time Repository and Runtime Repository

■ Common User Errors

■ Chapter Summary
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Administering OracleAS Integration B2B with the User Interface Tools
The OracleAS Integration B2B user interface tool enables you to perform the design 
tasks shown in Figure 12–1 and the import, export, and purge management tasks 
shown in Figure 12–2. References to instructions for performing these tasks are listed 
in Table 12–1:

Figure 12–1 Design Tasks

Figure 12–2 Management Tasks

Table 12–1 Design and Management Tasks

Task See Section...

Managing contact types "Managing Contact Types" on page 12-3

Managing trading partner identification 
types

"Managing Trading Partner Identification Types" 
on page 12-4

Importing and exporting the design-time 
repository

"Exporting and Importing the Design-Time 
Repository" on page 12-5

Purging the design-time repository and 
portions of the runtime repository

"Purging the Design-Time Repository and 
Runtime Repository" on page 12-10
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Managing Contact Types
The OracleAS Integration B2B user interface tool enables you to perform the contact 
type management tasks shown in Figure 12–3. These tasks are described in detail in 
this section. The contact type is the method for contacting persons or organizations 
(such as a phone number or e-mail address). OracleAS Integration B2B includes a 
predefined set of contact types shown in Figure 12–3 that cannot be updated or 
deleted. 

Figure 12–3 Contact Type Management Tasks

Table 12–2 identifies the contact type management tasks shown in Figure 12–3 and 
provides references to procedures for performing these tasks.

Viewing a Contact Type
Follow these instructions to view details about a contact type:

1. Click Administration > Design.

2. Select a specific contact type to view in the Name column of the Contact Types 
section. 

The Contact Type Details page for the selected contact type appears (for example, 
for e-mail).

3. View specific details, including the contact type and description. 

4. Click Return to List to return to the Design tab main page.

Table 12–2 Contact Type Management Tasks

Page Elements Management Tasks See Section...

Shortcuts section of 
Figure 12–3

Take a shortcut to the Trading 
Partners page

"Managing Trading Partners" 
on page 8-5

Name column of Contact 
Types section of Figure 12–3

View details about a contact 
type

"Viewing a Contact Type" on 
page 12-3
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Managing Trading Partner Identification Types
The OracleAS Integration B2B user interface tool enables you to perform the trading 
partner identification type management tasks shown in Figure 12–4. These tasks are 
described in detail in this section. The trading partner identification type includes a 
value that uniquely identifies a trading partner, such as a Data Universal Numbering 
System (DUNS) number or an electronic data interchange (EDI) location code. 
OracleAS Integration B2B includes a predefined set of trading partner identification 
types shown in Figure 12–4 that cannot be updated or deleted. You can also create 
your own custom trading partner identification types. 

Figure 12–4 Trading Partner Identification Type Management Tasks

Table 12–3 identifies the trading partner identification type management tasks shown 
in Figure 12–4 and provides references to procedures for performing these tasks.

Creating a Trading Partner Identification Type
Follow these instructions to create a trading partner identification type:

1. Click Administration > Design.

2. Click Create in the Trading Partner Identification Types section.

The Create Trading Partner Identification Type page appears.

Table 12–3 Trading Partner Identification Type Management Tasks

Page Elements Management Tasks See Section...

Shortcut section of 
Figure 12–4

Take a shortcut to the Trading 
Partners page

"Managing Trading Partners" 
on page 8-5

Create button of Trading 
Partner Identification 
Types section of Figure 12–4

Create a trading partner 
identification type

"Creating a Trading Partner 
Identification Type" on 
page 12-4

Name column of Trading 
Partner Identification 
Types section of Figure 12–4

View details about a trading 
partner identification type

"Viewing a Trading Partner 
Identification Type" on 
page 12-5

Note: Trading partner identification types cannot be deleted or 
updated.
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3. Enter the following details to create a trading partner identification type. An 
asterisk (*) indicates a required field.

4. Click Apply.

The trading partner identification type is created and the Trading Partner 
Identification Type Details page appears. The trading partner identification type 
appears as a selection on the Create Trading Partner Identification page (accessible 
by clicking Partners > Trading Partners > trading_partner_name_in_Name_
column > Trading Partner Identifications > Create). The trading partner 
identification type is also available for selection when you run the Create Trading 
Partner wizard.

Viewing a Trading Partner Identification Type
Follow these instructions to view details about a trading partner identification type:

1. Click Administration > Design.

2. Select a specific trading partner identification type to view in the Name column of 
the Trading Partner Identification Types section. 

The Trading Partner Identification Type Details page for the selected trading 
partner identification type appears.

3. View the trading partner identification type description. You can also manage 
(view, update, and delete) the value of the assigned types from this section.

4. Click Return to List to return to the Design tab main page.

Exporting and Importing the Design-Time Repository
The OracleAS Integration B2B user interface tool enables you to create partner data 
(such as trading partners and trading partner agreements) that is stored in the 
OracleAS Integration B2B design-time repository portion of the Oracle Application 
Server Metadata Repository. Partner data is the condition of data prior to being 
included in a deployed configuration. This type of partner data describes the behavior 
of the configuration and the steps that must be sequenced for the configuration to be 
executed. Partner data stored in the design-time repository can also be reused in 
multiple integrations, thus eliminating duplication of effort in designing an 
integration. 

The OracleAS Integration B2B user interface tool provides design-time repository 
export and import functionality that enables you to perform several tasks. Some of 
these tasks include the following:

■ Export and import the entire contents of the design-time repository to and from an 
XML file. This enables you to export the contents from one repository and import 
it into another repository.

Field Value

Name * Enter a unique and recognizable trading partner identification type name.

Description Enter a description.

See Also: "Creating Trading Partner Identification" on page 8-8 
for instructions on selecting a trading partner identification value
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■ Export and import a configuration created under the Deployment tab to and from 
the design-time repository

■ Import supported, predefined RosettaNet collaborations (partner interface 
processes (PIPs)), EDI X12 and EDI EDIFACT transaction sets (business actions), 
and UCCnet standards into the design-time repository to assign to trading 
partners. This information can then be viewed by clicking Partners > Protocols > 
business_protocol_name_in_Name_column > Process Protocol Revisions > 
Details. A transaction set maps to a document type of a business action in the 
OracleAS Integration B2B user interface tool.

There are several methods for using export and import.

■ In high availability environments, you can back up specific configurations from 
your design-time repository.

■ For migrating from a test environment to a production environment, you can 
import configurations tested in a staging environment into a production 
environment.

OracleAS Integration B2B supports the following types of export:

■ The export feature accessible under the Administration tab (and described in 
this section) exports the latest versions of all partner data in the design-time 
repository to a file.

■ The configuration export feature accessible under the Deployment tab exports 
only the data included in a specific configuration.

■ The export feature accessible from the Agreement Details page and Trading 
Partner Details page exports the partner data associated with those pages to 
XML files. The XSDs for these XML files are included in the exported 
document.

Note the following details about importing and exporting the latest versions of all 
partner data to a file:

■ Person passwords are not updated if you import partner data into a repository 
where the person and password already exist, even if the password was 
different when the export file was created. 

If a specific person existed when the export file was created, but does not exist 
in the design-time repository into which the partner data is being imported, 
the person and password are imported into the new design-time repository. 
However, if a specific person and password exist in both the design-time 
repository and the file to be imported, the password is not imported; it 
remains the same as before import.

Person passwords are not imported; passwords for transport servers are 
imported.

■ The wallet password for the host trading partner is not exported or imported. 
This password must be created manually by following the instructions under 
Partners > Trading Partners > host_trading_partner_name_in_Name_column.

Caution: Do not manually edit exported files. If you do so, OracleAS 
Integration B2B cannot guarantee their integrity.
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■ All trading partner agreements are imported in the Draft state, even if they 
were approved before the export. You must validate the relevant trading 
partner agreements before creating and deploying a configuration.

■ Do not use the OracleAS Integration B2B export and import features for 
backup or recovery of the design-time repository. OracleAS Integration B2B 
uses the b2b schema in the metadata repository. This schema has additional 
metadata and runtime state not included in the OracleAS Integration B2B 
export file. Use the Oracle database import and export utilities or the Oracle 
Application Server archiving tool to back up this schema.

Select a task to perform and see the referenced section for instructions:

Exporting the Design-Time Repository Contents
Follow these instructions to export the design-time repository contents:

1. Ensure that you first reviewed "Exporting and Importing the Design-Time 
Repository" on page 12-5.

2. Click Administration > Management > Export.

Management Task See Section...

Export the entire design-time repository to a 
file

"Exporting the Design-Time Repository 
Contents" on page 12-7

Import the design-time repository from a file 
(exported by clicking Administration > 
Management > Export)

"Importing the Design-Time Repository 
Contents" on page 12-8

Import a configuration (exported by clicking 
Deployment > configuration_name_in_
Name_column > Export)

"Importing an Exported Configuration" on 
page 12-9

Import supported, predefined RosettaNet 
collaborations, EDI transaction sets, and 
UCCnet standards

"Importing Support for Collaborations, 
Transaction Sets, and UCCnet Standards" on 
page 12-9

See Also:

■ "Exporting a Configuration" on page 11-10 for instructions on 
exporting a configuration

■ "Exporting Partner Data to an XML File" on page 4-10 for 
instructions on exporting partner data to a file

■ "Managing Trading Partner Persons" on page 8-20 for 
instructions on creating persons and assigning passwords

■ "Managing the Host Trading Partner Wallet Password" on 
page 8-14 for instructions on creating a wallet password for the 
host trading partner 

■ Oracle Application Server Administrator’s Guide for details about 
Oracle Application Server backup and recovery

■ Oracle Database Backup and Recovery Basics available on the 
Oracle Technology Network Web site for additional details 
about backup and recovery strategies:

http://www.oracle.com/technology
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The entire and latest contents of partner data in the design-time repository are 
copied to a file named export.xml that you are prompted to open or download 
to a directory location. Depending on the size of the design-time repository 
contents, this process can take time.

Importing the Design-Time Repository Contents
Follow these instructions to import the design-time repository contents that you 
exported to an XML file by clicking Administration > Management > Export:

Follow these instructions to import the design-time repository contents:

1. Ensure that you first reviewed "Exporting and Importing the Design-Time 
Repository" on page 12-5.

2. Click Administration > Management.

3. Click Browse to select a file to import.

4. Click Import.

The Import Status page appears. A clock displays onscreen saying that the import 
is being processed and can take several minutes.

The entire contents of the file are loaded into their previous locations in the 
design-time repository and display in the OracleAS Integration B2B user interface 
tool. You cannot import parts of the file. A message appears indicating that the 
import completed successfully.

The partner data that comprises a configuration is reimported, but the 
configuration is not re-created. You must first validate the trading partner 
agreement of the configuration and then re-create the configuration.

If an import fails, then the changes are rolled back and the design-time repository 
remains unchanged. A message appears indicating that the import was 
unsuccessful.

Caution: The design-time repository contents exported to a file 
represent a copy of the current partner data. This file is no longer 
accessible for changes with the OracleAS Integration B2B user 
interface tool until it is imported back into OracleAS Integration 
B2B.

If you continue to make changes to the design-time repository 
contents with the OracleAS Integration B2B user interface tool, then 
import the exported file (the contents of which are now older), the 
following occurs:

■ New data created with the OracleAS Integration B2B user 
interface tool after the file was exported is left untouched after 
the file is imported.

■ Data updated or deleted after the file was exported is 
overwritten with the older contents of the imported file.
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Importing an Exported Configuration
Follow these instructions to import a configuration exported by clicking Deployment 
> configuration_name_in_Name_column > Export:

1. Ensure that you first reviewed "Exporting and Importing the Design-Time 
Repository" on page 12-5.

2. Click Administration > Management.

3. Click Browse to select the file containing the exported configuration to import.

4. Click Import.

The Import Status page appears. A clock displays onscreen saying that the import 
is being processed and can take several minutes.

The trading partner agreement of a configuration is loaded into its previous 
location in the design-time repository. You must then validate the trading partner 
agreement and re-create the configuration that includes this trading partner.

If an import fails, then the changes are rolled back and the design-time repository 
remains unchanged. A message appears indicating that the import was 
unsuccessful.

Importing Support for Collaborations, Transaction Sets, and UCCnet Standards
OracleAS Integration B2B includes support for importing the following collaborations, 
transaction sets, and UCCnet standards: 

■ Approximately 25 frequently-used RosettaNet collaborations in the 
ip/demo/samples/RosettaNet/RosettaNet_sample.xml file

■ EDI X12, document protocol revision 4010, transaction sets 850, 855, and 997 in 
the ip/demo/samples/X12/X12_sample.xml file

■ EDI EDIFACT, document protocol revision D98A with transaction sets ORDERS 
and ORDRSP, and document protocol revision D3 with transaction set CONTRL in 
the ip/demo/samples/EDIFACT/EDIFACT_sample.xml file

■ UCCnet standards (protocol revision 2.3.1) in the 
ip/demo/samples/UCCnet/UCCnet_sample.xml file

Before you can use these collaborations, transaction sets, and standards, you must 
import these files into the design-time repository. This action enables you to see and 
use them in the OracleAS Integration B2B user interface tool. 

Follow these instructions to import RosettaNet collaborations, EDI X12 and EDIFACT 
transaction sets, and UCCnet standards:

1. Ensure that you first reviewed "Exporting and Importing the Design-Time 
Repository" on page 12-5.

2. Click Administration > Management.

The Import page appears.

3. Click Browse to select the collaborations, transaction sets, or standards to import.

4. Click Import.

The Import Status page appears. A clock displays onscreen saying that the import 
is being processed.

Once imported, these collaborations, transaction sets, and standards display in the 
Process Protocol Revision Details page accessible by clicking Partners > Protocols 
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> business_protocol_name_in_Name_column > Process Protocol Revisions > 
Details. You can then assign these collaborations, transaction sets, and standards 
to remote trading partners. 

If an import fails, the design-time repository remains unchanged. A message 
appears indicating that the import was unsuccessful.

Purging the Design-Time Repository and Runtime Repository
OracleAS Integration B2B partner data consists of two types. 

■ Partner data (stored in the OracleAS Integration B2B design-time repository)

 See "Exporting and Importing the Design-Time Repository" on page 12-5 for a 
description of partner data.

■ Instance data (stored in the OracleAS Integration B2B runtime repository)

Instance data is partner data included in a deployed configuration. During 
configuration creation, partner data of the integration is validated end-to-end a 
final time to ensure that only a complete and consistent configuration is deployed 
to the runtime repository. After a configuration is deployed, the runtime 
repository stores the configuration of instance data required to execute an 
integration. Instance data is created during runtime when messages are processed. 

The OracleAS Integration B2B design-time repository and runtime repository are both 
part of the Oracle Application Server Metadata Repository.

The OracleAS Integration B2B user interface tool enables you to purge all partner data 
in the design-time repository (with the exception of predefined data that was part of 
installation) and instance data in the runtime repository. Data in a deployed 
configuration in the runtime repository that is not in a completed state is considered to 
be in use and cannot be deleted. When its state is complete, it can be purged. Purging 
enables you to perform the following tasks:

■ Manage disk space and improve performance

■ Delete multiple objects of larger granularity

Follow these instructions to purge partner data from the design-time repository and 
instance data from the runtime repository:

1. Ensure that you first reviewed "Purging the Design-Time Repository and Runtime 
Repository" on page 12-10.

2. Click Administration > Management > Purge.

The Purge page appears.

3. Select the type of data you want to purge and see the appropriate section. The 
page refreshes based on your selection.

See Also: Chapter 2, "Supported Protocols" for a list of supported 
collaborations, transaction sets, and standards

Note: A second user accessing the same OracleAS Integration B2B 
user interface tool on another host can also view purging progress. 
The second user sees a message stating that purging is in progress. A 
View Status link appears that takes the second user to a purging 
progress page. 
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The page refreshes to display additional fields.

Purging Business Message or Collaboration Instance Data
1. Use the calendar icons in the Date Range section to select the start and end dates 

for purging the runtime repository of instance data. If you do not specify any 
dates, all instance data is purged.

The list that displays is based on your selection in Step 3 on page 12-10.

2. Make a selection from the list that appears.

3. Select the configuration from the Configuration Name list. If you do not select a 
specific configuration to purge, all configurations are purged. 

4. If you want to configure advanced business message or collaboration parameters, 
click Show Advanced Parameters. This enables you to more specifically define the 
data you want to delete.

The page refreshes to display additional fields based on your selection in Step 3 on 
page 12-10.

5. Enter the following details:

Purge Type Description See Section...

Business 
Messages

Enables you to purge the design-time repository 
data and instance data of the runtime repository 
that you created for use with any EDI or Custom 
Document business protocol.

"Purging Business 
Message or 
Collaboration Instance 
Data" on page 12-11

Collaboration 
Instances

Enables you to purge the design-time repository 
data and instance data of the runtime repository 
that you created for use with the RosettaNet over 
RNIF business protocol.

"Purging Business 
Message or 
Collaboration Instance 
Data" on page 12-11

Entire Repository Enables you to purge the entire design-time 
repository and instance data of the runtime 
repository. 

Predefined data that was part of the installation 
(for example, business protocols such as EDI and 
RosettaNet and identification types such as a Data 
Universal Numbering System (DUNS) and an 
EDI Location Code) is not deleted.

This action returns the design-time repository to 
its state at the time of installation.

"Purging the Entire 
Repository" on 
page 12-14

Note: If you do not want to continue purging instance data, click 
Return to Management. This action returns you to the initial 
Management page shown in Figure 12–2 on page 12-2.

If You Selected... Then...

Business Messages Select the business action from the Business Action Name list.

Collaboration Instances Select the collaboration from the Collaboration Name list.
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If You Selected... Then...

Business Messages 1. Enter an identifier in the Business Message Id field. 

This is a 16-digit value that you can obtain from the ORACLE_
HOME/ip/log/b2b/b2b.log file. You can enter a portion of 
this value, and all values that include the portion entered are 
returned. 

2. Select the business message status from the Business Message 
Status list:

■ Aborted

Message processing is aborted.

■ Collab Wait

A message is waiting for collaboration activity to complete.

■ Complete

Message delivery and all processing has completed.

■ Continue Process

Message processing is continuing.

■ Error

An error occurred during message processing.

■ Invalid

The message is invalid.

■ Out of Band Error

An out-of-band error has occurred.

■ Process Ack

An acknowledgment message is processing for this business 
message (not a valid state for an acknowledgment message).

■ Process Exp

An exception message is processing for this business message. 
(not a valid state for an exception message).

■ Send Ack

An acknowledgment message is sent.

■ Send Exp

An exception message is sent.

■ Transmit Failed

Message transmission has failed. Depending upon the number 
of retries specified, this message may be sent later. If all retries 
fail, the status of this message changes to an error.

■ Wait Ack

Waiting for an acknowledgment message.

■ Wait Transmit

Waiting for a message to be transmitted.
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6. Enter the following details. 

7. Click Purge. 

Collaboration Instances 1. Enter an identifier in the Protocol Collaboration Id field. This is a 
16-digit value that you can obtain from the ORACLE_
HOME/ip/log/b2b/b2b.log file. You can enter a portion of 
this value, and all values that include the portion entered are 
returned. 

2. Select the collaboration status from the Collaboration Status list:

■ Aborted

The collaboration was aborted.

■ Complete

The collaboration has completed. 

■ Error

An error occurred during the collaboration.

■ In Progress

The collaboration is in progress.

■ Out of Band Error

An out-of-band error occurred during the collaboration.

Field Value

Trading Partner

■ Sending Trading Partner Select the trading partner that sent the message.

■ Receiving Trading Partner Select the trading partner that received the message.

■ Sending Trading Partner 
Identification

Select the trading partner identification type of the sending 
trading partner (for example, DUNS or EDI Location Code).

■ Sending Trading Partner 
Value

Enter the sending trading partner identification type value. 
For example, if you selected DUNS, enter the DUNS 
number.

■ Receiving Trading Partner 
Identification

Select the trading partner identification type of the receiving 
trading partner.

■ Receiving Trading Partner 
Value

Enter the receiving trading partner identification type value. 

Protocol

■ Business Protocol

Note: This field only 
displays if you selected 
Business Messages in Step 3 
on page 12-10. 

Select the specific EDI or Custom Document business 
protocol used in this business transaction between sending 
and receiving trading partners. 

Agreement

■ Agreement Name Select the trading partner agreement in which the sending 
and receiving trading partners are included.

If You Selected... Then...
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Purging the Entire Repository

1. Click Purge. 

A message appears stating that purging is an irreversible operation and purged 
data cannot be recovered. You are asked if you want to continue.

2. If you want to continue with this action, click Yes. Otherwise, click No.

Common User Errors
■ Do not manually edit exported files. If you do so, OracleAS Integration B2B cannot 

guarantee their integrity.

Chapter Summary
This chapter describes how to use the OracleAS Integration B2B user interface tool for 
the following tasks: 

■ Manage contact types and trading partner identification types

■ Export and import the design-time repository to and from XML files

■ Import configurations from XML files

■ Import RosettaNet collaborations, EDI X12 and EDIFACT transaction sets, and 
UCCnet standards

■ Purge data in the design-time repository and instance data in the runtime 
repository

Caution: Purging is an irreversible operation. Ensure that you first 
archive any important configurations with the Oracle Application 
Server archiving tool before purging the repository.

See Also: Oracle Application Server Administrator’s Guide for 
instructions on archiving data before purging the repository
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13
System Management with Oracle Enterprise

Manager 10g

This chapter provides an overview of Oracle Application Server Integration B2B 
monitoring and administration tasks that you can perform from Oracle Enterprise 
Manager 10g.

This chapter contains these topics:

■ Oracle Enterprise Manager 10g Monitoring and Administration Overview

■ Managing and Monitoring a Middle-Tier Instance from Oracle Enterprise Manager 
10g Application Server Control Console

■ Starting and Stopping OracleAS Integration B2B Components with OPMN

■ Additional Oracle Application Server and OracleAS Integration B2B Management 
Tasks

■ Changing Port Numbers

■ Chapter Summary

See Also:

■ Oracle Application Server Administrator’s Guide for details about 
using Oracle Enterprise Manager 10g to manage Oracle 
Application Server

■ Oracle Enterprise Manager Concepts for conceptual details about 
Oracle Enterprise Manager 10g
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Oracle Enterprise Manager 10g Monitoring and Administration Overview
Figure 13–1 provides a high-level overview of how OracleAS Integration B2B is 
managed.

Figure 13–1  Monitoring and Management with Oracle Enterprise Manager 10g

In Figure 13–1, OracleAS Integration B2B is installed on three Oracle Application 
Server middle tiers that connect to an Oracle Application Server Metadata 
Repository. 

The Oracle Enterprise Manager 10g Application Server Control Console is designed to 
provide local monitoring and administration tasks on an Oracle Application Server 
Integration B2B middle-tier instance basis. The Oracle Enterprise Manager 10g 
Application Server Control Console also provides real-time systems monitoring details 
such as up and down status, current CPU and memory consumption, and current 
performance status on the instance.

Note: OracleAS Integration B2B cannot be managed from the Oracle 
Enterprise Manager 10g Grid Control Console for this release. Only 
management from the Oracle Enterprise Manager 10g Application 
Server Control Console is supported.

See Also: Oracle Enterprise Manager Concepts
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OracleAS Integration B2B Management Concepts and Components
This section describes the following OracleAS Integration B2B management concepts 
and components:

■ Oracle Application Server Metadata Repository

■ OracleAS Integration B2B Instance

■ B2B Server of OracleAS Integration B2B

■ OC4J Instance of OracleAS Integration B2B

Oracle Application Server Metadata Repository
The Oracle Application Server Metadata Repository contains all the partner data 
required for an integration. The Oracle Application Server Metadata Repository can be 
installed either through Oracle Application Server Infrastructure or with the Oracle 
Application Server Repository Creation Assistant. Every OracleAS Integration B2B 
middle-tier instance requires a connection to the Oracle Application Server Metadata 
Repository to work properly. 

OracleAS Integration B2B Instance
An OracleAS Integration B2B middle-tier instance is a logical grouping of the B2B 
server and the Oracle Application Server Containers for J2EE (OC4J) instance. There 
is one OracleAS Integration B2B middle-tier instance for each Oracle home. 

B2B Server of OracleAS Integration B2B
The B2B server is the runtime component of OracleAS Integration B2B. The B2B server 
processes B2B transactions.

OC4J Instance of OracleAS Integration B2B
The OC4J instance hosts the OracleAS Integration B2B user interface tool used for 
designing and deploying configurations, generating reports, managing trading 
partners, and other integration aspects. 

Oracle Enterprise Manager 10g Application Server Control Console Tasks
You can perform the following local monitoring and administration tasks from the 
Oracle Enterprise Manager 10g Application Server Control Console:

■ Start and stop the B2B server and OC4J instance components running in each 
OracleAS Integration B2B middle-tier instance.

■ View the current running status (started or stopped) and memory and CPU usage 
for the B2B server and OC4J instances running in each Oracle Application Server 
middle-tier instance.

■ View and edit OracleAS Integration B2B server properties. The online Help lists all 
server properties, including detailed descriptions, default values, and allowed 
ranges.

See Also: Oracle Application Server Installation Guide for Oracle 
Application Server Metadata Repository installation concepts

See Also: The Oracle Application Server Administrator’s Guide for 
details about troubleshooting OC4J instance issues



Managing and Monitoring a Middle-Tier Instance from Oracle Enterprise Manager 10g Application Server Control Console

13-4 Oracle Application Server Integration B2B User’s Guide

■ View OracleAS Integration B2B performance (the number of messages received 
and number of messages that errored).

■ Access the OracleAS Integration B2B user interface tool for designing and 
deploying integrations.

■ View the OracleAS Integration B2B log files.

Managing and Monitoring a Middle-Tier Instance from Oracle Enterprise 
Manager 10g Application Server Control Console

Follow these instructions to access OracleAS Integration B2B from the Oracle 
Enterprise Manager 10g Application Server Control Console.

1. Go to the following URL:

http://hostname:port/

where:

■ hostname is the name of the host on which the OracleAS Integration B2B 
middle-tier instance is installed

■ port is the number assigned during OracleAS Integration B2B installation. 
The following sources also identify the port number used to access the Oracle 
Enterprise Manager 10g Application Server Control Console:

– The ipsetupinfo.txt file in the install subdirectory of your Oracle 
home directory

– The End of Installation page that displayed during installation

2. Enter the following login details when prompted:

The Oracle Application Server home page appears:

See Also: "Managing and Monitoring a Middle-Tier Instance from 
Oracle Enterprise Manager 10g Application Server Control 
Console" on page 13-4

Field Value

Username Enter ias_admin

Password Enter the password you specified during J2EE and Web Cache installation and 
OracleAS Integration B2B installation for the ias_admin user.

Note: If you have multiple Oracle Application Server middle-tier 
instances installed on a single host, you need to specify different 
Oracle Enterprise Manager 10g ports for each instance. See the 
portlist.ini file in the ORACLE_HOME/install directory for a 
list of which ports are currently in use.
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3. Select a management task to perform and see the referenced section for 
instructions.

Table 13–1 Management Tasks

Page Elements Management Task See Also

Name list of System 
Components section

Select B2B for the OracleAS Integration B2B 
middle-tier instance to monitor and 
administer from the Oracle Enterprise 
Manager 10g Application Server Control 
Console.

 "OracleAS Integration B2B Monitoring 
and Administration Tasks" on page 13-6 
for an overview of OracleAS Integration 
B2B tasks you can perform 

J2EE Applications link Select J2EE Applications to view the J2EE 
applications you have deployed using this 
instance.

Online Help available with this page

Ports link Select Ports to view ports assigned to 
OracleAS Integration B2B and other Oracle 
Application Server components.

"OracleAS Integration B2B Port 
Management" on page 13-9

Infrastructure link Select Infrastructure to review and modify 
details about this Oracle Application Server 
instance, including identity management 
status.

Online Help available with this page

See Also: Oracle Application Server Administrator’s Guide for 
instructions on changing the ias_admin username password



Managing and Monitoring a Middle-Tier Instance from Oracle Enterprise Manager 10g Application Server Control Console

13-6 Oracle Application Server Integration B2B User’s Guide

OracleAS Integration B2B Monitoring and Administration Tasks
Figure 13–2 shows the OracleAS Integration B2B middle-tier instance page that 
displays after selecting the B2B component from the System Components section in 
Step 3 on page 13-5. 

Figure 13–2 OracleAS Integration B2B Middle-Tier Instance Page

Table 13–2 identifies the tasks that you can perform. These tasks are further described 
in the online Help available by clicking Help in the top right corner of each page.

Table 13–2 Oracle Enterprise Manager 10g Application Server Control Console Monitoring and 
Administration Tasks

Page Elements Management Task

General section ■ View an overall status of the B2B server and OC4J instance components on this 
middle-tier instance. For the overall status to display as Up, both components 
must be running.

■ Click Start All to start the B2B server and OC4J instance together.

■ Click Stop All to stop the B2B server and OC4J instance together.

■ Click Restart All to restart the B2B server and OC4J instance together.

B2B Server and OC4J 
Instance sections

■ View CPU and memory usage details and the time at which each component 
started.

■ Click Start to start a specific component (either the B2B server or OC4J instance). 
Each component has its own Start button.

■ Click Stop to stop a specific component (either the B2B server or OC4J instance). 
Each component has its own Stop button.

■ Click Restart to restart a specific component (either the B2B server or OC4J 
instance). Each component has its own Restart button.
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OracleAS Integration B2B Log Files
Oracle Application Server components such as OracleAS Integration B2B generate log 
files describing all types of events, including startup and shutdown details, errors, 
warning messages, access details on HTTP requests, and so on. You can view log files 
for OracleAS Integration B2B.

1. Ensure that you followed the instructions in "OracleAS Integration B2B 
Monitoring and Administration Tasks" on page 13-6 to access the page for viewing 
log files.

The View Logs page appears.

2. Select B2B in the Available Components list.

3. Use the Move arrows to move selected components to the Selected Components 
list.

4. Click Search.

A list of log files appears in the Results table.

5. Click a specific log to view in the Log File column.

OracleAS Integration B2B Middle-Tier Instance Performance
You can view details about performance in a specific OracleAS Integration B2B 
middle-tier instance, including:

■ The number of messages received since the B2B server was started

■ The number of messages that have errored out since the B2B server was started

Figure 13–3 shows the performance page for a specific OracleAS Integration B2B 
middle-tier instance. 

Logs link (at bottom or 
top right)

■ Click to access a page from which you can view OracleAS Integration B2B log 
files.

See Also: "OracleAS Integration B2B Log Files" on page 13-7

Performance link ■ Click to access a page from which you can view business message performance.

See Also: "OracleAS Integration B2B Middle-Tier Instance Performance" on page 13-7

Administration link ■ Click to display a page from which you can access the Server Properties link (to 
view and edit OracleAS Integration B2B server properties) and the OracleAS 
Integration B2B user interface tool login page

See Also: "OracleAS Integration B2B Middle-Tier Instance Server Properties" on 
page 13-8

See Also: The Oracle Application Server Administrator’s Guide for 
details about viewing log files and troubleshooting OC4J instance 
issues

See Also: Oracle Application Server Administrator’s Guide and the 
online Help for details about viewing log files

Table 13–2 (Cont.) Oracle Enterprise Manager 10g Application Server Control Console Monitoring and 
Administration Tasks

Page Elements Management Task
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Figure 13–3 OracleAS Integration B2B Middle-Tier Instance Performance Page

OracleAS Integration B2B Middle-Tier Instance Server Properties
You can edit server property settings for logging levels, security, and trading partner 
(B2B) properties. These parameters are stored in a file called tip.properties. 
However, Oracle recommends that you edit these parameters only through the Server 
Properties page. Do not edit these parameters by accessing the tip.properties file 
from the directory path location and using an ASCII editor. Figure 13–4 shows the 
page for viewing and editing server properties.

Figure 13–4 Server Properties Page
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OracleAS Integration B2B Port Management
You can view OracleAS Integration B2B and Oracle Application Server component 
ports, and change some Oracle Application Server ports. However, it is strongly 
recommended that you not change OracleAS Integration B2B ports for this release.

1. Ensure that you selected Ports in Step 3 of "Managing and Monitoring a 
Middle-Tier Instance from Oracle Enterprise Manager 10g Application Server 
Control Console" on page 13-4 to access the page for viewing and changing 
component ports.

The page listing component ports appears.

2. Click the Component title in the Component column to alphabetically arrange the 
order of ports by name.

The B2B server and OC4J instance components of OracleAS Integration B2B 
display details.

3. View details about ports, including the current port number and range of available 
ports.

4. Click the Configure column for a port that you want to change. Only ports with 
the pencil icon in the Configure column can be changed.

5. Follow the instructions on the page that displays to change the component port. 
Click the online Help for additional details.

Starting and Stopping OracleAS Integration B2B Components with OPMN 
You can also start and stop the B2B server and OC4J instance components of OracleAS 
Integration B2B from the operating system command prompt of ORACLE_
HOME/opmn/bin using the Oracle Process Manager and Notification Server 
(OPMN).

To stop the B2B server and OC4J instance individually:

Note: If using OracleAS Integration B2B on Windows operating 
systems, you must update server properties settings in the following 
order: 

1. Stop the B2B server and OC4J instance of OracleAS Integration 
B2B.

2. Make updates to server property settings in the Server Properties 
page.

3. Start the B2B server and OC4J instance.

If you do not follow this order, these updates are not applied correctly.

See Also: The online Help for a detailed description of 
parameters you can edit, their range of values, and the default 
values

See Also: "Port Changing Error Message" on page 13-11 for the type 
of error message you receive if you attempt to start OracleAS 
Integration B2B components, but another component is already using 
the assigned port
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1. Enter the following commands at your operating system command prompt to stop 
the B2B server and OC4J instance.

prompt> opmnctl stopproc process-type=B2BServer

prompt> opmnctl stopproc process-type=OC4J_B2B

To start the B2B server and OC4J instance individually:

1. Enter the following commands at your operating system command prompt to start 
the B2B server and OC4J instance.

prompt> opmnctl startproc process-type=B2BServer

prompt> opmnctl startproc process-type=OC4J_B2B

To start and stop the B2B server and OC4J instance together:

1. Enter the following commands at your operating system command prompt to start 
and stop the B2B server and OC4J instance together.

prompt> opmnctl startproc ias-component=B2B

prompt> opmnctl stopproc ias-component=B2B

Additional Oracle Application Server and OracleAS Integration B2B 
Management Tasks

Table 13–3 describes additional Oracle Application Server administration tasks that 
also relate to OracleAS Integration B2B. References to documentation that describes 
these tasks are also provided.

See Also:

■ Oracle Process Manager and Notification Server Administrator’s 
Guide

■ Oracle Application Server Administrator’s Guide

Table 13–3 Additional Oracle Enterprise Manager 10g Tasks

Task See Also

Configure an Oracle Application Server instance to use 
Infrastructure Services.

Oracle Application Server 
Administrator’s Guide

Installing and configuring Oracle Application Server for 
high availability (including Oracle Application Server 
Cold Failover Clusters)

Oracle Application Server Installation 
Guide

Changing Internet Protocol (IP) addresses and 
hostnames for an Oracle Application Server host

Oracle Application Server 
Administrator’s Guide

Viewing and changing ports Oracle Application Server 
Administrator’s Guide

"OracleAS Integration B2B Port 
Management" on page 13-9

"Changing Port Numbers" on 
page 13-11

Using the dynamic host configuration protocol (DHCP) 
in Windows and Linux environments.

Oracle Application Server 
Administrator’s Guide
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Changing Port Numbers
Oracle Enterprise Manager 10g uses dynamic monitoring services (DMS) ports to 
gather performance data about Oracle Application Server components. For this 
release, OracleAS Integration B2B does not seamlessly support the use of dynamic 
ports. Instead, static port numbers assigned during installation are used for gathering 
performance data. Changing a port number is a complicated procedure. Oracle 
strongly recommends that you do not change port numbers. Instead, find the process 
that uses the ports, and stop that process (or whatever else is required to free that 
port). However, if you must change the port number, follow the instructions in this 
section.

This section contains these topics:

■ Port Changing Error Message

■ Modifying Ports

Port Changing Error Message
This error message occurs when you attempt to start OracleAS Integration B2B 
components, while another component is already using the assigned port:

isunrak21(17:45:03):/private/sabburi/m13/opmn/bin % opmnctl startproc 
process-type=B2BServer
opmnctl: starting opmn managed processes...
 ================================================================================
     opmn id=isunrak21:6200
         0 of 1 processes started.
      
     ias-instance id=m13.isunrak21
     
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++
     ias-component/process-type/process-set:
         B2B/B2BServer/m13.isunrak21
      
     Error
     --> Process (pid=0)
         failed to start a managed process after the maximum retry limit
         no port available from the port range
         no port available from the port range

Configuring Oracle HTTP Server for secure socket layer 
(SSL) and secure HTTP

Oracle HTTP Server Administrator’s 
Guide

Configuring OC4J for SSL and secure HTTP Oracle Application Server Security 
Guide

Configuring firewalls and load balancing Oracle Application Server High 
Availability Guide

See Also:

■ Oracle Application Server Performance Guide for additional details 
about DMS

■ "OracleAS Integration B2B Monitoring and Administration 
Tasks" on page 13-6 for instructions on stopping OracleAS 
Integration B2B processes

Table 13–3 (Cont.) Additional Oracle Enterprise Manager 10g Tasks

Task See Also
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         Log:
         none

Modifying Ports
If you must change the port number, follow these instructions:

1. Make backup copies of the opmn.xml and targets.xml files to be modified in 
these procedures before you begin.

2. Stop all OPMN and Oracle Enterprise Manager 10g processes:

emctl stop iasconsole
opmnctl stopall

3. Open the ORACLE_HOME/opmn/conf/opmn.xml file.

4. Modify the range attribute of the port element for the corresponding OracleAS 
Integration B2B component.

<process-type id="B2BServer" module-id="b2bengine" 
working-dir="$ORACLE_HOME/ip" status="enabled">
    <module-data>
       <category id="start-parameters">
          <data id="java-parameters" value="-server -Xms8M -Xmx512M"/>
       </category>
    </module-data>
    <port id="dms" range="8777"/>
    <process-set id="%IASNAME%" numprocs="1"/>
    <start timeout="3600"/>
    <stop timeout="3600"/>
  </process-type>

5. Open ORACLE_HOME/sysman/emd/targets.xml.

6. Change the "HTTPPort" attribute to the port you specified in opmn.xml in Step 
4.

<Target TYPE="oracle_integb2b_engine" 
NAME="as.dhcp-dci-stevens-towers-125-95-159-245.dci.acme.com_B2BServer" 
DISPLAY_NAME="B2BServer" VERSION="3.0">
        <Property NAME="OracleHome" VALUE="D:\OraHome1\as"/>
        <Property NAME="EmptyOracleHome" VALUE=""/>
        <Property NAME="HTTPPort" VALUE="8777"/>
        <Property NAME="HTTPMachine" VALUE="stdevtemp"/>
        <Property NAME="OPMNPort" VALUE="6003"/>
        <Property NAME="OidRepSchemaName" VALUE="B2B"/>
        <AssocTargetInstance ASSOC_TARGET="ias" TYPE="acme_ias" 
NAME="as.dhcp-dci-stevens-towers-125-95-159-245.dci.acme.com"/>
        <CompositeMembership>
            <MemberOf TYPE="oracle_integb2b_instance" 
NAME="as.dhcp-dci-stevens-towers-125-95-159-245.dci.acme.com_B2B_Instance"/>
        </CompositeMembership>
 </Target>

7. Run the following command:

ORACLE_HOME/dcm/bin/dcmctl updateConfig

8. Restart OPMN (and the Oracle Enterprise Manager 10g Application Server Control 
Console, if you are using it).

opmnctl startall
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emctl start iasconsole

Chapter Summary
This chapter explains how to use Oracle Enterprise Manager 10g to manage OracleAS 
Integration B2B (for example, starting and stopping the B2B server or OC4J instance 
components, viewing log files, and editing server properties). For this initial release, 
OracleAS Integration B2B can only be managed from the Oracle Enterprise Manager 
10g Application Server Control Console. Oracle Enterprise Manager 10g Grid Control 
Console management of OracleAS Integration B2B is not supported.

See Also: Oracle Application Server Administrator’s Guide for details 
about port ranges
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14
Creating Reports

This chapter describes how to create Oracle Application Server Integration B2B reports 
that describe the status of runtime behavior of a deployed configuration.

This chapter contains these topics:

■ Reports Overview

■ Creating Business Message Status Reports

■ Creating Wire Message Status Reports

■ Creating Collaboration Status Reports

■ Creating Error Status Reports

■ Saving Reports

■ Saving Report Definitions

■ Importing Reports

■ Chapter Summary
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Reports Overview
Instance data exists in the runtime repository as business messages are exchanged. 
The OracleAS Integration B2B user interface tool enables you to query this information 
to see what is occurring and to perform business analysis. You can query this 
information in several different ways based on the type that you want. Specifically, 
you can query for information such as business message status, wire message status, 
collaboration status, and errors.

Reports User Role
A trading partner can include individuals such as business analysts who must be able 
to create and analyze configuration reports. 

For these situations, OracleAS Integration B2B provides a Reports user role that you 
can assign to host trading partner users. This role provides a user with access to only 
the functionality of the Reports tab of the OracleAS Integration B2B user interface tool. 
A user with this role cannot see or access the other parts of the user interface tool.

Note that a host trading partner user with the Administrator role can access the 
functionality of the entire OracleAS Integration B2B user interface tool, including the 
Reports tab.

Creating Business Message Status Reports
Business message status reports identify business message instance details for an 
electronic data interchange (EDI) or Custom Document business protocol. These 
details include the sending and receiving trading partners, exchange protocol, 
document protocol, business action and its state, message date, and message details.

Follow these instructions to create a business message status report.

1. Click Reports > Business Message.

The Business Message Report Definition page appears.

2. Enter the following details:

3. If you want to specify advanced report parameters, click Show Advanced Report 
Options.

4. Enter the following details:

See Also: "Assigning a User Role to a Host Trading Partner Person" 
for instructions on assigning the Reports role to a host trading 
partner user

Field Value

Name Accept the default business message report name or enter a 
unique and recognizable name.

Start Date Use the calendar icon to select the date at which to start collecting 
message details.

End Date Use the calendar icon to select the date at which to complete 
collecting message details.

Business Action Name Select the business action from the list.
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Field Value

Business Message Id Enter an identifier in the field. This is a 16-digit value that you 
can obtain from the ORACLE_HOME/ip/log/b2b/b2b.log file. 
You can enter a portion of this value, and all values that include 
the portion entered are returned. 

Business Message Status Select the status of the business message from the list:

■ Aborted

Message processing was aborted.

■ Collab Wait

A message is waiting for collaboration activity to complete. 

■ Complete

Message delivery and all processing has completed.

■ Continue Process

Message processing is continuing.

■ Error

An error occurred during message processing.

■ Invalid

The message is invalid.

■ Out of Band Error

An out-of-band error has occurred.

■ Process Ack

An acknowledgment message is processing for this business 
message (not a valid state for an acknowledgment message).

■ Process Exp

An exception message is processing for this business 
message (not a valid state for an exception message).

■ Send Ack

An acknowledgment message has been sent.

■ Send Exp

An exception message has been sent.

■ Transmit Failed

Message transmission has failed. Depending upon the 
number of retries specified, this message may be sent later. If 
all retries fail, the status of this message changes to an error.

■ Wait Ack

Waiting for an acknowledgment message.

■ Wait Transmit

Waiting for a message to be transmitted.

Sending Trading Partner Select the trading partner that sent the message.

Receiving Trading Partner Select the trading partner that received the message.

Sending Trading Partner 
Identification

Select the trading partner identification type of the sending 
trading partner (for example, DUNS or EDI Location Code).

Sending Trading Partner 
Value

Select the sending trading partner identification type value. For 
example, if you selected DUNS, select the Data Universal 
Numbering System (DUNS) number.
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5. Click Run Report.

The status report appears.

6. View specific details. If you want to save the report results to a comma-separated 
value (CSV)-formatted file, click Save Report.

7. If you want to save the report definition, click Save Definition.

Creating Wire Message Status Reports
Wire messages are the native format of data sent from trading partners. Wire messages 
can contain a number of sections, such as payloads, attachments, or trailers. Wire 
message status reports identify details about wire message instances, such as the 
transport protocol name, the transport protocol revision, and the protocol message 
identification and its state.

Follow these instructions to create a wire message status report. 

1. Click Reports > Wire Message.

The Wire Message Report Definition page appears.

2. Enter the following details:

Receiving Trading Partner 
Identification

Select the trading partner identification type of the receiving 
trading partner.

Receiving Trading Partner 
Value

Select the receiving trading partner identification type value. 

Business Protocol Select the specific EDI, RosettaNet, or Custom Document 
business protocol used in this business transaction between 
sending and receiving trading partners. 

Agreement Name Select the trading partner agreement in which the sending and 
receiving trading partners are participants.

Configuration Name Select the configuration that includes this trading partner 
agreement. By default, the report results come from the latest 
active configuration.

Comments Enter comments to display under the title after report creation is 
complete.

Field Value

Name Accept the default wire message report name or enter a unique 
and recognizable name.

Start Date Use the calendar icon to select the date at which to start collecting 
message details.

End Date Use the calendar icon to select the date at which to complete 
collecting message details.

Protocol Message Id Enter the protocol message identification. You can obtain this 
value from the ORACLE_HOME/ip/log/b2b/b2b.log file or 
from the trading partners that sent or received the message. You 
can enter a portion of this value, and all values that include the 
portion entered are returned. 

Field Value
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3. If you want to specify advanced report parameters, click Show Advanced Report 
Options.

4. Enter the following details:

Transport Protocol Select a transport protocol about which to collect data from the 
list:

■ AQ - 1.0

■ B2B Queues - 1.0

■ E-Mail - 1.0

■ FTP - 1.0

■ File - 1.0

■ HTTP - 1.0

■ HTTP - 1.0 (Secure)

■ HTTP - 1.1

■ HTTP - 1.1 (Secure)

■ JMS - 1.0

■ XML Gateway Queues - 1.0

Wire Message Status Select the wire message status from the list:

■ Complete

Message processing has completed. 

■ Consumed

The message has been deleted.

■ Error

An error occurred during message processing.

■ Processing

The message is currently processing.

Field Value

Sending Trading Partner Select the trading partner that sent the message.

Receiving Trading Partner Select the trading partner that received the message.

Sending Trading Partner 
Identification

Select the trading partner identification type of the sending 
trading partner (for example, DUNS or EDI Location Code).

Sending Trading Partner 
Value

Select the sending trading partner identification type value. For 
example, if you selected DUNS, select the DUNS number.

Receiving Trading Partner 
Identification

Select the trading partner identification type of the receiving 
trading partner.

Receiving Trading Partner 
Value

Select the receiving trading partner identification type value. 

Configuration Name Select the configuration that includes this trading partner 
agreement. By default, the report results come from the latest 
active configuration.

Comments Enter comments to display under the title after report creation is 
complete.

Field Value
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5. Click Run Report.

The status report appears.

6. View specific details. If you want to save the report results to a CSV-formatted file, 
click Save Report.

7. If you want to save the report definition, click Save Definition.

Creating Collaboration Status Reports
Collaboration status reports identify collaboration instance details for the RosettaNet 
over RNIF business protocol. These details include the revision, protocol collaboration 
identification, state, and start and end times for the collaboration.

Follow these instructions to create a collaboration status report.

1. Click Reports > Collaboration.

The Collaboration Report Definition page appears.

2. Enter the following details:

3. If you want to specify advanced report parameters, click Show Advanced Report 
Options.

4. Enter the following details:

Field Value

Name Accept the default collaboration report name or enter a unique 
and recognizable name.

Start Date Use the calendar icon to select the date at which to start collecting 
message details.

End Date Use the calendar icon to select the date at which to complete 
collecting message details.

Collaboration Name Select the collaboration from the list (for example, 3A4).

Field Value

Protocol Collaboration Id Enter an identifier in the field. You can obtain this value from the 
ORACLE_HOME/ip/log/b2b/b2b.log file or from the trading 
partners that sent or received the collaboration. You can enter a 
portion of this value, and all values that include the portion 
entered are returned. 

Collaboration Status Select the collaboration message status from the list:

■ Aborted

Collaboration processing was aborted.

■ Complete

Collaboration delivery has completed.

■ Error

An error occurred during collaboration processing.

■ In Progress

The collaboration is currently in progress.

■ Out of Band Error

An out-of-band error has occurred.
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5. Click Run Report.

The status report appears.

6. View specific details. If you want to save the report results to an XML file, click 
Save Report.

7. If you want to save the report results to a CSV-formatted file, click Save Report.

8. If you want to save the report definition, click Save Definition.

Creating Error Status Reports
Error status reports identify error message details. These details include the error code, 
error text, business message identification, message date, and message details.

Follow these instructions to create an error message status report.

1. Click Reports > Error.

The Error Report Definition page appears.

2. Enter the following details:

Sending Trading Partner Select the trading partner that sent the message.

Receiving Trading Partner Select the trading partner that received the message.

Sending Trading Partner 
Identification

Select the trading partner identification type of the sending 
trading partner (for example, DUNS or EDI Location Code).

Sending Trading Partner 
Value

Select the sending trading partner identification type value. For 
example, if you selected DUNS, select the DUNS number.

Receiving Trading Partner 
Identification

Select the trading partner identification type of the receiving 
trading partner.

Receiving Trading Partner 
Value

Select the receiving trading partner identification type value. 

Agreement Name Select the trading partner agreement in which the sending and 
receiving trading partners are participants.

Configuration Name Select the configuration that includes this trading partner 
agreement. By default, the report results come from the latest 
active configuration.

Comments Enter comments to display under the title after report creation is 
complete.

Field Value

Name Accept the default error status report name or enter a unique and 
recognizable name.

Start Date Use the calendar icon to select the date at which to start collecting 
message details.

End Date Use the calendar icon to select the date at which to complete 
collecting message details.

Message Type Select Business Message, select Wire Message, or leave this field 
unselected to collect data for both message types.

Field Value
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3. If you want to specify advanced report parameters, click Show Advanced Report 
Options.

4. Click Run Report.

The status report appears.

5. View specific details. If you want to save the report results to a CSV-formatted file, 
click Save Report.

6. If you want to save the report definition, click Save Definition.

Saving Reports
You can save the generated reports in CSV format. This enables you to view reports in 
Microsoft Excel. 

Follow these instructions to save the contents of a generated report:

1. Create an appropriate report.

2. Click Run Report.

The status page appears.

3. Click Save Report. 

The report contents are saved to CSV format. Only Microsoft Excel is supported 
for viewing CSV-formatted reports.

Saving Report Definitions
You can save the contents of your generated reports to XML files. You can then 
reimport the report contents as needed into the OracleAS Integration B2B user 
interface tool.

Follow these instructions to save the contents of a generated report:

1. Create an appropriate report.

2. Click Run Report.

The status page appears.

3. Click Save Definition. 

The report contents are copied to an XML file that you are prompted to open or 
download to a directory location.

Field Value

Configuration Name Select the configuration that includes this trading partner 
agreement. By default, the report results come from all 
configurations. For this reason, no configuration is selected by 
default.

Comments Enter comments to display under the title after report creation is 
complete.
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Importing Reports
You can import a report that you saved previously to an XML file through the Save 
Definition option. 

Follow these instructions to import a saved report:

1. Click Reports > Import.

The Import page appears.

2. Click Browse to select a report definition file to import.

3. Click Finish.

The report contents are reimported and the report results appear in OracleAS 
Integration B2B.

Chapter Summary
This chapter describes how to create business message, wire message, collaboration, 
and error status reports. This chapter also describes how to save report results to a 
CSV-formatted file for viewing in Microsoft Excel and how to save the report 
definition to an XML file that you can later reimport into OracleAS Integration B2B.
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15
Oracle Application Server Integration B2B

Security

The ability to control user access to Web content and to protect your site against people 
breaking into your system is critical. This chapter describes the architecture and 
configuration of security for Oracle Application Server Integration B2B.

This chapter contains these topics:

■ About OracleAS Integration B2B Security

■ Configuring Oracle Application Server Security Framework for OracleAS 
Integration B2B

■ Configuring OracleAS Integration B2B Security

■ Chapter Summary

See Also: The following documents for additional details about 
security:

■ Oracle Application Server Security Guide for an overview of 
Oracle Application Server security and its core functionality

■ Oracle Identity Management Concepts and Deployment Planning 
Guide for guidance for administrators of the Oracle security 
infrastructure
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About OracleAS Integration B2B Security
This section describes the OracleAS Integration B2B security model. This section 
contains these topics:

■ Classes of Users and Their Privileges

■ Resources Protected

■ Authorization and Access Enforcement

■ Use of Oracle Application Server Security Services

■ Use of Oracle Identity Management Infrastructure

Classes of Users and Their Privileges
A single user named admin is automatically created during OracleAS Integration B2B 
installation. The password for admin is the same one you specified for the Oracle 
Application Server administrator named ias_admin when prompted during the J2EE 
and Web Cache and OracleAS Integration B2B installations.

The admin user consists of a single default user role named Administrator. The 
Administrator role consists of the use cases (privileges) that enable the admin user 
to use the entire functionality of the OracleAS Integration B2B user interface tool to 
design, deploy, monitor, and manage integrations. A Reports role is also available for 
users (such as business analysts) that require access to only the Reports tab of the 
OracleAS Integration B2B user interface tool. The admin user can create additional 
users to which to assign the Administrator role.

You can also administer portions of OracleAS Integration B2B from the Oracle 
Enterprise Manager 10g Application Server Control Console. Log in with the ias_
admin username. Use the same password for ias_admin that you specified when 
prompted during the J2EE and Web Cache and OracleAS Integration B2B installations.

See Also: The following sections for instructions on performing 
these tasks:

■ "Creating a Trading Partner Person" on page 8-22 to create 
additional users of the OracleAS Integration B2B user interface 
tool

■ "Assigning a User Role to a Host Trading Partner Person" on 
page 8-24 to assign the Administrator or Reports role to a 
user

■ "Viewing a Trading Partner Person and Updating the Person 
Password" on page 8-22 to update the admin user password

■ "Updating a Host or Remote Trading Partner" on page 8-7 to 
update the name

■ Chapter 13, "System Management with Oracle Enterprise 
Manager 10g" to administer OracleAS Integration B2B from the 
Oracle Enterprise Manager 10g Application Server Control 
Console
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Resources Protected
The following security is provided for protecting resources:

■ The partner data that you design with the OracleAS Integration B2B user interface 
tool is protected by both the admin username and password and by the security 
provided by the Oracle database used for the Oracle Application Server Metadata 
Repository.

■ Network messaging can be secured and encrypted using Oracle Advanced 
Security. Network messaging can also be secured by using secure HTTP with the 
OracleAS Integration B2B user interface tool.

■ Transport protocols that enable communication between applications and 
OracleAS Integration B2B use their own security (such as HTTP, FTP, and SMTP) 
to restrict access to data.

■ The messages that trading partners send and receive during integrations between 
enterprises are protected by the following levels of security:

■ Digital envelopes and certificates

■ Digital signatures for host and remote trading partners

■ Secure HTTP (using secure socket layer (SSL))

■ Encrypted wallet password for a host trading partner

Authorization and Access Enforcement
When you attempt to access the OracleAS Integration B2B user interface tool, you are 
prompted for a username and password. Without knowledge of this connection 
information, you cannot access the user interface tool to design, deploy, and manage 
integrations between enterprises.

Use of Oracle Application Server Security Services
Oracle Application Server provides a series of security services. OracleAS Integration 
B2B enables you to use SSL. You can use SSL for securing connections between host 
and remote trading partners. SSL uses a public key infrastructure to provide 
authentication and data integrity.

Secure HTTP can also be used to secure the OracleAS Integration B2B user interface 
tool.

Use of Oracle Identity Management Infrastructure
This release of OracleAS Integration B2B does not require use of Oracle Identity 
Management infrastructure features; Oracle Identity Management is optionally 
selectable for use during OracleAS Integration B2B installation and is only used for 
OracleAS Integration B2B schema password storage. 

See Also: "OracleAS Integration B2B Security Configuration" on 
page 15-5 for an overview of security configuration for integrations 
between enterprises

See Also: Oracle Application Server Security Guide for a description 
of Oracle Application Server security services
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Configuring Oracle Application Server Security Framework for OracleAS 
Integration B2B

This section describes Oracle Application Server security options to configure to use 
OracleAS Integration B2B. This section contains these topics:

■ OracleAS Integration B2B Security Framework Configuration Issues

■ Identity Management Configuration Issues Specific to OracleAS Integration B2B

OracleAS Integration B2B Security Framework Configuration Issues
The OracleAS Integration B2B schema is protected by a password created during 
Oracle Application Server Infrastructure installation. These schemas are stored in the 
metadata repository of Oracle Application Server Infrastructure to which you 
configure access during OracleAS Integration B2B installation. In addition, the partner 
data you design, deploy, and manage with the OracleAS Integration B2B user interface 
tool is stored in this same metadata repository of Oracle Application Server 
Infrastructure.

Identity Management Configuration Issues Specific to OracleAS Integration B2B
This initial release of OracleAS Integration B2B does not use the identity management 
infrastructure. Therefore, there are no identity management configuration issues and 
options.

Configuring OracleAS Integration B2B Security
This section provides an overview of OracleAS Integration B2B installation and 
configuration issues. This section contains these topics:

■ OracleAS Integration B2B Installation

■ OracleAS Integration B2B Security Configuration

■ Host Trading Partner Password Encryption in High Availability Environments

■ Configuration Issues and Options to Use for Oracle Application Server Security 
Framework

■ Oracle HTTP Server Transport Servlet and OracleAS Integration B2B

OracleAS Integration B2B Installation
This section describes OracleAS Integration B2B security installation issues.

See Also:

■ Oracle Application Server Security Guide for Oracle Application 
Server Infrastructure and Oracle Application Server security 
details, including how to configure the Oracle HTTP Server 
with secure HTTP

■ Oracle Application Server Containers for J2EE Security Guide
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Required Information for Successfully Installing Oracle Application Server 
Integration B2B
While you do not specify security parameters when installing OracleAS Integration 
B2B, the Oracle Application Server administrator must know the following 
information to install OracleAS Integration B2B:

■ The name of the host on which the Oracle Application Server Infrastructure 
installation to use as the metadata repository is installed 

■ The specific Oracle Application Server Infrastructure installation on that host that 
includes the OracleAS Integration B2B schema

■ The OracleAS Integration B2B schema password automatically created during 
Oracle Application Server Infrastructure installation

■ The ias_admin password specified during J2EE and Web Cache installation, 
which is used as the initial password for the OracleAS Integration B2B admin user 
and for the Oracle Enterprise Manager 10g Application Server Control Console 
ias_admin user

OracleAS Integration B2B Security Configuration
You configure security with the OracleAS Integration B2B user interface tool after 
installation. OracleAS Integration B2B provides the following levels of security:

■ Digital Envelopes and Certificates for Host and Remote Trading Partners

■ Digital Signatures for Host and Remote Trading Partners

■ Secure HTTP and Client Authentication

■ Encrypted Wallet Passwords for Host Trading Partners

Digital Envelopes and Certificates for Host and Remote Trading Partners
You can create encrypted business messages with remote trading partner certificates. 
Table 15–1 provides an overview of the tasks.

See Also: Oracle Application Server Integration B2B Installation 
Guide for OracleAS Integration B2B installation instructions

See Also: "Creating a Trading Partner Agreement" on page 10-6 to 
create a trading partner agreement to which to assign a trading 
partner with its delivery channel characteristics

Table 15–1 Host and Remote Trading Partner Certificate Tasks

Tasks See...

Assign a digital envelope to a remote trading 
partner with the Create Trading Partner wizard:

■ Select Yes from the Encryption Enabled list 
of the Create Trading Partner : Delivery 
Channel page.

■ "Page 4: Delivery Channel Page" on 
page 7-15 

■ Select a digital envelope from the Digital 
Envelope list of the Create Trading Partner : 
Document Exchange page.

■ "Page 5: Document Exchange Page" on 
page 7-17 

Assign remote trading partner certificates 
through either of two methods:

With the Create Trading Partner wizard:
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These digital envelope and remote trading partner certificate details comprise a 
portion of the delivery channel characteristics. You can then assign the delivery 
channel to a trading partner participating in a trading partner agreement.

Digital Signatures for Host and Remote Trading Partners
You can use a digital signature with host and remote trading partners. The digital 
signature ensures that the message is authentic. Table 15–2 provides an overview of 
the tasks for configuring digital signatures.

■ Enter a remote certificate name in the Name 
field of the Create Trading Partner : 
Document Exchange page.

■ "Page 5: Document Exchange Page" on 
page 7-17

■ Click Browse to select a certificate file for 
the Certificate File field of the Create 
Trading Partner : Document Exchange page.

■ "Page 5: Document Exchange Page" on 
page 7-17

Without the Create Trading Partner wizard:

Note: Creating a remote trading partner 
certificate through this second method means 
that you must manually attach the correct digital 
envelope.

■ "Creating a Remote Trading Partner 
Certificate" on page 8-13

Assign a wallet password to the host trading 
partner in the user interface tool:

■ Create a wallet password with the user 
interface tool.

■ "Creating a Host Trading Partner Wallet 
Password" on page 8-15

■ Specify a wallet location on the Server 
Properties page of Oracle Enterprise 
Manager 10g Application Server Control 
Console.

■ "OracleAS Integration B2B Middle-Tier 
Instance Server Properties" on page 13-8

See Also:

■ Chapter 7, "Creating Trading Partners" for information on the 
different methods for using the Create Trading Partner wizard

■ "Creating a Trading Partner Agreement" on page 10-6

Table 15–2 Digital Signature Tasks

Tasks See...

Assign digital signatures to host and remote 
trading partners with the Create Trading 
Partner wizard:

Table 15–1 (Cont.) Host and Remote Trading Partner Certificate Tasks

Tasks See...
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These digital signature details comprise a portion of the delivery channel 
characteristics. You can then assign the delivery channel to a trading partner 
participating in a trading partner agreement.

Secure HTTP and Client Authentication
You can use SSL to secure connections between host and remote trading partners. 
Table 15–3 provides an overview of the parts to configuring SSL.

■ Select Yes from the Is Non-Repudiation of 
Origin Required list and Is 
Non-Repudiation of Receipt Required list 
on the Create Trading Partner : Delivery 
Channel page.

Notes: If you select Yes from the Is 
Non-Repudiation of Origin Required list, 
you must also select Yes from the Is 
Non-Repudiation of Receipt Required list.

In a trading partner agreement, both the 
host and remote trading partners must 
have the same values for Is 
Non-Repudiation of Origin Required and 
Is Non-Repudiation of Receipt Required.

■ "Page 4: Delivery Channel Page" on 
page 7-15

■ Select a digital signature from the Digital 
Signature list of the Create Trading Partner 
: Document Exchange page.

Note: Oracle recommends that you select a 
digital signature that uses SHA-RSA.

■ "Page 5: Document Exchange Page" on 
page 7-17

Assign a signing credential to a remote trading 
partner with the Create Trading Partner wizard:

■ Enter a signing credential name in the 
Name field of the Create Trading Partner : 
Document Exchange page.

■ "Page 5: Document Exchange Page" on 
page 7-17

■ Click Browse to select a signing credential 
for the Certificate File field of the Create 
Trading Partner : Document Exchange 
page.

■ "Page 5: Document Exchange Page" on 
page 7-17

Assign a wallet password to the host trading 
partner:

■ Update the wallet password in the user 
interface tool.

■ "Updating a Host Trading Partner 
Wallet Password" on page 8-16

■ Update the wallet location on the Server 
Properties page of Oracle Enterprise 
Manager 10g Application Server Control 
Console.

■ "OracleAS Integration B2B Middle-Tier 
Instance Server Properties" on page 13-8

See Also:

■ Chapter 7, "Creating Trading Partners" for information on the 
different methods for using the Create Trading Partner wizard

■ "Creating a Trading Partner Agreement" on page 10-6

Table 15–2 (Cont.) Digital Signature Tasks

Tasks See...
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These SSL details comprise a portion of the delivery channel characteristics. You can 
then assign the delivery channel to a trading partner participating in a trading partner 
agreement.

Table 15–3 SSL Tasks

Part Task See...

1 Assign SSL for transport security with the Create 
Trading Partner wizard:

■ Select Yes from the Transport Security 
Enabled list of the Create Trading Partner : 
Delivery Channel page.

■ "Page 4: Delivery Channel Page" 
on page 7-15

■ Select HTTP 1.0 (Secure) or HTTP 1.1 
(Secure) from the Transport Protocol list of 
the Create Trading Partner : Transport page.

■ "Page 6: Transport Page" on 
page 7-21

2 Set up a certificate authority (CA):

■ Start Oracle Wallet Manager at the 
operating system command prompt:

owm

Oracle Application Server 
Administrator’s Guide

■ Import a trading partner’s CA into Oracle 
Wallet Manager.

■ Export the entire wallet into a text file. The 
file requires a .txt extension.

■ Place this file in the same location as the 
original wallet file.

3 Assign a wallet password to the host trading 
partner:

■ Update the wallet password you created 
previously.

■ "Updating a Host Trading 
Partner Wallet Password" on 
page 8-16

■ Update the wallet location on the Server 
Properties page of Oracle Enterprise 
Manager 10g Application Server Control 
Console.

■ "OracleAS Integration B2B 
Middle-Tier Instance Server 
Properties" on page 13-8

4 Configure SSL server and client authentication 
for Oracle Application Server.

■ Oracle Application Server 
Administrator’s Guide

■ Oracle Application Server Security 
Guide

Note: Oracle Wallet Manager allows only base64 files to be 
imported. Use Internet Explorer or another tool to convert a 
nonbase64 encoded certificate to base64.

See Also:

■ Chapter 7, "Creating Trading Partners" for information on the 
different methods for using the Create Trading Partner wizard

■ "Creating a Trading Partner Agreement" on page 10-6
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Troubleshooting SSL Setup  Follow these instructions to troubleshoot SSL setup:

Use the browser to connect to the secure HTTP URL. Upon successful connection, the 
following details are viewable:

■ If you are using Internet Explorer, select File > Properties from the main menu. 
The connection information appears. A Certificates button that displays certificate 
information also appears.

■ You may get a confirmation page from the remote server.

Verifying SSL Client Authentication  Follow these instructions to verify SSL client 
authentication:

■ Using the Netscape browser:

1. Import an Oracle Wallet by selecting Communicator > Tools > Security Info > 
Certificates > Yours > Import a Certificate from the main menu.

2. Connect to the secure HTTP URL.

■ Using the Internet Explorer browser:

Internet Explorer does not recognize the .p12 file generated using Oracle Wallet. 
Perform these steps to import the Oracle Wallet:

1. Import the Oracle Wallet by selecting Communicator > Tools > Security Info 
> Certificates > Yours > Import a Certificate from the main menu. 

2. Export the Oracle Wallet by selecting Communicator > Tools > Security Info 
> Certificates > Yours > Export.

3. Import this Oracle Wallet into Internet Explorer and try connecting to the 
secure HTTP URL.

Encrypted Wallet Passwords for Host Trading Partners
OracleAS Integration B2B uses an Oracle Wallet for storing private and public keys. A 
wallet password is required for accessing an Oracle Wallet. You create an initial wallet 
password and an Oracle Wallet with Oracle Wallet Manager. The wallet password is 
stored in encrypted format in the Oracle Application Server Metadata Repository. This 
wallet is used for digital envelopes, digital signatures, and SSL. Table 15–4 provides an 
overview of the tasks to perform in the OracleAS Integration B2B user interface tool 
after you create the wallet password and Oracle Wallet:

Table 15–4 Host Trading Partner Wallet Password

Task See...

Create a host trading 
partner wallet 
password

"Creating a Host Trading Partner Wallet Password" on page 8-15

Note: Enter the same wallet password that you created in Oracle Wallet 
Manager. If you later change the wallet password in Oracle Wallet 
Manager, you must also update the password in the OracleAS 
Integration B2B user interface tool.

Specify the directory 
location for the 
wallet file

"OracleAS Integration B2B Middle-Tier Instance Server Properties" on 
page 13-8 to access the OracleAS Integration B2B server properties 
(under the Server Properties section) with Oracle Enterprise Manager 
10g Application Server Control Console. The Wallet Location property 
enables you to specify the directory location for the wallet file.
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Host Trading Partner Password Encryption in High Availability Environments
OracleAS Integration B2B provides a feature that automatically encrypts the host 
trading partner’s OracleAS Integration B2B passwords through use of an obfuscated, 
encryption key created during installation. If you want to change this key value, do so 
during OracleAS Integration B2B downtime, as all passwords within the OracleAS 
Integration B2B schema are re-encrypted. A new encryption key is then created.

If OracleAS Integration B2B is part of a high availability or disaster recovery 
configuration and you want to change the encryption key, you must perform the 
following procedures:

1. Follow the instructions in "Managing and Monitoring a Middle-Tier Instance from 
Oracle Enterprise Manager 10g Application Server Control Console" on page 13-4 
to log in to the Oracle Enterprise Manager 10g Application Server Control Console 
and access the primary OracleAS Integration B2B instance.

2. Shut down the B2B server and Oracle Application Server Containers for J2EE 
(OC4J) instance subcomponents on the primary system on which OracleAS 
Integration B2B is installed.

3. Go to the Security Key parameter on the Server Properties page.

4. Make the following changes:

a. Change the encryption key in the Security Key field.

b. Check the Re-encrypt Security Key for B2B Repository box.

This action re-encrypts the OracleAS Integration B2B schema password. 

5. Click Apply.

6. Go to the secondary (or backup) system of which OracleAS Integration B2B is a 
part.

7. Repeat Steps 2 and 3 on the secondary system.

8. Enter the same encryption key in the Security Key field as you did in Step 4a. 
However, do not check the Re-encrypt Security Key for B2B Repository box. 

9. Repeat Steps 6 through 8 for additional secondary systems.

10. Restart the primary and secondary systems.

Configuration Issues and Options to Use for Oracle Application Server Security 
Framework

You can enable encryption between OracleAS Integration B2B and the Oracle 
Application Server Metadata Repository by setting several Oracle Net configuration 
parameters. For example, you can encrypt JDBC with the following sqlnet.ora 
parameters:

sqlnet.encryption_server=accepted
sqlnet.encryption_client=requested
sqlnet.encryption_types_server=(RC4_40)
sqlnet.encryption_types_client=(RC4_40)
sqlnet.crypto_seed ="-kdje83kkep39487dvmlqEPTbxxe70273"

See Also: Oracle Database Advanced Security Administrator's Guide 
available on the Oracle Technology Network:

http://www.oracle.com/technology
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Oracle HTTP Server Transport Servlet and OracleAS Integration B2B
OracleAS Integration B2B is integrated with the transport servlet of the Oracle HTTP 
Server to provide security for incoming messages of trading partners. 

Messages sent from remote trading partners must first pass through the transport 
servlet of the Oracle HTTP Server that is automatically deployed after installation. The 
transport server receives and passes messages on to a remote method invocation 
(RMI) port and instance name to which the B2B server component of OracleAS 
Integration B2B listens. RMI functionality enables the different Java processes of the 
Oracle HTTP Server and the B2B server to interface. RMI also provides for scalability: 
you can configure one RMI to communicate with multiple B2B servers. The messages 
are then passed on to OracleAS Integration B2B. 

Figure 15–1 shows Oracle HTTP Server and OracleAS Integration B2B configuration.

Figure 15–1 Oracle HTTP Server and OracleAS Integration B2B

The RMI port number and instance name to which the OracleAS Integration B2B 
listens are automatically configured with the same values in both the transport 
servlet’s web.xml file and in the OracleAS Integration B2B server properties settings 
(accessible from the Oracle Enterprise Manager 10g Application Server Control 
Console). These values must be the same. If you change these values in one location, 
you must also change them to the same values in the other location. 

This procedure is followed only for incoming messages from remote trading partners.

For security reasons, Oracle recommends that you install and configure an additional 
Oracle HTTP Server outside your corporate network to receive messages from remote 
trading partners and pass them onto the Oracle HTTP Server and OracleAS 
Integration B2B instances inside your corporate network. This additional Oracle HTTP 
Server hides the actual location of the host trading partner from all outside parties.
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Chapter Summary
This chapter describes the security provisions of OracleAS Integration B2B, including 
how to use the OracleAS Integration B2B user interface tool to configure digital 
envelopes, remote trading partner certificates, digital signatures, SSL, and host trading 
partner wallet passwords. 

See Also:

■ Oracle Application Server Integration B2B Installation Guide for 
instructions on configuring an additional Oracle HTTP Server 
outside your corporate network

■ Oracle HTTP Server Administrator’s Guide for additional transport 
servlet details

■ Oracle Enterprise Manager 10g Application Server Control 
Console online Help for instructions on setting RMI port and RMI 
instance name values

■ Oracle Application Server High Availability Guide for instructions on 
changing the RMI hostname value for high availability 
environments in which you have multiple OracleAS Integration 
B2B instances using the same Oracle Application Server Metadata 
Repository
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A
Troubleshooting and Workarounds

This appendix describes Oracle Application Server Integration B2B troubleshooting 
methods.

This appendix contains these topics:

■ Checking the IP_IN_QUEUE and IP_OUT_QUEUE Queues

■ Running Reports

■ Checking Log Files

■ Correcting Out-of-Memory Errors

■ Resolving Connection Errors

■ Generic Exchange Protocol Workarounds
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Checking the IP_IN_QUEUE and IP_OUT_QUEUE Queues
OracleAS Integration B2B provides two queues that enable you to confirm the validity 
of messages. These queues can be used to integrate with any application that supports 
advanced queuing (AQ).

■ IP_IN_QUEUE queue

For inbound messages, you can confirm if the message remains in this queue.

■ IP_OUT_QUEUE queue

For outbound messages, you can confirm if the message remains in this queue.

Running Reports
OracleAS Integration B2B provides several report creation wizards that enable you to 
track the movement of messages and identify errors:

■ Error Status Report

This report identifies errors and all exceptions that occur. This includes 
enqueue/dequeue errors on a queue, transport errors occurring during wire 
message communication, plug-ins errors, core errors, XEngine errors (an EDI 
document processing runtime API), and file handling errors. 

This report also enables you to access other report details.

■ Wire Message Report

This report enables you to check inbound and outbound wire messages to confirm 
that they are valid and have been received or sent.

■ Business Message Report

This report identifies the exchange trail of messages between trading partners.

Checking Log Files
OracleAS Integration B2B creates log files describing all types of occurrences, 
including startup and shutdown details, errors, warning messages, access details on 
HTTP requests, and so on. The log file names and formats are determined by the 
oracle.tip.LogType setting in the ORACLE_
HOME/ip/config/tip.properties file. For example, the runtime log file and 
design-time log file are named as follows:

You can view the log files in either of two ways: 

■ Through a command line editor:

1. Go to the ORACLE_HOME/ip/log/b2b directory.

See Also: Chapter 14, "Creating Reports" for instructions on creating 
reports

If oracle.tip.LogType is Set to... Then the File Name is...

ojdl (default) log.xml (for both files)

text b2b.log

ui.log
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2. Open the log.xml file or b2b.log file.

3. Search for:

– Error messages (begin with AIP-) 

– Exceptions

– iAudit report for validation errors in the XEngine (the EDI document 
processing runtime API)

4. Go to the ORACLE_HOME/ip/log/ui directory.

5. Open the log.xml file or ui.log file.

6. Search for design-time issues, such as deployment errors.

■ Through Oracle Enterprise Manager 10g Application Server Control Console

Setting Log Levels
After installation, the OracleAS Integration B2B logging level is automatically set to 
ERROR. To create more detailed logging level information, set the level to DEBUG. 
Perform this task on the Server Properties page of Oracle Enterprise Manager 10g 
Application Server Control Console. Three server properties can be set:

■ Generic Log Level

■ B2B Server Log Level

■ User Interface Log Level 

Generic Log Level provides general B2B server and user interface tool logging results. 
This property value is overridden if you set B2B Server Log Level or User Interface 
Log Level. Both these properties provide more detailed logging results than setting 
only Generic Log Level.

Correcting Out-of-Memory Errors
If many large messages are enqueued, OracleAS Integration B2B can stop processing 
with no indication of errors in the OracleAS Integration B2B log files. If this occurs, 
you can be experiencing an out-of-memory error. Out-of-memory errors that occur in 
OracleAS Integration B2B are logged in the Oracle Process Manager and Notification 
Server (OPMN) log files. This type of error can be corrected by increasing the heap 
size.

1. Open the ORACLE_HOME/opmn/log/B2B~B2BServer~instance_name file on 
your Oracle Application Server middle tier. For example, if your host is named 
myhostname and your Oracle home is named midtier, the log file is named 
C:\midtier\opmn\log\B2B~B2BServer~midtier.myhostname.us.oracl
e.com~1.

2. Look for any out-of-memory errors: 

java.lang.OutOfMemoryError

See Also: "OracleAS Integration B2B Log Files" on page 13-7 for 
instructions on accessing log files through Oracle Enterprise Manager 
10g Application Server Control Console

See Also: "OracleAS Integration B2B Middle-Tier Instance Server 
Properties" on page 13-8 for instructions on setting log levels through 
Oracle Enterprise Manager 10g Application Server Control Console
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If you find this type of error, increase the heap size to correct the problem.

3. Open the ORACLE_HOME/opmn/conf/opmn.xml file on the same Oracle 
Application Server middle tier.

4. Find the process-type section for B2BServer, which looks similar to the 
following:

<process-type id="B2BServer" module-id="b2bengine" 
working-dir="$ORACLE_HOME/ip" status="enabled"> 
<environment> 
<variable id="EDIFECS_HOME" value="$ORACLE_HOME/ip/oem/edifecs/EDIFECSXE"/> 
<variable id="ECRegistryPath"  
value="$ORACLE_HOME/ip/oem/edifecs/EDIFECSXE/eTools/Validator/Docs/Settings/Pr 
oduction/registryValid ator.xml"/> 
<variable id="LD_PRELOAD"  
value="$ORACLE_HOME/ip/oem/edifecs/EDIFECSXE/eTools/bin/Release/libxenginereso 
urcelib.so"/> 
<variable id="LD_LIBRARY_PATH" 
value="$ORACLE_HOME/ip/oem/edifecs/EDIFECSXE/eTools/bin/Release"  
append="true"/> 
<variable id="PATH" 
value="$ORACLE_HOME/ip/oem/edifecs/EDIFECSXE/eTools/bin/Release" 
append="true"/> 
<variable id="CLASSPATH"  
value="$ORACLE_HOME/ip/oem/edifecs/EDIFECSXE/eTools/java/javalibs/edifecsXData 
.jar" append="true"/> 
<variable id="CLASSPATH"  
value="$ORACLE_HOME/ip/oem/edifecs/EDIFECSXE/eTools/java/javalibs/edifecsXTest 
.jar" append="true"/> 
<variable id="CLASSPATH"  
value="$ORACLE_HOME/ip/oem/edifecs/EDIFECSXE/eTools/java/javalibs/edifecs.jar" 
 append="true"/> 
<variable id="CLASSPATH" 
value="$ORACLE_HOME/ip/oem/edifecs/EDIFECSXE/eTools/java/javalibs/log.jar"  
append="true"/> 
<variable id="CLASSPATH"  
value="$ORACLE_HOME/ip/oem/edifecs/EDIFECSXE/eTools/java/javalibs/xalan.jar" 
append="true"/> 
<variable id="CLASSPATH" 
value="$ORACLE_HOME/ip/oem/edifecs/EDIFECSXE/eTools/java/javalibs/js.jar"  
append="true"/> 
<variable id="CLASSPATH" 
value="$ORACLE_HOME/ip/oem/edifecs/EDIFECSXE/eTools/java/javalibs/bsf.jar"  
append="true"/> 
<variable id="CLASSPATH"  
value="$ORACLE_HOME/ip/oem/edifecs/EDIFECSXE/eTools/java/javalibs/xerces.jar" 
append="true"/> 
</environment> 
<module-data> 
<category id="start-parameters"> 
<data id="java-parameters" value="-server -Xms8M -Xmx512M"/> 
</category> 
</module-data> 
<start timeout="3600"/> 
<stop timeout="3600"/> 
<port id="dms" range="8777"/> 
@ <process-set id="midtier.iwinrcf19.us.oracle.com" numprocs="1"/> 
</process-type> 
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5. Find the java-parameters entry (identified in bold in the preceding text) and 
change the value of Xmx512M to a more appropriate value.

6. Save your changes.

7. Stop and restart the B2B server instance.

Resolving Connection Errors
Table A–1 identifies connection errors you can receive and actions for correcting these 
errors. These errors can appear when you create reports to monitor the status of your 
business messages.

Generic Exchange Protocol Workarounds
This section describes workarounds for using the generic exchange protocol.

■ Transport Protocol Parameter Settings for the FTP or File Transport Protocol

■ FTP Server on Windows Operating Systems

■ Generic Exchange Protocols and Functional Acknowledgments

■ Generic Exchange Protocols and Oracle Application Server Web Cache

See Also: "OracleAS Integration B2B Monitoring and 
Administration Tasks" on page 13-6 for instructions on stopping and 
starting the B2B server instance

Table A–1 Connection Errors and Corrective Actions

Error Action

Unable to establish a 
connection

1. Connect to the transport servlet at 
http://hostname:port/b2b/transportServlet.

2. Ensure that the transport servlet is running.

Unable to contact the RMI 
server

1. Ensure that the B2B server instance is running in Oracle 
Enterprise Manager 10g Application Server Control 
Console.

2. Ensure that RMI Port and RMI Instance parameter values 
match those for the transport servlet. The transport servlet 
values are defined in the web.xml file. The OracleAS 
Integration B2B RMI Port and RMI Instance values are 
defined in the Server Properties page of Oracle Enterprise 
Manager 10g Application Server Control Console.

See Also:

■ "OracleAS Integration B2B Monitoring and Administration Tasks" 
for instructions on monitoring the status of the B2B server

■ "OracleAS Integration B2B Middle-Tier Instance Server Properties" 
on page 13-8 for instructions on editing RMI Port and RMI 
Instance parameter values in Oracle Enterprise Manager 10g 
Application Server Control Console

■ "Oracle HTTP Server Transport Servlet and OracleAS Integration 
B2B" on page 15-11 for details about the transport servlet and the 
web.xml file
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Transport Protocol Parameter Settings for the FTP or File Transport Protocol
If you are using a business protocol with a generic exchange, and select the FTP or File 
transport parameter, you must specify the following values for the transport protocol 
parameters shown in Table A–2. Otherwise, your business transaction is deleted 
during transit. You specify these parameters on the Create Trading Partner : Transport 
page of the Create Trading Partner wizard for both host and remote trading partners.

Timestamp Formats
You can specify multiple format masks, each enclosed by square brackets.

<format-mask> ::=  <start> "," <end> "," "'" <time-pattern> "'" [ "," 
<current-year> ] 

<start>  ::= integer 
<end>    ::= integer 

<time-pattern> ::=  <java.text.SimpleDateFormat> | "N" 
<current-year> ::=  "CY" 

TimestampFormats ::=  { "[" <format-mask> "]" }+

Table A–2 Transport Protocol Parameters for File or FTP Transport Protocol

Parameter Value

receiver read only ■ True

Enables files in the inbound directory to be retrieved in the 
ascending order of their last-modified time.

■ False

Enables files in the inbound directory, which have been 
successfully retrieved, to be deleted.

receiver read ordered ■ True

Files are retrieved in the ascending order of their 
last-modified time.

■ False

Files are retrieved in a random fashion.

receiver read ordered 
timestamp source

■ listtime (recommended)

For the FTP transport protocol, the FTP command LIST 
file obtains the last modified time of the file and the size. 
This command typically returns a text string of the format 
MMM dd HH:mm or MMM dd yyyy depending on the age of 
the file. You must specify the type of format you want the 
FTP server to return.

For the File transport protocol, the last modified time of the 
file is retrieved by java.io.File.lastModified().

■ filename

The timestamp is extracted directly from the file name (for 
both the FTP and File transport protocols). You must specify 
the start and end of the substring of the file name, which 
contains the timestamp to use and the timestamp format.

receiver read ordered 
timestamp format

Specify one or more timestamp formats for parsing the output of 
FTP commands or timestamp substrings of filenames. See 
"Timestamp Formats" on page A-6 for an example of the syntax 
to specify.
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Example A–1 provides an example:

Example A–1 Timestamp Formats

[41,53,'MMM dd HH:mm',CY][41,53,'MMM dd  yyyy']

The CY token shown in the preceding text must be added for time patterns where a 
year is not present. The adapter then internally appends the format yyyy to the 
user-provided format mask and appends the current year to the actual timestamp 
string before parsing it. 

The <start> and <end> indexes demarcate the timestamp substring of the string, 
originating either from the FTP LIST command or the actual file name. For a given 
FTP server (brand/vendor), you may need to manually experiment with the server to 
determine which format masks to use. 

If <time-pattern> is specified as N, the substring is treated as a regular integral 
number. In terms of time (t), the number (N) is interpreted as follows:

t =  "12:00 am, January 1, 1970 UTC"  +  N milliseconds

If multiple format masks are entered, they are applied in the order in which they 
appear, until one works.

FTP Server on Windows Operating Systems
If you are using a generic exchange with the FTP transport protocol on Windows 
operating systems, you must use the Serv-U version 5.2 FTP server and perform the 
following tasks. Not doing so means that FTP cannot successfully access trading 
partner endpoints to transfer files. Use of Microsoft FTP servers is not supported.

1. Download the Serv-U version 5.2 FTP server from: 

http://www.serv-u.com

2. Assign admin privileges to the FTP user on the Serv-U FTP server.

3. Create typical Windows directory paths:

C:\private\edi_data

4. Ensure that endpoint directories are within the home directory of the FTP user. For 
example, if the FTP user home directory is C:\private\edi_data, then create a 
subdirectory for use as the endpoint:

C:\private\edi_data\Acme

5. Create a zero-byte file in the incoming trading partner endpoint directory and a 
zero-byte file in the outgoing trading partner endpoint directory. For example: 

c:\private\edi_data\Acme\incoming0 (0 bytes) 
c:\private\edi_data\GlobalChips\outgoing0 (0 bytes)

Generic Exchange Protocols and Functional Acknowledgments
If you are using EDI X12 over Generic Exchange or EDI EDIFACT over Generic 
Exchange with HTTP or HTTPS, do not select Yes in the Functional acknowledgment 
required? field of the Create Trading Partner: Operational Capability page. 
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Generic Exchange Protocols and Oracle Application Server Web Cache
If you use the Custom Document over Generic Exchange, EDI X12 over Generic 
Exchange, or EDI EDIFACT over Generic Exchange business protocol with HTTP or 
HTTPS as your transport protocol, ensure that Oracle Application Server Web Cache is 
disabled. Contact Oracle Support Services for instructions.
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acknowledgment mode

The mode in which trading partners receive messages (asynchronous or synchronous).

active configuration

A configuration state during which the trading partner agreement included in the 
configuration is available for execution of business in the Oracle Application Server 
Integration B2B runtime repository. Incoming messages are accepted based on your 
design in the trading partner agreement and processed accordingly.

admin user

The default username for accessing and using the Oracle Application Server 
Integration B2B user interface tool. This username is created automatically during 
installation.

Administration tab

A main tab of the Oracle Application Server Integration B2B user interface tool that 
enables you to manage and administer Oracle Application Server Integration B2B, 
including exporting and importing the design-time repository; importing 
configurations; importing RosettaNet collaborations, EDI transaction sets, and UCCnet 
standards; importing and purging the design-time repository and instance data in the 
runtime repository; and managing contact types and trading partner identification 
types.

Administrator role

The role that enables a user to access and use the entire Oracle Application Server 
Integration B2B user interface tool. Only a user in the host trading partner 
organization can be assigned this role.

agreement

See trading partner agreement.

Applicability Statement 2

An EDI specification between businesses using the Internet's Web page protocol 
(HTTP). This specification was created by EDI over the Internet (EDIINT), a working 
group of the Internet Engineering Task Force (IETF) that develops secure and reliable 
business communication standards. 

AS2

See Applicability Statement 2.
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associated agreements

See trading partner agreement.

back-end application

See host application.

B2B

See business-to-business.

B2B core

The process, document, and exchange protocols and protocol revisions supported by 
Oracle Application Server Integration B2B.

B2B integration

B2B integration enables trading partners to exchange business data across networks 
such as the Internet and incorporates the trading partners' host applications and 
business processes.

B2B transaction

See business transaction.

business action

Identifies the roles played in a configuration using an EDI or Custom Document 
business protocol. Business actions describe the business documents and their 
movement between trading partners. In the Oracle Application Server Integration B2B 
user interface tool, trading partners define their operational capabilities by the 
business actions they support. 

business collaboration

Consists of a set of roles (buyer and seller) collaborating through a set of agreed-on 
business transactions by exchanging business documents. Trading partners participate 
in a business collaboration through roles. This business collaboration must achieve a 
specified outcome. 

business document

The name for messages exchanged between trading partners.

Business Message Status Reports

Monitor trading partner business message instances for EDI or Custom Document 
business protocols.

business protocol

Identifies the implementation guidelines to use for the reliable transport of business 
document messages between trading partners. The business protocol consists of three 
protocols: process (of which support for business actions and collaborations are a 
part), document, and exchange.

business transaction

A unit of business conducted by two or more trading partners that generates a definite 
state of success or failure. A business transaction is conducted between two trading 
partners playing opposite roles in a transaction. The roles are always an initiating role 
and a responding role.
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business-to-business

A type of integration technology that enables companies to integrate trading partners 
with other trading partners.

callouts

Used to transform documents from one form to another. You can use callouts to invoke 
an XSLT style sheet and any Java program in general. For example, an incoming 
remote trading partner’s EDI document is sent to the host trading partner’s host 
Oracle E-Business Suite application, which uses XML. Callouts enable you to 
transform the EDI document into an XML format understood by the Oracle E-Business 
Suite application. The outgoing document can then be transformed back into its 
original format. Callouts are associated with internal delivery channels.

certificate

See remote trading partner certificates.

collaboration

Collaborations consist of a set of RosettaNet PIPs that define the capabilities of a 
trading partner in a business transaction (such as buyer and seller). Collaborations 
describe the business documents and their movement between trading partners. In the 
Oracle Application Server Integration B2B user interface tool, trading partners define 
their operational capabilities by the collaborations they support. 

Collaboration Status Reports

Monitor trading partner business message instances for the RosettaNet over RNIF 
business protocol.

communication capabilities

Define the following details for the business protocol of a host or remote trading 
partner: 

■ Delivery channel details, such as use of nonrepudiation, encryption, and transport 
security

■ Document exchange details, such as use of digital envelopes, encryption 
credentials, digital signatures, and signing credentials

■ Transport details, such as transport mode, protocol, server name, and endpoint 
address details

company boundaries

See enterprise.

concurrent conversations

Defines the maximum number of concurrent collaboration instances that can be in 
progress at any time.

configuration

A collection of partner data of trading partners that is consistent, complete, and 
deployable. Creating a configuration enforces the validation rules so that only valid, 
complete, and consistent data is available in the runtime repository.

configuration states

The state that a configuration is in at any given time (for example, active, validated, 
quiesced, retired, and discarded).
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contact information

The method by which to contact a user or organization when you want to perform a 
specific action (such as reviewing a trading partner or trading partner agreement).

contact types

The method for contacting persons and organizations (such as a phone number or 
e-mail address) when a specific activity within Oracle Application Server Integration 
B2B is required (such as reviewing a trading partner agreement).

Create Business Action wizard

Enables you to create support for business actions for any EDI or Custom Document 
business protocol. 

Create Collaboration wizard

Enables you to create support for PIP collaborations for the RosettaNet over RNIF 
business protocol. 

Create Trading Partner wizard

Enables you to create a remote trading partner, assign support for a business protocol 
to a remote trading partner, assign operational capabilities (collaborations or business 
actions) to a remote trading partner, and assign communication capabilities (delivery 
channels, document exchanges, transports, and endpoint details) to a host trading 
partner and remote trading partner. 

To simplify the user experience, the host trading partner is automatically assigned 
support for all business protocols and operational capabilities; only the 
communication capabilities for the host trading partner must be created.

Custom Document

A customer-defined protocol, such as UCCnet.

Data Universal Numbering System

A unique, sequentially-generated, nine-digit number that you can assign as the trading 
partner identification type. You obtain this number from Dun and Bradstreet.

delivery channel

Describes whether trading partner security characteristics such as nonrepudiation of 
origin and receipt, acknowledgment mode, time to acknowledge, retry count, 
transport security, encryption, and file compression are required. The delivery channel 
also includes the associated transport (with its transport protocol, mode, server, and 
endpoint address) and document exchange (with its exchange protocol parameters, 
exchange protocol override elements, and, if defined, its support for digital envelope, 
encryption credentials, digital signature, signing credentials, and validation). 

deployment

The process of activating a configuration from the design-time repository to the 
runtime repository. 

Deployment tab

A main tab of the Oracle Application Server Integration B2B user interface tool that 
enables you to manage (create, validate, deploy, quiesce, discard, or export) a 
configuration.
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design-time data

See partner data.

design-time repository

The repository in which partner data (trading partners and trading partner 
agreements) is stored before being included in a deployed configuration in the runtime 
repository. The Oracle Application Server Integration B2B design-time repository is 
part of the Oracle Application Server Metadata Repository.

digital envelope

The packaging method for a digital signature.

digital signature

Created when a public key algorithm signs the sender's message with the sender's 
private key. The digital signature ensures that the document is authentic, has not been 
forged by another trading partner, has not been altered, and cannot be repudiated by 
the sender.

discarded configuration

A configuration state during which a configuration has been discarded and cannot be 
deployed. These types of configurations were created and validated, but never 
deployed.

document definition

The fourth level in the document protocol hierarchy. In this hierarchy, a document 
protocol can consist of multiple document protocol revisions. A document protocol 
revision can consist of multiple document types. A document type can consist of 
multiple document definitions. A document definition can consist of an XSD or DTD 
file and associated information. An example of a document definition is an XSD file for 
EDI X12 4010 8050 or a DTD file for RosettaNet V02.00 RequestPurchaseOrder.

document exchange

Describes the supported exchange protocol (such as RosettaNet 02.00) and, if being 
used, credential encryption and signing credentials, digital envelopes and digital 
signatures, and validation support. The document exchange uses these capabilities to 
exchange messages with a trading partner.

document protocol

Defines the document type of the message payload. The first level in the document 
protocol hierarchy. In this hierarchy, a document protocol can consist of multiple 
document protocol revisions. A document protocol revision can consist of multiple 
document types. A document type can consist of multiple document definitions. An 
example of a document protocol is RosettaNet, EDI X12, EDI EDIFACT, or Custom 
Document (such as UCCnet).

document protocol revision

The second level in the document protocol hierarchy. In this hierarchy, a document 
protocol can consist of multiple document protocol revisions. A document protocol 
revision can consist of multiple document types. A document type can consist of 
multiple document definitions. An example of a document protocol revision is 
RosettaNet V02.00 or EDI X12 4010.
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document type

The third level in the document protocol hierarchy. In this hierarchy, a document 
protocol can consist of multiple document protocol revisions. A document protocol 
revision can consist of multiple document types. A document type can consist of 
multiple document definitions. An example of a document type is a RosettaNet 
RequestPurchaseOrder or EDI X12 4010 850.

DUNS

See Data Universal Numbering System.

e-business

The conduct of business over the Internet, such as buying and selling products, 
servicing customers, and collaborating with other companies, known as trading 
partners.

EDI

See electronic data interchange.

EDI EDIFACT

EDI for Administration, Commerce, and Transport (EDIFACT) is the international 
standard for EDI. Developed by the United Nations, these standards work for 
international conventions for electronic data interchange. 

EDI X12

A numbered set of commercial EDI transactions defined by the American National 
Standards Institute's Accredited Standards Committee X12. These uniform rules for 
the interchange of business documents are defined for cross industry EDI use and are 
based upon the variable-length X12 standard. 

electronic data interchange

A standard format for exchanging electronic business data. 

encryption credential

The certificate to use for encryption of the document to exchange.

endpoint

The physical endpoint address of a trading partner. An endpoint includes a protocol 
endpoint, which is a combination of a specific endpoint address (such as 
http://server.partner.com:5555/submit/rnmsg) and transport protocol 
(such as HTTP 1.1). The trading partner uses this address to send or receive data. 
Endpoints are global to all trading partners. 

enterprise

The boundaries of a company.

Error Status Reports

Monitor business message error instances.

exchange protocol

Defines the message exchange mechanism—how to exchange the documents defined 
by the document protocol. It defines the headers, the acknowledgments, and the 
packaging that puts the headers and payload together. It also defines the transport 
protocol and packaging protocol for the exchange.
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export

The Oracle Application Server Integration B2B user interface tool provides design-time 
repository export functionality that enables you to perform the following tasks:

■ Export the entire contents of the design-time repository to an XML file

■ Export a configuration created under the Deployment tab to and from the 
design-time repository

■ Export the partner data associated with trading partners and trading partner 
agreements to XML files that can then be submitted to individuals for optional 
review and eventual approval

generic exchange

An exchange protocol supported by Oracle Application Server Integration B2B. 

host application

The application installed within the host trading partner’s environment. An internal 
delivery channel is the communication interface between the host trading partner’s 
host application and their installation of OracleAS Integration B2B. 

host trading partner

The organization in which Oracle Application Server Integration B2B is installed. The 
host trading partner conducts business with the remote trading partner (the 
organization outside your enterprise).

ias_admin user

The default user account for accessing and using the Oracle Enterprise Manager 10g 
Application Server Control Console. This user is created automatically during 
installation.

import

The Oracle Application Server Integration B2B user interface tool provides design-time 
repository import functionality that enables you to perform the following tasks:

■ Import the entire contents of the previously exported design-time repository from 
an XML file

■ Import a previously exported configuration created under the Deployment tab

■ Import support for RosettaNet collaborations (partner interface processes (PIPs)), 
EDI X12 and EDIFACT transaction sets, and UCCnet standards into the 
design-time repository to assign to trading partners

■ Import reports

■ Import the design-time repository and instance data of the runtime repository

instance data

Partner data included in a deployed configuration. During configuration creation, 
partner data of the integration is validated end-to-end a final time to ensure that only a 
complete and consistent configuration is deployed to the runtime repository. After a 
configuration is deployed, the runtime repository stores the configuration of runtime 
data required to execute an integration. Runtime data is created during runtime when 
messages are exchanged between trading partners. These messages are logged in an 
instance table in the runtime repository.
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integrations between enterprises

See business-to-business.

internal delivery channels

An internal delivery channel is the communication interface between the host trading 
partner’s host application and their installation of OracleAS Integration B2B. Internal 
delivery channels operate only within the host trading partner’s enterprise.

internal endpoints

Predefined endpoints that are associated with a specific internal delivery channel to 
enable communication between the host trading partner’s host application and their 
installation of OracleAS Integration B2B. Internal endpoints operate only within the 
host trading partner’s enterprise. 

lifecycle management

Enables you to manage the various states in the design and deployment of partner 
data (such as draft, approved, and deployed).

lifecycle states

The states that partner data is in at any given point in time. The set of lifecycle states is 
based on state changes that must be captured from a business (that is, integration) 
standpoint.

message payload

The data contents of a message (for example, a payload of a purchase order can 
identify the quantity ordered, the total cost, the product being ordered, and so on).

metadata repository

See Oracle Application Server Metadata Repository.

middle tier

The host on which you installed the J2EE and Web Cache and Oracle Application 
Server Integration B2B installation types.

MIME

See multipurpose internet mail extensions.

multipurpose internet mail extensions

An extension of the original Internet e-mail protocol that lets users use the protocol to 
exchange different kinds of datafiles on the Internet: audio, video, images, application 
programs, and other kinds, as well as the ASCII handled in the original protocol, the 
simple mail transfer protocol (SMTP). 

nonrepudiation

A standard that provides absolute evidence that a specific action occurred. Oracle 
Application Server Integration B2B supports two types:

■ Nonrepudiation of origin requires a message sender to digitally sign a message. 
This protects against any attempt by a sender to deny sending a message. 

■ Nonrepudiation of receipt requires a message recipient to send back a digitally 
signed acknowledgment. This protects against any attempt by a message recipient 
to deny receiving a message.
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OC4J

See Oracle Application Server Containers for J2EE.

operational capabilities

Defines the support for business actions or collaborations for the business protocol of a 
host or remote trading partner.

OPMN

See Oracle Process Manager and Notification Server.

OracleAS Integration B2B - Document Editor

An integrated guideline creation and implementation application for creating 
business-to-business (B2B) electronic commerce. You can use the OracleAS Integration 
B2B - Document Editor library of templates to create EDI X12 and EDI EDIFACT .ecs 
files and RosettaNet XSD and DTD files that you then import into the OracleAS 
Integration B2B user interface tool with the Create Business Action wizard and Create 
Collaboration wizard. This enables you to create configurations with OracleAS 
Integration B2B trading partners that use EDI X12, EDI EDIFACT, and RosettaNet.

Oracle Application Server Containers for J2EE

A complete set of J2EE containers written entirely in Java that execute on the Java 
Virtual Machine (JVM) of the standard Java Development Kit (JDK). 

Oracle Application Server Metadata Repository

An Oracle database that contains schemas and business logic used by application 
server components (including Oracle Application Server Integration B2B). The Oracle 
Application Server Integration B2B schema is part of the Oracle Application Server 
Metadata Repository. The Oracle Application Server Integration B2B design-time 
repository and runtime repository are both part of the Oracle Application Server 
Metadata Repository.

Oracle Application Server Integration B2B

Enables you to successfully design, deploy, monitor, and maintain configurations 
between trading partners.

Oracle Application Server Integration B2B middle-tier instance

A single installation of Oracle Application Server Integration B2B.

Oracle E-Business Suite

Provides a complete set of applications capable of automating daily business process 
functions. These applications assist in running supply chain operations; managing 
employees; and marketing, selling, and providing customer services. 

Oracle Process Manager and Notification Server

Enables you to monitor Oracle Application Server Metadata Repository processes 
based on settings in the opmn.xml file.

Oracle Wallet Manager

A Java-based application that security administrators use to manage public-key 
security credentials on clients and servers.
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packaging

Encapsulates all components of a message into a packaging format (for example, 
Oracle Application Server Integration B2B supports the multipurpose internet mail 
extensions (MIME) format).

packaging protocol

Defines a packaging mechanism. Message security such as signing and encryption are 
often based on a specific packaging mechanism.

participant

See trading partner.

partner data

Design-time data before it is included in a deployed configuration (for example, 
trading partner and trading partner agreement data). Partner data is the data that you 
create under the Partners tab in the Oracle Application Server Integration B2B user 
interface tool. Partner data is stored in the design-time repository part of the Oracle 
Application Server Metadata Repository.

Partners tab

A main tab of the Oracle Application Server Integration B2B user interface tool that 
enables you to create a remote trading partner, assign support for a business protocol 
to a remote trading partner, create the operational capabilities (support for 
collaborations or business actions) for the business protocol of the remote trading 
partner, and create the communication (delivery channel, security, transport, transport 
server, and endpoint details) capabilities for the business protocols of the remote and 
host trading partners. 

To simplify the user experience, the host trading partner is automatically assigned 
support for all business protocols and operational capabilities; only the 
communication capabilities for the host trading partner must be created.

person

A user that can be assigned as an OracleAS Integration B2B user interface tool user or 
as an optional reviewer of trading partner and trading partner agreement details.

PIP

See RosettaNet Partner Interface Process.

process protocol

Defines how documents are exchanged. Process protocols define the support for 
collaborations (for the RosettaNet over RNIF business protocol) and business actions 
(for any EDI or Custom Document business protocols) that are associated with specific 
document types. 

protocol endpoint

Consists of a transport protocol (such as HTTP 1.1) and trading partner endpoint 
address (such as URI www.myapp124abc.com).

purging

Deletes data from the design-time repository with the exception of data that was part 
of installation. In addition, instance data in the runtime repository can also be purged.
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quiesce

The process of gracefully shutting down a deployed configuration. A configuration 
can be automatically or manually quiesced. 

quiesced configuration

A configuration state during which the configuration is in the process of being 
quiesced (retired). Once quiesced, the configuration can be retired or redeployed.

remote trading partner

The organization outside your enterprise with whom to conduct business. The host 
trading partner must define the capabilities for both the host and remote trading 
partners with the Oracle Application Server Integration B2B user interface tool.

remote trading partner certificates

A method by which to secure the given exchange of data. A certificate securely binds 
an identity such as a trading partner to a public key. A certificate is created when a 
trading partner’s public key is signed by a trusted identity known as a certificate 
authority (CA). This certificate ensures that the trading partner's data is correct and 
that the public key actually belongs to that trading partner. You select the location of a 
certificate. This is typically the location for the Oracle Wallet Resource Locator.

Reports role

Provides a host trading partner user with access to only the functionality of the 
Reports tab of the OracleAS Integration B2B user interface tool. A user with this role 
cannot see or access the other parts of the user interface tool.

Reports tab

A main tab of the Oracle Application Server Integration B2B user interface tool that 
enables you to create reports that describe Oracle Application Server Integration B2B 
runtime behavior.

repository

See design-time repository and runtime repository.

retired configuration

A configuration state during which a deployed configuration has been quiesced and 
retired. This configuration cannot be redeployed. This occurs when you deploy 
another configuration. This action causes any currently running configurations to be 
quiesced and retired. You can also manually quiesce a deployed configuration.

RNBD

See RosettaNet Business Dictionary.

RNIF

See RosettaNet Implementation Framework.

RosettaNet

A nonprofit organization of leading technology companies that has created and 
implemented a common set of nonproprietary, XML-based, e-business standards. 
These standards define how trading partners conduct business through the exchange 
of business documents over the Internet. Guidelines are provided for transport, 
routing, packaging, security, signals, and trading partner agreements.
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RosettaNet Business Dictionary

A RosettaNet dictionary that designates the properties used in basic business 
transactions between trading partners. The business dictionary defines the business 
properties and fundamental business data entities in PIP messages.

RosettaNet dictionaries

Define and describe a common set of properties for use in PIP messages. These 
properties define a common vocabulary for conducting business. This ensures that the 
information exchanged between trading partners is consistent, overlapping efforts of 
trading partners are eliminated, and confusion caused by the uniquely defined 
terminology of each trading partner is reduced. There are two dictionary types: 
business dictionary and technical dictionary. OracleAS Integration B2B supports only 
the business dictionary.

RosettaNet Implementation Framework

Defines the implementation guidelines for the reliable exchange of business data 
messages (in XML business documents) between trading partners over the Internet.

RosettaNet Partner Interface Process

XML-based dialogs that define the specific sequence of steps required to execute a 
business process (and thus, exchange data) between trading partners. PIPs are 
XML-based dialogs that define the structure, allowable data elements, values, and 
value types for each business document message exchanged. Trading partners agree 
on the set of PIPs to support to conduct business.

RosettaNet validation

Compares the elements in RosettaNet XML-format business documents to the 
requirements specified in the RosettaNet Message Guideline specification to determine 
their validity. This specification defines requirements for information such as element 
datatypes, element lengths, element value lists, and element cardinality.

runtime data

See instance data.

runtime repository 

Stores the runtime data required to deploy and execute a configuration. Runtime data 
is created during runtime when messages are processed. The Oracle Application 
Server Integration B2B runtime repository is part of the Oracle Application Server 
Metadata Repository.

Save Definition button

Saves the contents of generated reports to XML files. You can reimport the report 
contents as needed into the Oracle Application Server Integration B2B user interface 
tool.

S/MIME

See secure multipurpose internet mail extensions.

secure multipurpose internet mail extensions

A secure method of sending e-mail. MIME indicates how to organize an electronic 
message. S/MIME describes how encryption data and a digital certificate can be 
included as part of the message body. 
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signing credential

Enables you to assign the certificate to use to sign the given document exchange.

trading partner

Engages in business transactions with another trading partner. You assign a trading 
partner to a trading partner agreement.

trading partner agreement

An electronic agreement that defines the way in which a host and remote trading 
partner agree to interact when performing an agreed-on collaboration or business 
action. 

trading partner identification type

A type for which you assign a value that uniquely identifies a trading partner, such as 
a data universal numbering system (DUNS) number. You can define other types of 
trading partner identification types.

trading partner management

The design stage during which you define the basic B2B transaction. This includes 
setting up trading partners, assigning support for business protocols, creating business 
protocol operational and communication capabilities, and creating trading partner 
agreements.

transaction set

A collection of formatted data that contains the information required by a receiver to 
perform a standard business transaction. In an EDI standard, a transaction set has 
three sections (header, detail, and summary) and consists of a predefined group of 
segments in each section. An EDI transaction set maps to a document type of a 
business action in the OracleAS Integration B2B user interface tool.

transport

Defines the properties specific to a given usage of a protocol endpoint. The transport is 
responsible for message delivery using the selected transport protocol (such as HTTP 
1.1), mode (synchronous or asynchronous), server, and protocol endpoint address 
(trading partner address, such as a URI).

transport endpoint

See endpoint.

transport mode

A means by which data is sent or received, such as asynchronous or synchronous 
mode.

transport protocol

A protocol that describes how to transport data (such as HTTP).

transport server

The endpoint server name for the trading partner.

UCCnet

An industry standard utility for item registration and data synchronization between 
suppliers and retailers. UCCnet was created to synchronize item data between 
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suppliers and retailers. It is not-for-profit and a subsidiary of the Uniform Code 
Council. 

use case groups

The privileges of the Administrator role assigned to a user of the Oracle 
Application Server Integration B2B user interface tool.

user interface tool

The Oracle Application Server Integration B2B tool that enables you to design, deploy, 
monitor, and manage configurations.

user role

The group of related use case groups (privileges) that permit a user to perform tasks 
with the Oracle Application Server Integration B2B user interface tool.

validated

The state in which your design-time data is determined to be correct and complete. 

validated configuration

A configuration state during which the partner data has been successfully validated to 
ensure that it is correct and complete and a configuration has been created. The 
configuration is ready for deployment. Only valid configurations can exist; invalid 
configurations cannot be created.

value-added networks

A private network provider (sometimes called a turnkey communications line) hired 
by a company to facilitate electronic data interchange (EDI) or provide other network 
services.

VAN

See value-added networks.

wallet password

Opens a user's wallet. A wallet is a container in which certificates and trusted 
certificates are stored and managed. These data structures securely store a user private 
key, a user certificate, and a set of trusted certificates. 

Wire Message Status Reports

Monitor trading partner wire message instances.

wire messages

The native format of data sent from trading partners. Oracle Application Server 
Integration B2B does not know this data format. The direction of wire messages 
coming from trading partners is called inbound. The direction of wire messages sent to 
trading partners is called outbound. Wire messages can contain a number of sections, 
such as payloads, attachments, or trailers. 

XML Gateway

An Oracle E-Business Suite API that produces and consumes (deletes) XML messages.
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XSD

The XML Schema Definition (XSD) specifies how to formally describe the elements in 
an Extensible Markup Language (XML) document. Oracle Application Server 
Integration B2B provides predefined support for XSD.
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A
acknowledgment handled by Integration B2B

selecting with the Create Trading Partner 
wizard, 7-14

updating, 8-43, 8-46
acknowledgment mode

selecting with the Create Trading Partner 
wizard, 7-16

updating, 8-49
value must be None if using a generic exchange 

protocol, 7-6, 10-17
acknowledgment time

selecting with the Create Trading Partner 
wizard, 7-17

updating, 8-49
active

configuration state, 11-4
add button

differences with create button, 4-9
additional transport headers parameter

description, 8-59
admin user

cannot remove Administrator role, 8-24
default username for accessing the user interface 

tool, 4-2
protects partner data, 15-3
roles and privileges, 15-2

admin user password, 15-2
administration

tasks, 12-2
with the user interface tool, 12-2

administration tab
description, 4-4
overview of tasks, 4-20

Administrator role
for using the user interface tool, 4-2
required for connecting to the user interface 

tool, 8-21
advanced queuing (AQ)

using as the internal delivery channel transport 
protocol, 8-34

Agreement Details page
exporting to an XML file, 4-12
overview, 4-12

agreement ID

creating for a trading partner agreement, 10-8
updating, 10-9

agreements tab
description, 4-17
overview of tasks, 4-17

Applicability Statement 2 (AS2) exchange 
protocol, 2-9

using compression, 7-6, 7-17, 8-49
approved lifecycle state

description, 4-12
approvers

optionally exporting and submitting XML files of 
partner data for approval, 4-13

apps.ECX_INBOUND internal endpoint
associated with XML Gateway Inbound internal 

delivery channel, 8-31
description, 8-61
selecting, 8-61

apps.ECX_OUTBOUND internal endpoint
associated with XML Gateway Outbound internal 

delivery channel, 8-31
description, 8-61
selecting, 8-61

AS2
See Applicability Statement 2, 2-9

AS2 Identifier
assigning as trading partner identification, 8-9
description, 7-10, 7-24, 8-9
trading partner identification type, 7-10, 7-24

B
B2B Inbound internal delivery channel

associated with b2b.IP_IN_QUEUE internal 
endpoint, 8-31

description, 3-2, 8-31
sufficient for most environments, 10-7

B2B integration, 1-2
B2B Outbound internal delivery channel

associated with b2b.IP_OUT_QUEUE internal 
endpoint, 8-31

description, 3-2, 8-31
B2B protocols, 1-2, 1-3, 2-2
B2B server

description, 13-3
ensure server is running if you receive an RMI 
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server connection error, A-5
starting and stopping with OPMN, 13-9
starting and stopping with Oracle Enterprise 

Manager 10g, 13-6
B2B Server Level parameter

for defining the logging level, A-3
b2b.IP_IN_QUEUE internal endpoint

associated with B2B Inbound internal delivery 
channel, 8-31

description, 8-61
selecting, 8-61

b2b.IP_OUT_QUEUE internal endpoint
associated with B2B Outbound internal delivery 

channel, 8-31
description, 8-61
selecting, 8-61

b2b.jar file
do not modify, 9-6

b2b.log file
location of, A-2
troubleshooting errors, A-2

browsers
accessing the user interface tool, 4-2
restrictions on using the browser back and forward 

buttons, 4-9
business actions

assigning during a separate Create Trading Partner 
wizard session, 7-26

assigning during a single Create Trading Partner 
wizard session, 7-9

assigning remote trading partner support with the 
Create Trading Partner wizard, 6-3, 7-13

automatically assigned to host trading 
partner, 8-44, 10-2, 10-6

bidirectional, 6-3
creating with the Create Business Action 

wizard, 6-3, 6-17
defining the initiator or responder in a 

collaboration between trading partners, 7-14
deleting, 6-23, 8-46
Document Protocol Revision page of Create 

Business Action wizard, 6-17, 6-19
Document Type page of Create Business Action 

wizard, 6-18, 6-20
General page of Create Business Action 

wizard, 6-17, 6-18
importing, 12-9
managing, 8-44
overview, 6-3
Review page of Create Business Action 

wizard, 6-18, 6-21
selecting for a trading partner agreement, 10-6
updating, 6-22, 8-45
viewing, 6-22, 8-45

business message status reports
creating, 14-2
description, 4-20

business messages
purging business message instance data, 12-11

Business Protocol Details page

contents of, 7-25
overview, 8-4

business protocols, 1-4, 1-5, 2-11
assigning a business protocol and all operational 

and communication capabilities during a 
single wizard session, 7-9

assigning a business protocol during a separate 
Create Trading Partner wizard session, 7-24

assigning business protocol communication 
capabilities during a separate Create Trading 
Partner wizard session, 7-26

assigning business protocol operational 
capabilities during a separate Create Trading 
Partner wizard session, 7-25

assigning multiple business protocols to a remote 
trading partner, 7-8

automatically assigned to host trading 
partner, 6-3, 7-3, 7-7, 7-23, 7-28, 8-3

can assign multiple business protocols to a remote 
trading partner, 8-28

common user errors, 6-33
Custom Document over Generic Exchange, 7-11
Custom Document over Internet, 7-11
description, 6-2, 8-27
EDI EDIFACT over Generic Exchange, 7-11
EDI EDIFACT over Internet, 7-11
EDI X12 over Generic Exchange, 7-11
EDI X12 over Internet, 7-11
format of, 6-2
managing, 6-2, 8-26
removing from a remote trading partner, 8-30
RosettaNet over RNIF, 7-11
support provided for, 7-11
viewing, 6-4, 8-28

Business Protocols page
overview, 4-17

C
Callout Directory parameter

for defining callout .jar file library, 9-6
callout metadata parameters

creating, 9-13
deleting, 9-15
description, 9-13
encrypting, 9-14
limitations on use of date type, 9-14
updating, 9-15
viewing, 9-15

callout properties
creating, 9-8
deleting, 9-10
description, 9-7
encrypting, 9-9
managing, 9-7
overriding values set at callout usage level, 9-9
updating, 9-9
viewing, 9-9

callout usages
associating with internal delivery channels, 9-2
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creating, 9-11
deleting, 9-13
description, 9-2, 9-10, 9-11
managing, 9-10
selecting when creating a trading partner 

agreement, 3-7, 9-2, 9-11, 10-7
tutorial for creating, 9-16
updating, 9-13
viewing, 9-12

callouts
common user errors, 9-22
creating, 9-5
creating callouts with the same name, 9-5
defining the callout .jar file library location, 9-6
deleting, 9-7
description, 3-6, 9-2, 9-5
do not modify the b2b.jar file, 9-6
for transformations, 9-2
list page overview, 4-18
managing, 9-5
predefined XSLTCallout callout provided, 9-5
predefined XSLTCalloutImpl class file 

provided, 9-5
tasks overview, 9-4
tutorial for adding callout usages to the RosettaNet 

over the Internet transaction, 9-16
updating, 9-6
viewing, 9-6

Callouts Java API Reference
using to create a callout .jar file, 9-4

Callouts page
overview, 4-18

callouts tab
description, 4-18
overview of tasks, 4-18

Capabilities page
communication capabilities section 

overview, 4-16
operational capabilities section overview, 4-16
overview, 4-16, 8-3

certificates
See remote trading partner certificates

CLASSPATH environment
setting up for the tutorials, 5-4

collaboration roles
description, 7-12

collaboration status reports
creating, 14-6
description, 4-20

collaborations
assigning collaborations during a separate Create 

Trading Partner wizard session, 7-26
assigning during a single Create Trading Partner 

wizard session, 7-9
assigning remote trading partner support with the 

Create Trading Partner wizard, 6-3, 7-12
automatically assigned to host trading 

partner, 7-13, 8-41, 10-2, 10-6
bidirectional, 6-3
Business Transaction page of Create Collaboration 

wizard, 6-24, 6-27
creating with the Create Collaboration 

wizard, 6-3, 6-23
defining the initiator or responder in a 

collaboration between trading partners, 7-13
deleting, 6-33, 8-43
description, 7-12
General page of Create Collaboration 

wizard, 6-24, 6-26
importing, 4-22, 6-3, 12-9
managing, 8-40
overview, 6-3
purging collaboration instance data, 12-11
Requesting Business Action page of Create 

Collaboration wizard, 6-25, 6-28
Responding Business Action page of Create 

Collaboration wizard, 6-25, 6-30
Review page of Create Collaboration 

wizard, 6-25, 6-31
revision number must match the document type 

revision number, 6-12, 6-32
revision number must match the document type 

revision number in Create Collaboration 
wizard, 6-27, 6-29, 6-30

selecting for a trading partner agreement, 10-6
updating, 6-32, 8-42
viewing, 6-31, 8-42

common user errors
business protocols, 6-33
callouts, 9-22
configurations, 11-6
deployment, 11-10
exported files, 12-14
trading partner and trading partner 

agreements, 10-17
trading partners, 7-27, 8-64

communication capabilities
creating for the host and remote trading partners 

with the Create Trading Partner wizard, 7-15
description, 4-3, 4-12, 4-16, 7-3, 7-4, 7-7, 7-9, 7-10, 

7-23, 8-5, 8-28, 8-48, 8-51, 8-54, 8-57, 8-60, 10-2
overview, 1-6, 4-16
viewing in the user interface tool, 4-16, 7-25, 8-4, 

8-28
compression

for use with the Applicability Statement 2 (AS2) 
exchange protocol, 7-6, 7-17, 8-49

limitations on use, 7-6
selecting with the Create Trading Partner 

wizard, 7-17
updating, 8-49

concurrent conversations
assigning a value to a trading partner 

agreement, 10-8
updating a value in a trading partner 

agreement, 10-10
configurations, 1-4, 1-8

archive important configurations before 
purging, 12-14

cannot deploy the same trading partner agreement 
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in multiple configurations, 11-3, 11-6, 11-7
cannot name a configuration with a previously 

used name, 11-5
cannot update or delete some information that is 

part of a validated configuration, 11-6, 11-11
configuration name can be no more than 30 

characters in length, 11-5
creating for deployment, 11-2, 11-4
creation overview, 11-2
currently-deployed configuration is automatically 

quiesced when you deploy a second 
configuration with the same trading partner 
agreement, 11-9

deploying, 11-6
deployment overview, 11-6
description, 11-2
discarded configurations description, 11-9
discarding, 11-9
do not leave a configuration in the validated 

state, 4-3
exporting, 11-10
impact of changes to partner data in a 

currently-deployed configuration, 11-7
includes a trading partner agreement, 11-4
limitations on importing an exported 

configuration, 11-10, 12-8
only validated agreements can appear in a 

configuration, 11-4
overview, 11-2
purging data in a deployed configuration in the 

runtime repository, 12-10
quiescing, 11-9
states, 11-4
status of an imported configuration, 12-9
successful creation and validation, 11-6
trading partner agreement states, 11-8
trading partners, 11-6
unsuccessfully created configurations, 11-6
validations, 11-2
viewing, 11-8

contact information
creating for persons and organizations, 8-18
deleting for persons and organizations, 8-20
does not automatically contact a user or 

organization when a specific condition 
occurs, 8-18

managing for persons and organizations, 8-17
updating for persons and organizations, 8-19
viewing for persons and organizations, 8-18

contact types
administering, 12-3
description, 4-21, 12-3
not automatically sent to a user or organization 

when a specific condition occurs, 8-18
predefined contact types that you cannot delete or 

update, 12-3
viewing, 12-3

Create Business Action wizard
accessing, 6-18
creating business actions overview, 6-17

creating business actions support, 6-3, 6-17
disabling EDI document validation for 

globalization support, 6-10, 6-14, 6-20, 6-21
Document Protocol Revision page, 6-17, 6-19
Document Type page, 6-18, 6-20
General page, 6-17, 6-18
importing document definition files, 6-21
importing .ecs files, 6-20, 6-21
importing .xsd files, 6-21
Review page, 6-18, 6-21

create button
differences with add button, 4-9

Create Collaboration wizard
accessing, 6-26
Business Transaction page, 6-24, 6-27
collaboration and document type revision numbers 

must match, 6-27, 6-29, 6-30
creating collaborations overview, 6-24
creating collaborations support, 6-3, 6-23
ensure care in entering collaboration details, 6-26
General page, 6-24, 6-26
importing document definition files, 6-29, 6-31
importing .dtd files, 6-29, 6-31
importing .xsd files, 6-29, 6-31
Requesting Business Action page, 6-25, 6-28
Responding Business Action page, 6-25, 6-30
Review page, 6-25, 6-31

Create Trading Partner wizard
accessing, 7-7
acknowledgment handled by Integration 

B2B, 7-14
assigning a business protocol during a separate 

wizard session, 7-24
assigning a functional acknowledgment 

requirement, 7-6, 7-14
assigning an initiator, 7-13, 7-14
assigning business actions during a separate 

wizard session, 7-26
assigning business actions during a single wizard 

session, 7-9
assigning business protocol communication 

capabilities during a separate wizard 
session, 7-26

assigning business protocol operational and 
communication capabilities during a single 
wizard session, 7-9

assigning business protocol operational 
capabilities during a separate wizard 
session, 7-25

assigning collaborations during a separate wizard 
session, 7-26

assigning collaborations during a single wizard 
session, 7-9

assigning support for a business action, 7-13
assigning support for a collaboration, 7-12
creating a remote trading partner during a 

separate wizard session, 7-24
creating and defining all capabilities during 

separate wizard sessions, 7-23
creation overview, 7-2
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Delivery Channel page, 7-5, 7-15
do not select internal endpoints, 7-22
Document Exchange page, 7-5, 7-17
flexibility in using, 7-7
General page, 7-4, 7-9
Identification page, 7-4, 7-10, 7-24
importing .ecs files, 7-15
Operational Capability page, 7-5, 7-11
overview, 7-4
prerequisites, 7-7
Review page, 7-6, 7-23
Transport page, 7-6, 7-21

Custom Document over Generic Exchange
business protocol, 7-11

Custom Document over Internet
business protocol, 7-11

custom document protocols
cannot use functional acknowledgments in Create 

Trading Partner wizard, 7-6
importing UCCnet, 6-3
UCCnet, 6-15

Custom Documents, 2-6

D
data universal numbering system (DUNS)

assigning as trading partner identification, 8-9
description, 7-10, 7-24, 8-9
trading partner identification type, 7-10, 7-24

delete button
differences with remove button, 4-9

delivery channels
adding for trading partner participants, 10-15
creating for host and remote trading partners with 

the Create Trading Partner wizard, 7-15, 8-48
deleting, 8-50
description, 7-5, 8-47
impact on internal delivery channels of removing 

and adding a delivery channel, 10-16
managing, 8-47
managing for trading partner participants, 10-14
removing for trading partner participants, 10-16
selecting for a trading partner agreement, 10-7
updating, 8-49
updating for trading partner participants, 10-16
viewing, 8-48
viewing for trading partner participants, 10-15

deployed lifecycle state
description, 4-12
for partner data, 4-14

deployment, 1-4, 1-8
cannot deploy the same trading partner agreement 

in multiple configurations, 11-3, 11-6, 11-7
common user errors, 11-10
configuration overview, 11-2
creating a configuration, 11-4
do not leave a configuration in the validated 

state, 4-3, 4-19, 11-2, 11-5
of a configuration, 11-6
of trading partners in a configuration, 11-6

overview, 11-2, 11-6
trading partner agreement states, 11-8

Deployment page
overview, 4-19

deployment tab
description, 4-3, 4-19
overview of tasks, 4-19

Design page
overview, 4-21

design tab
overview of tasks, 4-21

designs
list page overview, 4-21

design-time data
creating incomplete partner data, 4-8
description, 12-5
flexibility of design, 4-8

design-time repository, 1-4
do not use export or import for backup and 

recovery purposes, 12-7
exporting, 12-5, 12-7
importing, 12-5, 12-8
purging, 4-22
restrictions on importing, 12-8

design-time workflow, 1-4
details pages

overview, 4-6
differences

between creating and adding commands, 4-9
between deleting and removing commands, 4-9

digital envelopes, 15-3
overview of configuration tasks, 15-5
selecting with the Create Trading Partner 

wizard, 7-16, 7-19
updating, 8-49

digital signatures, 15-3
enabled by nonrepudiation of origin and 

receipt, 7-16
overview of configuration tasks, 15-6
recommendations for using SHA-RSA, 7-20
selecting with the Create Trading Partner 

wizard, 7-16, 7-20
updating, 8-49

discarded
configuration state, 11-5

discarded configurations
description, 11-5, 11-9

document definition files
importing with the Create Business Action 

wizard, 6-21
importing with the Create Collaboration 

wizard, 6-29, 6-31
specifying .dtd or .xsd files, 6-2

document definitions
100-character limit on string values, 7-15
updating, 6-13
using default document definitions with the Create 

Trading Partner wizard, 7-15
viewing, 6-13

document exchanges
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associated with a delivery channel assigned to a 
trading partner agreement, 8-50, 10-14

creating for host and remote trading partners with 
the Create Trading Partner wizard, 7-17, 8-51

deleting, 8-53
description, 7-5, 8-50
managing, 8-50
updating, 8-52
viewing, 8-52

document protocol parameters
assigning with the Create Trading Partner 

wizard, 7-14
overriding default document definitions with the 

Create Trading Partner wizard, 7-15
overriding parameter values, 6-8
overriding parameter values with the Create 

Trading Partner wizard, 6-20, 7-15
using existing parameter values with the Create 

Trading Partner wizard, 7-15
document protocol revisions

creating without using the wizards, 6-8
deleting, 6-10
updating, 6-9
viewing, 6-8

document protocols, 1-4, 2-2
description, 6-5, 8-26
managing, 6-5
RosettaNet support provided only for version 

2.0, 6-7
viewing, 8-29

document standards
importing, 12-9

document type parameters
100-character limit on string values, 6-21
overriding parameter values, 6-11
overriding parameter values with the Create 

Trading Partner wizard, 6-21
document type revisions

collaborations revision number must match the 
document type revision number, 6-12, 6-32

collaborations revision number must match the 
document type revision number in Create 
Collaboration wizard, 6-27, 6-29, 6-30

document types
creating with the Create Business Action 

wizard, 6-18, 6-20
creating without using the wizards, 6-10
deleting, 6-12
relationship to a transaction set, 6-20
updating, 6-12
viewing, 6-11

draft lifecycle state
description, 4-12
exporting partner data to XML files, 4-13
for partner data, 4-13

.dtd files
downloading from the RosettaNet Web site, 6-2
importing with the Create Collaboration 

wizard, 6-29, 6-31

E
.ecs files

importing when creating a document protocol 
revision outside of the wizards, 6-8, 6-9

importing with the Create Business Action 
wizard, 6-20, 6-21

importing with the Create Trading Partner 
wizard, 7-15

EDI EDIFACT, 2-6
creating business actions, 6-3
importing transaction sets, 6-3, 12-9
transaction sets supported in OracleAS Integration 

B2B, 2-6
EDI EDIFACT over Generic (VAN) tutorial, 5-19
EDI EDIFACT over Generic Exchange

business protocol, 7-11
EDI EDIFACT over Internet

business protocol, 7-11
EDI Location Code

assigning as trading partner identification, 8-9
description, 7-10, 7-24, 8-9
trading partner identification type, 7-10, 7-24

EDI X12, 2-5
creating business actions, 6-3
importing transaction sets, 6-3, 12-9
transaction sets supported in OracleAS Integration 

B2B, 2-5
EDI X12 over Generic Exchange

business protocol, 7-11
EDI X12 over Internet

business protocol, 7-11
EDI X12 over Internet (AS2) tutorial, 5-40
Email transport protocol

limitations if the document being exchanged has 
large records, 7-21

must use angle brackets in To and From 
headers, 7-21

emctl command
stopping Oracle Enterprise Manager 10g, 13-12

encryption
cannot update in an existing delivery 

channel, 8-49
of host trading partner passwords in high 

availability environments, 15-10
of wallet passwords for host trading 

partners, 15-9
overview of configuration tasks, 15-5
selecting with the Create Trading Partner 

wizard, 7-16
viewing for an exchange protocol, 8-29

encryption credentials
selecting with the Create Trading Partner 

wizard, 7-19
updating, 8-49

endpoints
associated with a delivery channel assigned to a 

trading partner agreement, 8-60
creating for host and remote trading partners with 

the Create Trading Partner wizard, 7-22, 8-60
deleting, 8-62
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description, 8-59
global to all trading partners, 8-59
managing, 8-59
restrictions on editing for internal delivery 

channels, 8-32
updating, 8-56, 8-62
viewing, 8-61

error message status reports
creating, 14-7
description, 4-20

errors
connection errors, A-5
out-of-memory errors, A-3
RMI server contact errors, A-5

exchange protocol parameters
defining with the Create Trading Partner 

wizard, 7-18
meaning of Signed and Compressed parameter if 

using AS2, 7-18, 8-53
overriding values with the Create Trading Partner 

wizard, 7-18
updating, 8-53

exchange protocol revisions
selecting with the Create Trading Partner 

wizard, 7-17
updating, 8-53
using AS, 7-17, 8-53
using Generic Exchange, 7-17, 8-53
using RNIF, 7-17, 8-53

exchange protocols, 1-4, 2-7
description, 6-14, 7-11, 8-26
generic, 2-9
viewing, 6-14, 8-29

export
common user errors, 12-14
details about exporting a configuration created 

under the deployment tab, 4-22
details about exporting the design-time repository 

to a file, 4-22, 12-6
do not manually edit exported files, 4-12, 11-10, 

11-11, 12-6, 12-14
do not use export to back up the design-time 

repository, 12-7
location on user interface tool, 4-8
of a configuration, 11-10
of partner data to an XML file, 4-10
on Agreement Details page, 4-12
on Trading Partner Details page, 4-12
optionally exporting and submitting XML files of 

partner data for approval, 4-13
overview, 12-5
partner data details pages with an export 

button, 4-11
the design-time repository to a file, 12-5
to export.xml file, 12-7
types of export supported, 12-5, 12-6

export.xml file
exporting the design-time repository to, 12-7
importing the design-time repository from, 12-8

F
File transport protocol

security limitations, 7-7
transport protocol parameters you must set, A-6

FTP servers
Windows operating system requirements, A-7

FTP transport protocol
FTP server requirements on Windows operating 

systems, A-7
security limitations, 7-7
transport protocol parameters you must set, A-6

functional acknowledgment requirement
assigning with the Create Trading Partner 

wizard, 7-6, 7-14
do not enable if using EDI X12 or EDI EDIFACT 

over Generic Exchange with HTTP or 
HTTPS, A-7

does not apply to Custom document 
protocols, 7-6

updating, 8-46

G
generic exchange protocol, 2-9

acknowledgment mode value must be None, 7-6, 
7-16, 10-17

do not enable functional acknowledgements if 
using EDI X12 or EDI EDIFACT over Generic 
Exchange with HTTP or HTTPS, A-7

FTP server requirements on Windows operating 
systems, A-7

must disable Oracle Application Server Web Cache 
if using HTTP or secure HTTP, A-8

must use IP address instead of hostname in user 
interface tool, 7-4, 7-10, 7-22, 7-24, 8-9, 8-35

security limitations on using the File and FTP 
transport protocols, 7-7

selecting transport protocols, 7-21
transport protocol parameter settings for the FTP 

or File transport protocol, A-6
Generic Identifier

assigning as trading partner identification, 8-9
description, 7-4, 7-10, 7-24, 8-9
trading partner identification type, 7-4, 7-10, 7-24

Generic Log Level parameter
for defining the logging level, A-3

global usage code
selecting with the Create Trading Partner 

wizard, 7-16
updating, 8-49
used mainly with RNIF, 8-49

globalization support
disabling EDI document validation in the Create 

Business Action wizard, 6-10, 6-14, 6-20, 6-21
See Oracle Application Server Integration B2B 

Installation Guide for additional details, 6-20
graphical user interface tool

See user interface tool
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H
heap size

increasing, A-3
high availability

changing the RMI hostname value, 15-12
host applications

description, 8-30
use of internal delivery channels, 3-1, 8-30

host trading partner
automatically assigned a business action 

compatible with that of remote trading 
partner, 8-44, 10-2, 10-6

automatically assigned a collaboration compatible 
with that of remote trading partner, 7-13, 
8-41, 10-2, 10-6

automatically created, 7-9
automatically includes support for all business 

protocols and operational capabilities, 4-3, 
4-16, 6-3, 7-3, 7-7, 7-23, 7-28, 8-3

cannot delete, 4-15, 8-7
default name of MyCompany after 

installation, 4-15
description, 4-15, 7-2
in trading partner agreements, 10-2
person capabilities, 8-21
updating the MyCompany default host trading 

partner name after installation, 8-7
user of the user interface tool to define the 

capabilities of all trading partners, 4-15
host trading partner wallet passwords

See wallet passwords
HTTP/S. See secure HTTP

I
ias_admin user, 15-2

Oracle Enterprise Manager 10g user account, 13-4
import

cautions about importing an integration, 12-9
collaborations, transaction sets, and UCCnet 

standards, 4-22, 12-9
design-time repository and instance data of 

runtime repository, 4-22
details about importing a configuration created 

under the deployment tab, 4-22
details about importing the design-time repository 

from a file, 4-22, 12-6
do not use import to recover the design-time 

repository, 12-7
.dtd files from the RosettaNet Web site, 6-2
from export.xml file, 12-8
overview, 12-5
overview of collaborations and transaction 

sets, 6-3
precautions to importing the design-time 

repository, 12-8
reports, 14-9
status of an imported configuration, 12-9
status of imported trading partner 

agreements, 12-7

the design-time repository from a file, 12-5
UCCnet standards, 4-22

initiator
assigning with the Create Trading Partner 

wizard, 7-13, 7-14
creating bidirectional exchanges, 6-3
defining the initiator in a business action between 

trading partners, 7-14
defining the initiator in a collaboration between 

trading partners, 7-13
updating, 8-46

instance data
description, 12-10
importing, 4-22

internal delivery channels
advanced queuing (AQ) transport protocol, 8-34
associating with callout usages, 9-2
automatically associated with internal 

endpoints, 8-31
B2B Inbound, 8-31
B2B Outbound, 8-31
communicating with host applications, 3-2
creating, 8-33
deleting, 8-40
description, 8-30
direction is always from the perspective of the host 

trading partner, 8-33
example of an internal delivery channel with the 

JMS transport protocol, 8-37
General page for creating, 8-34
impact on internal delivery channels from adding 

and removing a delivery channel, 10-16
Java Message Service (JMS) transport 

protocol, 8-34
managing, 8-30
predefined, 8-31, 8-61
predefined internal delivery channels cannot be 

updated or deleted, 8-33
reasons for creating your own, 8-31
restrictions on editing transport parameter 

details, 8-32
Review page for creating, 8-37
selecting for a trading partner agreement, 10-7
Transport page for creating, 8-34
troubleshooting JMS transport protocol 

errors, 8-39
user-defined, 3-2, 3-6
using advanced queuing (AQ) as the transport 

protocol, 8-34
using Java Message Service (JMS) as the transport 

protocol, 8-34
using the IP_MESSAGE_TYPE message 

structure, 8-31
XML Gateway Inbound, 8-31
XML Gateway Outbound, 8-31

internal endpoints
apps.ECX_INBOUND internal endpoint, 8-61
apps.ECX_OUTBOUND internal endpoint, 8-61
automatically associated with internal delivery 

channels, 8-31
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b2b.IP_IN_QUEUE internal endpoint, 8-61
b2b.IP_OUT_QUEUE internal endpoint, 8-61
do not select with the Create Trading Partner 

wizard, 7-22
used only with internal delivery channels of host 

applications, 7-22
invocation limits

assigning to a trading partner agreement, 10-8
updating in a trading partner agreement, 10-10

IP queue, 1-3
IP_MESSAGE_TYPE message structure, 3-3

used with internal delivery channels, 8-31
ipsetupinfo.txt file

lists ports for accessing Oracle Enterprise Manager 
10g Application Server Control Console, 13-4

lists ports for accessing the user interface tool, 4-2
location of, 4-2, 13-4

J
Java Message Service (JMS)

using as the internal delivery channel transport 
protocol, 8-34

L
lifecycle states

approved state description, 4-12
deployed state description, 4-12
deployed state for partner data, 4-14
draft state description, 4-12
draft state for partner data, 4-13
of a trading partner agreement, 10-9
of trading partners, 8-6
validated state for partner data, 4-13
viewing partner data states on the details 

page, 4-12
list pages

callouts, 4-18
design, 4-21
management, 4-21
overview, 4-4
protocols, 4-17
trading partner agreements, 4-17
trading partners, 4-14

log files
defining the log file format in the tip.properties 

file, A-2
file name formats, A-2
for out-of-memory errors, A-3
location of, A-2
setting log levels, A-3
troubleshooting errors, A-2
viewing in Oracle Enterprise Manager 10g, 13-7, 

A-3
logging in

to the tutorial, 5-4
to the user interface tool, 4-2

log.xml file
location of, A-2

troubleshooting errors, A-2

M
main details pages

overview, 4-6
main list pages

overview, 4-4
management

list page overview, 4-21
Management page

overview, 4-21
management tab

overview of tasks, 4-21
MD5-RSA digital signatures

selecting with the Create Trading Partner 
wizard, 7-20

supported versions, 7-20
memory errors, A-3
message routing

support, 6-15
middle-tier instances

description, 13-3
one OracleAS Integration B2B instance for each 

Oracle home, 13-3
Oracle Application Server Metadata Repository 

requirements, 13-3
requirements for using multiple instances on a 

single host, 13-4
MyCompany

default host trading partner name after 
installation, 4-15

N
naming conventions

do not include beginning or trailing blank spaces 
in the names of data, 4-9

use unique and meaningful names for partner 
data, 4-9

next list
description, 4-6

nonrepudiation of origin and receipt
cannot update, 8-49
cannot update in an existing delivery 

channel, 8-49
enabling digital signatures and signing 

credentials, 7-16
host and remote trading partners must have same 

values you select for each of these, 15-7
overview of configuration tasks, 15-6
selecting with the Create Trading Partner 

wizard, 7-16
values you select for each must match, 7-16, 15-7

O
OC4J instance

description, 13-3
starting and stopping with OPMN, 13-9
starting and stopping with Oracle Enterprise 



Index-10

Manager 10g, 13-6
operational capabilities

automatically assigned to host trading 
partner, 6-3, 7-3, 7-7, 7-23, 7-28, 8-3

creating for the remote trading partner with the 
Create Trading Partner wizard, 7-11, 7-25

description, 4-3, 4-12, 4-16, 7-3, 7-4, 7-7, 7-10, 7-23, 
8-5, 8-28

overview, 1-6, 4-16
viewing in the user interface tool, 4-16, 7-25, 8-4, 

8-28
OPMN

See Oracle Process Manager and Notification 
Server (OPMN)

opmnctl command
stopping OPMN, 13-12
using to start and stop instances, 13-9

opmn.xml file
changing port numbers, 13-12

ora_wallet.txt file
naming, 8-15

Oracle Application Server Containers for J2EE (OC4J) 
instance

See OC4J instance
Oracle Application Server Integration B2B

See OracleAS Integration B2B
Oracle Application Server Metadata Repository

description, 13-3
Oracle Application Server Web Cache

must disable if using the generic exchange protocol 
with HTTP or secure HTTP, A-8

Oracle E-Business Suite, 1-2
in integrations with OracleAS Integration 

B2B, 3-4
internal delivery channels, 3-2

Oracle Enterprise Manager 10g
cannot manage OracleAS Integration B2B from the 

Oracle Enterprise Manager 10g Grid Control 
Console, 13-2

changing port numbers, 13-11
changing server property settings, 13-8
overview of monitoring and administration, 13-2
tasks, 13-3
updating server property values on Windows 

operating systems, 13-9
viewing log files, 13-7
viewing performance, 13-7
viewing ports, 13-9

Oracle Enterprise Manager 10g Application Server 
Control Console, A-3

Oracle Enterprise Manager 10g Grid Control Console
cannot manage OracleAS Integration B2B, 13-2

Oracle HTTP Server
installing an additional server outside the 

corporate network, 15-11
security, 15-11

Oracle Process Management and Notification 
(OPMN)

starting and stopping OracleAS Integration 
B2B, 13-9

starting and stopping the B2B server and OC4J 
instance, 13-9

Oracle Wallet
automatically created during installation, 8-15
exporting, 8-15

Oracle Wallet Manager
allows only base64 files to be imported, 15-8
tasks to perform in, 8-15

OracleAS Integration B2B
accessing the user interface tool, 4-2
does not provide internal support for remote 

trading partner-to-remote trading partner 
message routing, 6-15

one instance for each Oracle home, 13-3
starting and stopping with OPMN, 13-9
starting and stopping with Oracle Enterprise 

Manager 10g, 13-6
OracleAS Integration B2B - Document Editor

creating .xsd files, 6-2
description, 6-4
installing, 6-4

OracleAS Integration InterConnect, 1-2
in integrations with OracleAS Integration 

B2B, 3-3
internal delivery channels, 3-2

P
packaging protocols, 1-4
page layout

of user interface tool, 4-4
participants

See trading partner agreement participants
partner data

agreements tab overview, 4-17
callouts tab overview, 4-18
creating incomplete data, 4-8
deployed state, 4-14
description, 4-19
details pages with export button, 4-11
draft state, 4-13
exporting to an XML file, 4-10
naming conventions, 4-9
overview of tasks, 4-3
partners tab overview, 4-14
protocols tab overview, 4-17
validated state, 4-13

partner interface processes (PIPs), 1-7, 2-9
partners tab

description, 4-3
overview of tasks, 4-14

passwords
admin user, 15-2
any updates to transport server must include 

updating the password, 8-58
for accessing the user interface tool, 4-2
ias_admin user, 13-4
person passwords are not exported, 12-6
updating the admin password, 8-22
updating the ias_admin password, 13-5
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wallet passwords
wallet passwords not exported or imported, 12-6

performance
impacted if validation is set outside of OracleAS 

Integration B2B, 6-8, 6-9, 6-20, 6-29
viewing in Oracle Enterprise Manager 10g, 13-7

person contact details
creating, 8-18

persons
creating, 8-22
creating contact details, 8-18
deleting, 8-23
managing, 8-20
overview of host and remote trading partner 

person capabilities, 8-21
passwords are not exported, 12-6
updating the name or description, 8-23
updating the password, 8-22
viewing, 8-22

PIPs
See partner interface processes, 1-7

portlist.ini file
list of ports in use, 13-4

ports
changing OracleAS Integration B2B ports, 13-11
for accessing the user interface tool, 4-2
listed in ipsetupinfo.txt file, 4-2, 13-4
port changing error message, 13-11
portlist.ini file, 13-4
strongly recommended not to change OracleAS 

Integration B2B ports, 13-11
viewing through Oracle Enterprise Manager 

10g, 13-9
previous list

description, 4-6
process protocols, 1-4, 2-9

description, 6-15, 8-26
managing, 6-15
viewing, 8-30

protocol endpoints
deleting, 8-64
description, 8-59
updating, 8-63
viewing, 8-62

protocol transport endpoints
updating, 8-63

protocols, 1-2, 1-3, 2-2
business, 1-4, 1-5, 2-11
document, 1-4, 2-2
exchange, 1-4, 2-7
list page overview, 4-17
mix and match, 2-11
packaging, 1-4
process, 1-4, 2-9
transport, 1-4

protocols tab
overview of tasks, 4-17

purging
archive important configurations before 

purging, 12-14

business message or collaboration instance 
data, 12-11

cannot purge predefined partner data that was 
part of installation, 12-11

data in a deployed configuration in the runtime 
repository, 12-10

design-time and runtime repositories, 4-22
selecting specific configurations to purge, 12-11
the entire repository, 12-14

Q
queues

confirming the validity of messages, A-2
quiesced

configuration state, 11-5
quiesced configurations

description, 11-3
quiescing

configurations, 11-9

R
remote trading partner certificates

Certificate File field is always empty when you 
update a certificate, 8-14

creating outside of the Create Trading Partner 
wizard, 8-13

deleting, 8-14
description, 8-11
for remote trading partners only, 8-12
managing, 8-11
overview of configuration tasks, 15-5
procedures for deleting a certificate already 

assigned to a remote trading partner, 8-14
selecting a certificate file with the Create Trading 

Partner wizard, 7-19
updating, 8-14
viewing, 8-13

remote trading partners
assigning a business protocol during a separate 

Create Trading Partner wizard session, 7-24
assigning business protocol communication 

capabilities during a separate Create Trading 
Partner wizard session, 7-26

assigning business protocol operational and 
communication capabilities during a single 
wizard session, 7-9

assigning business protocol operational 
capabilities during a separate Create Trading 
Partner wizard session, 7-25

assigning collaborations and business actions 
to, 6-3

assigning multiple business protocols, 7-8
creating and defining all capabilities during 

separate Create Trading Partner wizard 
sessions, 7-23

creating during a separate Create Trading Partner 
wizard session, 7-24

creating with the Create Trading Partner 
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wizard, 7-9
default trading partner identification type called 

Name, 8-7
description, 4-15, 7-2
in trading partner agreements, 10-2
managing, 7-2
person capabilities, 8-21
routing messages to other remote trading partners 

must be done outside of OracleAS Integration 
B2B, 6-15

remove button
differences with delete button, 4-9

report definitions
saving, 14-8

reports
description, 14-2
importing, 14-9
saving report definitions, 14-8
saving to comma-separated value (CSV) 

format, 4-20, 14-8
troubleshooting errors, A-2

Reports page
overview, 4-19

Reports role
description, 14-2
required for generating reports, 8-21

reports tab
description, 4-3
overview of tasks, 4-19

responding callout usages
appearing when creating a trading partner 

agreement, 9-3
selecting when creating a trading partner 

agreement, 9-3, 10-8
responding internal delivery channels

appearing when creating a trading partner 
agreement, 10-7

selecting for a trading partner agreement, 10-7
restrictions

on using the browser back and forward 
buttons, 4-9

retired
configuration state, 11-5

retired configurations
description, 11-5

retry count
selecting with the Create Trading Partner 

wizard, 7-17
updating, 8-49

return to list link
using, 4-9

RMI Instance parameter
for defining the RMI instance, 15-12, A-5
value must match with transport servlet setting in 

web.xml, 15-11, A-5
RMI Port parameter

for defining the RMI port, 15-12, A-5
value must match with transport servlet setting in 

web.xml, 15-11, A-5
RMI server

errors when attempting to contact, A-5
RNIF

See RosettaNet Implementation Framework, 2-7
roles

Administrator, 8-21
assigning to a host trading partner, 8-24
cannot delete, 8-25
removing from a host trading partner, 8-24
Reports, 8-21
viewing for a host trading partner, 8-25

RosettaNet, 2-4
creating collaborations, 6-3
document protocol support provided only for 

version 2.0, 6-7
importing collaborations, 6-3, 12-9

RosettaNet Business Dictionary, 2-5
RosettaNet Implementation Framework (RNIF), 2-8
RosettaNet Implementation Guidelines

revision 2.0 guidelines, 2-7
RosettaNet over RNIF

business protocol, 7-11
RosettaNet over the Internet tutorial, 5-7
RosettaNet Technical Dictionary, 2-5
RosettaNet validation, 2-5
routing

support, 6-15
runtime repository, 1-4

purging, 4-22
runtime system

deployment overview, 11-6

S
search facility

description, 4-5
in user interface tool, 4-9
only available if number of elements exceeds 

ten, 4-10
using wildcards, 4-10

secure HTTP
connecting to the secure HTTP URL, 15-9
enabling transport security with the Create 

Trading Partner wizard, 7-17
for secure connections between trading 

partners, 15-7
selecting with the Create Trading Partner 

wizard, 7-21
secure socket layer (SSL)

selecting with the Create Trading Partner 
wizard, 7-21

troubleshooting setup, 15-9
security

authorization and access enforcement, 15-3
classes of users and their privileges, 15-2
configuration issues, 15-5
configuration issues and options, 15-10
digital envelopes, 15-5
digital signatures, 15-6
encrypted wallet passwords for host trading 

partners, 15-9
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encryption, 15-5
for trading partners, 15-3
host trading partner password encryption in high 

availability environments, 15-10
identity management configuration issues, 15-4
installation issues, 15-4
installing and configuring an additional Oracle 

HTTP Server outside your corporate 
network, 15-11

network messaging, 15-3
nonrepudiation of origin and receipt, 15-6
Oracle Application Server security services, 15-3
Oracle HTTP Server, 15-11
Oracle Identity Management Infrastructure, 15-3
overview, 15-2
remote trading partner certificates, 15-5
resources protected, 15-3
secure HTTP, 15-3
secure HTTP and client authentication

overview of tasks, 15-7
security framework configuration issues, 15-4
signing credentials, 15-6
verifying SSL client authentication, 15-9
wallet passwords, 15-6, 15-7, 15-8

Security Key parameter
for defining the encryption key, 15-10

send for approval button
on details pages, 4-13

server properties
B2B Server Level parameter, A-3
Callout Directory parameter, 9-6
changing in Oracle Enterprise Manager 10g, 13-8, 

A-3
defining the log file format, A-2
description, 13-8
Generic Log Level parameter, A-3
range of values described in the online help, 13-3, 

13-9
RMI Instance parameter, 15-12, A-5
RMI Port parameter, 15-12, A-5
Security Key parameter, 15-10
setting log levels, A-3
updating property values on Windows operating 

systems, 13-9
User Interface Log Level parameter, A-3
Wallet Location parameter, 8-16, 15-6, 15-7, 15-8, 

15-9
SHA-RSA digital signatures

recommended digital signature, 15-7
selecting with the Create Trading Partner 

wizard, 7-20
supported versions, 7-20

shortcut section
description, 4-6
for creating a trading partner agreement, 4-6
for creating a trading partner and a trading partner 

agreement, 4-14
signing credentials

enabled by nonrepudiation of origin and 
receipt, 7-16

overview of configuration tasks, 15-6
selecting with the Create Trading Partner 

wizard, 7-16, 7-20
updating, 8-49
viewing for an exchange protocol, 8-29

S/MIME digital envelopes
selecting with the Create Trading Partner 

wizard, 7-19
supported versions, 7-19

states
approved, 4-12
deployed, 4-12
draft, 4-12
of a configuration, 11-4
viewing partner data lifecycle states on the details 

page, 4-12
string values

100-character limit for document definitions, 7-15
100-character limit for document type parameter 

values, 6-21
SYSTEM.ECXMSG message structure, 3-5

in callouts tutorial, 9-17

T
targets.xml file

changing port numbers, 13-12
trading partner agreement participants

adding additional identifications and operational 
and communication capabilities, 10-11

cannot remove the host trading partner, 10-14
managing, 10-10
removing a remote trading partner, 10-14
updating identifications, delivery channels, 

internal delivery channels, and callout usages 
for a remote trading partner, 10-13

viewing, 10-12
trading partner agreements, 1-4, 1-7

adding multiple collaborations or business actions 
to a single agreement, 10-6

assigning a beginning date, 10-8
assigning a concurrent conversation value, 10-8
assigning an ending date, 10-8
assigning an invocation limit, 10-8
cannot have more than two trading partners in an 

agreement, 10-6
common user errors, 10-17
creating, 10-6
creating an agreement ID, 10-8
creation overview, 10-3
deleting, 10-10
description, 10-2
enabling responding callout usages to appear, 9-3
enabling responding internal delivery channels to 

appear, 9-3
impact of a validated agreement when the wallet 

password is updated or created, 8-14
included in a configuration, 11-4
list page overview, 4-17
managing, 10-5
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must revalidate an agreement of a configuration 
that was exported, 11-10, 12-8

nonrepudiation of origin and receipt values must 
match for both host and remote trading 
partners, 15-7

only validated agreements can appear in a 
configuration, 11-4

overview, 10-2
prerequisites, 10-4
selecting a business action, 10-6
selecting a callout usage, 3-7, 9-2, 10-7
selecting a collaboration, 10-6
selecting a delivery channel, 10-7
selecting a responding callout usage, 9-3, 10-8
selecting a responding internal delivery 

channel, 9-3, 10-7
selecting a trading partner identification type 

value, 10-7
selecting an internal delivery channel, 3-7, 9-2, 

10-7
shortcut to creating, 4-6
status after importing, 12-7
status of a trading partner agreement in an 

imported configuration, 12-9
updating, 10-9
updating a beginning date, 10-9
updating a concurrent conversation value, 10-10
updating an ending date, 10-9
updating an invocation limit, 10-10
viewing, 10-8
viewing the lifecycle states, 10-9

Trading Partner Agreements page
overview, 4-17

Trading Partner Details page
capabilities section, 4-15
exporting to an XML file, 4-12
general section, 4-15
organization section, 4-15
overview, 4-12, 4-15, 8-2
users section, 4-15

trading partner identification types
AS2 Identifier, 7-10, 7-24
assigning a DUNS number, 8-9
assigning an AS2 Identifier, 8-9
assigning an EDI Location Code, 8-9
assigning an Generic Identifier, 8-9
creating, 12-4
creating outside of the Create Trading Partner 

wizard, 8-8
creating with the Create Trading Partner 

wizard, 7-10, 7-24
data universal numbering system (DUNS), 7-10, 

7-24
deleting, 8-10
description, 4-21, 12-4
EDI Location Code, 7-10, 7-24
Generic Identifier, 7-4, 7-10, 7-24
managing, 8-7, 12-4
predefined contact types that you cannot delete or 

update, 12-4

selecting a value for a trading partner 
agreement, 10-7

updating, 8-10
viewing, 8-9, 12-5

trading partner management, 1-4, 1-5, 1-7
Trading Partner page

overview, 4-14
trading partner participant delivery channel

impact on internal delivery channels of removing 
and adding a delivery channel, 10-16

trading partner participant delivery channels
adding, 10-15
managing, 10-14
removing, 10-16
updating, 10-16
viewing, 10-15

trading partners
accessing the Create Trading Partner wizard, 7-7
Business Protocol Details page, 8-4
cannot delete the host trading partner, 8-7
Capabilities page, 8-3
common user errors, 7-27, 8-64, 10-17
Create Trading Partner wizard prerequisites, 7-7
creating a remote trading partner during a 

separate Create Trading Partner wizard 
session, 7-24

creation overview, 7-2
defining the initiator or responder in a business 

action, 7-14
defining the initiator or responder in a 

collaboration, 7-13
deleting, 8-7
Delivery Channel page of Create Trading Partner 

wizard, 7-5, 7-15
description, 7-2
Document Exchange page of Create Trading 

Partner wizard, 7-5, 7-17
General page of Create Trading Partner 

wizard, 7-4, 7-9
Identification page of Create Trading Partner 

wizard, 7-4, 7-10, 7-24
in a configuration, 11-6
list page overview, 4-14
managing, 8-2, 8-5
managing the associated trading partner 

agreement, 8-10
Operational Capability page of Create Trading 

Partner wizard, 7-5, 7-11
Review page of Create Trading Partner 

wizard, 7-6, 7-23
Trading Partner Details page, 8-2
Transport page of Create Trading Partner 

wizard, 7-6, 7-21
updating, 8-7
viewing, 8-6
viewing the lifecycle states, 8-6

transaction sets
description, 4-3
importing, 4-22, 6-3, 12-9
relationship to a document type of a business 
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action, 4-3, 6-20, 12-6
transformations

using callouts, 9-2
transport parameters

restrictions on editing for internal delivery 
channels, 8-32

transport protocol parameters
defining with the Create Trading Partner 

wizard, 7-22
parameters that appear are based on transport 

protocol used, 7-22, 8-59
updating values, 8-59
when using the FTP or File transport 

protocol, A-6
transport protocols, 1-4

selecting Email, 7-21
selecting File, 7-21
selecting FTP, 7-21
selecting HTTP, 7-21
selecting secure HTTP, 7-21
selecting with the Create Trading Partner 

wizard, 7-21
updating, 8-55

transport security
cannot update, 8-49
selecting with the Create Trading Partner 

wizard, 7-17
updating, 8-49

transport servers
any updates must include updating the 

password, 8-58
associated with a delivery channel assigned to a 

trading partner agreement, 8-56
creating for host and remote trading partners with 

the Create Trading Partner wizard, 8-57
deleting, 8-59
description, 8-56
managing, 8-56
updating, 8-55, 8-58
viewing, 8-58

transport servlet
accessing, A-5
provides security for incoming messages of trading 

partners, 15-11
web.xml values must match with RMI Port and 

RMI Instance parameter values, 15-11, A-5
transports

associated with a delivery channel assigned to a 
trading partner agreement, 8-53, 10-14

creating for host and remote trading partners with 
the Create Trading Partner wizard, 7-21, 8-54

deleting, 8-56
description, 7-6, 8-53
managing, 8-53
updating, 8-55
viewing, 8-55

troubleshooting
checking log files, A-2
checking queues, A-2
internal delivery channels using the JMS transport 

protocol, 8-39
out-of-memory errors, A-3
resolving connection errors, A-5
running reports, A-2
setting log levels, A-3
SSL setup, 15-9

tutorials
adding callout usages to the RosettaNet over the 

Internet transaction, 9-16
EDI EDIFACT over Generic (VAN) 

transaction, 5-19
EDI X12 over Internet (AS2) transaction, 5-40
RosettaNet over the Internet transaction, 5-7
setting up the CLASSPATH environment, 5-4

U
UCCnet, 2-6

importing document standards, 4-22, 6-3, 12-9
supported in OracleAS Integration B2B, 2-6
using as a custom document protocol, 6-15

ui.log file
location of, A-2
troubleshooting errors, A-2

updateConfig command
updating configuration changes, 13-12

use case groups
cannot delete, 8-25
viewing, 8-25

use cases
description, 8-24
privileges of a user role, 8-21

user errors
business protocols, 6-33
callouts, 9-22
deployment, 11-10
exported files, 12-14
trading partner and trading partner 

agreements, 10-17
trading partners, 7-27, 8-64

User Interface Log Level parameter
for defining the logging level, A-3

user interface tool
accessing, 4-2
administration, 12-2
administration tab overview, 4-20
Administrator role, 4-2
Administrator role required for use, 8-21
agreements tab overview, 4-17
callouts tab overview, 4-18
creating incomplete information, 4-8
creating, adding, deleting, and removing 

data, 4-9
deployment tab overview, 4-19
design tab overview, 4-21
details pages overview, 4-6
exporting partner data to an XML file, 4-10
flexibility of design, 4-8
list pages overview, 4-4
location of export button, 4-8
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main page, 4-2
management tab overview, 4-21
page layout, 4-4
partner data details pages with an export 

button, 4-11
partners tab overview, 4-14
protocols tab overview, 4-17
reports tab overview, 4-19
restrictions on using the browser back and forward 

buttons, 4-9
searching for data, 4-9
user currently logged in, 4-5, 4-8
using the return to list link, 4-9
viewing partner data states on the details 

page, 4-12
user roles

Administrator, 8-21
cannot delete, 8-25
cannot remove Administrator role from the default 

admin user, 8-24
description, 8-24
Reports, 8-21

users
admin user name, 4-2, 15-2
creating, 8-22
currently logged into the user interface tool, 4-5, 

4-8
deleting, 8-23
for accessing the user interface tool, 4-2
ias_admin user name, 15-2
managing, 8-20
updating the name or description, 8-23
updating the password, 8-22
viewing, 8-22

users roles
assigning to a host trading partner, 8-24
removing from a host trading partner, 8-24
viewing for a host trading partner, 8-25

V
validate button

location of, 4-8
separate from end-to-end validation when creating 

a configuration, 4-13
validate partner data for individual 

correctness, 4-13
validated

configuration state, 11-4
validated lifecycle state

for creating partner data, 4-13
validation

disabling if using globalization support with EDI 
documents, 6-10, 6-14, 6-20, 6-21

of a configuration, 11-2
performance impacted if validation is set outside 

of OracleAS Integration B2B, 6-8, 6-9, 6-20, 
6-29

value-added networks (VANs), 1-3
VANs

See value-added networks, 1-3

W
Wallet Location parameter

for defining the wallet file location, 8-16, 15-6, 
15-7, 15-8, 15-9

wallet passwords
creating, 8-15
description, 8-14
enabling the Update button to appear, 8-15
encrypted only for host trading partners, 15-9
for host trading partner only, 8-14
impact of a validated trading partner agreement 

when the wallet password is created or 
updated, 8-14

managing, 8-14
must first update in Oracle Wallet Manager, 8-16
not exported or imported, 12-6
Oracle Wallet automatically created during 

installation, 8-15
overview of configuration tasks, 15-6, 15-7, 15-8
password must match the Oracle Wallet 

password, 8-16
Web browsers

accessing the user interface tool, 4-2
restrictions on using the browser back and forward 

buttons, 4-9
wildcards

using in search facility, 4-10
wire message status reports

creating, 14-4
description, 4-20

wire messages
description, 14-4

workflow
design-time, 1-4

X
XML file

export of a configuration, 11-10
export of partner data, 4-10

XML Gateway, 1-3
message structure, 3-5

XML Gateway Inbound internal delivery channel
associated with apps.ECX_INBOUND internal 

endpoint, 8-31
description, 3-2, 8-31

XML Gateway Outbound internal delivery channel
associated with apps.ECX_OUTBOUND internal 

endpoint, 8-31
description, 3-2, 8-31

.xsd files
importing with the Create Business Action 

wizard, 6-21
importing with the Create Collaboration 

wizard, 6-29, 6-31
XSLTCallout callout

predefined callout for XML-to-XML 
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transformations, 9-5
tutorial for using, 9-19

XSLTCalloutImpl class file
predefined class file for XML-to-XML 

transformations, 9-5
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